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Erste Schritte

Teil |
Erste Schritte

In diesem Teil enthaltene Kapitel:

e Einfiihrung
. Schnellstart
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Einfiihrung

1.1

1.2

1.3

Einfihrung

In diesem Kapitel behandelte Themen:

e Informationen (ber diese Betriebsanleitung
*  Modellcode der Auswerteelektronik

*  Kommunikations-Hilfsmittel und -protokolle
e Zusdtzliche Dokumentation und Ressourcen

Informationen iiber diese Betriebsanleitung

Dieses Handbuch enthélt Informationen (iber die Konfiguration, Inbetriebnahme,
Verwendung, Wartung und Stérungssuche der Micro Motion Modell 2700
Auswerteelektronik.

Wichtig

Dieses Handbuch setzt voraus, dass die Auswerteelektronik richtig und vollstdndig gemaR den
Anweisungen im entsprechenden Installationshandbuch installiert wurde, und dass die Installation
alle geltenden Sicherheitsanforderungen erfiillt.

Modellcode der Auswerteelektronik

Ihre Auswerteelektronik kann anhand der Modellnummer auf dem Typenschild
identifiziert werden.

Die Auswerteelektronik hat eine Modellnummer in folgender Form:
2700(l/R[C|B)**D** ****

Integrierte Montage

Externe Montage, 4-adrig

Externe Montage, 9-adrig

Externer Core-Prozessor mit externer Auswerteelektronik

o w N~

Eigensichere Ausgange

Kommunikations-Hilfsmittel und -protokolle

Es konnen mehrere unterschiedliche Kommunikations-Hilfsmittel und -protokolle
verwendet werden, um eine Verbindung mit der Auswerteelektronik herzustellen. Es
kénnen unterschiedliche Hilfsmittel an unterschiedlichen Standorten fiir unterschiedliche
Aufgaben verwendet werden.

Micro Motion® Auswerteelektronik Modell 2700 mit eigensicheren Ausgédngen
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Tabelle 1-1: Kommunikations-Hilfsmittel, -protokolle und zugehorige Informationen

Kommunika-
tions-Hilfsmit-
tel

Unterstiitzte Proto-
kolle

Anwendungsbereich

In dieser Betriebsan-
leitung

Weitere Informatio-
nen

e Service Port

tion und Inbetrieb-
nahme

zerinformationen. Siehe
Anhang C.

Display Nicht zutreffend Grundkonfiguration Vollstandige Benutzer- | Nicht zutreffend
und -Inbetriebnahme informationen. Siehe
Anhang A.
ProLink Il e HART/Bell 202 Vollstandige Konfigura- | Basis-Benutzerinforma- | Betriebsanleitung
 Service Port tion und Inbetrieb- tionen. Siehe AnhangB. | » Mit der Software in-
nahme stalliert
e Auf Micro Motion
Benutzerdokumen-
tations-CD
e Auf Micro Motion
Website (www.mi-
cromotion.com)
ProLink Il * HART/Bell 202 Vollstdandige Konfigura- | Grundlegende Benut- | Betriebsanleitung

e Mitder Software in-
stalliert

¢ Auf Micro Motion
Benutzerdokumen-
tations-CD

¢ Auf Micro Motion
Website (www.mi-
cromotion.com)

Handterminal

HART/Bell 202

Vollstandige Konfigura-
tion und Inbetrieb-
nahme

Grundlegende Benut-
zerinformationen. Siehe
Anhang D.

Betriebsanleitung auf
Micro Motion Website
(www.micromo-
tion.com

1.4

Hinweis

Maglicherweise kénnen andere Kommunikations-Hilfsmittel von Emerson Process Management
verwendet werden, wie AMS Suite: Intelligent Device Manager oder der Smart Wireless THUM™
Adapter. Die Verwendung des Smart Wireless THUM Adapters wird in diesem Handbuch nicht
behandelt. Das AMS Interface dhnelt dem ProLink Il Interface. Weitere Informationen zum Smart
Wireless THUM Adapter finden Sie in der Dokumentation unter www.micromotion.com.

Zusatzliche Dokumentation und Ressourcen

Micro Motion bieten eine zusdtzliche Dokumentation, um die Installation und den Betrieb
der Auswerteelektronik zu unterstiitzen.

Tabelle 1-2: Zusatzliche Dokumentation und Ressourcen

Thema

Dokument

Sensor

Sensor Dokumentation

Auswerteelektronik In-
stallation

Micro Motion Auswerteelektronik Modell 1700 und Modell 2700: Installa-
tionsanleitung
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Tabelle 1-2: Zusatzliche Dokumentation und Ressourcen (Fortsetzung)

Thema Dokument
Installation im Ex-Be- Weitere Informationen sind in der mit der Auswerteelektronik geliefert-
reich en Zulassungsdokumentation zu finden oder alternativ kann die en-

tsprechende Dokumentation auch von der Website Micro Motion unter
www.micromotion.com herunterladen werden.

Alle Dokumentationsressourcen sind auf der Website Micro Motion unter
www.micromotion.com oder auf der Micro Motion Anwender Dokumentations-CD zu

finden.
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2 Schnellstart

In diesem Kapitel behandelte Themen:

*  Einschalten der Auswerteelektronik

e Status des Durchfluss-Messsystems priifen

. Herstellen einer Inbetriebnahme Verbindung mit der Auswerteelektronik
e Charakterisieren des Durchfluss-Messsystems (falls erforderlich)

. Verifizieren der Massedurchflussmessung

»  Verifizieren des Nullpunkts

2.1 Einschalten der Auswerteelektronik

Die Auswerteelektronik muss fiir alle Konfigurations- und Inbetriebnahmeaufgaben sowie
fiir Prozessmessungen eingeschaltet sein.

1. Stellen Sie sicher, dass alle Auswerteelektronik und Sensor Gehdusedeckel sowie
Verschliisse geschlossen sind.

A\ VORSICHT!

Sicherstellen, dass alle Gehdusedeckel und Dichtungen dicht verschlossen sind, um eine
Entziindung in einer brennbaren Umgebung zu vermeiden. Bei Installationen in
explosionsgefdahrdeten Bereichen und mit ge6ffneten Gehdusedeckeln kann das
Einschalten der Stromversorgung zu einer Explosion fiihren.

2. Schalten Sie die Spannungsversorgung ein.

Die Auswerteelektronik fiihrt automatisch Diagnoseroutinen durch. In dieser
Zeitspanne ist Alarm 009 aktiv. Die Diagnoseroutinen sind in ungefahr 30 Sekunden
abgeschlossen. Bei Auswerteelektroniken mit Bedieninterface wechselt die Status-
LED auf griin und beginnt zu blinken wenn die Inbetriebnahme Diagnose beendet
ist. Zeigt die Status-LED ein abweichendes Verhalten, liegt eine Alarmbedingung
vor.

Nachbereitungsverfahren

Obwohl der Sensor bereits kurz nach dem Startvorgang das Prozessmedium verarbeiten
kann, kann die Elektronik bis zu 10 Minuten bend&tigen, um ein thermisches Gleichgewicht
zu erreichen. Aus diesem Grund kann es bei dem erstmaligen Startvorgang bzw. bei einer
Abschaltung, die so lange gedauert hat, dass die Komponenten die
Umgebungstemperatur annehmen konnten, ungefdhr 10 Minuten dauern, bis sich die
Elektronik erwarmt hat und zuverldssige Prozessmessungen liefert. Wahrend dieser
Warmlaufphase kann es sein, dass Sie geringfligige Instabilititen oder Ungenauigkeiten
der Messung feststellen.

2.2 Status des Durchfluss-Messsystems priifen

Das Durchfluss-Messsystem auf jegliche Stérbedingungen priifen, die eine Aktion des
Anwenders erforderlich machen oder die die Messgenauigkeit beeinflussen.

Konfigurations- und Bedienungsanleitung 5
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1.  Ca.10Sekunden warten, bis der Startvorgang abgeschlossen ist.

Sofort nach dem Startvorgang durchlauft die Auswerteelektronik Diagnoseroutinen
und priift auf Stérbedingungen. Wahrend des Startvorgangs ist Alarm A009 aktiv.
Dieser Alarm sollte nach dem Startvorgang automatisch geldscht werden.

2. Priifen Sie die Status-LED an der Auswerteelektronik.

Tabelle 2-1: Durch die Status-LED angezeigter Status der Auswerteelektronik

LED-Status Beschreibung Empfehlung
griin Es sind keine Alarme aktiv. Mit der Konfiguration oder der Prozessmes-
sung fortfahren.
Griin blinkend™ Es sind keine Alarme aktiv. Mindestens ein zu- | Mit der Konfiguration oder der Prozessmes-
vor aktiver Alarm wurde nicht bestatigt. sung fortfahren. Falls erforderlich, kénnen die
Alarme bestatigt werden.
gelb Mindestens ein Alarm niedriger Stufe ist aktiv | Eine Alarmbedingung niedriger Stufe wirkt
und wurde bestatigt. sich nicht auf die Genauigkeit oder das Aus-

gangsverhalten aus. Es kann mit der Konfigu-
ration oder der Prozessmessung fortgefahren
werden. Falls erforderlich, kann die Alarmbe-
dingung identifiziert und behoben werden.

Gelb blinkend® Mindestens ein Alarm niedriger Stufe ist aktiv = Eine Alarmbedingung niedriger Stufe wirkt
und wurde nicht bestdtigt. sich nicht auf die Genauigkeit oder das Aus-
gangsverhalten aus. Es kann mit der Konfigu-
ration oder der Prozessmessung fortgefahren
werden. Falls erforderlich, kann die Alarmbe-
dingung identifiziert und behoben werden.
Der Alarm kann auch bestatigt werden.

rot Mindestens ein Alarm hoher Stufe ist aktiv und | Eine Alarmbedingung hoher Stufe wirkt sich
wurde bestdtigt. auf die Genauigkeit oder das Ausgangsverhal-
ten aus. Die Alarmbedingungen vor dem For-
tfahren korrigieren.

Rot blinkend(3) Mindestens ein Alarm hoher Stufe ist aktiv und | Eine Alarmbedingung hoher Stufe wirkt sich
wurde nicht bestatigt. auf die Genauigkeit oder das Ausgangsverhal-
ten aus. Die Alarmbedingungen vor dem For-
tfahren korrigieren. Der Alarm kann auch bes-
tatigt werden.

Nachbereitungsverfahren

Weitere Informationen bzgl. der Anzeige der Liste aktiver Alarme sind unter Abschnitt 9.4
zu finden.

Weitere Informationen bzgl. der einzelnen Alarme und empfohlener MaBnahmen sind
unter Abschnitt 12.2 zu finden.

(1) Wenn Status LED Blinking deaktiviert ist, leuchtet die LED konstant griin und blinkt nicht.
(2) Wenn Status LED Blinking deaktiviert ist, leuchtet die LED konstant gelb und blinkt nicht.
(3) Wenn Status LED Blinking deaktiviert ist, leuchtet die LED konstant rot und blinkt nicht.
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2.3

2.4

Konfigurations- und Bedienungsanleitung

Herstellen einer Inbetriebnahme Verbindung
mit der Auswerteelektronik

Alle Konfigurations-Hilfsmittel mit Ausnahme des Bedieninterfaces erfordern eine aktive
Verbindung zu der Auswerteelektronik, um diese zu konfigurieren.

Den anzuwendenden Verbindungstyp identifizieren und den Anweisungen fiir diesen
Verbindungstyp im entsprechenden Anhang folgen.

Zu verwendender Verbin-
Kommunikations-Hilfsmittel = dungstyp Anweisungen
ProLink Il Service Port Anhang B
ProLink Il Service Port Anhang C
Handterminal HART Anhang D

Charakterisieren des Durchfluss-Messsystems
(falls erforderlich)

Anzeiger Not available

ProLink Il *  ProLink > Configuration > Device > Sensor Type
*  ProLink > Configuration > Flow

e ProLink > Configuration > Density

¢ ProLink > Configuration > T Series

ProLink Il Device Tools > Calibration Data
Handterminal Configure > Manual Setup > Characterize
Uberblick

Die Charakterisierung des Durchfluss-Messsystems passt die Auswerteelektronik an die
spezifischen Eigenschaften des angeschlossenen Sensors an. Die
Charakterisierungsparameter (auch Kalibrierparameter genannt) stellen die
Sensorempfindlichkeit beziiglich Durchfluss, Dichte und Temperatur dar. Abhangig vom
Sensortyp sind unterschiedliche Parameter erforderlich. Die fiir den Sensor zutreffenden
Werte von Micro Motion sind auf dem Typenschild des Sensors oder dem Kalibrierzertifikat
abzulesen.

Hinweis
Wenn das Durchfluss-Messsystem als eine Einheit bestellt wurde, wurde die Charakterisierung
bereits ab Werk vorgenommen. Die Charakterisierungsparameter sollten trotzdem Gberpriift
werden.

Verfahren
1. Sensor Type spezifizieren.

* Straight-tube (T-Serie)
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2.4.1

 Curved-tube (alle Sensoren auBer T-Serie)
2. Die Durchfluss Charakterisierungsparameter einstellen. Darauf achten, dass alle
Kommastellen beriicksichtigt werden.

* Bei Geradrohrsensoren FCF (Flow Cal oder Flow Calibration Factor), FTG und FFQ
einstellen.

 Bei Sensoren mit gebogenem Rohr Flow Cal (Flow Calibration Factor) einstellen.

3.  Die Dichte Charakterisierungsparameter einstellen.

e Bei Geradrohrsensoren D1, D2, DT, DTG, K1, K2, FD, DFQ1 und DFQ2 einstellen.

 Bei Sensoren mit gebogenem Rohr D1, D2, TC, K1, K2 und FD einstellen. (TC wird
manchmal als DT angezeigt.)

Beispiel Sensor Typenschilder

Abbildung 2-1: Typenschild an dlteren Sensoren mit gebogenem Messrohr (alle
Sensoren aulBer T-Serie)

oMAX, PRESSURE RATING Al
oMAX, PRESSURE RATING Al

=5

r N
Sensor S/N
Meter Type
Meter Factor
Flow Cal Factor 19.0005.13

Dens Cal Factor 12500142864.44
Cal Factor Ref to 0°C

TEMP °C

TUBE * CONN % *

25'C, ACCORDING TO ASME B31.3.
25'C, ACCORDING TO ANSI/ASME B16.5 OR MFR'S RATING.

J

Abbildung 2-2: Typenschild an neueren Sensoren mit gebogenem Messrohr (alle

Sensoren auf3er T-Serie)

(MODEL

S/N

\

FLOW CALx 19.0005.13
DENS CAL* 12502142824 .44

D1 0.0010
D2 0.9980

K1 12502.000
K2 14282.000

TC 4.44000 FD 310

TEMP RANGE

TO

C

TUBE * %

CONN** % CASE * %

« GALIBRATION FACTORS REFERENCE T0 0 C*
s« NAXIMUM PRESSURE RATING AT 25 C, ACCCRDING TG ASME B31.3
C* NAXINUM PRESSURE RATING AT 25¢. ACCORDING TO ANSI/ZASME B16.5 OR MFR‘S RATING

4/
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2.4.2

Konfigurations- und Bedienungsanleitung

Abbildung 2-3: Typenschild an élteren Sensoren mit geradem Messrohr (T-Serie)

4 )
MODEL T100T628SCAZEZZ7Z S/N 1234567890

FLOW FCF X.XXXX FT X XX
FTG X.XX FFQ X XX
DENS D1 X.XXXXX K1 XXXXX . XXX
D2 X.XXXXX K2 XXXXX . XXX
DT X.XX FD XX . XX

DTG X.XX DFQ1 XX.XX DFQ2 X.XX
TEMP RANGE -XXX TO XXX C
TUBEx*  CONNx*x  CASE=*
XXXX XXXXX XXXX XXXXXX

o MAXIAM RATING AT 25°C, ACCORDING TO ASME B31.3
oe MAXIMM PRESSURE RATING AT 25°C, ACCORDING TO ANSI/ASIE B16.5, OR WFR‘S RATING )

.

Abbildung 2-4: Typenschild an neueren Sensoren mit geradem Messrohr (T-Serie)

4 )
MODEL T100T628SCAZEZZ7Z7Z S/N 1234567890
FLOW FCF XXXX.XX.XX

FTG X.XX FFQ X . XX

DENS D1 X.XXXXX K1 XXXXX . XXX
D2 X.XXXXX K2 XXXXX . XXX
DT X.XX FD XX, XX

DTG X.XX DFQ1 XX. XX DFQ2 X.XX
TEMP RANGE —-XXX TO XXX C
TUBE* CONNx*x*  CASEx
XXXX XXXXX XXXX XXXXXX

* MAXIMUM PRESSURE RATING AT 25°C, ACCORDING TO ASME B31.3
\ #*# MAXIMUM PRESSURE RATING AT 25°C, ACCORDING TO ANSI/ASME B16.5, OR MFR‘S RATING /

Durchflusskalibrierparameter (FCF, FT)

Zur Beschreibung der Durchflusskalibrierung werden zwei separate Werte verwendet: ein
6 Zeichen langer FCF-Wert und ein 4 Zeichen langer FT-Wert. Diese stehen auf dem
Sensor-Typenschild.

Beide Werte beinhalten Dezimalpunkte. Bei der Charakterisierung konnen diese als zwei
Werte oder als eine Zahl, bestehend aus 10 Zeichen eingegeben werden. Der 10 Zeichen
lange String wird entweder Flowcal oder FCF genannt.

Wenn die FCF- und FT-Werte separat auf lhrem Sensor-Typenschild angezeigt werden und
sie einen einzelnen Wert eingeben miissen, verkniipfen Sie die beiden Werte, um den
einzelnen Parameterwert zu bilden.

Wenn lhr Sensor-Typenschild einen verkniipften Flowcal- oder FCF-Wert anzeigt und Sie die
FCF- und FT-Werte separat eingeben miissen, trennen Sie den verkniipften Wert:

o FCF = Die ersten 6 Zeichen, einschlieRlich des Dezimalpunkts

. FT = Die letzten 4 Zeichen, einschlieRlich des Dezimalpunkts

Beispiel: Verkniipfen von FCF und FT

FCF = x.xxxx

FT=yyy
Flow calibration parameter: X.xxxxy.yy
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Beispiel: Teilen des verkniipften Flowcal- oder FCF-Werts

Flow calibration parameter: x.xxxxy.yy
FCF = x.xxxx

FT=yyy

Dichtekalibrierparameter (D1, D2, K1, K2, FD, DT, TC)

Dichtekalibrierparameter sind normalerweise auf dem Sensortypenschild und dem
Kalibrierzertifikat zu finden.

Wenn das Typenschild lhres Sensors keinen D1 oder D2 Wert aufweist:

o Fiir D1 geben Sie den Dens A oder den D1 Wert vom Kalibrierzertifikat ein. Dieser
Wert ist die Betriebsdichte des Kalibriermediums mit der niedrigen Dichte.
Micro Motion verwendet Luft. Wenn Sie keinen Wert Dens A oder D1 finden, geben
Sie 0,001 g/cm?3 ein.

o Fiir D2 geben Sie den Wert Dens B oder D2 vom Kalibrierzertifikat ein. Dieser Wert ist
die Betriebsdichte des Kalibriermediums mit der h6heren Dichte. Micro Motion
verwendet Wasser. Wenn Sie keinen Wert Dens B oder D2 finden, geben Sie
0,998 g/cm? ein.

Wenn das Typenschild lhres Sensors keinen Wert K1 oder K2 aufweist:

. Fiir K1 geben Sie die ersten 5 Ziffern des Dichtekalibrierfaktors ein. Im Beispiel-
Typenschild ist dieser Wert 12500.

o Fiir K2 geben Sie die zweiten 5 Ziffern des Dichtekalibrierfaktors ein. Im Beispiel-
Typenschild ist dieser Wert 14286.

Wenn das Typenschild lhres Sensors keinen Wert FD aufweist, nehmen Sie mit dem
Micro Motion Kontakt auf.

Wenn das Typenschild Ihres Sensors keinen Wert DT oder TC aufweist, geben Sie die
letzten 3 Ziffern des Dichtekalibrierfaktors ein. Im Beispiel-Typenschild ist dieser Wert
4,44,

Verifizieren der Massedurchflussmessung

Uberpriifen Sie, ob der von der Auswerteelektronik ausgegebene Massedurchfluss korrekt
ist. Daflir kann jede beliebige Methode verwendet werden.

. Lesen Sie den Wert fiir Mass Flow Rate auf dem Display der Auswerteelektronik ab.

o Verbinden Sie die Auswerteelektronik mit ProLink Il und lesen Sie den Wert fiir Mass
Flow Rate im Fenster Process Variables ab (ProLink > Process Variables).

o Verbinden Sie die Auswerteelektronik mit ProLink Ill und lesen Sie den Wert fiir Mass
Flow Rate im Bereich Process Variables ab.

. Vrbinden Sie die Auswerteelektronik mit Handterminal und lesen Sie den Wert fiir
Mass Flow Rate im Mendi Process Variables ab (On-Line Menu > Overview > Primary Purpose
Variables).

Nachbereitungsverfahren

Wenn der gemeldete Massedurchfluss nicht korrekt ist:

. Priifen Sie die Charakterisierungsparameter.

Micro Motion® Auswerteelektronik Modell 2700 mit eigensicheren Ausgédngen
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. Beachten Sie die Vorschlage zur Stérungsanalyse und -beseitigung bei Problemen
mit Durchflussmessungen. Siehe Abschnitt 12.3.

2.6 Verifizieren des Nullpunkts

Das Verifizieren des Nullpunkts kann dabei helfen zu bestimmen, ob der gespeicherte
Nullpunkt fiir die entsprechende Anlage geeignet ist oder ob eine Nullpunktkalibrierung
vor Ort die Messgenauigkeit verbessert.

Die Nullpunktverifizierung analysiert den Nullpunktwert unter Bedingungen mit Null
Durchfluss und vergleicht diesen mit dem Nullpunktstabilitdtsbereich des Sensors. Wenn
der mittlere Nullpunktwert innerhalb eines angemessenen Bereichs liegt, ist der in der
Auswerteelektronik gespeicherte Nullpunktwert giiltig. Eine Feldkalibrierung fiihrt in
diesem Fall nicht zu einer Verbesserung der Messgenauigkeit.

2.6.1 Verifizieren des Nullpunkts mittels ProLink Il

Das Verifizieren des Nullpunkts kann dabei helfen zu bestimmen, ob der gespeicherte
Nullpunkt fiir die entsprechende Anlage geeignet ist oder ob eine Nullpunktkalibrierung
vor Ort die Messgenauigkeit verbessert.

Wichtig
In den meisten Fallen ist die werksseitige Nullpunktkalibrierung genauer als die im Feld. Kalibrieren
Sie den Nullpunkt des Durchflussmesssystems nicht, es sei denn:

. Anlagenverfahren erfordern eine Nullpunktkalibrierung.

. Der gespeicherte Nullpunktwert besteht das Nullpunktverifizierungsverfahren nicht.

Vorbereitungsverfahren

ProLink Il v2.94 oder hoher

Wichtig

Verifizieren bzw. kalibrieren Sie den Nullpunkt nicht, wenn ein Alarm mit hoher Prioritét aktiv ist. Das
Problem muss erst behoben werden, bevor der Nullpunkt des Durchflussmesssystems verifiziert
bzw. kalibriert wird. Sie kdnnen den Nullpunkt verifizieren bzw. kalibrieren, wenn ein Alarm mit
niedriger Prioritdt aktiv ist.

Verfahren
1. Vorbereiten des Durchflussmesssystems:
a. Lassen Sie das Durchflussmesssystem nach dem Einschalten mindestens
20 Minuten aufwdrmen.

b. Lassen Sie das Prozessmedium durch den Sensor strémen, bis die
Sensortemperatur ungefahr die normale Betriebstemperatur erreicht hat.

c. Stoppen Sie den Durchfluss durch den Sensor, indem Sie das in Flussrichtung
abwarts liegende Ventil und danach das in Flussrichtung aufwarts liegende Ventil
schlieBen (falls verfligbar).

d. Stellen Sie sicher, dass der Sensor abgesperrt ist, kein Durchfluss mehr
vorhanden ist und der Sensor vollstandig mit dem Prozessmedium gefdillt ist.

Konfigurations- und Bedienungsanleitung 11
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2. Wihlen Sie ProLink > Calibration > Zero Verification and Calibration > Verify Zero und warten
Sie, bis der Vorgang abgeschlossen ist.

3. Wenn die Nullpunktkalibrierung fehlschlagt:
a. Bestdtigen Sie, dass der Sensor vollstdndig abgesperrt ist, der Durchfluss
gestoppt ist und der Sensor vollstdndig mit dem Prozessmedium gefiillt ist.

b. Stellen Sie sicher, dass durch das Prozessmedium keine Kondensationsschliage
entstehen bzw. Kondensation entsteht und es keine Partikel enthalt, die sich
absetzen konnen.

c. Wiederholen Sie die Nullpunktverifizierung.

d. Falls sie erneut fehlschldgt, den Nullpunkt des Durchflussmesssystems
kalibrieren.

Siehe Abschnitt 11.3 bzgl. Anweisungen zur Nullpunktkalibrierung.
Nachbereitungsverfahren

Offnen Sie die Ventile, um den normalen Durchfluss durch den Sensor wieder herzustellen.

Verifizieren des Nullpunkts mittels ProLink Il

Das Verifizieren des Nullpunkts kann dabei helfen zu bestimmen, ob der gespeicherte
Nullpunkt fiir die entsprechende Anlage geeignet ist oder ob eine Nullpunktkalibrierung
vor Ort die Messgenauigkeit verbessert.

Wichtig
In den meisten Fallen ist die werksseitige Nullpunktkalibrierung genauer als die im Feld. Kalibrieren
Sie den Nullpunkt des Durchflussmesssystems nicht, es sei denn:

. Anlagenverfahren erfordern eine Nullpunktkalibrierung.

. Der gespeicherte Nullpunktwert besteht das Nullpunktverifizierungsverfahren nicht.

Vorbereitungsverfahren

ProLink Il v1.0 mit Patch Build 31 oder neuerer Version

Wichtig

Verifizieren bzw. kalibrieren Sie den Nullpunkt nicht, wenn ein Alarm mit hoher Prioritat aktiv ist. Das
Problem muss erst behoben werden, bevor der Nullpunkt des Durchflussmesssystems verifiziert
bzw. kalibriert wird. Sie kdnnen den Nullpunkt verifizieren bzw. kalibrieren, wenn ein Alarm mit
niedriger Prioritdt aktiv ist.

Verfahren
1. Vorbereiten des Durchflussmesssystems:
a. Lassen Sie das Durchflussmesssystem nach dem Einschalten mindestens

20 Minuten aufwdrmen.

b. Lassen Sie das Prozessmedium durch den Sensor strémen, bis die
Sensortemperatur ungefahr die normale Betriebstemperatur erreicht hat.

c. Stoppen Sie den Durchfluss durch den Sensor, indem Sie das in Flussrichtung
abwarts liegende Ventil und danach das in Flussrichtung aufwarts liegende Ventil
schlieBen (falls verfligbar).
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d. Stellen Sie sicher, dass der Sensor abgesperrt ist, kein Durchfluss mehr

vorhanden ist und der Sensor vollstandig mit dem Prozessmedium gefiillt ist.

Wahlen Sie Device Tools > Device Calibration > Zero Verification and Calibration > Verify Zero
und warten Sie, bis der Vorgang abgeschlossen ist.

Wenn die Nullpunktkalibrierung fehlschldgt:

d.

Bestdtigen Sie, dass der Sensor vollstdndig abgesperrt ist, der Durchfluss
gestoppt ist und der Sensor vollstdndig mit dem Prozessmedium gefiillt ist.

Stellen Sie sicher, dass durch das Prozessmedium keine Kondensationsschldge
entstehen bzw. Kondensation entsteht und es keine Partikel enthalt, die sich
absetzen kénnen.

Wiederholen Sie die Nullpunktverifizierung.

Falls sie erneut fehlschldgt, den Nullpunkt des Durchflussmesssystems
kalibrieren.

Siehe Abschnitt 11.3 bzgl. Anweisungen zur Nullpunktkalibrierung.

Nachbereitungsverfahren

Offnen Sie die Ventile, um den normalen Durchfluss durch den Sensor wieder herzustellen.

2.6.3 Terminologie verwendet bei Nullpunktverifizierung und
Nullpunktkalibrierung

Tabelle 2-2: Terminologie verwendet bei Nullpunktverifizierung und Nullpunktkalibrierung

Begriff

Definition

Null

Im Allgemeinen ist dies der Offet, der erforderlich ist, um den linken mit dem rechten
Aufnehmer unter Null Durchflussbedingungen zu synchronisieren. Einheit = Mikrosekun-
den

Hersteller Nullpunktwert

Der unter Laborbedingungen werksseitig ermittelte Nullpunktwert.

Nullpunkt im Feld

Der Nullpunktwert, der durch eine Nullpunktkalibrierung auRerhalb des Werks erzielt
wird.

Vorheriger Nullpunktwert

Der Nullpunktwert, der zum Beginn der Nullpunktkalibrierung gespeichert ist. Kann der
werksseitige Nullpunktwert oder ein vorheriger Nullpunktwert im Feld sein.

Manueller Nullpunktwert

Der in der Auswerteelektronik gespeicherte Nullpunktwert, der normalerweise durch
eine Nullpunktkalibrierung ermittelt wird. Dieser Wert kann auch manuell konfiguriert
werden. Auch “mechanischer Nullpunkt” oder “gespeicherter Nullpunktwert genannt.”

Nullpunktwert

Biredirektionale Echtzeit-Massedurchfluss ohne angewendeter Durchflussddmpfung oder
Massedurchflussabschaltung. Ein adaptiver Dampfungswert wird nur angewendet, wenn
sich die Massedurchflussrate (iber eine sehr kurze Zeitspanne stark verdndert. Einheit =
konfigurierte Messeinheit fiir Massedurchfluss

Nullpunktstabilitdt

Ein im Labor ermittelter Wert, der verwendet wird, um die erwartete Genauigkeit fiir ei-
nen Sensor zu berechnen. Unter Laborbedingungen bei Null Durchfluss wird davon aus-
gegangen, dass der durchschnittliche Durchfluss in dem Bereich liegen wird, die durch
den Nullpunktstabilitdtswert (0 + Nullpunktstabilitdt) definiert ist. Jede SensorgréRe und
jedes Sensormodell besitzen einen eindeutigen Nullpunktstabilitdtswert. Statistisch ge-
sehen fallen 95 % aller Datenpunkte innerhalb des durch den Nullpunktstabilitatswert fes-
tgelegten Bereich.

Nullpunktkalibrierung

Das Verfahren, das verwendet wird, um den Nullpunktwert zu bestimmen.

Konfigurations- und Bedienungsanleitung 13
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Tabelle 2-2: Terminologie verwendet bei Nullpunktverifizierung und Nullpunktkalibrierung

(Fortsetzung)
Begriff Definition
Nullzeit Die Zeitdauer, die fir das Nullpunkt Kalibrierungsverfahren angewandt wird. Einheit = Se-
kunden.

Feld Verifizierungsnullpunkt | Ein 3-minttiger laufender Durchschnitt des aktuellen Nullpunktwertes, berechnet durch
die Auswerteelektronik . Einheit = konfigurierte Messeinheit fiir Massedurchfluss

Nullpunktverifizierung Ein Verfahren, das verwendet wird, um den gespeicherten Nullpunktwert zu bewerten
und zu bestimmen, ob ein Nullpunkt im Feld die Messgenauigkeit erhdhen kann.
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Teil Il

Konfiguration und Inbetriebnahme

In diesem Teil enthaltene Kapitel:

Konfiguration und Inbetriebnahme - Einflihrung
Prozessmessung konfigurieren

Gerdteoptionen und Préferenzen konfigurieren
Integrieren des Messgerdtes mit dem Steuersystem
Abschluss der Konfiguration

Einstellungen der eichamtlichen Transfer Anwendung

Konfigurations- und Bedienungsanleitung
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Konfiguration und Inbetriebnahme -
Einfihrung

In diesem Kapitel behandelte Themen:

Ablaufdiagramm - Konfiguration

Voreingestellte Werte und Bereiche

Aktivieren des Zugriffs auf das Offline-Men(i des Bedieninterfaces
Deaktivieren des Schreibschutzes der Konfiguration der Auswerteelektronik
Werkskonfiguration wiederherstellen

Ablaufdiagramm - Konfiguration

Verwenden Sie das folgende Ablaufdiagramm als allgemeine Richtlinie fiir die
Konfiguration und Inbetriebnahme der Auswerteelektronik.

Einige Optionen treffen ggf. nicht auf Ihre Installation zu. In diesem Handbuch finden Sie
detaillierte Informationen tiber die Verfahren. Falls Sie die Anwendung Gewichte und
MaRe verwenden, sind zusatzliche Konfigurations- und Einrichtungsschritte erforderlich.

Micro Motion® Auswerteelektronik Modell 2700 mit eigensicheren Ausgédngen
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Abbildung 3-1: Ablaufdiagramm - Konfiguration

Prozessmessung konfigurieren

Massedurchflussmessung
konfigurieren

v

Volumen
Durchflussmessung
konfigurieren

‘'olumendurchflus:
Art

Flissigke

it Gas

Gerateoptionen und Préferenzen
konfigurieren

Bedieninterface

Gas Eigenschaften
definieren

l

¥

Durchflussrichtung
konfigurieren

!

Dichtemessung
konfigurieren

|

Temperaturmessung
konfigurieren

}

Anwendung
Mineral6lmessung (API)
konfigurieren (falls
verfligbar)

I

Anwendung
Konzentrationsmessung
konfigurieren (falls
verfugbar)

|

Druckkompensation
konfigurieren (optional)

"| Parameter konfigurieren

Tests und Vorbereitung fiir den Betrieb

Testen oder Anpassen
der Auswerteelektronik

I

Parameter flir
Handhabung der Alarme
konfigurieren

!

Sensorparameter
konfigurieren

!

Gerateparameter
konfigurieren

Gerét mit Steuerungssystem
integrieren f

Kanal/Kanale
konfigurieren

'

mA Ausgang/Ausgénge
konfigurieren

Y

Frequenzausgang/-
ausgange konfigurieren

'

Bindrausgang/-ausgange
konfigurieren

'

Ereignisse konfigurieren

Y

Digitale Kommunikation
konfigurieren

l

mittels Sensorsimulation

l

Backup der
Auswerteelektronik
Konfiguration

l

Schreibschutz der
Auswerteelektronik
Konfiguration aktivieren

Fertig

3.2 Voreingestellte Werte und Bereiche

Siehe Abschnitt E. 1 bzgl. der voreingestellten Werte und Bereiche fiir die meist

verwendeten Parameter.

Konfigurations- und Bedienungsanleitung
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Aktivieren des Zugriffs auf das Offline-Menii
des Bedieninterfaces

Anzeiger OFF-LINE MAINT > OFF-LINE CONFG > DISPLAY

ProLink Il ProLink > Configuration > Display > Display Options

ProLink Il Device Tools > Configuration > Transmitter Display > Display Security

Handterminal Configure > Manual Setup > Display > Offline Variable Menu Features
Uberblick

StandardmaRig ist der Zugriff auf das Offline-Mendi aktiviert. Ist der Zugriff deaktiviert,
muss er zuerst aktiviert werden, wenn das Bedieninterface zur Konfiguration der
Auswerteelektronik verwendet werden soll.

Einschrdankung

Das Bedieninterface kann nicht verwendet werden, um den Zugriff zum Offline-Men(i zu aktivieren.
Es muss eine Verbindung (iber ein anderes Hilfsmittel hergestellt werden.

Deaktivieren des Schreibschutzes der
Konfiguration der Auswerteelektronik

Anzeiger OFF-LINE MAINT > CONFG > LOCK

ProLink Il ProLink > Configuration > Device > Enable Write Protection

ProLink Il Device Tools > Configuration > Write-Protection

Handterminal Configure > Manual Setup > Info Parameters > Transmitter Info > Write Protect
Uberblick

Wenn die Auswerteelektronik schreibgeschiitzt ist, ist die Konfiguration gesperrt und
muss vor dem Andern von Konfigurationsparametern entsperrt werden. StandardmaRig
ist die Auswerteelektronik nicht schreibgeschiitzt.

Hinweis

Wenn die Auswerteelektronik schreibgeschiitzt ist, werden ungewollte Anderungen an der
Konfiguration verhindert. Der normale Betrieb wird dadurch nicht beeintrédchtigt. Sie kénnen den
Schreibschutz jederzeit aufheben, erforderliche Konfigurationsdnderungen durchfiihren und den
Schreibschutz danach wieder aktivieren.

Micro Motion® Auswerteelektronik Modell 2700 mit eigensicheren Ausgédngen
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3.5 Werkskonfiguration wiederherstellen
Anzeiger Nicht verfligbar
ProLink Il ProLink > Configuration > Device > Werkskonfiguration wiederherstellen
ProLink Il Gerate Extras > Konfigurationstibertragung > Restore Factory Configuration
Handterminal Nicht verflighar
Uberblick

Das Wiederherstellen der Werkskonfiguration versetzt die Auswerteelektronik in eine
bekannte Betriebskonfiguration. Dies kann hilfreich sein, wenn wahrend der Konfiguration
Probleme auftreten.

Hinweis

Die Wiederherstellung der Werkskonfiguration ist keine Aktion, die haufig durchgefiihrt werden
sollte. Wenn Sie einen diesbezliglichen Bedarf erkennen, sollten Sie sich an Micro Motion wenden,
um in Erfahrung zu bringen, ob fiir die Lésung bestimmter Probleme eine bevorzugte Methode
existiert.
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Prozessmessung konfigurieren

In diesem Kapitel behandelte Themen:

e Massedurchflussmessung konfigurieren

*  Konfigurieren von Volumendurchflussmessungen fir Flissigkeitsanwendungen
e Gas Standard Volumendurchflussmessung konfigurieren

. Konfigurieren von Durchflussrichtung

e Konfigurieren der Dichtemessung

. Konfigurieren einer Temperaturmessung

*  Anwendung Mineralélmessung konfigurieren

e Konfigurieren der Anwendung Konzentrationsmessung

*  Druckkompensation konfigurieren

Massedurchflussmessung konfigurieren

Die Parameter der Massedurchflussmessung steuern, wie Massedurchfluss gemessen und
ausgegeben wird.

Die Parameter der Massedurchflussmessung umfassen:

. Massedurchfluss Messeinheit

. Durchflussdampfung

. Massedurchfluss Abschaltung

Massedurchfluss Messeinheit konfigurieren

Anzeiger OFF-LINE MAINT > OFF-LINE CONFG > UNITS > MASS

ProLink Il ProLink > Configuration > Flow > Mass Flow Units

ProLink Il Device Tools > Configuration > Process Measurement > Flow

Handterminal Configure > Manual Setup > Measurements > Flow > Mass Flow Unit
Uberblick

Massedurchfluss Messeinheit spezifiziert die Messeinheit, die fiir den Massedurchfluss
verwendet wird. Die fiir die Masse Summen- und Gesamtzahler verwendet Messeinheit
wird von dieser Einheit abgeleitet.

Verfahren
Setzen Sie Massedurchfluss Messeinheit auf die Einheit, die Sie verwenden mochten.

Die Voreinstellung fiir Massedurchfluss Messeinheit ist g/s (Gramm pro Sekunde).
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Hinweis
Wenn die Messeinheit, die Sie verwenden mochten, nicht verfiigbar ist, kénnen Sie eine Spezial-
Messeinheit definieren.

Optionen fiir Massedurchfluss Messeinheit

Die Auswerteelektronik stellt einen Standardsatz sowie eine anwenderdefinierbare
Messeinheit fiir die Massedurchfluss Messeinheit zur Verfiigung. Verschiedene
Kommunikations-Hilfsmittel verwenden u. U. unterschiedliche Kennzeichnungen fiir die
Gerate.

Tabelle 4-1: Optionen fiir Massedurchfluss Messeinheit

Bezeichnung
Beschreibung der Einheit Anzeiger ProLink I ProLink 1l Handterminal
Gramm pro Sekunde G/S glsec glsec gls
Gramm pro Minute G/MIN g/min g/min g/min
Gramm pro Stunde GH g/hr g/hr gh
Kilogramm pro Sekunde KG/S kg/sec kg/sec kgls
Kilogramm pro Minute KG/MIN kg/min kg/min kg/min
Kilogramm pro Stunde KG/H kg/hr kg/hr kg/h
Kilogramm pro Tag KG/D kg/Tag kg/day kg/d
Metrische Tonnen pro Minute | T/MIN T/min mTon/min MetTon/min
Metrische Tonnen pro Stunde | T/H mTon/hr mTon/hr MetTon/h
Metrische Tonnen pro Tag T/D T/Tag mTon/day MetTon/d
Pfund pro Sekunde LB/S Ibs/sec Ibs/sec lb/s
Pfund pro Minute LB/MIN Ibs/min Ibs/min Ib/min
Pfund pro Stunde LBH Ibs/hr Ibs/hr lb/h
Pfund pro Tag LB/D Ibs/day Ibs/day Ib/d
Short tons (2000 Pfund) pro ST/MIN sTon/min sTon/min STon/min
Minute
Short tons (2000 Pfund) pro STH sTon/hr sTon/hr STon/h
Stunde
Short tons (2000 Pfund) pro STID sTon/Tag sTon/day ShTon/d
Tag
Long tons (2240 Pfund) pro LTH [Ton/hr [Ton/hr LTon/h
Stunde
Long tons (2240 Pfund) pro LT/D [Ton/Tag [Ton/day LTon/d
Tag
Spezialeinheit SPEZ Spezial special Spez
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Spezial-Messeinheit fiir Massedurchfluss definieren

Anzeiger Not available

ProLink Il ProLink > Configuration > Special Units

ProLink Il Device Tools > Configuration > Process Measurement > Flow > Special Units

Handterminal Configure > Manual Setup > Measurements > Special Units > Mass Special Units
Uberblick

Eine Spezial-Messeinheit ist eine benutzerdefinierte Messeinheit, mit der Prozessdaten,
Zahlerdaten und Summendaten in einer Einheit ausgegeben werden kénnen, die nichtin
der Auswerteelektronik verfligbar ist. Eine Spezial-Messeinheit wird mithilfe eines
Umrechnungsfaktors aus einer bestehenden Messeinheit berechnet.

Anmerkung

Obwohl eine Spezial-Messeinheit nicht Giber das Display definiert werden kann, kann das Display
verwendet werden, um eine bestehende Spezial-Messeinheit auszuwdhlen und die Prozessdaten
mittels Spezial-Messeinheit anzuzeigen.

Verfahren

1. Spezifizieren sie die Basis Masseeinheit.
Basis Masseeinheit ist die existierende Masseeinheit auf der die Spezialeinheit basieren
wird.

2. Spezifizieren Sie die Basiszeiteinheit.
Basiszeiteinheit ist die existierende Zeiteinheit, auf der die Spezialeinheit basieren
wird.

3. Berechnen Sie den Massedurchfluss Umrechnungsfaktor wie folgt:

a. xBasiseinheiten =y Spezialeinheiten
b. Massedurchfluss Umrechnungsfaktor = x|y
4.  Geben Sie den Massedurchfluss Umrechnungsfaktor ein.

5. Setzen Sie die Massedurchfluss Bezeichnung auf den Namen, den Sie fiir die
Massedurchfluss Einheit verwenden mochten.

6.  Setzen Sie die Masse Summenzahler Bezeichnung auf den Namen, den Sie fiir die Masse
Summenzéhler und Gesamtzahler Messeinheit verwenden méchten.

Die Spezial-Messeinheit wird in der Auswerteelektronik gespeichert. Die
Auswerteelektronik kann so konfiguriert werden, dass sie die Spezial-Messeinheit zu jeder
Zeit verwendet.

Beispiel: Spezial-Messeinheit fiir Massedurchfluss definieren
Sie wollen den Massedurchfluss in Unzen pro Sekunden (oz/s) messen.

1. Setzen Sie die Basis Masseeinheit auf Ib. (Ib).
Setzen Sie die Basiszeiteinheit auf Sekunden (sec).
Berechnen Sie den Massedurchfluss Umrechnungsfaktor:

a. 1lb/sec=160z/sec
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b. Massedurchfluss Umrechnungsfaktor = 1/16 = 0.0625
4, Setzen Sie den Massedurchfluss Umrechnungsfaktor auf 0,0625.
Setzen Sie die Massedurchfluss Bezeichnung auf oz/s.

6. Setzen Sie die Masse Summenzahler Bezeichnung auf oz.
4.1.2 Konfigurieren der Durchflussdampfung
Anzeiger Not available
ProLink Il ProLink > Configuration > Flow > Flow Damp
ProLink Il Device Tools > Configuration > Process Measurement > Flow
Handterminal Configure > Manual Setup > Measurements > Flow > Flow Damping
Uberblick

Die Dampfung wird verwendet, um kleine, plotzlich auftretende Schwankungen des
Prozessmesswerts zu gldtten. Damping Value gibt die Zeitdauer (in Sekunden) an, tiber die
die Auswerteelektronik die Anderungen in der ausgegebenen Prozessvariable verteilt. Am
Ende des Intervalls spiegelt die ausgegebene Prozessvariable 63 % der Anderung des
eigentlichen gemessenen Wertes wider.

Verfahren
Flow Damping auf den gewiinschten Wert einstellen.

Der Standardwert ist 0,8 Sekunden. Der Bereich richtet sich nach dem Typ des Core
Prozessors und der Einstellung fiir Update Rate (siehe nachfolgende Tabelle).

Core Prozessor Typ Einstellung Update Rate: Bereich fiir Flow Damping
Standard Normal 0 bis 51,2 Sekunden
Spezial 0 bis 10,24 Sekunden
Erweiterte Funktionalitdt | Nicht anwendbar 0 bis 51,2 Sekunden
Hinweise

* Ein hoher Ddmpfungswert ldsst die Prozessvariable regelméRiger erscheinen, da der
ausgegebene Wert sich langsamer dndert.

 Ein niedriger Dampfungswert lasst die Prozessvariable unregelméRiger erscheinen, da der
ausgegebene Wert sich schneller dndert.

* Die Kombination eines hohen Dampfungswertes und plétzlich auftretenden, groen
Anderungen in der Durchflussrate kann zu erhéhten Messfehlern fiihren.

e Immer, wenn der Dampfungswert nicht Null ist, wird der ausgegebene Messwert hinter der
eigentlichen Messung liegen, da der ausgegebene Wert (iber die Zeit gemittelt wird.

* Allgemein werden niedrigere Dampfungswerte vorgezogen, da das Risiko von Datenverlusten
und die Verzégerung zwischen dem eigentlichem und dem ausgegebenen Wert geringer ist.

* In Gasanwendungen empfiehlt Micro Motion, den Wert fiir Flow Damping auf 2.56 oder héher
einzustellen.
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4.1.3
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Der eingegebene Wert wird automatisch auf den nachst gliltigen Wert abgerundet.
Giiltige Dampfungswerte sind in der folgenden Tabelle dargestellt.

Tabelle 4-2: Giiltige Werte fiir Flow Damping

Core Prozessor Typ Einstellung Update Rate: Giiltige Dampfungswerte
Standard Normal 0,02,04,08,...51.2

Spezial 0,0.04,0.08, 0.16, ... 10.24
Erweiterte Funktionalitdt | Nicht anwendbar 0,0.2,0.4,08,...51.2

Auswirkung der Durchflussdampfung auf die Volumenmessung

Die Durchflussdampfung wirkt sich auf die Volumenmessung fiir die
Flissigkeitsvolumendaten aus. Die Durchflussdampfung wirkt sich auBerdem auf die
Volumenmessung fiir die Gas-Standardvolumendaten aus. Die Auswerteelektronik
berechnet die Volumendaten anhand der geddmpften Massedurchflussdaten.

Wechselwirkung zwischen Durchflussddampfung und Zusatzlicher
Dampfung

In einigen Féllen werden sowohl die Durchflussddmpfung als auch die Zusétzliche Dampfung auf
den ausgegebenen Massedurchfluss angewandt.

Die Durchflussdémpfung regelt die Anderungsrate der Durchfluss-Prozessvariablen. Die
Zusétzliche Dampfung regelt die Anderungsrate, die (iber den mA-Ausgang ausgegeben wird.
Wenn die mA-Ausgangs-Prozessvariable auf Massedurchfluss gesetzt ist und sowohl die
Durchflussd@mpfung als auch die Zusétzliche Ddmpfung auf einen Wert ungleich Null gesetzt
sind, wird zuerst die Durchflussddmpfung angewandt, und die Berechnung der
zusatzlichen Dampfung wird auf das Ergebnis der ersten Rechnung angewandt

Massedurchfluss Abschaltung konfigurieren

Anzeiger Not available

ProLink Il ProLink > Configuration > Flow > Mass Flow Cutoff

ProLink Il Device Tools > Configuration > Process Measurement > Flow

Handterminal Configure > Manual Setup > Measurements > Flow > Mass Flow Cutoff
Uberblick

Massedurchfluss Abschaltung spezifiziert den niedrigsten Massedurchfluss, der als Messwert
ausgegeben wird. Jeder Massedurchfluss unterhalb dieses Abschaltungswerts wird als 0
ausgegeben.

Verfahren

Setzen Sie Massedurchfluss Abschaltung auf den gewiinscthen Wert.
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Der voreingestellte Wert flir Massedurchfluss Abschaltung ist 0,0 g/s oder ein werkseitig
eingestellter, sensorspezifischer Wert. Die empfohlene Einstellung ist 0,05 % des
maximalen Nenndurchflusses des Sensors bzw. ein Wert unter dem héchsten erwarteten
Durchfluss. Setzen Sie Massedurchfluss Abschaltung nicht auf 0,0 g/s.

Auswirkung der Massedurchflussabschaltung auf die
Volumenmessung

Die Massedurchflussabschaltung wirkt sich nicht auf die Volumenmessung aus. Die
Volumendaten werden anhand der tatsachlichen Massendaten errechnet anstelle des
ausgegebenen Werts.

Wechselwirkung zwischen Massedurchflussabschaltung und AO-
Abschaltung

Massedurchflussabschaltung spezifiziert den niedrigsten Massedurchfluss, den die
Auswerteelektronik als Messwert ausgibt. Die AO-Abschaltung definiert die niedrigste
Durchflussrate, die (iber den mA-Ausgang ausgegeben wird. Wenn die Prozessvariable mA-
Ausgang auf Massedurchfluss eingestellt ist, wird der vom mA-Ausgang ausgegebene
Massedurchfluss vom héheren der beiden Abschaltwerte geregelt.

Massedurchflussabschaltung wirkt sich auf alle ausgegebenen Werte aus, die in anderen
Auswerteelektronik-Verhalten verwendet werden (z. B. Ereignisse, die fiir den
Massedurchfluss definiert wurden).

Die AO-Abschaltung wirkt sich nur auf die Massedurchfliisse aus, die (iber den mA-Ausgang
ausgegeben wurden.

Beispiel: Abschaltwechselwirkung bei AO-Abschaltung kleiner als
Massedurchflussabschaltung

Konfiguration:

J mA-Ausgang-Prozessvariable: Massedurchfluss

. Frequenzausgang-Prozessvariable: Massedurchfluss

. AO-Abschaltung: 10 g/s

. Massedurchflussabschaltung: 15 g/s

Ergebnis: Wenn der Massedurchfluss unter 15 g/s abfallt, wird der Massedurchfluss als 0
ausgegeben und fiir alle internen Verarbeitungsverfahren verwendet.

Beispiel: Abschaltwechselwirkung bei AO-Abschaltung groBer als
Massedurchflussabschaltung

Konfiguration:

. mA-Ausgang-Prozessvariable: Massedurchfluss

. Frequenzausgang-Prozessvariable: Massedurchfluss

. AO-Abschaltung: 15 g/s

. Massedurchflussabschaltung: 10 g/s

Ergebnis:
. Féllt der Massedurchfluss unter 15 g/s aber nicht unter 10 g/s:
- Gibt der mA-Ausgang Nulldurchfluss aus.
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- Der Frequenzausgang gibt den Istdurchfluss aus, und der Istdurchfluss wird fiir
alle internen Verarbeitungsverfahren verwendet.

. Wenn der Massedurchfluss unter 10 g/s abfillt, geben beide Ausgange
Nulldurchfluss aus, und fiir alle internen Verarbeitungsverfahren wird 0 verwendet.

4.2 Konfigurieren von
Volumendurchflussmessungen fiir
Fliissigkeitsanwendungen

Die Parameter fiir Volumendurchflussmessungen steuern, wie der
Flissigkeitsvolumenstrom gemessen und gemeldet wird.

Die Parameter fiir Volumendurchflussmessungen umfassen:

. Volume Flow Type

. Volume Flow Measurement Unit

. Volume Flow Cutoff

Einschrdankung

Flissigkeit Volumendurchfluss und Gas Standard Volumendurchfluss kdnnen nicht gleichzeitig
verwendet werden. Sie konnen jeweils immer nur eine Option auswéhlen.

4.2.1 Konfigurieren von Volumendurchfluss Art fiir
Fliissigkeitsanwendungen

Anzeiger Not available

ProLink Il ProLink > Configuration > Flow > Vol Flow Type > Liquid Volume

ProLink Il Device Tools > Configuration > Process Measurement > Flow

Handterminal Configure > Manual Setup > Measurements > GSV > Volume Flow Type > Liquid
Uberblick

Volume Flow Type steuert, ob Fliissigkeit oder Gas Standard Volumendurchfluss gemessen
wird.

Einschrdankung

Bei Verwendung der Anwendung Mineral6lmessung muss Volume Flow Type auf Liquid eingestellt
werden. Eine Gas Standard Volumenmessung ist mit der Anwendung Mineral6lmessung nicht
kompatibel.

Einschrdankung

Bei Verwendung der Anwendung Konzentrationsmessung muss Volume Flow Type auf Liquid eingestellt
werden. Eine Gas Standard Volumenmessung ist mit der Anwendung Konzentrationsmessung nicht
kompatibel.
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4.2.2

Verfahren

Setzen Sie Volume Flow Type auf Liquid.

Konfigurieren von Volumendurchfluss-Messeinheit fiir
FlGissigkeitsanwendungen

Anzeiger OFF-LINE MAINT > OFF-LINE CONFG > UNITS > VOL

ProLink Il ProLink > Configuration > Flow > Vol Flow Units

ProLink Il Device Tools > Configuration > Process Measurement > Flow
Handterminal Configure > Manual Setup > Measurements > Flow > Volume Flow Unit

Uberblick

Volume Flow Measurement Unit gibt die Messeinheit an, die fiir die Anzeige des
Volumendurchflusses verwendet wird. Die Einheit, die flir den Volumen Summen- und
Gesamtzahler verwendet wird, basiert auf dieser Einheit.

Vorbereitungsverfahren

Stellen Sie vor dem Konfigurieren von Volume Flow Measurement Unit sicherstellen, dass
Volume Flow Type auf Liquid gesetzt ist.

Verfahren
Setzen Sie Volume Flow Measurement Unit auf die gewtinschte Einheit.

Die Voreinstellung fiir Volume Flow Measurement Unit ist I/s (Liter pro Sekunde).

Hinweis
Wenn die Messeinheit, die Sie verwenden mdchten, nicht verfiigbar ist, kénnen Sie eine Spezial-
Messeinheit definieren.

Optionen fiir Volume Flow Measurement Unit fiir
Fliissigkeitsanwendungen

Die Auswerteelektronik bietet ein Standardsatz an Messeinheiten flir Volume Flow
Measurement Unit und eine zusatzliche benutzerdefinierbare Messeinheit. Unterschiedliche
Kommunikations-Hilfsmittel verwenden moéglicherweise unterschiedliche
Kennzeichnungen fiir die Einheiten.

Tabelle 4-3: Optionen fiir Volume Flow Measurement Unit fiir Fliissigkeitsanwendungen

Kennzeichnung
Beschreibung der Einheit Anzeiger ProLink II ProLink Ill Handterminal
Kubikfuss pro Sekunde FT3/S ft3/sec ft3/sec ft3/s
Kubikfuss pro Minute FT3/IM ft3/min ft3/min ft3/min
Kubikfuss pro Stunde CUFTH ft3/hr ft3/hr ft3/h
Kubikfuss pro Tag FT3/D ft3/day ft3/day ft3/Tag
Kubikmeter pro Sekunde M3/S m3/sec m3/sec m3/s

Konfigurations- und Bedienungsanleitung

27



Prozessmessung konfigurieren

Tabelle 4-3: Optionen fiir Volume Flow Measurement Unit fiir Fliissigkeitsanwendungen (Fortsetzung)

Kennzeichnung
Beschreibung der Einheit Anzeiger ProLink I ProLink Ill Handterminal
Kubikmeter pro Minute M3/MIN m3/min m3/min m3/min
Kubikmeter pro Stunde M3/H m3/hr m3/hr m3/h
Kubikmeter pro Tag M3/D m3/day m3/day m3/Tag
U.S. Gallonen pro Sekunde USG/S US gallsec US gallsec Galls
U.S. Gallonen pro Minute USG/M US gal/min US gal/min Gal/min
U.S. Gallonen pro Stunde USG/H US gal/hr US galthr Gal/h
U.S. Gallonen pro Tag USG/D US gallTag US gal/day Gal/Tag
Millionen U.S. Gallonen pro MILG/D mil US gal/day mil US gal/day Mgal/Tag
Tag
Liter pro Sekunde L/S IIsec I/'sec I/s
Liter pro Minute L/MIN I/min I/min L/min
Liter pro Stunde LH I/hr I/hr I/h
Millionen Liter pro Tag MILL/D mil l/Tag mil l/day ml/Tag
Imperial Gallonen pro Sekunde | UKG/S Imp galls Imp gallsec ImpGal/s
Imperial Gallonen pro Minute | UKG/M Imp gal/min Imp gal/min ImpGal/min
Imperial Gallonen pro Stunde | UKG/H Imp galh Imp galfhr ImpGal/h
Imperial Gallonen pro Tag UKG/D Imp gal/Tag Imp gal/day ImpGal/Tag
Barrel pro Sekunde(") BRL/S Barrel/s barrels/sec bblis
Barrel pro Minute(!) BBL/MN Barrel/min barrels/min bbl/min
Barrel pro Stunde(") BRL/H Barrel/h barrels/hr bbl/h
Barrel pro Tag(") BRL/D Barrel/Tag barrels/day bbl/d
Bier Barrel pro Sekunde(2) BBBL/S Bier Barrel/s Beer barrels/sec bbblis
Bier Barrel pro Minute(?) BBBL/M Bier Barrel/min Beer barrels/min bbbl/min
Bier Barrel pro Stunde(2) BBBL/H Bier Barrel/h Beer barrels/hr bbbl/h
Bier Barrel pro Tag(?) BBBL/D Bier Barrel/Tag Beer barrels/day bbbl/d
Spezialeinheit SPECL Spezial special Spez

Festlegen einer speziellen Messeinheit fiir

Volumendurchfluss
Anzeiger Not available
ProLink Il ProLink > Configuration > Special Units
ProLink Il Device Tools > Configuration > Process Measurement > Flow > Special Units
Handterminal Configure > Manual Setup > Measurements > Special Units > Volume Special Units

(1) Einheiten basieren auf Ol Barrels (42 U.S Gallonen).
(2) Einheiten basieren auf Bier Barrels (31 U.S Gallonen).
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Uberblick

Eine Spezial-Messeinheit ist eine benutzerdefinierte Messeinheit, mit der Prozessdaten,
Zahlerdaten und Summendaten in einer Einheit ausgegeben werden kénnen, die nichtin
der Auswerteelektronik verfiigbar ist. Eine Spezial-Messeinheit wird mithilfe eines
Umrechnungsfaktors aus einer bestehenden Messeinheit berechnet.

Anmerkung

Obwohl eine Spezial-Messeinheit nicht iber das Display definiert werden kann, kann das Display
verwendet werden, um eine bestehende Spezial-Messeinheit auszuwéhlen und die Prozessdaten
mittels Spezial-Messeinheit anzuzeigen.

Verfahren

1. Legen Sie die Base Volume Unit fest.
Base Volume Unit ist die existierende Volumeneinheit, auf der die Spezialeinheit
basieren wird.

2. Legen Sie die Base Time Unit fest.
Base Time Unit ist die existierende Zeiteinheit, auf der die Spezialeinheit basieren
wird.

3. Berechnen Sie Volume Flow Conversion Factor wie folgt:

a. xBasiseinheiten =y Spezialeinheiten
b. Volume Flow Conversion Factor = x|y
4. Geben Sie den Volume Flow Conversion Factor ein.

5. Setzen Sie Volume Flow Label auf den Namen, den Sie fiir die
Volumendurchflusseinheit verwenden mochten.

6. Setzen Sie Volume Total Label auf den Namen, den Sie fiir die Einheit fir des Volumen
Summen- und Gesamtzahlers verwenden mochten.

Die Spezial-Messeinheit wird in der Auswerteelektronik gespeichert. Die
Auswerteelektronik kann so konfiguriert werden, dass sie die Spezial-Messeinheit zu jeder
Zeit verwendet.

Beispiel: Festlegen einer speziellen Messeinheit fiir Volumendurchfluss
Es soll der Volumendurchfluss in Pint/s gemessen werden.

1. Setzen Sie Base Volume Unit auf Gallons (gal).
Setzen Sie Base Time Unit auf Seconds ().
Umrechnungsfaktor berechnen:

a. 1gal/sec= 8 pints/sec
b. Volume Flow Conversion Factor=1/8 =0.1250

4. Setzen Sie Volume Flow Conversion Factor auf 0,1250.
Setzen Sie Volume Flow Label auf pints/sec.

6. Setzen Sie Volume Total Label auf pints.
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Konfigurieren der Volumendurchflussabschaltung

Anzeiger Not available

ProLink Il ProLink > Configuration > Flow > Vol Flow Cutoff

ProLink Il Device Tools > Configuration > Process Measurement > Flow

Handterminal Configure > Manual Setup > Measurements > Flow > Volume Flow Cutoff
Uberblick

Volume Flow Cutoff gibt den niedrigsten Volumendurchfluss an, der als gemessen gemeldet
wird. Jeder Volumendurchfluss unter diesem Grenzwert wird als 0 gemeldet.

Verfahren
Setzen Sie Volume Flow Cutoff auf den gew{inschten Wert.

Der Standardwert fiir Volume Flow Cutoff betrdgt 0,0 I/s (Liter pro Sekunde). Der untere
Grenzwert ist 0. Der obere Grenzwert ist der Durchflusskalibrierfaktor des Sensors in
Einheiten von I/sec, multipliziert mit 0.2.

Wechselwirkung zwischen Volumendurchflussabschaltung und AO-
Abschaltung

Volumendurchflussabschaltung spezifiziert den niedrigsten Fllissigkeitsvolumendurchfluss, den
die Auswerteelektronik als Messwert ausgibt. Die AO-Abschaltung definiert die niedrigste
Durchflussrate, die (iber den mA-Ausgang ausgegeben wird. Wenn die Prozessvariable mA-

Ausgang auf Volumendurchfluss eingestellt ist, wird der vom mA-Ausgang ausgegebene
Volumendurchfluss vom héheren der beiden Abschaltwerte geregelt.

Die Volumendurchflussabschaltung wirkt sich auf die (iber die Ausgange ausgegebenen
Vlumendurchflusswerte und die in anderen Auswerteelektronik-Verhalten (z. B. Ereignisse,
die fir den Vvolumendurchfluss definiert wurden) verwendeten Volumendurchflusswerte
aus.

Die AO-Abschaltung wirkt sich nur auf die Durchfliisse aus, die (iber den mA-Ausgang
ausgegeben wurden.

Beispiel: Abschaltwechselwirkung bei AO-Abschaltung kleiner als
Volumendurchflussabschaltung

Konfiguration:

. mA-Ausgang-Prozessvariable: Volumendurchfluss

. Frequenzausgang-Prozessvariable: Volumendurchfluss

. AO-Abschaltung: 10 I/s

. Volumendurchflussabschaltung: 15 1/s

Ergebnis: Wenn der Volumendurchfluss unter 15 SLPM abfillt, wird der

Volumendurchfluss als 0 ausgegeben und fiir alle internen Verarbeitungsverfahren
verwendet.
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Beispiel: Abschaltwechselwirkung bei AO-Abschaltung groBer als
Volumendurchflussabschaltung

Konfiguration:

. mA-Ausgang-Prozessvariable: Volumendurchfluss

. Frequenzausgang-Prozessvariable: Volumendurchfluss
AQ-Abschaltung: 151/s

Volumendurchflussabschaltung: 10 1/s

Ergebnis:
. Fallt der Volumendurchfluss unter 15 I/s aber nicht unter 10 /s:
- Gibt der mA-Ausgang Nulldurchfluss aus.

- DerFrequenzausgang gibt den Istdurchfluss aus, und der Istdurchfluss wird fiir
alle internen Verarbeitungsverfahren verwendet.

. Wenn der Volumendurchfluss unter 10 I/s abfillt, geben beide Ausgédnge
Nulldurchfluss aus, und fiir alle internen Verarbeitungsverfahren wird 0 verwendet.

4.3 Gas Standard Volumendurchflussmessung
konfigurieren

Die Parameter der Gas Standard Volumendurchflussmessung steuern, wie der Gas
Standard Volumendurchfluss gemessen und ausgegeben wird.

Die Parameter der Gas Standard Volumendurchflussmessung umfassen:

. Volumendurchfluss Art

. Standard Dichte des Gases

. Gas Standard Volumendurchfluss Einheit

. Gas Standard Volumen Durchflussabschaltung

Einschrdankung

Flissigkeit Volumendurchfluss und Gas Standard Volumendurchfluss kénnen nicht gleichzeitig
verwendet werden. Sie kénnen jeweils immer nur eine Option auswdhlen.

4.3.1 Volumendurchfluss Art fir Gasmessungen konfigurieren
Anzeiger Not available
ProLink Il ProLink > Configuration > Flow > Vol Flow Type
ProLink Il Device Tools > Configuration > Process Measurement > Flow
Handterminal Configure > Manual Setup > Measurements > GSV > Volume Flow Type > Standard Gas Volume
Uberblick

Volumendurchfluss Art steuert, ob Fllissigkeit oder Gas Standard Volumendurchfluss
gemessen wird.
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Einschrankung

Bei Verwendung der Anwendung Mineraldlmessung muss Volume Flow Type auf Liquid eingestellt
werden. Eine Gas Standard Volumenmessung ist mit der Anwendung Mineralélmessung nicht
kompatibel.

Einschrankung

Bei Verwendung der Anwendung Konzentrationsmessung muss Volume Flow Type auf Liquid eingestellt
werden. Eine Gas Standard Volumenmessung ist mit der Anwendung Konzentrationsmessung nicht
kompatibel.

Verfahren

Setzen Sie Volumendurchfluss Art auf Gas Standard Volumen.

Standard Gas Dichte konfigurieren

Anzeiger Not available

ProLink Il ProLink > Configuration > Flow > Std Gas Density

ProLink Il Device Tools > Configuration > Process Measurement > Flow

Handterminal Configure > Manual Setup > Measurements > GSV > Gas Ref Density
Uberblick

Der Wert Standard Gas Dichte wird verwendet, um die gemessenen Durchflussdaten in die
Standard Referenzwerte umzurechnen.

Vorbereitungsverfahren

Stellen Sie sicher, dass Dichte Messeinheit auf die Messeinheit gesetzt ist, die Sie fiir Standard
Gas Dichte verwenden mdéchten.

Verfahren

Setzen Sie Standard Gas Dichte auf die Standard Referenzdichte des Gases, das Sie messen
wollen.

Anmerkung

ProLink Il und ProLink Ill bieten eine gefiihrten Methode, die Sie zur Berechnung der Standard Dichte
des zu messenden Gases verwenden kénnen, falls diese nicht bekannt ist.

Gas Standard Volumendurchfluss Messeinheit konfigurieren

Anzeiger OFF-LINE MAINT > OFF-LINE CONFG > UNITS > GSV

ProLink Il ProLink > Configuration > Flow > Std Gas Vol Flow Units

ProLink Il Device Tools > Configuration > Process Measurement > Flow
Handterminal Configure > Manual Setup > Measurements > GSV > GSV Flow Unit
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Uberblick

Gas Standard Volumendurchfluss Messeinheit spezifiziert die Messeinheit, die fir den Gas
Standard Volumendurchfluss angezeigt wird. Die fiir den Gas Standard Volumen
Summenzdhler und den Gas Standard Volumen Gesamtzdhler verwendete Messeinheit
wird von dieser Einheit abgeleitet.

Vorbereitungsverfahren

Bevor Sie Gas Standard Volumendurchfluss Messeinheit konfigurieren, miissen Sie sicherstellen,
dass Volumendurchfluss Art auf Gas Standard Volumen gesetzt ist.

Verfahren

Setzen Sie Gas Standard Volume Flow Measurement Unit auf die Einheit, die Sie verwenden
mochten.

Die Voreinstellung fiir Gas Standard Volume Flow Measurement Unit ist SCFM (Standard
KubikfuR pro Minute).

Hinweis
Wenn die Messeinheit, die Sie verwenden mochten, nicht verfiigbar ist, konnen Sie eine Spezial-
Messeinheiten definieren.

Optionen fiir die Messwerteinheit von Gas-Standardvolumendurchfluss

Die Auswerteelektronik bietet ein Standardsatz an Messwerteinheiten fiir die Einheit von
Standardvolumendurchfluss von Gas und eine zuséatzliche benutzerdefinierte Messwerteinheit.

Verschiedene Kommunikations-Hilfsmittel verwenden u. U. unterschiedliche
Kennzeichnungen fiir die Geréte.

Tabelle 4-4: Optionen fiir die Messwerteinheit von Gas-Standardvolumen

Bezeichnung
Beschreibung der Einheit Anzeiger ProLink I ProLink Ill Handterminal
Normkubikmeter pro Sekunde | NM3/S Nm3/s Nm3/sec Nm3/s
Normkubikmeter pro Minute | NM3/M Nm3/min Nm3/sec Nm3/min
Normkubikmeter pro Stunde | NM3/H Nm3/h Nm3/hr Nm3/h
Normkubikmeter pro Tag NM3/D Nm3/Tag Nm3/day Nm3/Tag
Normliter pro Sekunde NLPS NLPS NLPS NLPS
Normliter pro Minute NLPM NLPM NLPM NLPM
Normliter pro Stunde NLPH NLPH NLPH NLPH
Normliter pro Tag NLPD NLPD NLPD NLPD
Standard-KubikfuR pro Se- SCFS SCFS SCFS SCFS
kunde
Standard-KubikfuR pro Minute | SCFM SCFM SCFM SCFM
Standard-Kubikful pro Stunde | SCFH SCFH SCFH SCFH
Standard-KubikfuR pro Tag SCFD SCFD SCFD SCFD
Standardkubikmeter pro Se- SM3/S Sm3/s Sm3/sec Sm3/s
kunde

Konfigurations- und Bedienungsanleitung
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Tabelle 4-4: Optionen fiir die Messwerteinheit von Gas-Standardvolumen (Fortsetzung)

Bezeichnung

Beschreibung der Einheit Anzeiger ProLink I ProLink Ill Handterminal
Standardkubikmeter pro Mi- SM3/M Sm3/min Sm3/min Sm3/min
nute

Standardkubikmeter pro SM3/H Sm3/h Sm3/hr Sm3/h
Stunde

Standardkubikmeter proTag | SM3/D Sm3/Tag Sm3/day Sm3/Tag
Standardliter pro Sekunde SLPS SLPS SLPS SLPS
Standardliter pro Minute SLPM SLPM SLPM SLPM
Standardliter pro Stunde SLPH SLPH SLPH SLPH
Standardliter pro Tag SLPD SLPD SLPD SLPD
Spezial-Messwerteinheit SPECL Spezial special Spezial
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Spezial-Messeinheit fiir Gas Standard Volumendurchfluss

definieren

Anzeiger

Not available

ProLink Il

ProLink > Configuration > Special Units

ProLink Il

Device Tools > Configuration > Process Measurement > Flow > Special Units

Handterminal

Configure > Manual Setup > Measurements > Special Units > Special GSV Units

Uberblick

Eine Spezial-Messeinheit ist eine benutzerdefinierte Messeinheit, mit der Prozessdaten,
Zahlerdaten und Summendaten in einer Einheit ausgegeben werden kénnen, die nichtin
der Auswerteelektronik verfligbar ist. Eine Spezial-Messeinheit wird mithilfe eines
Umrechnungsfaktors aus einer bestehenden Messeinheit berechnet.

Anmerkung

Obwohl eine Spezial-Messeinheit nicht Giber das Display definiert werden kann, kann das Display
verwendet werden, um eine bestehende Spezial-Messeinheit auszuwdhlen und die Prozessdaten
mittels Spezial-Messeinheit anzuzeigen.

Verfahren

1.  Spezifizieren Sie die Base Gas Standard Volume Unit.

Base Gas Standard Volume Unit ist die existierende Gas Standard Volumeneinheit, auf
der die Spezialeinheit basieren wird.

2. Spezifizieren Sie die Base Time Unit.

Base Time Unit ist die existierende Zeiteinheit, auf der die Spezialeinheit basieren

wird.

3. Berechnen Sie den Gas Standard Volume Flow Conversion Factor wie folgt:
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a. xBasiseinheiten =y Spezialeinheiten
b. Gas Standard Volume Flow Conversion Factor = x|y
4,  Geben Sie den Gas Standard Volume Flow Conversion Factor ein.

5. Setzen Sie Gas Standard Volume Flow Label auf den Namen, den Sie fir die Einheit des
Gas Standard Volumendurchflusses verwenden mochten.

6. Setzen Sie Gas Standard Volume Total Label auf den Namen, den Sie fiir die Einheit des
Gas Standard Volumen Summenzahlers und des Gas Standard Volumen
Gesamtzahlers verwenden mochten.

Die Spezial-Messeinheit wird in der Auswerteelektronik gespeichert. Die
Auswerteelektronik kann so konfiguriert werden, dass sie die Spezial-Messeinheit zu jeder
Zeit verwendet.

Beispiel: Spezial-Messeinheit fiir Gas Standard Volumendurchfluss definieren

Sie mochten den Gas Standard Volumendurchfluss als Tausenderwert (K) von Standard
Kubikfu® pro Minute messen.
Setzen Sie Base Gas Standard Volume Unit auf SCFM.
Setzen Sie Base Time Unit auf minutes (min).
Umrechnungsfaktor berechnen:
a. Tausenderwert von Standard Kubikfu pro Minute = 1000 Kubikfu pro Minute
b. Gas Standard Volume Flow Conversion Factor=1/1000 = 0,001
4, Setzen Sie Gas Standard Volume Flow Conversion Factor auf 0,001.
Setzen Sie Gas Standard Volume Flow Label auf KSCFM.
6. Setzen Sie Gas Standard Volume Total Label auf KSCF.

4.3.4 Gas Standard Volumen Durchflussabschaltung konfigurieren
Anzeiger Not available
ProLink Il ProLink > Configuration > Flow > Std Gas Vol Flow Cutoff
ProLink Il Device Tools > Configuration > Process Measurement > Flow
Handterminal Configure > Manual Setup > Measurements > GSV > GSV Cutoff
Uberblick

Gas Standard Volumen Durchflussabschaltung spezifiziert den niedrigsten Gas Standard
Volumendurchfluss, der als Messwert ausgegeben wird. Jeder Gas Standard
Volumendurchfluss unterhalb dieses Schwellenwerts wird als 0 ausgegeben.

Verfahren
Setzen Sie Gas Standard Volumen Durchflussabschaltung auf den gewtinschten Wert.

Der voreingestellt Wert flir Gas Standard Volumen Durchflussabschaltung ist 0.0. Der untere
Grenzwert ist 0.0. Es gibt keine Obergrenze.
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Wechselwirkung zwischen Gas-Standardvolumen-
Durchflussabschaltung und AO-Abschaltung
Gas-Standardvolumen-Durchflussabschaltung spezifiziert den niedrigsten Gas-
Standardvolumendurchfluss, den die Auswerteelektronik als Messwert ausgibt. Die AO-
Abschaltung definiert die niedrigste Durchflussrate, die (iber den mA-Ausgang ausgegeben
wird. Wenn die Prozessvariable mA-Ausgang auf Gas-Standardvolumendurchfluss eingestellt ist,

wird der vom mA-Ausgang ausgegebene Volumendurchfluss vom héheren der beiden
Abschaltwerte geregelt.

Die Gas-Standardvolumen-Durchflussabschaltung wirkt sich auf die tiber die Ausgange
ausgegebenen Gas-Standardvolumendurchflusswerte und die in anderen
Auswerteelektronik-Verhalten (z. B. Ereignisse, die fiir den Gas-
Standardvolumendurchfluss definiert wurden) verwendeten Gas-
Standardvolumendurchflusswerte aus.

Die AO-Abschaltung wirkt sich nur auf die Durchfliisse aus, die (iber den mA-Ausgang
ausgegeben wurden.

Beispiel: Abschaltwechselwirkung bei AO-Abschaltung kleiner als Gas-Standardvolumen-
Durchflussabschaltung
Konfiguration:

. Prozessvariable mA-Ausgang flir den primaren mA-Ausgang: Gas-
Standardvolumendurchfluss

. Frequenzausgang-Prozessvariable: Gas-Standardvolumendurchfluss

. AQ-Abschaltung fiir den primaren mA-Ausgang: 10 SLPM (Standardliter pro Minute)
. Gas-Standardvolumen-Durchflussabschaltung: 15 SLPM

Ergebnis: Wenn der Gas-Standardvolumendurchfluss unter 15 SLPM abfillt, wird der

Volumendurchfluss als 0 ausgegeben und fiir alle internen Verarbeitungsverfahren
verwendet.

Beispiel: Abschaltwechselwirkung bei AO-Abschaltung groBer als Gas-Standardvolumen-
Durchflussabschaltung
Konfiguration:

. Prozessvariable mA-Ausgang fiir den primdren mA-Ausgang: Gas-
Standardvolumendurchfluss

. Frequenzausgang-Prozessvariable: Gas-Standardvolumendurchfluss
. AQ-Abschaltung fiir den primdren mA-Ausgang: 15SLPM (Standardliter pro Minute)
. Gas-Standardvolumen-Durchflussabschaltung: 10SLPM

Ergebnis:
. Wenn der Gas-Standardvolumendurchfluss unter 15 SLPM, aber nicht unter 10 SLPM
abfallt:

- Gibt der primdre mA-Ausgang Nulldurchfluss aus

- Der Frequenzausgang gibt den Istdurchfluss aus, und der Istdurchfluss wird fiir
alle internen Verarbeitungsverfahren verwendet.

. Wenn der Gas-Standardvolumendurchfluss unter 10 SLPM abfillt, geben beide
Ausgange Nulldurchfluss aus, und fiir alle internen Verarbeitungsverfahren wird 0
verwendet.
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4.4

4.4.1

Konfigurieren von Durchflussrichtung

Anzeiger Not available

ProLink Il ProLink > Configuration > Flow > Flow Direction

ProLink Il Device Tools > Configuration > Process Measurement > Flow

Handterminal Configure > Manual Setup > Measurements > Flow > Flow Direction
Uberblick

Mittels Flow Direction steuert, wie sich Vorwarts- und Riickwartsstromung auf
Durchflussmessungen und deren Anzeige auswirken.
Flow Direction wird entsprechend dem Durchfluss-Richtungspfeil auf dem Sensor definiert:

. Eine Vorwartsstromung (positiver Durchfluss) bewegt sich in Richtung des
Durchflusspfeils auf dem Sensor.

. Eine Riickwdrtsstromung (negativer Durchfluss) bewegt sich entgegengesetzt zu
dem auf dem Sensor angegebenen Durchflusspfeil.

Hinweis
Micro Motion Die Sensoren sind bidirektional. Die Messgenauigkeit wird nicht durch die eigentliche
Durchflussrichtung oder durch die Einstellung des Parameters Durchflussrichtung beeinflusst.

Verfahren

Flow Direction auf den gewiinschten Wert einstellen.

Optionen der Durchflussrichtung

Tabelle 4-5: Optionen der Durchflussrichtung

Einstellung der Durchflussrichtung Beziehung zum Durchflussrich-

ProLink Il

i R tungspfeil auf dem Sensor
ProLink Ill Handterminal

Vorwarts

Forward Vorwarts Korrekt, wenn der Durchflussrich-
tungspfeil in dieselbe Richtung wie der
GroRteil des Durchflusses weist.

Riickwarts

Reverse Riickwarts Korrekt, wenn der Durchflussrich-
tungspfeil in dieselbe Richtung wie der
GroRteil des Durchflusses weist.

Absolutwert

Absolute Value Absolutwert Durchflussrichtungspfeil ist unrele-
vant.

Bidirektional

Bidirectional Beide Richtungen Korrekt, wenn beide Strémungen
(vorwarts, riickwarts) zu erwarten
sind, der Vorwartsfluss dominiert und
der Riickwartsfluss jedoch beachtlich
ist.
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Tabelle 4-5: Optionen der Durchflussrichtung (Fortsetzung)

Einstellung der Durchflussrichtung Beziehung zum Durchflussrich-
] ] ] tungspfeil auf dem Sensor

ProLink Il ProLink Ill Handterminal

Vorwarts negieren Negate Forward Negieren/nur Vorwérts Korrekt, wenn der Durchflussrich-
tungspfeil in die entgegengesetzte
Richtung wie der GroRteil des Durch-
flusses weist.

Bidirektional negieren Negate Bidirectional Negieren/Bi-direktional Korrekt, wenn beide Strémungen

(vorwarts, riickwarts) zu erwarten
sind, der Riickwartsfluss dominiert
und der Vorwartsfluss jedoch beacht-
lichist.

Auswirkungen der Durchflussrichtung auf die mA-Ausgdnge

Die Durchflussrichtung beeinflusst die Art, in der die Auswerteelektronik Durchflusswerte
tiber die mA-Ausgange ausgibt. Die mA-Ausgange werden nur dann von der
Durchflussrichtung beeinflusst, wenn die Prozessvariable mA-Ausgang auf eine
Durchflussvariable eingestellt ist.

Durchflussrichtung und mA-Ausgdnge

Die Auswirkung der Durchflussrichtung auf mA-Ausgange hangt vom Messanfang ab, der fiir
den mA-Ausgang konfiguriert wurde:

o Wenn der Messanfang auf 0 eingestellt ist, siehe Abbildung 4-1.
. Wenn der Messanfang auf einen Minuswert eingestellt ist, siehe Abbildung 4-2.

Abbildung 4-1: Auswirkung der Durchflussrichtung auf den mA-Ausgang: Messanfang =0

Durchflussrichtung = Vorwarts Durchflussrichtung = Rickwarts, Vorwarts Durchflussrichtung = Absolutwert, Bidirektional,
negieren Bidirektional negieren
20 20 20
212 212 212
@© © ©
o o j=2]
2] 2] 12}
3 3 3
< < <
E 4 £ 4 £ 4
-X 0 X -X 0 X -X 0 X
<RUCkwértsdurchﬂuss—l—VonNértsdurchfluss-} 4RUckwértsdurchﬂuss—l—Vorwéirtsdurchﬂuss-} -<Rl'.'lckwértsdurchfluss—'—Vorwéirtsdurchﬂuss-}
. Messanfang = 0
. Messende = x
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Abbildung 4-2: Auswirkung der Durchflussrichtung auf den mA-Ausgang: Messanfang < 0

Durchflussrichtung = Vorwarts Durchflussrichtung = Riickwarts, Vorwarts

Durchflussrichtung = Absolutwert, Bidirektional,

20— 20 20
I v
I I I
I I I
I I I
212F--—----- | 212 22b--4------ |
S I | > S | | |
) ! | 2 4 | | |
< : 1 :(( ::( 1 : 1
t 4 i i E 4 £ 4 i | i
1 1 | 1 | |
! ! . ! ! !

negieren Bidirektional negieren

-X

<Rﬂckwénsdurchﬂuss-'—VonNéﬂsdurchﬂuss—b

0 X -X 0 X -X 0 X
-4-R\'jckwérlsdurchﬂuss—'—Voménsdurchfluss} <Rﬂckwénsdurchfluss—l—Vorwértsdurchquss-}

. Messanfang = -x

o Messende = x

Konfigurations- und Bedienungsanleitung

Beispiel: Durchflussrichtung = Vorwéarts und Messanfang = 0

Konfiguration:

o Durchflussrichtung = Vorwérts
. Messanfang =0 g/s

. Messende = 100 g/s

Ergebnis:
. Bei Riickwarts- oder Nulldurchfluss hat der mA-Ausgang 4 mA.

. Bei Vorwadrtsdurchfluss bis zu einem Durchfluss von 100 g/s liegt der mA-Ausgang
zwischen 4 mA und 20 mA, proportional zum Durchfluss.

. Bei Vorwdrtsdurchfluss, wenn der Durchfluss gleich oder héher als 100 g/s ist, ist der
mA-Ausgang bis 20,5 mA proportional zum Durchfluss und wird bei hoherem
Durchfluss auf 20,5 mA begrenzt.

Beispiel: Durchflussrichtung = Vorwarts und Messanfang < 0

Konfiguration:

. Durchflussrichtung = Vorwérts
o Messanfang =-100 g/s

. Messende = +100 g/s

Ergebnis:

o Bei Nulldurchfluss hat der mA Ausgang 12 mA.

. Bei Vorwdrtsdurchfluss bis zu einem Durchfluss zwischen 0 und +100 g/s liegt der
mA-Ausgang zwischen 12 mA und 20 mA, proportional zum Durchfluss (absoluter
Wert).

. Bei Vorwdrtsdurchfluss, wenn der Durchfluss (absoluter Wert) gleich oder héher als

100 g/s ist, ist der mA-Ausgang bis 20,5 mA proportional zum Durchfluss und wird
bei héherem Durchfluss auf 20,5 mA begrenzt.
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. Bei Riickwartsdurchfluss bis zu einem Durchfluss zwischen 0 und -100 g/s liegt der
mA-Ausgang zwischen 4 mA und 12 mA umgekehrt proportional zum absoluten
Wert des Durchflusses.

. Bei Riickwartsdurchfluss, wenn der absolute Wert des Durchflusses gleich oder
héherals 100 g/s ist, ist der mA-Ausgang bis 3,8 mA umgekehrt proportional und
wird bei héheren Absolutwerten auf 3,8 mA begrenzt.

Beispiel: Durchflussrichtung = Riickwarts

Konfiguration:

J Durchflussrichtung = Riickwérts
. Messanfang = 0 g/s

o Messende = 100 g/s

Ergebnis:
. Bei Vorwarts- oder Nulldurchfluss hat der mA-Ausgang 4 mA.

. Bei Riickwdrtsdurchfluss bis zu einem Durchfluss zwischen 0 und +100 g/s liegt der
mA-Ausgang zwischen 4 mA und 20 mA umgekehrt proportional zum absoluten
Wert des Durchflusses.

. Bei Riickwdrtsdurchfluss, wenn der absolute Wert des Durchflusses gleich oder
héherals 100 g/s ist, ist der mA Ausgang bis 20,5 mA proportional zum absoluten
Wert des Durchflusses und wird bei héherem absoluten Durchfluss auf 20,5 mA
begrenzt.

Auswirkungen der Durchflussrichtung auf die Frequenzausgdnge

Die Durchflussrichtung beeinflusst die Art, in der die Auswerteelektronik Durchflusswerte
ber die Frequenzausgange ausgibt. Frequenzausgiange werden nur dann von der
Durchflussrichtung beeinflusst, wenn die Prozessvariable Frequenzausgang auf eine
Durchflussvariable eingestellt ist.

Tabelle 4-6: Auswirkung des Parameters Durchflussrichtung und der tatsachlichen
Durchflussrichtung auf die Frequenzausgdnge

Einstellung der Durchfluss- Tatsachliche Durchflussrichtung
richtung Vorwarts Nulldurchfluss Riickwarts
Vorwérts Hz>0 0Hz 0Hz
Riickwarts OHz 0Hz Hz>0
Bidirektional Hz>0 0Hz Hz>0
Absolutwert Hz>0 0Hz Hz>0
Vorwarts negieren 0Hz OHz Hz>0
Bidirektional negieren Hz>0 0 Hz Hz>0

Auswirkungen der Durchflussrichtung auf die Bindrausgdange

Die Durchflussrichtung wirkt sich nur dann auf das Verhalten der Bindrausgdnge aus, wenn die
Bindrausgangsquelle auf Durchflussrichtung eingestellt ist.

40 Micro Motion® Auswerteelektronik Modell 2700 mit eigensicheren Ausgédngen



Prozessmessung konfigurieren

Tabelle 4-7: Auswirkung des Parameters Durchflussrichtung und der tatsachlichen
Durchflussrichtung auf die Bindrausgdnge

Einstellung der Durchflussrich- Tatsdchliche Durchflussrichtung

tung Vorwarts Nulldurchfluss Riickwarts
Vorwarts OFF OFF ON
Ruickwarts OFF OFF ON
Bidirektional OFF OFF ON
Absolutwert OFF OFF OFF
Vorwarts negieren ON OFF OFF
Bidirektional negieren ON OFF OFF

Auswirkungen der Durchflussrichtung auf die digitale
Kommunikation

Die Durchflussrichtung wirkt sich auf die Ausgabe von Durchflusswerten (iber die digitale
Kommunikation aus.

Tabelle 4-8: Auswirkung des Parameters Durchflussrichtung und der tatsachlichen
Durchflussrichtung auf die iiber die digitale Kommunikation
ausgegebenen Durchflusswerte

Einstellung der Durchfluss- Tatsachliche Durchflussrichtung
richtung Vorwarts Nulldurchfluss Riickwarts
Vorwarts Positiv 0 Negativ
Ruckwarts Positiv 0 Negativ
Bidirektional Positiv 0 Negativ
Absolutwert Positiv(3) 0 Positiv
Vorwarts negieren Negativ 0 Positiv
Bidirektional negieren Negativ 0 Positiv

Auswirkung der Durchflussrichtung auf Durchflusswerte

Die Durchflussrichtung wirkt sich auf die Berechnung von Summen- und Gesamtzdhlern aus.

Tabelle 4-9: Auswirkung des Parameters Durchflussrichtung und der tatsachlichen
Durchflussrichtung auf die Summen- und Gesamtzahler

. Tatsachliche Durchflussrichtung
Einstellung der Durch-
flussrichtung Vorwarts Nulldurchfluss Riickwarts
Vorwérts Zahler steigen Zahler andern sich nicht | Zahler andern sich
nicht
Riickwarts Zahler dndern sich Zdhler dndern sich nicht | Zahler steigen
nicht

(3) Siehe Statusbits der digitalen Kommunikation als Indikation, ob der Durchfluss positiv oder negativ ist.
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4.5

4.5.1
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Tabelle 4-9: Auswirkung des Parameters Durchflussrichtung und der tatsachlichen
Durchflussrichtung auf die Summen- und Gesamtzdhler (Fortsetzung)

. Tatsdchliche Durchflussrichtung
Einstellung der Durch-
flussrichtung Vorwarts Nulldurchfluss Riickwarts
Bidirektional Zahler steigen Zahler andern sich nicht | Z&hler fallen
Absolutwert Zdhler steigen Zdhler andern sich nicht | Zahler steigen
Vorwarts negieren Zahler andern sich Zahler andern sich nicht | Zahler steigen

nicht

Bidirektional negieren Zahler fallen Zahler andern sich nicht | Zahler steigen

Konfigurieren der Dichtemessung

Die Dichtemessparameter steuern, wie die Dichte gemessen und ausgegeben wird. Die
Dichtemessung (zusammen mit der Massemessung) wird verwendet, um den
Volumendurchfluss fir Flissigkeiten zu bestimmen.

Die Dichtemessparameter beinhalten:

. Dichte Messeinheit

U Schwallstromparameter

. Dichtedampfung

. Dichteabschaltung

Konfigurieren der Dichte Messeinheit

Anzeiger OFF-LINE MAINT > OFF-LINE CONFG > UNITS > DENS

ProLink Il ProLink > Configuration > Density > Density Units

ProLink Il Device Tools > Configuration > Process Measurement > Density

Handterminal Configure > Manual Setup > Measurements > Density > Density Unit
Uberblick

Die Density Measurement Unit gibt die Messeinheiten an, die als Dichtemessung angezeigt
werden.

Verfahren
Die Density Measurement Unit auf die gew{inschte Option einstellen.
Die Standardeinstellung fiir die Density Measurement Unit ist g/cm3 (Gramm pro

Kubikzentimeter).

Optionen fiir die Dichtemesseinheit

Die Auswerteelektronik bietet einen Standardsatz an Messeinheiten fir die
Dichtemesseinheit. Verschiedene Kommunikations-Hilfsmittel verwenden u. U.
unterschiedliche Kennzeichnungen.
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Tabelle 4-10: Optionen fiir die Dichtemesseinheit

Bezeichnung
Beschreibung der Einheit Display ProLink I ProLink Ill Handterminal
Spezifische Dichteeinheit SGU SGU SGU SGU
(nicht Temp. korrigiert)
Gramm pro Kubikzentimeter | G/CM3 glem3 glem3 glem3
Gramm pro Liter G/L g/l g/l g/l
Gramm pro Milliliter G/mL g/ml g/ml g/ml
Kilogramm pro Liter KGIL kg/l kgl kg/l
Kilogramm pro Kubikmeter KG/M3 kg/m3 kg/m3 kg/m3
Pfund pro U.S. Gallone LB/GAL Ibs/Usgal Ibs/Usgal Ib/Gal
Pfund pro Kubikfu LB/CUF Ibs/ft3 Ibs/ft3 Ib/ft3
Pfund pro Kubikzoll LB/CUI Ibs/in3 Ibs/in3 Ib/Culn
API Dichte D API degAPI degAPI degAPI
Short ton pro Kubikyard STICUY sTlyd3 sTlyd3 ShTonlyd3
4.5.2 Schwallstrom Parameter konfigurieren
Anzeiger Not available
ProLink Il ¢ ProLink > Configuration > Density > Slug High Limit

¢ ProLink > Configuration > Density > Slug Low Limit
¢ ProLink > Configuration > Density > Slug Duration

ProLink Il Device Tools > Configuration > Process Measurement > Density

Handterminal *  Configure > Manual Setup > Measurements > Density > Slug Low Limit
*  Configure > Manual Setup > Measurements > Density > Slug High Limit
*  Configure > Manual Setup > Measurements > Density > Slug Duration

Uberblick

Die Schwallstrom Parameter steuern, wie die Auswerteelektronik eine
Zweiphasenstromung (Gas in einem Fliissigkeitsprozess oder Fliissigkeit in einem
Gasprozess) erkennt und ausgibt.

Verfahren

1. Setzen Sie Unterer Schwallstrom Grenzwert auf den niedrigsten Dichtewert, der in lhrem
Prozess als normal betrachtet wird.

Werte unter diesem Grenzwert flihren dazu, dass die Auswerteelektronik die fiir
Schwallstrom konfigurierte Aktion ausfiihrt. Ublicherweise ist dieser Wert die
niedrigste Dichte im normalen Bereich Ihres Prozesses.
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Hinweis

Gaseinschliisse konnen dazu fiihren, dass die Prozessdichte kurzzeitig abfallt. Um das
Auftreten von Schwallstrom Alarmen, die fiir den Prozess nicht von Bedeutung sind, zu
reduzieren, setzen Sie Unterer Schwallstrom Grenzwert etwas unterhalb der niedrigsten
erwarteten Prozessdichte.

Sie miissen Unterer Schwallstrom Grenzwert in g/cm?3 auch dann eingeben, wenn Sie eine
andere Einheit fiir die Dichtemessung konfiguriert haben.

Der voreingestellte Wert fiir Unterer Schwallstrom Grenzwert ist 0,0 g/cm?. Der Bereich
ist 0,0 bis 10,0 g/cm?3.

2. Setzen Sie Oberer Schwallstrom Grenzwert auf den héchsten Dichtewert, der in Ihrem
Prozess als normal betrachtet wird.

Werte (iber diesem Grenzwert flihren dazu, c{_ass die Auswerteelektronik die fiir
Schwallstrom konfigurierte Aktion ausfihrt. Ublicherweise ist dieser Wert die
hdchste Dichte im normalen Bereich lhres Prozesses.

Hinweis

Um das Auftreten von Schwallstrom Alarmen, die fiir den Prozess nicht von Bedeutung sind,
zu reduzieren, setzen Sie Oberer Schwallstrom Grenzwert etwas oberhalb der h6chsten erwarteten
Prozessdichte.

Sie miissen Oberer Schwallstrom Grenzwert in g/cm3 auch dann eingeben, wenn Sie eine
andere Einheit fiir die Dichtemessung konfiguriert haben.

Der voreingestellte Wert fiir Oberer Schwallstrom Grenzwert ist 5,0 g/cm?3. Der Bereich
ist 0,0 bis 10,0 g/cm3.

3. Setzen Sie Schwallstromdauer auf die Anzahl der Sekunden, die die Auswerteelektronik
auf die Beseitigung einer Schwallstrombedingung wartet, bevor die fiir
Schwallstrom konfigurierte Aktion ausgefiihrt wird.

Der voreingestellte Wert fiir Schwallstromdauer ist 0,0 s. Der Bereich ist 0,0 bis 60,0 s.

Schwallstromerkennung und -ausgabe

Die Schwallstromung wird {iblicherweise als Indikator eines Zweiphasenstroms (Gas in
einem Fliissigkeitsprozess oder Fliissigkeit in einem Gasprozess) verwendet. Der
Zweiphasenstrom kann verschiedene Probleme bei der Prozessregelung verursachen.
Durch die richtige Konfiguration der Schwallstromparameter fiir lIhre Anwendung kénnen
Sie Prozessbedingungen erkennen, die korrigiert werden miissen.

Hinweis
Um das Auftreten von Schwallstromalarmen zu reduzieren, senken Sie den Unteren Schwallstrom-
Grenzwert oder erh6hen den Oberen Schwallstrom-Grenzwert.

Eine Schwallstromung tritt auf, wenn die gemessene Dichte unter den Unteren Schwallstrom-
Grenzwert fdllt oder tiber den Oberen Schwallstrom-Grenzwert steigt. In diesem Fall:

. Wird ein Schwallstromalarm in der aktiven Alarmliste gesetzt.

. Alle Ausgange, die auf Durchfluss konfiguriert sind, halten den letzten gemessenen
Durchflusswert vor der Schwallstromung bis zum Ende der konfigurierten
Schwallstromdauer.
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Wenn der Schwallstromzustand verschwindet, bevor die Schwallstromdauer abgelaufen ist:

. Ausgange, die auf Durchfluss konfiguriert sind, kehren zur aktuellen
Durchflussanzeige zuriick.

. Der Schwallstromalarm wird deaktiviert, verbleibt aber in der Alarmliste bis er
bestitigt ist.

Wenn der Schwallstromzustand nicht verschwindet, bevor die Schwallstromdauer abgelaufen
ist, zeigen die Ausgange die auf Durchfluss konfiguriert sind, Nulldurchfluss an.

Wenn die Schwallstromdauer auf 0,0 Sekunden eingestellt ist, zeigen die Ausgdnge, die auf
Durchfluss konfiguriert sind, Nulldurchfluss an, sobald ein Schwallstromzustand erkannt
wird.

4.5.3 Konfigurieren der Dichtedampfung

Anzeiger Not available

ProLink Il ProLink > Configuration > Density > Density Damping

ProLink Il Device Tools > Configuration > Process Measurement > Density

Handterminal Configure > Manual Setup > Measurements > Density > Density Damping
Uberblick

Die Ddmpfung wird verwendet, um kleine, plétzlich auftretende Schwankungen des
Prozessmesswerts zu gldtten. Damping Value gibt die Zeitdauer (in Sekunden) an, iiber die
die Auswerteelektronik die Anderungen in der ausgegebenen Prozessvariable verteilt. Am
Ende des Intervalls spiegelt die ausgegebene Prozessvariable 63 % der Anderung des
eigentlichen gemessenen Wertes wider.

Verfahren
Density Damping auf den gewiinschten Wert einstellen.

Der Standardwert ist 1,6 Sekunden. Der Bereich richtet sich nach dem Typ des Core
Prozessors und der Einstellung von Update Rate (siehe nachfolgende Tabelle):

Core Prozessor Typ EinstellungUpdate Rate: Bereich fiir Density Damping
Standard Normal 0 bis 51,2 Sekunden
Spezial 0 bis 10,24 Sekunden
Erweiterte Funktionalitdt | Nicht anwendbar 0 bis 40,96 Sekunden
Hinweise

* Ein hoher Dampfungswert |dsst die Prozessvariable regelmaRiger erscheinen, da der
ausgegebene Wert sich langsamer dndert.

* Ein niedriger Dampfungswert ldsst die Prozessvariable unregelmdRiger erscheinen, da der
ausgegebene Wert sich schneller andert.

* Immer, wenn der Ddmpfungswert nicht Null ist, wird der ausgegebene Messwert hinter der
eigentlichen Messung liegen, da der ausgegebene Wert {iber die Zeit gemittelt wird.
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* Allgemein werden niedrigere Ddmpfungswerte vorgezogen, da das Risiko von Datenverlusten
und die Verzogerung zwischen dem eigentlichem und dem ausgegebenen Wert geringer ist.

Der eingegebene Wert wird automatisch auf den nachst giiltigen Wert abgerundet. Die
gliltigen Werte fiir Density Damping sind von der Einstellung von Update Rate abhdngig.

Tabelle 4-11: Giiltige Werte fiir Density Damping

Core Prozessor Typ EinstellungUpdate Rate: Giiltige Daimpfungswerte
Standard Normal 0,0.2,0.4,08,...51.2

Spezial 0,0.04,0.08, 0.16, ... 10.24
Erweiterte Funktionalitdt | Nicht anwendbar 0,0.04, 0.08, 0.16, ... 40.96

Effekt der Dichtedampfung auf die Volumenmessung

Die Dichtedampfung wirkt sich auf die Fliissigkeitsvolumenmessung aus. Die Werte des
Flissigkeitsvolumens werden mittels des gedampften Dichtewerts anstatt des
gemessenen Dichtewerts errechnet. Die Dichteddmpfung wirkt sich nicht auf die Standard-
Gasvolumenmessung aus.

Interaktion zwischen Dichteddmpfung und Zusatzlicher Dampfung

In einigen Féllen werden sowohl die Dichteddmpfung als auch die Zusatzliche Dampfung auf den
ausgegebenen Dichtewert angewandt.

Die Dichteddmpfung regelt die Anderungsrate der Dichte-Prozessvariablen. Die Zusatzliche
Dampfung regelt die Anderungsrate, die (iber den mA-Ausgang ausgegeben wird. Wenn die
mA-Ausgangs-Prozessvariable auf Dichte gesetzt ist und sowohl die Dichteddmpfung als auch die
Zusatzliche Dampfung auf einen Wert ungleich Null gesetzt sind, wird zuerst die
Dichtedampfung angewandt, und die Berechnung der zusatzlichen Dampfung wird auf
das Ergebnis der ersten Rechnung angewandt

Konfigurieren der Dichteabschaltung

Anzeiger Not available

ProLink Il ProLink > Configuration > Density > Low Density Cutoff

ProLink Il Device Tools > Configuration > Process Measurement > Density

Handterminal Configure > Manual Setup > Measurements > Density > Density Cutoff
Uberblick

Density Cutoff gibt den niedrigsten Dichtewert an, der als gemessen ausgegeben wird. Alle
Dichtewerte unter dieser Abschaltung werden als 0 ausgegeben.

Verfahren
Density Cutoff auf den gewiinschten Wert einstellen.

Der Standardwert fiir Density Cutoff ist 0,2 g/cm3. Der Bereich liegt bei 0,0 g/cm? bis
0,5 g/cm?.

Micro Motion® Auswerteelektronik Modell 2700 mit eigensicheren Ausgédngen



Prozessmessung konfigurieren

4.6

4.6.1

Auswirkung der Dichteabschaltung auf die Volumenmessung

Dichteabschaltung beeinflusst die Volumenmessung von Fliissigkeiten. Wenn der Dichtewert
die Dichteabschaltung unterschreitet, wird die Volumendurchflussrate als 0 wiedergegeben.
Dichteabschaltung beeinflusst nicht die Standardvolumenmessung von Gas.
Standardvolumenwerte von Gas werden immer vom gemessenen Dichtewert berechnet.

Konfigurieren einer Temperaturmessung

Die Parameter der Temperaturmessung steuern, wie die Temperaturdaten vom Sensor
ausgegeben werden. Die Temperaturdaten werden verwendet, um die Auswirkungen zu
kompensieren, die die Temperatur auf Messrohre wahrend Durchflussmessungen hat.
Die Parameter der Temperaturmessung umfassen:

U Temperature Measurement Unit

. Temperature Damping

Konfigurieren einer Temperatur Messeinheit

Anzeiger OFF-LINE MAINT > OFF-LINE CONFG > UNITS > TEMP

ProLink Il ProLink > Configuration > Temperature > Temp Units

ProLink Il Device Tools > Configuration > Process Measurement > Temperature
Handterminal Configure > Manual Setup > Measurements > Temperature > Temperature Unit

Uberblick

Temperature Measurement Unit gibt die Einheit an, die fir die Temperaturmessung verwendet
wird.

Verfahren
Setzen Sie Temperature Measurement Unit auf die gewiinschte Option.

Die Standardeinstellung ist Degrees Celsius.

Optionen fiir die Temperatur Messeinheit

Die Auswerteelektronik bietet einen Standardsatz an Messeinheiten fiir Temperature
Measurement Unit. Unterschiedliche Kommunikations-Hilfsmittel verwenden
moglicherweise unterschiedliche Kennzeichnungen fiir die Einheiten.

Tabelle 4-12: Optionen fiir Temperature Measurement Unit

Kennzeichnung
Beschreibung der Ein-
heit Anzeiger ProLink II ProLink IlI Handterminal
Grad Celsius °C GradC °C GradC
Grad Fahrenheit °F °F °F °F
Grad Rankine °R °R °R °R

Konfigurations- und Bedienungsanleitung

47



Prozessmessung konfigurieren

4.6.2

48

Tabelle 4-12: Optionen fiir Temperature Measurement Unit (Fortsetzung)

. . Kennzeichnung
Beschreibung der Ein-

heit Anzeiger ProLink I ProLink Ill Handterminal

Kelvin °K degK °K Kelvin

Konfigurieren der Temperaturdampfung

Anzeiger Not available

ProLink Il ProLink > Configuration > Temperature > Temp Damping

ProLink Il Device Tools > Configuration > Temperature

Handterminal Configure > Manual Setup > Measurements > Temperature > Temp Damping
Uberblick

Die Dampfung wird verwendet, um kleine, pl6tzlich auftretende Schwankungen des
Prozessmesswerts zu gldtten. Damping Value gibt die Zeitdauer (in Sekunden) an, iiber die
die Auswerteelektronik die Anderungen in der ausgegebenen Prozessvariable verteilt. Am
Ende des Intervalls spiegelt die ausgegebene Prozessvariable 63 % der Anderung des
eigentlichen gemessenen Wertes wider.

Verfahren
Geben Sie den Wert ein, der fiir Temperature Damping verwendet werden soll.

Der Standardwert betragt 4,8 Sekunden. Der Bereich liegt zwischen 0,0 und
76,8 Sekunden.

Hinweise

e Ein hoher Dampfungswert |dsst die Prozessvariable regelmaRiger erscheinen, da der
ausgegebene Wert sich langsamer andert.

* Ein niedriger Dampfungswert ldsst die Prozessvariable unregelmdRiger erscheinen, da der
ausgegebene Wert sich schneller andert.

* Immer, wenn der Ddmpfungswert nicht Null ist, wird der ausgegebene Messwert hinter der
eigentlichen Messung liegen, da der ausgegebene Wert (iber die Zeit gemittelt wird.

* Allgemein werden niedrigere Dampfungswerte vorgezogen, da das Risiko von Datenverlusten
und die Verzégerung zwischen dem eigentlichem und dem ausgegebenen Wert geringer ist.

Der eingegebene Wert wird automatisch auf den nachsten giiltigen Wert abgerundet.
Giiltige Werte fiir Temperature Damping sind 0, 0,6, 1,2,2,4,48, ... 76,8.

Auswirkung der Temperaturddmpfung auf die Prozessmessung

Die Temperaturddmpfung beeinflusst die Reaktionsgeschwindigkeit der
Temperaturkompensation bei schwankenden Temperaturen. Die
Temperaturkompensation passt die Prozessmessung an, um den Temperatureinfluss auf
das Messrohr zu kompensieren.
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Die Temperaturd@mpfung beeinflusst die Prozessvariablen der Mineral6lmessung nur dann,
wenn die Auswerteelektronik so konfiguriert wurde, dass sie Temperaturdaten vom Sensor
verwendet. Wenn ein externer Temperaturwert fiir die Mineralélmessung verwendet wird,
wirkt sich die Temperaturd@mpfung nicht auf die Prozessvariablen der Minerallmessung aus

Die Temperaturddmpfung beeinflusst die Prozessvariablen der Konzentrationsmessung nur
dann, wenn die Auswerteelektronik so konfiguriert wurde, dass sie Temperaturdaten vom
Sensor verwendet. Wenn ein externer Temperaturwert fiir die Konzentrationsmessung
verwendet wird, wirkt sich die Temperaturddmpfung nicht auf die Prozessvariablen der
Konzentrationsmessung aus

4.7 Anwendung Mineralélmessung konfigurieren

Die Mineral6lmessung ermdglicht die Messung des temperaturkorrigierten
Flissigkeitsvolumens oder CTL. Die Anwendung berechnet einen Volumendurchfluss-
Korrekturfaktor und wendet diesen auf die Volumenmessung an. Interne Berechnungen
entsprechen den Standards des American Petroleum Institute (API).

4.7.1 Mineralolmessung konfigurieren unter Verwendung von
ProLink Il

1. Wahlen Sie ProLink > Configuration > API Setup.

2. Geben Sie an, welche API-Tabelle verwendet werden soll.

a. Wabhlen Sie unter API-Kapitel 11.1 Tabellentyp die API-Tabellengruppe.

b. Wahlen Sie unter Units die zu verwendenden MaReinheiten.

Die API-Tabelle wird durch diese zwei Parameter genau spezifiziert.

3. Wenn lhre APl Tabelle 53A, 53B, 53D oder 54C ist, setzen Sie die Referenztemperatur auf
den entsprechenden Wert fiir lhre Anwendung. Geben Sie den Wert in °C ein.

4.  Wenn lhre API Tabelle 6C, 24C oder 54C ist, setzen Sie den Warmeausdehnungskoeffizient
auf den entsprechenden Wert fiir Ihre Anwendung.

5. Ermitteln Sie, wie die Auswerteelektronik die Temperaturdaten fiir die
Berechnungen der Mineral6lmessung empfangt und fiihren Sie die entsprechende
Einrichtung durch.

Option Einrichtung
Temperaturdaten  a. Waéhlen Sie View > Preferences .
vom Sensor b. Deaktivieren Sie Use External Temperature.

Wahlen Sie View > Preferences .

Aktivieren Sie Use External Temperature.

Wabhlen Sie ProLink > Configuration > Temperature.

Stellen Sie die External Temperature auf den zu verwendenden
Wert ein.

Ein vom Anwender
konfigurierter sta-
tischer Temperatur-
wert

oan oo
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Option

Einrichtung

Abfrage fiir Tem-
peratur(4)

a. Stellen Sie sicher, dass der primdre mA Ausgang gemaR HART-

Abfrage verdrahtet wurde.

Wahlen Sie View > Preferences .

Aktivieren Sie Use External Temperature.

Wahlen Sie ProLink > Configuration > Polled Variables.

Wahlen Sie einen freien Abfrage-Slot.

Setzen Sie Polling Control auf Poll As Primary oder Poll as Secondary

und klicken Sie dann auf Apply.

g. Setzen Sie External Tag auf die HART-Kennzeichnung des exter-
nen Temperaturmessgerats.

h. Setzen Sie Variable Type auf External Temperature.

mpon o

Hinweis

e Als Primar abfragen: Auf dem Netzwerk ist kein anderer HART Mas-
ter vorhanden.

e Als Sekundar abfragen: Auf dem Netzwerk sind andere HART Mas-
ter vorhanden. Das Handterminal ist kein HART Master.

Ein von der digital-
en Kommunikation
bereitgestellter
Wert

a. Wahlen Sie View > Preferences .

b. Aktivieren Sie Use External Temperature.

c. Fihren Sie die erforderlichen Schritte zur Programmierung des
Hostsystems und zur Einrichtung der Kommunikation durch, um
Temperaturdaten in entsprechenden Intervallen auf die Auswer-
teelektronik zu schreiben.

Anmerkung

Wenn die Weights & Measures Anwendung (eichamtlicher Transfer)
implementiert ist und die Auswerteelektronik schreibgeschiitzt ist,
kann die digitale Kommunikation nicht verwendet werden, um
Temperaturdaten auf die Auswerteelektronik zu schreiben.

4.7.2 Mineral6lmessung konfigurieren unter Verwendung von

ProLink Il

Wahlen Sie Device Tools > Configuration > Process Measurement > Petroleum Measurement.

2. Geben Sie an, welche API-Tabelle verwendet werden soll.

a. Widhlen Sie die API-Tabellengruppe aus dem API-Tabellentyp aus.

b. Stellen Sie die Petroleum Measurement Units auf die zu verwendenden MaReinheiten

ein.

c. Klicken Sie auf Apply.

Die API-Tabelle wird durch diese zwei Parameter genau spezifiziert.

3. Wenn lhre APl Tabelle 53A, 53B, 53D oder 54C ist, setzen Sie die Referenztemperatur auf
den entsprechenden Wert fiir lhre Anwendung. Geben Sie den Wert in °C ein.

4.  Wenn lhre API Tabelle 6C, 24C oder 54C ist, setzen Sie den Warmeausdehnungskoeffizient
auf den entsprechenden Wert fiir Ihre Anwendung.

(4) Nicht bei allen Auswerteelektroniken verfiigbar.
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5. Setzen Sie Temperature Source auf die Methode, die die Auswerteelektronik fiir den
Empfang der Temperaturdaten verwendet.

Option Beschreibung

Externen Wert abfragen(®) Die Auswerteelektronik fragt ein externes Temperaturmess-
gerat ab. Sie verwendet hierfiir das HART-Protokoll iiber den
primdren mA Ausgang.

Widerstandsthermometer Die Auswerteelektronik verwendet die Temperaturdaten
vom Sensor.

Statische oder digitale Kommuni- = Die Auswerteelektronik verwendet den aus dem Speicher

kation gelesenen Temperaturwert.

 Statisch: Der konfigurierte Wert wird verwendet.

¢ Digitale Kommunikation: Ein externer Host schreibt Dat-
en in den Speicher der Auswerteelektronik.

Fiir beide Optionen wird der gleiche Speicherort verwendet.

Externe Temperaturdaten werden nur fiir Berechnungen bei Mineral6lmessungen
verwendet. Alle anderen Berechnungen der Auswerteelektronik verwenden die
Temperaturdaten vom Sensor.

6.  Wenn Sie RTD wahlen, ist keine weitere Konfiguration erforderlich. Klicken Sie auf
Apply um zu verlassen.

7. Wenn Sie die Abfrage von Temperaturdaten wahlen:

a. Waihlen Sie den zu verwendenden Polling Slot.

b. Setzen Sie Polling Control auf Poll as Primary oder auf Poll as Secondary und klicken Sie
dann auf Apply.

Hinweis
 Als Primér abfragen: Auf dem Netzwerk ist kein anderer HART Master vorhanden.

e Als Sekundar abfragen: Auf dem Netzwerk sind andere HART Master vorhanden. Das
Handterminal ist kein HART Master.

c. Setzen Sie die External Device Tag auf die HART-Kennzeichnung des externen
Temperaturmessgerdts und klicken Sie auf Apply.

8.  Wenn Sie einen statischen Temperaturwert wahlen, stellen Sie External Temperature
auf den zu verwendenden Wert ein und klicken Sie auf Apply.

9.  Wenn Sie digitale Kommunikation verwenden méchten, fiihren Sie die
erforderlichen Schritte zur Programmierung des Hostsystems und zur Einrichtung
der Kommunikation durch, um Temperaturdaten in entsprechenden Intervallen auf
die Auswerteelektronik zu schreiben.

Anmerkung

Wenn die Weights & Measures Anwendung (eichamtlicher Transfer) implementiert ist und die
Auswerteelektronik schreibgeschiitzt ist, kann die digitale Kommunikation nicht verwendet
werden, um Temperaturdaten auf die Auswerteelektronik zu schreiben.

(5) Nicht bei allen Auswerteelektroniken verfiigbar.
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4.7.3 Mineralolmessung konfigurieren unter Verwendung von
Handterminal

1. Wahlen Sie Online > Configure > Manual Setup > Measurements > Set Up Petroleum.

2. Geben Sie an, welche API-Tabelle verwendet werden soll.

a. Offnen Sie das Menti Petroleum Measurement Source und wihlen Sie die API-
Tabellennummer.

Je nach Ihrer Auswahl werden Sie evtl. zur Eingabe einer Referenztemperatur
oder eines Warmeausdehnungskoeffizienten aufgefordert.

b. Geben Sie den Buchstaben der API-Tabelle ein.

Die API-Tabelle wird durch diese zwei Parameter genau spezifiziert.
3. Ermitteln Sie, wie die Auswerteelektronik die Temperaturdaten fir die

Berechnungen der Konzentrationsmessung empfangt und fiihren Sie die
entsprechende Einrichtung durch.

Option Einrichtung

Temperaturdaten a. Wahlen Sie Online > Configure > Manual Setup > Measurements > Exter-
vom Sensor nal Pressure/Temperature > Temperature.
b. Setzen Sie die External Temperature auf Disabled.

Ein vom Anwender | a. Waéhlen Sie Online > Configure > Manual Setup > Measurements > Exter-

konfigurierter sta- nal Pressure/Temperature > Temperature.

tischer Temperatur- b. Setzen Sie die External Temperature to Enabled.

wert c. Stellen Sie die Correction Temperature auf den zu verwendenden
Wert ein.

Abfrage fiir Tem- a. Stellen Sie sicher, dass der primdre mA Ausgang gemaR HART-

peratur(®) Abfrage verdrahtet wurde.

b. Wihlen Sie Online > Configure > Manual Setup > Measurements > Exter-
nal Pressure/Temperature > Temperature.

c. Setzen Sie die External Temperature auf Enabled.

d. Wabhlen Sie External Polling.

e. Setzen Sie die Poll Control auf Poll As Primary oder auf Poll as Secon-
dary.

f. Entscheiden Sie, ob Abfrage-Slot 1 oder Abfrage-Slot 2 verwen-
det werden soll.

g. Setzen Sie die Externe Geratekennung fiir den gewdhlten Slot auf
die HART-Kennzeichnung des externen Temperaturmessgeréts.

h. Setzen Sie die Polled Variable fiir den gewahlten Slot auf Tempera-
ture.

Hinweis

e Als Primar abfragen: Auf dem Netzwerk ist kein anderer HART Mas-
ter vorhanden.

e Als Sekundar abfragen: Auf dem Netzwerk sind andere HART Mas-
ter vorhanden. Das Handterminal ist kein HART Master.

(6) Nicht bei allen Auswerteelektroniken verfiigbar.
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4.7.4

Option

Einrichtung

Ein von der digital-  a.
en Kommunikation
bereitgestellter

Wert

Wahlen Sie Online > Configure > Manual Setup > Measurements > Exter-
nal Pressure/Temperature > Temperature.

b. Setzen Sie die External Temperature auf Enabled.

Fiihren Sie die erforderlichen Schritte zur Programmierung des
Hostsystems und zur Einrichtung der Kommunikation durch, um
Temperaturdaten in entsprechenden Intervallen auf die Auswer-
teelektronik zu schreiben.

Anmerkung

Wenn die Weights & Measures Anwendung (eichamtlicher Transfer)
implementiert ist und die Auswerteelektronik schreibgeschiitzt ist,
kann die digitale Kommunikation nicht verwendet werden, um
Temperaturdaten auf die Auswerteelektronik zu schreiben.

API Referenztabellen

Tabelle 4-13: API Referenztabellen, zugehérige Prozessmedien und zugehorige Berechnungswerte

konstanter Basisdichte
oder bekanntem War-
meausdehnungskoeffi-
zient

ferte Dichte (oder War-
meausdehnungskoeffi-
zient) und die beobach-
tete Temperatur

bar)

Tabellen-
name Prozessmedium CTL Quelldaten Referenztemperatur Dichteeinheit
5A Allgemeines Rohdlund | Beobachtete Dichte und | 60 °F (nicht konfigurier- = Grad API
JP4 Temperatur bar) Bereich: 0 bis 100
5B Allgemeine Produkte Beobachtete Dichte und | 60 °F (nicht konfigurier- | Grad API
Temperatur bar) Bereich: 0 bis 85
5D Schmieréle Beobachtete Dichte und | 60 °F (nicht konfigurier- | Grad API
Temperatur bar) Bereich: -10 bis +40
6C Flissigkeiten mit Vom Anwender gelie- 60 °F (nicht konfigurier- | Grad API
konstanter Basisdichte | ferte Dichte (oder War- | bar)
oder bekanntem War- meausdehnungskoeffi-
meausdehnungskoeffi- | zient) und die beobach-
zient tete Temperatur
23A Allgemeines Rohdlund | Gemessene Dichte und | 60 °F (nicht konfigurier- | Relative Dichte
P4 Temperatur bar) Bereich: 0,6110 bis
1,0760
23B Allgemeine Produkte Beobachtete Dichte und | 60 °F (nicht konfigurier- | Relative Dichte
Temperatur bar) Bereich: 0,6535 bis
1,0760
23D Schmieréle Beobachtete Dichte und | 60 °F (nicht konfigurier- | Relative Dichte
Temperatur bar) Bereich: 0,8520 bis
1,1640
24C FlGssigkeiten mit Vom Anwender gelie- 60 °F (nicht konfigurier- | Relative Dichte
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Tabelle 4-13: API Referenztabellen, zugehérige Prozessmedien und zugehorige Berechnungswerte

(Fortsetzung)
Tabellen-
name Prozessmedium CTL Quelldaten Referenztemperatur Dichteeinheit
53A Allgemeines Rohdlund | Beobachtete Dichte und | 15 °C (konfigurierbar) Basisdichte
P4 Temperatur Bereich: 610 bis
1075 kg/m3
53B Allgemeine Produkte Beobachtete Dichte und | 15 °C (konfigurierbar) Basisdichte
Temperatur Bereich: 653 bis
1075 kg/m3
53D Schmieréle Beobachtete Dichte und | 15 °C (konfigurierbar) Basisdichte
Temperatur Bereich: 825 bis
1164 kg/m?3
54C FlGssigkeiten mit Vom Anwender gelie- 15 °C (konfigurierbar) Basisdichte in kg/m3
konstanter Basisdichte | ferte Dichte (oder War-
oder bekanntem War- meausdehnungskoeffi-
meausdehnungskoeffi- | zient) und die beobach-
zient tete Temperatur
4.8 Konfigurieren der Anwendung
Konzentrationsmessung
Die Anwendung Konzentrationsmessung berechnet Konzentrationsdaten aus
Prozesstemperatur und Dichte. Micro Motion stellt einen Satz von Konzentrationsmatrizen
zur Verfligung, die die Referenzdaten fiir viele hundert Standard-Industrieanwendungen
und Prozessmedien liefern. Falls gewiinscht kann eine anwenderdefinierte Matrix fiir das
entsprechende Prozessmedium erstellt oder eine tiber Micro Motion erworben werden.
Weiteren Informationen bzgl. der Anwendung zur Konzentrationsmessung sind im
folgenden Handbuch verfiigbar: Micro Motion Anwendung mit erweiterter Dichte: Theorie,
Konfiguration und Betrieb.
Anmerkung
Die Anwendung zur Konzentrationsmessung ist auch als erweiterte Dichteanwendung bekannt.
4.8.1 Konfigurieren der Konzentrationsmessung unter

Verwendung von ProLink I

Diese Aufgabe fiihrt Sie durch das Laden und die Einrichtung einer Konzentrationsmatrix
fiir die Messung. Das Erstellen einer Konzentrationsmatrix wird hier nicht beschrieben.

Anmerkung

Konzentrationsmatrixen kdnnen entweder durch Laden einer bestehenden Matrix aus einer Datei
oder durch Erstellen einer neuen Matrix geladen werden. lhre Auswerteelektronik kann bis zu sechs
Matrixen laden, es kann jedoch immer nur eine Matrix zur Messung verwendet werden. Detaillierte
Informationen zum Erstellen einer Matrix finden Sie unter Micro Motion Anwendung mit erweiterter
Dichte: Theorie, Konfiguration und Betrieb.
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Vorbereitungsverfahren

Bevor Sie die Konzentrationsmessung konfigurierent kénnen:

Die Anwendung Konzentrationsmessung muss auf Ihrer Auswerteelektronik
aktiviert sein.

Die zu verwendende Konzentrationsmatrix muss entweder auf Ihrer
Auswerteelektronik oder als Datei auf lhrem Computer vorhanden sein.

Sie missen die abgeleitete Variable kennen, fiir die Ihre Matrix vorgesehen ist.
Sie miissen die von lhrer Matrix verwendete MaReinheit fiir die Dichte kennen.
Sie missen die von lhrer Matrix verwendete MaReinheit fiir die Temperatur kennen.

Die Anwendung zur Konzentrationsmessung muss freigegeben sein.

Verfahren

1.

Wabhlen Sie ProLink > Configuration > Density und stellen Sie die Density Units auf die von
lhrer Matrix verwendete Dichte Einheit ein.

Wahlen Sie ProLink > Configuration > Temperature und stellen Sie die Temp Units auf die
von lhrer Matrix verwendete Temperatur Einheit ein.

Wahlen Sie ProLink > Configuration > CM Setup.

Stellen Sie unter Global Config, set Derived Variable auf die von Ihrer Matrix
verwendete abgeleitete Variable ein.

Wichtig

e Alle Konzentrationsmatrixen in der Auswerteelektronik miissen die gleiche abgeleitete
Variable verwenden. Wenn Sie eine der Standardmatrixen von Micro Motion verwenden,
stellen Sie die Derived Variable auf Mass Conc (Density) ein. Wenn Sie eine benutzerdefinierte
Matrix verwenden, siehe Referenzinformationen fiir Ihre Matrix.

e Wenn Sie die Einstellung der abgeleiteten Variable verandern, werden alle vorhandenen
Konzentrationsmatrizen aus dem Speicher der Auswerteelektronik geldscht. Stellen Sie
die abgeleitete Variable ein, bevor Sie die Konzentrationsmatrixen laden.

Laden Sie eine oder mehrere Matrizen.

a. Unter Curve Specific Config, setzen Sie Curve Configured auf den Speicherort, auf
den die Matrix geladen wird.

b. Klicken Sie auf Load this curve from a file, navigieren Sie zur Matrixdatei auf Ihrem PC
und laden Sie die Matrix.

c. Wiederholen Sie diesen Vorgang, bis alle benétigten Matrixen geladen wurden.

Richten Sie die Extrapolationsalarme ein.

Jede Konzentrationsmatrix ist fiir einen bestimmten Dichtebereich und einen
bestimmten Temperaturbereich ausgelegt. Wenn die Prozessdichte oder -
temperatur diesen Bereich verldsst, extrapoliert die Auswerteelektronik die
Konzentrationswerte. Die Extrapolation kann jedoch die Genauigkeit
beeintrachtigen. Extrapolationsalarme machen den Bediener darauf aufmerksam,
dass eine Extrapolation stattfindet.

a. Unter Curve Specific Config, setzen Sie Curve Configured auf die zu konfigurierende
Matrix.

b. Stellen Sie Alarm Limit auf den Prozentsatz ein, bei dem ein Extrapolationsalarm
ausgegeben werden soll.
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c. Aktivieren bzw. deaktivieren Sie je nach Wunsch die oberen und unteren
Alarmgrenzwerte fiir die Temperatur und Dichte.

Einschrdnkung

Fiir die unteren und oberen Alarmgrenzwerte ist ein Core Prozessor mit erweiterter
Funktionalitat erforderlich.

Beispiel: Wenn die Alarm Limit auf 5 % eingestellt ist, Enable Temp High markiert ist und
eine Matrix fir den Temperaturbereich von 40 °F bis 80 °F eingerichtet wird, wird ein
Extrapolationsalarm gesetzt, wenn die Temperatur 82 °F (iberschreitet.

7. Wihlen Sie die Kennzeichnung fiir die Konzentrationseinheit aus.
a. Unter Curve Specific Config stellen Sie Curve Configured auf die zu konfigurierende
Matrix ein.
b. Wabhlen Sie die gewlinschte Kennzeichnung aus der Liste Units aus.

c. Wenn die Units auf Special eingestellt werden, geben Sie eine benutzerdefinierte
Kennzeichnung ein.

8.  Ermitteln Sie, wie die Auswerteelektronik die Temperaturdaten fir die
Berechnungen der Konzentrationsmessung empfangt und fiihren Sie die
entsprechende Einrichtung durch.

Option Einrichtung
Temperaturdaten  a. Waihlen Sie View > Preferences .
vom Sensor b. Deaktivieren Sie Use External Temperature.

Ein vom Anwender | a. Wéhlen Sie View > Preferences .

konfiguriertersta- | b. Aktivieren Sie Use External Temperature.

tischer Temperatur- c. Wahlen Sie ProLink > Configuration > Temperature.

wert d. Stellen Sie die externe Temperatur auf den zu verwendenden Wert
ein.

Abfrage fiir Tem- a. Stellen Sie sicher, dass der primare mA Ausgang gemaR HART-

peratur(?) Abfrage verdrahtet wurde.

Wabhlen Sie View > Preferences .

Aktivieren Sie Use External Temperature.

Wabhlen Sie ProLink > Configuration > Polled Variables.

Wabhlen Sie einen freien Abfrage-Slot.

Setzen Sie Polling Control auf Poll As Primary oder Poll as Secondary

und klicken Sie dann auf Apply.

g. Setzen Sie External Tag auf die HART-Kennzeichnung des exter-
nen Temperaturmessgerats.

h. Setzen Sie Variable Type auf External Temperature.

hoan o

Hinweis

e Als Primar abfragen: Auf dem Netzwerk ist kein anderer HART Mas-
ter vorhanden.

e Als Sekundar abfragen: Auf dem Netzwerk sind andere HART Mas-
ter vorhanden. Das Handterminal ist kein HART Master.

(7) Nicht bei allen Auswerteelektroniken verfiigbar.
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Option Einrichtung

Einvon der digital- | a. Wahlen Sie View > Preferences .

en Kommunikation | b. Aktivieren Sie Use External Temperature.

bereitgestellter c. Fuhren Sie die erforderlichen Schritte zur Programmierung des
Wert Hostsystems und zur Einrichtung der Kommunikation durch, um
Temperaturdaten in entsprechenden Intervallen auf die Auswer-
teelektronik zu schreiben.

Anmerkung

Wenn die Weights & Measures Anwendung (eichamtlicher Transfer)
implementiert ist und die Auswerteelektronik schreibgeschiitzt ist,
kann die digitale Kommunikation nicht verwendet werden, um
Temperaturdaten auf die Auswerteelektronik zu schreiben.

9.  Stellen Sie unter Global Config die Active Curve auf die fiir die Prozessmessung zu
verwendende Matrix ein.

Die Prozessvariablen fiir die Konzentration sind jetzt auf der Auswerteelektronik verfligbar.
Sie konnen Sie auf die gleiche Weise anzeigen und ausgeben wie andere Prozessvariablen.

4.8.2 Konfigurieren der Konzentrationsmessung unter
Verwendung von ProLink Il

Diese Aufgabe fiihrt Sie durch das Laden und die Einrichtung einer Konzentrationsmatrix
fiir die Messung. Das Erstellen einer Konzentrationsmatrix wird hier nicht beschrieben.

Anmerkung

Konzentrationsmatrixen kénnen entweder durch Laden einer bestehenden Matrix aus einer Datei
oder durch Erstellen einer neuen Matrix geladen werden. Ihre Auswerteelektronik kann bis zu sechs
Matrixen laden, es kann jedoch immer nur eine Matrix zur Messung verwendet werden. Detaillierte
Informationen zum Erstellen einer Matrix finden Sie unter Micro Motion Anwendung mit erweiterter
Dichte: Theorie, Konfiguration und Betrieb.

Vorbereitungsverfahren

Bevor Sie die Konzentrationsmessung konfigurierent kénnen:

. Die Anwendung Konzentrationsmessung muss auf lhrer Auswerteelektronik
aktiviert sein.

. Die zu verwendende Konzentrationsmatrix muss entweder auf Ihrer
Auswerteelektronik oder als Datei auf lhrem Computer vorhanden sein.

. Sie missen die abgeleitete Variable kennen, fiir die Ihre Matrix vorgesehen ist.

. Sie missen die von hrer Matrix verwendete MaReinheit fiir die Dichte kennen.

. Sie missen die von lhrer Matrix verwendete MaReinheit fiir die Temperatur kennen.

. Die Anwendung zur Konzentrationsmessung muss freigegeben sein.

Verfahren

1. Wabhlen Sie Device Tools > Configuration > Process Measurement > Density und stellen Sie

die Density Unit auf die von lhrer Matrix verwendete Dichte Einheit ein.
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Wabhlen Sie Device Tools > Configuration > Process Measurement > Temperature und stellen
Sie die Temperature Unit auf die von lhrer Matrix verwendete Temperatur Einheit ein.

Wahlen Sie Device Tools > Configuration > Process Measurement > Concentration
Measurement.

Stellen Sie die Derived Variable auf die von Ihrer Matrix verwendete abgeleitete
Variable ein und klicken Sie auf Apply.

Wichtig

Alle Konzentrationsmatrixen in der Auswerteelektronik miissen die gleiche abgeleitete
Variable verwenden. Wenn Sie eine der Standardmatrixen von Micro Motion verwenden,
stellen Sie die Derived Variable auf Mass Concentration (Density) ein. Wenn Sie eine
benutzerdefinierte Matrix verwenden, siehe Referenzinformationen fiir Ihre Matrix.

Wenn Sie die Einstellung der Derived Variable verandern, werden alle vorhandenen
Konzentrationsmatrixen aus dem Speicher der Auswerteelektronik geléscht. Stellen Sie
die Derived Variable ein, bevor Sie die Konzentrationsmatrizen laden.

Laden Sie eine oder mehrere Matrixen.

d.

C.

Stellen Sie die Matrix Being Configured auf den Speicherort ein, auf den die Matrix
geladen wird.

Klicken Sie auf Matrix von Datei laden, navigieren Sie zur Matrixdatei auf Ihrem
Computer und laden Sie die Matrix.

Wiederholen Sie diesen Vorgang, bis alle benétigten Matrizen geladen wurden.

Priifen und konfigurieren Sie die Matrixdaten.

d.

d
e
f.
g

Falls erforderlich stellen Sie Matrix Being Configured auf die Matrix ein, die Sie
anzeigen mochten, und klicken Sie auf Change Matrix.

. Stellen Sie Concentration Unit auf die Kennzeichnung ein, die fiir die

Konzentrationseinheit verwendet wird.

Wenn die Concentration Unit auf Special eingestellt werden, geben Sie eine
benutzerdefinierte Kennzeichnung ein.

. Falls gewiinscht, kann der Matrixname gedndert werden.

. Priifen Sie die Datenpunkte fiir diese Matrix.

Reference Temperature und der Curve Fit Maximum Order nicht andern.

. Wenn Matrixdaten gedndert wurden, klicken Sie auf Apply.

Richten Sie die Extrapolationsalarme ein.

Jede Konzentrationsmatrix ist fiir einen bestimmten Dichtebereich und einen
bestimmten Temperaturbereich ausgelegt. Wenn die Prozessdichte oder -
temperatur diesen Bereich verldsst, extrapoliert die Auswerteelektronik die
Konzentrationswerte. Die Extrapolation kann jedoch die Genauigkeit
beeintrachtigen. Extrapolationsalarme machen den Bediener darauf aufmerksam,
dass eine Extrapolation stattfindet.

d.

b.

C.

Stellen Sie ggf. die Matrix Being Configured auf die Matrix ein, die Sie anzeigen
mochten, und klicken Sie auf Change Matrix.

Stellen Sie die Extrapolation Alarm Limit auf den Prozentsatz ein, bei dem ein
Extrapolationsalarm ausgegeben werden soll.

Aktivieren bzw. deaktivieren Sie je nach Wunsch die oberen und unteren
Alarmgrenzwerte fiir die Temperatur und Dichte und klicken Sie auf Apply.
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Einschrankung

Fiir die unteren und oberen Alarmgrenzwerte ist ein Core Prozessor mit erweiterter

Funktionalitat erforderlich.

Beispiel: Wenn Extrapolation Alarm Limit auf 5 % eingestellt ist, ist der High Extrapolation
Limit (Temperature) aktiviert und es wird eine Matrix fiir den Temperaturbereich von
40 °F bis 80 °F eingerichtet. Wenn die Temperatur 82 °F iberschreitet, wird ein
Extrapolationsalarm ausgegeben.

8. Setzen Sie Temperature Source auf die Methode, die die Auswerteelektronik fiir den
Empfang der Temperaturdaten verwendet.

Option

Beschreibung

Externen Wert abfragen(8)

Die Auswerteelektronik fragt ein externes Temperaturmess-
gerdt ab. Sie verwendet hierfiir das HART-Protokoll Giber den
primdren mA Ausgang.

Widerstandsthermometer

Die Auswerteelektronik verwendet die Temperaturdaten
vom Sensor.

Statische oder digitale Kommuni-

kation

Die Auswerteelektronik verwendet den aus dem Speicher

gelesenen Temperaturwert.

 Statisch: Der konfigurierte Wert wird verwendet.

 Digitale Kommunikation: Ein Host schreibt Daten in den
Speicher der Auswerteelektronik.

Anmerkung

Wenn die Weights & Measures Anwendung (eichamtlicher
Transfer) implementiert ist und die Auswerteelektronik
schreibgeschiitzt ist, kann die digitale Kommunikation nicht
verwendet werden, um Temperaturdaten auf die Auswer-
teelektronik zu schreiben.

9.  Wenn Sie RTD wahlen, ist keine weitere Konfiguration erforderlich. Klicken Sie auf

Apply um zu verlassen.

10.  Wenn Sie die Abfrage von Temperaturdaten wahlen:

a. Wahlen Sie den zu verwendenden Polling Slot.

b. Setzen Sie Polling Control auf Poll as Primary oder auf Poll as Secondary und klicken Sie

dann auf Apply.

Hinweis

e Als Primar abfragen: Auf dem Netzwerk ist kein anderer HART Master vorhanden.

e Als Sekundar abfragen: Auf dem Netzwerk sind andere HART Master vorhanden. Das
Handterminal ist kein HART Master.

c. Setzen Sie die External Device Tag auf die HART-Kennzeichnung des externen
Temperaturmessgerdts und klicken Sie auf Apply.

(8) Nicht bei allen Auswerteelektroniken verfiigbar.
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4.8.3
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11.  Wenn Sie einen statischen Temperaturwert wahlen, stellen Sie External Temperature
auf den zu verwendenden Wert ein und klicken Sie auf Apply.

12.  Wenn Sie digitale Kommunikation verwenden moéchten, klicken Sie auf Apply und
fiihren Sie dann die erforderlichen Schritte zur Programmierung des Hostsystems
und zur Einrichtung der Kommunikation durch, um Temperaturdaten in
entsprechenden Intervallen auf die Auswerteelektronik zu schreiben.

13.  Stellen Sie die Active Matrix auf die fiir die Messung zu verwendende Matrix ein.

Die Prozessvariablen fiir die Konzentration sind jetzt auf der Auswerteelektronik verfligbar.
Sie kénnen Sie auf die gleiche Weise anzeigen und ausgeben wie andere Prozessvariablen.

Konfigurieren der Konzentrationsmessung unter
Verwendung des Handterminal

Diese Aufgabe fiihrt Sie durch die Einrichtung einer Konzentrationsmatrix fiir die Messung.
Das Laden oder Erstellen einer Konzentrationsmatrix wird hier nicht beschrieben.

Anmerkung

Konzentrationsmatrixen kénnen entweder durch Laden einer bestehenden Matrix aus einer Datei
oder durch Erstellen einer neuen Matrix geladen werden. Ihre Auswerteelektronik kann bis zu sechs
Matrixen laden, es kann jedoch immer nur eine Matrix zur Messung verwendet werden. Detaillierte
Informationen zum Erstellen einer Matrix finden Sie unter Micro Motion Anwendung mit erweiterter
Dichte: Theorie, Konfiguration und Betrieb.

Vorbereitungsverfahren

Bevor Sie die Konzentrationsmessung konfigurierent konnen:

. Die Anwendung Konzentrationsmessung muss auf Ihrer Auswerteelektronik
aktiviert sein.

. Sie missen die abgeleitete Variable kennen, fiir die Ihre Matrix vorgesehen ist.

. Sie missen die von lhrer Matrix verwendete MaReinheit fiir die Dichte kennen.

. Sie miissen die von lhrer Matrix verwendete MaReinheit fiir die Temperatur kennen.

. Die Anwendung zur Konzentrationsmessung muss freigegeben sein.

Verfahren

1. Wabhlen Sie Online > Konfiguration > Manuelle Einrichtung > Messungen > Dichte und stellen
Sie die MaReinheit fiir die Dichte auf die von Ihrer Matrix verwendete Dichte-MaReinheit
ein.

2. Wabhlen Sie Online > Konfiguration > Manuelle Einrichtung > Messungen > Temperatur und

stellen Sie die MaReinheit fiir die Temperatur auf die von lhrer Matrix verwendete
Temperatur-MaReinheit ein.

3. Wabhlen Sie Online > Konfiguration > Manuelle Einrichtung > Messungen > Konzmess. (CM) >
KM-Konfiguration.

4, Richten Sie die Extrapolationsalarme ein.

Jede Konzentrationsmatrix ist fiir einen bestimmten Dichtebereich und einen
bestimmten Temperaturbereich ausgelegt. Wenn die Prozessdichte oder -
temperatur diesen Bereich verlasst, extrapoliert die Auswerteelektronik
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Konzentrationswerte. Die Extrapolation kann jedoch die Genauigkeit
beeintrachtigen. Extrapolationsalarme machen das Bedienpersonal darauf
aufmerksam, dass eine Extrapolation stattfindet.

a. Wahlen Sie Online > Konfiguration > Manuelle Einrichtung > Messungen > Konzmess. (CM)
> Matrix-Konfiguration.

b. Stellen Sie Matrix wird konfiguriert auf die zu konfigurierende Matrix ein.

c. Stellen Sie die Extrapolationsalarmgrenze auf den Prozentsatz ein, bei dem ein
Extrapolationsalarm ausgegeben werden soll.

d. Wabhlen Sie Online > Configure > Alarm-Einstellung > KM-Alarme.

e. Aktivieren bzw. deaktivieren Sie je nach Wunsch die oberen und unteren
Alarmgrenzwerte fiir die Temperatur und Dichte.

Einschrdankung

Fiir die unteren und oberen Alarmgrenzwerte ist ein Core Prozessor mit erweiterter
Funktionalitat erforderlich.

Beispiel: Wenn die Alarmgrenze auf 5 % eingestellt ist, ist der Extrapolationsalarm fir
hohe Temperatur aktiviert und es wird eine Matrix fiir den Temperaturbereich von
40 °F (5 °C) bis 80 °F (26 °C) eingerichtet. Wenn die Temperatur 82 °F (27 °C)
iberschreitet, wird ein Extrapolationsalarm ausgegeben.

5.  Wadhlen Sie die Kennzeichnung fir die Konzentrationseinheit aus.
a. Wabhlen Sie Online > Konfiguration > Manuelle Einrichtung > Messungen > Konzmess. (CM)
> Matrix-Konfiguration.
b. Stellen Sie Matrix wird konfiguriert auf die zu konfigurierende Matrix ein.
c. Stellen Sie die gew(inschte Kennzeichnung fiir die Konzentrationseinheiten ein.

d. Wenn die Einheiten auf Spezial eingestellt werden, geben Sie eine
benutzerdefinierte Kennzeichnung ein.

6. Ermitteln Sie, wie die Auswerteelektronik die Temperaturdaten fiir die
Konzentrationsmessungsberechnungen empfangt und fiihren Sie die
entsprechende Einrichtung durch.

Option Einrichtung

Temperaturdaten a. Wahlen Sie Online > Konfiguration > Manuelle Einrichtung > Messungen
vom Sensor > Externe(r) Druck/Temperatur > Temperatur.
b. Deaktivieren Sie Externe Temperatur.

Einvom Anwender | a. Wdhlen Sie Online > Konfiguration > Manuelle Einrichtung > Messungen

konfigurierter sta- > Externe(r) Druck/Temperatur > Temperatur.

tischer Temperatur- b. Aktivieren Sie Externe Temperatur.

wert c. Stellen Sie die Korrekturtemperatur auf den zu verwendenden Wert
ein.
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Option Einrichtung

Abfrage fiir Tem- a. Stellen Sie sicher, dass der primare mA Ausgang gemaR HART

peratur(®) Abfrage verdrahtet wurde.

b. Wahlen Sie Online > Konfiguration > Manuelle Einrichtung > Messungen
> Externe(r) Druck/Temperatur > Temperatur.

c. Aktivieren Sie Externe Temperatur.

d. Wabhlen Sie Online > Configure > Manual Setup > Measurements > Exter-
nal Pressure/Temperature > External Polling.

e. Setzen Sie Poll Control auf Poll As Primary Host oder auf Poll as Secon-
dary Host.

f.  Wahlen Sie einen freien Abfrage-Slot.

g. Setzen Sie External Tag auf die HART-Kennzeichnung des exter-
nen Temperaturmessgerats.

h. Setzen Sie Abgefragte Variable auf Temperatur.

Hinweis

e Als Primar abfragen: Auf dem Netzwerk ist kein anderer HART Mas-
ter vorhanden.

e Als Sekundar abfragen: Auf dem Netzwerk sind andere HART Mas-
ter vorhanden. Das Handterminal ist kein HART Master.

Ein von der digital- | a. Wahlen Sie Online > Konfiguration > Manuelle Einrichtung > Messungen

en Kommunikation > Externe(r) Druck/Temperatur > Temperatur.
bereitgestellter b. Aktivieren Sie Externe Temperatur.
Wert c. Fihren Sie die erforderlichen Schritte zur Programmierung des

Hostsystems und zur Einrichtung der Kommunikation durch, um
Temperaturdaten in entsprechenden Intervallen auf die Auswer-
teelektronik zu schreiben.

Anmerkung

Wenn die Weights & Measures Anwendung (eichamtlicher Transfer)
implementiert ist und die Auswerteelektronik schreibgeschiitzt ist,
kann die digitale Kommunikation nicht verwendet werden, um
Temperaturdaten auf die Auswerteelektronik zu schreiben.

7. Online > Konfiguration > Manuelle Einrichtung > Messungen > Konzmess. (KM) > KM-
Konfiguration und stellen Sie die Aktive Matrix auf die flir die Messung zu verwendende
Matrix ein.

Die Prozessvariablen fiir die Konzentration sind jetzt auf der Auswerteelektronik verfiigbar.
Sie kénnen Sie auf die gleiche Weise anzeigen und ausgeben wie andere Prozessvariablen.

4.8.4 Standardmatrixen fiir die Anwendung
Konzentrationsmessung

Die verfiigbaren Standard Konzentrationsmatrixen von Micro Motion sind anwendbar fiir
eine Vielzahl von Prozessmedien.

(9) Nicht bei allen Auswerteelektroniken verfiigbar.
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Tabelle 4-14 zeigt eine Liste der Standard Konzentrationsmatrixen von Micro Motion, die in
der Berechnung verwendeten MaReinheiten fiir Dichte und Temperatur sowie die zur
Angabe der Konzentrationsdaten verwendete MaReinheit.

Hinweis

Sollten die Standardmatrixen fiir hre Anwendung nicht geeignet sein, knnen Sie selbst eine Matrix
definieren oder eine kundenspezifische Matrix bei Micro Motion bestellen.

Tabelle 4-14: Standard Konzentrationsmatrixen und zugehérige MaReinheiten

Matrixname

Beschreibung

Dichteeinheit

Temperaturein-
heit

Einheit fiir Kon-
zentration

Deg Balling

Die Matrix reprasentiert den prozen-
tualen Extraktanteil in Masse in der Lo-
sung, basierend auf °Balling. Beispiel:
Wenn eine Wiirze 10 °Balling hat und
der Extrakt in der Losung 100 % Sac-
charose ist, so ist der Extrakt 10 % vom
Gesamtgewicht.

g/cm?3

°F

°Balling

Deg Brix

Die Matrix reprasentiert eine Fllissig-
keitsskala fiir Saccharosel6sungen, die
den prozentualen Gewichtsanteil der
Saccharaose an der Lésung bei gegeb-
ener Temperaturen angibt. Beispiel:
40 kg Saccharose gemischt mit 60 kg
Wasser ergeben eine 40 °Brix Losung.

g/cm?

°C

°Brix

Deg Plato

Die Matrix reprasentiert den prozen-
tualen Extraktanteil in Masse in der L6-
sung, basierend auf °Plato. Beispiel:
Wenn eine Wiirze 10 °Plato hat und
der Extrakt in der Losung 100 % Sac-
charose ist, so ist der Extrakt 10 % vom
Gesamtgewicht.

g/cm3

°F

°Plato

HFCS 42

Die Matrix reprdsentiert eine Fllssig-
keitsskala fiir HFCS 42 (high fructose
corn syrup) Losung, die den prozen-
tualen Gewichtsanteil der HFCS in der
Lésung angibt.

g/cm?3

°C

%

HFCS 55

Die Matrix reprdsentiert eine Fllssig-
keitsskala fiir HFCS 55 (high fructose
corn syrup) Losung, die den prozen-
tualen Gewichtsanteil der HFCS in der
Losung angibt.

g/cm?3

°C

%

HFCS 90

Die Matrix reprasentiert eine Fl{issig-
keitsskala fiir HFCS 90 (high fructose
corn syrup) Losung, die den prozen-
tualen Gewichtsanteil der HFCS in der
L6sung angibt.

g/cm?

°C

%
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4.8.5

Tabelle 4-15: Abgeleitete Variablen und berechnete Prozessvariablen

Abgeleitete Variablen und berechnete Prozessvariablen

Fiir jede abgeleitete Variable berechnet die Anwendung Konzentrationsmessung einen

anderen Satz an Prozessvariablen.

Berechnete Prozessvariablen

tion abgeleitet vom
spezifischen Ge-
wicht

eines gel6sten Stoffes
oder Stoff in Ldsung in
der Gesamtldsung, ab-
geleitet vom spezifi-
schen Gewicht

Dichte bei | Standard Netto Netto
Referenz-  Volumen- | Spezi- Masse- Volumen-
tempera- | durch- fisches Konzen- | durch- durch-
Abgeleitete Variable | Beschreibung tur fluss Gewicht | tration fluss fluss
Dichte bei Refer- Masse/Einheit Volu- v v
enztemperatur men, korrigiert auf eine
gegebene Referenz-
temperatur
Spezifisches Ge- Verhaltnis der Dichte v v v
wicht des Prozessmediums
bei gegebener Temper-
atur zur Dichte von
Wasser bei gegebener
Temperatur. Die bei-
den gegebenen Tem-
peraturbedingungen
miissen nicht gleich
sein.
Massekonzentration = Prozentualer Massean- v v v v
abgeleitet von der | teil eines (gelsten)
Referenzdichte Stoffes in einer Losung,
abgeleitet von der Ref-
erenzdichte
Massekonzentration = Prozentuale Masse v v v v v
abgeleitet vom spe- | eines gelosten Stoffes
zifischen Gewicht | oder Stoff in Lésung in
der Gesamtl6ésung, ab-
geleitet vom spezifi-
schen Gewicht
Volumenkonzentra- | Prozentuale Volumen v v v v
tion abgeleitet von | eines gelOsten Stoffes
der Referenzdichte | oder Stoff in Losungin
der Gesamtloésung, ab-
geleitet von der Refer-
enzdichte
Volumenkonzentra- | Prozentuale Volumen v v v v v
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Tabelle 4-15: Abgeleitete Variablen und berechnete Prozessvariablen (Fortsetzung)

Berechnete Prozessvariablen

leitet von der Refer-
enzdichte

Dichte bei | Standard Netto Netto

Referenz-  Volumen- | Spezi- Masse- Volumen-

tempera-  durch- fisches Konzen- | durch- durch-
Abgeleitete Variable | Beschreibung tur fluss Gewicht | tration fluss fluss
Konzentration abge- = Masse, Volumen, Ge- v v v

wicht oder Anzahl der
Mole eines geldsten
Stoffes oder Stoff in L6-
sung proportional zur
Gesamtldsung, zur L6-
sung, abgeleitet von
der Referenzdichte

Konzentration abge-
leitet vom spezifi-
schen Gewicht

Masse, Volumen, Ge- v v v v
wicht oder Anzahl der
Mole eines gel6sten
Stoffes oder Stoff in L6-
sung proportional zur
Gesamtlosung, zur L6-
sung, abgeleitet vom
spezifischen Gewicht

4.9

4.9.1

Konfigurations- und Bedienungsanleitung

Druckkompensation konfigurieren

Die Druckkompensation nimmt Anpassungen an der Prozessmessung vor, um den Einfluss
des Drucks auf den Sensor zu kompensieren. Der Einfluss des Drucks ist die Anderung der
Empfindlichkeit des Sensors beziiglich Durchfluss und Dichte, die durch die Differenz
zwischen dem Kalibrierdruck und dem Prozessdruck verursacht wird.

Hinweis

Nicht alle Sensoren oder Anwendungen erfordern eine Druckkompensation. Der Einfluss des Drucks
auf ein bestimmtes Sensormodell ist im Produktdatenblatt aufgefiihrt, das unter
www.micromotion.com zu finden ist. Wenn Sie sich nicht sicher sind, ob die Druckkompensation zu
verwenden ist, wenden Sie sich an den Micro Motion Kundenservice.

Druckkompensation konfigurieren mittels ProLink I

Vorbereitungsverfahren
Sie benoétigen den Durchflussfaktor, den Dichtefaktor und die Kalibrierdruckwerte fiir den
Sensor.

. Durchflussfaktor und Dichtefaktor sind im Produktdatenblatt des Sensors
angegeben.

. Der Kalibrierdruck ist im Kalibrierdatenblatt des Sensors zu finden. Sind die Daten
nicht verfligbar, verwenden Sie 20 psi.
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Verfahren

1.

Wibhlen Sie View > Preferences und stellen Sie sicher, dass das Kontrollfeld Externe
Druckkompensation aktivieren markiert ist.

Wabhlen Sie ProLink > Configuration > Pressure.

Geben Sie den Flow Factor fur Ihren Sensor ein.

Der Durchflussfaktor ist die prozentuale Anderung des Durchflusses pro psi. Bei der
Eingabe des Wertes verwenden Sie das umgekehrte Vorzeichen.

Beispiel:
Wenn der Durchflussfaktor 0,000004 % pro psi ist, geben Sie -0,000004 % pro psi ein.
Geben Sie den Density Factor fiir lhren Sensor ein.

Der Dichtefaktor ist die Anderung der Dichte des Prozessmediums in g/cm3/psi. Bei
der Eingabe des Wertes verwenden Sie das umgekehrte Vorzeichen.

Beispiel:
Wenn der Dichtefaktor 0,000006 g/cm3/psi ist, geben Sie -0,000006 g/cm3/psi ein.
Geben Sie den Cal Pressure fiir hren Sensor ein.

Der Kalibrierdruck ist der Druck, bei dem der Sensor kalibriert wurde. Dies entspricht
dem Druck, bei dem kein Einfluss des Drucks vorhanden ist. Sind die Daten nicht
verfligbar, geben Sie 20 psi ein.

Ermitteln Sie, wie die Auswerteelektronik die Druckdaten empfangt, und fiihren Sie
die entsprechende Einrichtung durch.

Option Einrichtung

Einvom Anwender | a. Setzen Sie Pressure Units auf die gewiinschte Einheit.
konfigurierter, sta- | b. Setzen Sie External Pressure auf den gewlinschten Wert.
tischer Druckwert

Abfragen von a. Stellen Sie sicher, dass der primare mA Ausgang gemaR HART

Druck(10) Abfrage verdrahtet wurde.

b. Wahlen Sie ProLink > Configuration > Polled Variables.

Wahlen Sie einen freien Abfrage Slot.

d. Setzen Sie Polling Control auf Poll As Primary oder Poll as Secondary
und klicken Sie dann auf Apply.

e. Setzen Sie External Tag auf die HART Kennzeichnung des externen
Druckmessgerits.

f. Setzen Sie Variable Type auf Pressure.

n

Hinweis

e Als Primér abfragen: Auf dem Netzwerk ist kein anderer HART Mas-
ter vorhanden.

e Als Sekundar abfragen: Auf dem Netzwerk sind andere HART Mas-
ter vorhanden. Das Handterminal ist kein HART Master.

(10) Nicht bei allen Auswerteelektroniken verfiigbar.
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4.9.2

Option Einrichtung

Einvon derdigital- | a. Setzen Sie Pressure Units auf die gew(inschte Einheit.

en Kommunikation b. Fiihren Sie die erforderlichen Schritte zur Programmierung des
bereitgestellter Hostsystems und zur Einrichtung der Kommunikation durch, um
Wert die Druckdaten in entsprechenden Intervallen auf die Auswer-
teelektronik zu schreiben.

Anmerkung

Wenn die Weights & Measures Anwendung (eichamtlicher Transfer)
implementiert ist und die Auswerteelektronik schreibgeschiitzt ist,
kann die digitale Kommunikation nicht verwendet werden, um
Temperaturdaten auf die Auswerteelektronik zu schreiben.

Nachbereitungsverfahren

Wenn Sie ein externes Druckmessgerat verwenden, (iberpriifen Sie die Einstellung, indem
Sie ProLink > Process Variables wahlen und den in External Pressure angezeigten Wert priifen.
Druckkompensation konfigurieren mittels ProLink I

Vorbereitungsverfahren

Sie beno6tigen den Durchflussfaktor, den Dichtefaktor und die Kalibrierdruckwerte fiir den
Sensor.

. Durchflussfaktor und Dichtefaktor sind im Produktdatenblatt des Sensors
angegeben.
. Der Kalibrierdruck ist im Kalibrierdatenblatt des Sensors zu finden. Sind die Daten

nicht verfligbar, verwenden Sie 20 psi.
Verfahren

1. Wahlen Sie Device Tools > Configuration > Process Measurement > Pressure Compensation.
Setzen Sie Pressure Compensation Status to Enabled.

Geben Sie den Flow Calibration Pressure fiir Ihren Sensor ein.

Der Kalibrierdruck ist der Druck, bei dem der Sensor kalibriert wurde. Dies entspricht
dem Druck, bei dem kein Einfluss des Drucks vorhanden ist. Sind die Daten nicht
verfligbar, geben Sie 20 psi ein.

4, Geben Sie den Flow Factor fiir lhren Sensor ein.

Der Durchflussfaktor ist die prozentuale Anderung des Durchflusses pro psi. Bei der
Eingabe des Wertes verwenden Sie das umgekehrte Vorzeichen.

Beispiel:
Wenn der Durchflussfaktor 0,000004 % pro psi ist, geben Sie -0,000004 % pro psi ein.
5. Geben Sie den Density Factor fiir lhren Sensor ein.

Der Dichtefaktor ist die Anderung der Dichte des Prozessmediums in g/cm3/psi. Bei
der Eingabe des Wertes verwenden Sie das umgekehrte Vorzeichen.

Beispiel:
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Wenn der Dichtefaktor 0,000006 g/cm3/psi ist, geben Sie -0,000006 g/cm3/psi ein.

6. Setzen Sie Pressure Source auf die Methode, die die Auswerteelektronik fiir den
Empfang der Druckdaten verwendet.

Option Beschreibung

Externen Wert abfragen(11) Die Auswerteelektronik fragt ein externes Druckmessgerdt
ab. Sie verwendet hierfiir das HART Protokoll Gber den pri-
madren mA Ausgang.

Statische oder digitale Kommuni- = Die Auswerteelektronik verwendet den aus dem Speicher

kation gelesenen Druckwert.

 Statisch: Der konfigurierte Wert wird verwendet.

¢ Digitale Kommunikation: Ein Host schreibt Daten in den
Speicher der Auswerteelektronik.

Anmerkung

Wenn die Weights & Measures Anwendung (eichamtlicher
Transfer) implementiert ist und die Auswerteelektronik
schreibgeschiitzt ist, kann die digitale Kommunikation nicht
verwendet werden, um Temperaturdaten auf die Auswer-
teelektronik zu schreiben.

7. Wenn Sie die Abfrage von Druckdaten wahlen:

a. Wahlen Sie den zu verwendenden Abfrage Slot.

b. Setzen Sie Polling Control auf Poll as Primary oder auf Poll as Secondary und klicken Sie
dann auf Apply.

Hinweis
 Als Primar abfragen: Auf dem Netzwerk ist kein anderer HART Master vorhanden.

e Als Sekundar abfragen: Auf dem Netzwerk sind andere HART Master vorhanden. Das
Handterminal ist kein HART Master.

c. Setzen Sie External Device Tag auf die HART Kennzeichnung des externen
Druckmessgerats und klicken Sie dann auf Apply.

8. Wenn Sie einen statischen Druckwert verwenden:

a. Setzen Sie Pressure Unit auf die gewlinschte Einheit.

b. Setzen Sie Static or Current Pressure auf den Wert, den Sie verwenden mochten,
und klicken Sie auf Apply.

9.  Wenn Sie digitale Kommunikation verwenden mdéchten, klicken Sie auf Apply und
fiihren Sie dann die erforderlichen Schritte zur Programmierung des Hostsystems
und zur Einrichtung der Kommunikation durch, um Druckdaten in entsprechenden
Intervallen auf die Auswerteelektronik zu schreiben.

Nachbereitungsverfahren

Wenn Sie einen externen Druckwert verwenden, (iberpriifen Sie die Einstellung, indem Sie
den Wert External Pressure priifen, derim Bereich Inputs des Hauptfensters angezeigt wird.

(11) Nicht bei allen Auswerteelektroniken verfiigbar.
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49.3 Druckkompensation konfigurieren mittels Handterminal

Vorbereitungsverfahren

Sie benétigen den Durchflussfaktor, den Dichtefaktor und die Kalibrierdruckwerte fiir den

Sensor.

. Durchflussfaktor und Dichtefaktor sind im Produktdatenblatt des Sensors
angegeben.

. Der Kalibrierdruck ist im Kalibrierdatenblatt des Sensors zu finden. Sind die Daten

nicht verfligbar, verwenden Sie 20 psi.
Verfahren

1. Wabhlen Sie Online > Configure > Manual Setup > Measurements > External Pressure/
Temperature > Pressure.

Setzen Sie Pressure Compensation auf Enabled.
Geben Sie den Flow Cal Pressure ftir Ihren Sensor ein.

Der Kalibrierdruck ist der Druck, bei dem der Sensor kalibriert wurde. Dies entspricht
dem Druck, bei dem kein Einfluss des Drucks vorhanden ist. Sind die Daten nicht
verfiigbar, geben Sie 20 psi ein.

4, Geben Sie den Flow Press Factor fir Ihren Sensor ein.

Der Durchflussfaktor ist die prozentuale Anderung des Durchflusses pro psi. Bei der
Eingabe des Wertes verwenden Sie das umgekehrte Vorzeichen.

Beispiel:
Wenn der Durchflussfaktor 0,000004 % pro psi ist, geben Sie -0,000004 % pro psi ein.
5.  Geben Sie den Dens Press Factor fiir Ihren Sensor ein.

Der Dichtefaktor ist die Anderung der Dichte des Prozessmediums in g/cm?/psi. Bei
der Eingabe des Wertes verwenden Sie das umgekehrte Vorzeichen.

Beispiel:
Wenn der Dichtefaktor 0,000006 g/cm3/psi ist, geben Sie -0,000006 g/cm3/psi ein.
6. Ermitteln Sie, wie die Auswerteelektronik die Druckdaten empfangt, und fiihren Sie

die entsprechende Einrichtung durch.

Option Einrichtung

Einvom Anwender | a. Setzen Sie Pressure Unit auf die gewtinschte Einheit.
konfigurierter, sta- b. Setzen Sie Compensation Pressure auf den gewiinschten Wert.
tischer Druckwert
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Option

Einrichtung

Abfragen von
Druck(12)

a.

Stellen Sie sicher, dass der primare mA Ausgang gemaR HART
Abfrage verdrahtet wurde.

Wahlen Sie Online > Configure > Manual Setup > Measurements > Exter-
nal Pressure/Temperature > External Polling.

Setzen Sie Poll Control auf Poll As Primary Host oder auf Poll as Secon-
dary Host.

d. Wabhlen Sie einen freien Abfrage Slot.

e. Setzen Sie External Tag auf die HART Kennzeichnung des externen
Druckmessgerits.
f.  Setzen Sie Polled Variable auf Pressure.
Hinweis
e Als Primar abfragen: Auf dem Netzwerk ist kein anderer HART Mas-
ter vorhanden.
e Als Sekundar abfragen: Auf dem Netzwerk sind andere HART Mas-
ter vorhanden. Das Handterminal ist kein HART Master.
Einvon derdigital- | a. Setzen Sie Pressure Unit auf die gewiinschte Einheit.
en Kommunikation b. Fiihren Sie die erforderlichen Schritte zur Programmierung des
bereitgestellter Hostsystems und zur Einrichtung der Kommunikation durch, um
Wert die Druckdaten in entsprechenden Intervallen auf die Auswer-
teelektronik zu schreiben.
Anmerkung

Nachbereitungsverfahren

Wenn die Weights & Measures Anwendung (eichamtlicher Transfer)
implementiert ist und die Auswerteelektronik schreibgeschiitzt ist,
kann die digitale Kommunikation nicht verwendet werden, um
Temperaturdaten auf die Auswerteelektronik zu schreiben.

Wenn Sie einen externen Druckwert verwenden, (iberpriifen Sie die Einstellung, indem Sie
Service Tools > Variables > External Variables wahlen und den fiir External Pressure angezeigten

Wert priifen.

49.4 Optionen fiir Druckmesseinheit

Die Auswerteelektronik bietet ein Standardsatz an Messeinheiten fiir Pressure Measurement
Unit. Unterschiedliche Kommunikations-Hilfsmittel verwenden moglicherweise
unterschiedliche Kennzeichnungen fiir die Einheiten. In den meisten Anwendungen sollte
Pressure Measurement Unit so eingestellt sein, dass sie mit dem vom externen Gerat
verwendeten Druckmesseinheit (ibereinstimmt.

(12) Nicht bei allen Auswerteelektroniken verfiigbar.
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Tabelle 4-16: Optionen fiir Pressure Measurement Unit

Kennzeichnung

Beschreibung der Einheit Anzeiger ProLink I ProLink Ill Handterminal
Feet Wasser bei 68 °F FTH20 Ft Wasser bei 68 °F | Ft Water @ 68°F ftH20
In. Wasser bei 4 °C INW4C In. Wasserbei4°C | In Water @ 4°C inH20 (4°C)
In. Wasser bei 60 °F INW60 In. Wasser bei 60 °F | In Water @ 60°F inH20 bei 60 °F
In. Wasser bei 68 °F INH20 In. Wasser bei 68 °F | In Water @ 68°F inH20
Millimeter Wasser bei 4 °C MMW4C mm Wasser bei 4 °C | mm Water @ 4°C mmH20 (4°C)
Millimeter Wasser bei 68 °F mmH20 mm Wasser bei mm Water @ 68°F mmH20

68 °F
Millimeter Quecksilber bei 0 °C | MMHG mm Quecksilber bei  mm Mercury @ 0°C mmHg

0°C
In. Quecksilber bei 0 °C INHG In. Quecksilber bei | In Mercury @ 0°C inHG

0°C
Pounds pro Quadratinch PSI PSI PSI psi
bar BAR bar bar bar
mbar mBAR mbar millibar mbar
Gramm pro Quadratzentime- | G/SCM g/lcm2 g/lcm2 g/lcm2
ter
Kilogramm pro Quadrat- KG/SCM kg/lcm2 kglcm?2 kg/cm2
zentimeter
Pascal PA Pa pascals Pa
kPa KPA kPa Kilopascals kPa
Megapascal MPA MPa Megapascals MPa
Torr bei 0°C TORR Torr bei 0°C Torr @ 0°C torr
Atmosphdren ATM at atms at
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5.1

5.1.1

72

Gerateoptionen und Praferenzen
konfigurieren

In diesem Kapitel behandelte Themen:

*  Konfigurieren des Auswerteelektronik-Displays

e Aktivieren oder Deaktivieren von Bedieneraktionen (iber das Display
*  Konfigurieren der Sicherheitseinstellungen fiir Display-Men(is

. Konfigurieren von Antwortzeitparametern

*  Konfigurieren der Alarmverwaltung

e Informationsparameter konfigurieren

Konfigurieren des Auswerteelektronik-
Displays

Die auf dem Display angezeigten Prozessvariablen und das Anzeigeverhalten sind
regelbar.

Zu den Displayparametern gehéren:

. Displaysprache

J Displayvariablen

. Anzeigegenauigkeit

J Aktualisierungsperiode

. Auto Scroll (Automatisches Blattern) und Auto Scroll Rate (Geschwindigkeit fiir automatisches
Blattern)

. Hintergrundbeleuchtung
. Status-LED blinkt

Konfigurieren der flir das Display verwendeten Sprache

Anzeiger OFF-LINE MAINT > OFF-LINE CONFG > DISPLAY > LANG

ProLink Il ProLink > Configuration > Display > Display Language

ProLink Il Device Tools > Configuration > Transmitter Display > General

Handterminal Configure > Manual Setup > Display > Language
Uberblick

Mit der Option Display Language (Displaysprache) wird die Sprache festgelegt, die fiir die
Anzeige der Prozessdaten und Meniis auf dem Display verwendet werden soll.

Verfahren

Die zu verwendende Sprache auswahlen.
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5.1.2

Die Sprache ist abhdngig von Modell und Version der Auswerteelektronik.

Konfigurieren der auf dem Display angezeigten
Prozessvariablen

Anzeiger Not available

ProLink Il ProLink > Configuration > Display

ProLink Il Device Tools > Configuration > Transmitter Display > Display Variables

Handterminal Configure > Manual Setup > Display > Display Variables
Uberblick

Die auf dem Display anzuzeigenden Prozessvariablen und deren Reihenfolge konnen
eingestellt werden. Auf dem Display konnen bis zu 15 Prozessvariablen in
anwenderdefinierter Reihenfolge durch Blattern angezeigt werden. Zusatzlich kénnen
Variablen wiederholt bzw. Anzeigepldtze unbelegt bleiben.

Einschrankungen

. Sie konnen die Display Variable 1 nicht auf None setzen. Display Variable 1 muss als Prozessvariable
eingestellt sein.

. Wenn Display Variable 1 so konfiguriert ist, um den primaren mA Ausgang anzuzeigen, kann die
Einstellung fir Display Variable 1 mit diesem Verfahren nicht gedndert werden. Um die
Einstellung der Display Variable 1 zu dndern, miissen Sie die Konfiguration der mA Ausgang
Prozessvariablen fiir den primdren mA Ausgang dndern.

Anmerkung

Wenn eine Displayvariable als Volumenprozessvariable konfiguriert und dann Volume Flow Type
geandert wird, wird die Displayvariable automatisch in die entsprechende Prozessvariable
umgedndert. Beispiel: Volume Flow Rate wird in Gas Standard Volume Flow Rate geéndert.

Verfahren

Fiir jede Displayvariable, die gedndert werden soll, muss eine Prozessvariable zugewiesen
werden, die verwendet werden soll.

Beispiel: Standard Displayvariablen Konfiguration

Displayvariable Prozessvariablen Zuordnung
Displayvariable 1 Massedurchfluss

Displayvariable 2 Masse Summenzahler
Displayvariable 3 Volumendurchfluss
Displayvariable 4 Volumen Summenzdhler
Displayvariable 5 Dichte

Displayvariable 6 Temperatur

Displayvariable 7 Externer Druck

Displayvariable 8 Massedurchfluss
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5.1.3

74

Displayvariable Prozessvariablen Zuordnung
Displayvariable 9 Keine
Displayvariable 10 Keine
Displayvariable 11 Keine
Displayvariable 12 Keine
Displayvariable 13 Keine
Displayvariable 14 Keine
Displayvariable 15 Keine

Konfigurieren der Displayvariable 1, um den primdren mA-
Ausgang zu iiberwachen

Anzeiger OFF-LINE MAINT > OFF-LINE CONFG > DISPLY > VAR 1
ProLink Il ProLink > Configuration > Display > Display Options > Display Variable 1 Selection
ProLink Il Device Tools > Configuration > Transmitter Display > Display Security
Handterminal Not available

Uberblick

Die Displayvariable 1 kann konfiguriert werden, um die mA-Ausgang-Prozessvariable fir den
primdren mA-Ausgang zu tiberwachen. Sofern die Uberwachung aktiviert ist, kann die
Displayvariable 1 (iber das Displaymeni (iberwacht werden.

Hinweis
Dies ist die einzige Moglichkeit, eine Displayvariable Giber die Displaymeniis zu konfigurieren und
trifft nur auf Displayvariable 1 zu.

Verfahren
Displayvariable 1 konfigurieren, um den primdren mA-Ausgang zu (iberwachen.

Die Displayvariable 1 wird automatisch so eingestellt, dass sie der mA-Ausgang-Prozessvariable
fiir den primdren mA-Ausgang entspricht. Wenn die Konfiguration fiir die mA-Ausgang-
Prozessvariable gedndert wird, wird die Displayvariable 1 automatisch aktualisiert.

Konfigurieren der Genauigkeit der auf dem Display
angezeigten Variablen

Anzeiger Not available

ProLink Il ProLink > Configuration > Display > Display Precision

ProLink Il Device Tools > Configuration > Transmitter Display > Display Variables
Handterminal Configure > Manual Setup > Display > Decimal Places
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5.14

5.1.5

Uberblick

Display Precision (Anzeigegenauigkeit)( gibt die Genauigkeit (Anzahl der Dezimalstellen) der auf
dem Display angezeigten Variablen an. Display Precision (Anzeigegenauigkeit) kann fiir jede
Variable individuell angepasst werden.

Das Anpassen von Display Precision (Anzeigegenauigkeit) wirkt sich nicht auf den eigentlichen
Wert der Prozessvariable aus.

Verfahren

1. Prozessvariable auswahlen.

2. Mit Display Precision (Anzeigegenauigkeit) wird die Anzahl der Dezimalstellen eingestellt,
die flir die Prozessvariable auf dem Display angezeigt werden soll.

Die Voreinstellung fiir Temperatur- und Dichteprozessvariablen ist zwei
Dezimalstellen. Die Voreinstellung fiir alle anderen Prozessvariablen ist 4
Dezimalstellen. Der Auswahlbereich ist 0 bis 5.

Hinweis

Je niedriger die ausgewéhlte Genauigkeit ist, desto héher muss die Prozessdanderung sein,
damit sie auf dem Display wiedergegeben werden kann. Der Wert fiir Display Precision
(Anzeigegenauigkeit) sollte nicht zu niedrig oder zu hoch sein, um einen Nutzen zu bringen.

Konfigurieren der Aktualisierungsrate der auf dem
Display angezeigten Daten

Anzeiger OFF-LINE MAINT > OFF-LINE CONFG > DISPLAY > RATE

ProLink Il ProLink > Configuration > Display > Update Period

ProLink Il Device Tools > Configuration > Transmitter Display > Display Variables

Handterminal Configure > Manual Setup > Display > Display Variable Menu Features > Refresh Rate
Uberblick

Update Period (Aktualisierungsrate) ist dafiir verantwortlich, wie oft die Daten auf dem Display
aktualisiert werden.

Verfahren
Update Period (Aktualisierungsrate) auf den gewlinschten Wert einstellen.

Voreingestellt sind 200 ms. Der Auswahlbereich ist 100 ms bis 10.000 ms (10 Sekunden).

Aktivieren oder Deaktivieren des automatischen
Blatterns durch Displayvariablen

Anzeiger OFF-LINE MAINT > OFF-LINE CONFG > DISPLAY > AUTO SCRLL

ProLink Il ProLink > Configuration > Display > Display Options > Display Auto Scroll

ProLink Il Device Tools > Configuration > Transmitter Display > General

Handterminal Configure > Manual Setup > Display > Display Variable Menu Features > Auto Scroll
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5.1.6
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Uberblick

Das Display kann so konfiguriert werden, dass die Displayvariablen automatisch
durchbléttert werden oder dass nur eine einzige Displayvariable angezeigt wird, bis der
Bediener Scroll (Blattern) aktiviert. Zusammen mit dem automatischen Blattern kann auch
die Anzeigeldnge konfiguriert werden, wie lange eine Displayvariable angezeigt werden
soll.

Verfahren
1. Auto Scroll (Automatisches Bléattern) je nach Bedarf aktivieren oder deaktivieren.
Option Beschreibung

Enabled (Aktiviert)  Das Display durchblattert die einzelnen Displayvariablen automatisch in
Abhdngigkeit von Scroll Rate (Blattergeschwindigkeit). Mithilfe von Scroll (Blat-
tern) kann der Bediener jederzeit zur ndchsten Displayvariable blattern.

Disabled (Deakti- Auf dem Display wird Display Variable 1 (Displayvariable 1) angezeigt und es
viert) (Standard) | erfolgt kein automatisches Blattern. Mithilfe von Scroll (Blattern) kann der
Bediener jederzeit zur ndchsten Displayvariable blattern.

2. Sofern Auto Scroll (Automatisches Blattern) aktiviert wurde, sollte Scroll Rate
(Blattergeschwindigkeit) nach Bedarf eingestellt werden.

Die Voreinstellung betrdgt 10 Sekunden.

Hinweis
Scroll Rate (Blattergeschwindigkeit) ist moglicherweise erst verfiigbar, nachdem Auto Scroll
(Automatisches Blattern) aktiviert wurde.

Aktivieren oder Deaktivieren des Display-
Hintergrundbeleuchtung

Anzeiger OFF-LINE MAINT > OFF-LINE CONFG > DISPLAY > BKLT
ProLink Il ProLink > Configuration > Display > Display Options > Display Backlight On/Off
ProLink Il Device Tools > Configuration > Transmitter Display > General
Handterminal Configure > Manual Setup > Display > Backlight
Uberblick

Die Display-Hintergrundbeleuchtung kann aktiviert oder deaktiviert werden.
Verfahren
Backlight (Hintergrundbeleuchtung) aktivieren oder deaktivieren.

Die Voreinstellung ist Enabled (Aktiviert).
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5.1.7 Aktivieren oder Deaktivieren von Status LED Blinking
(Status-LED blinkt
Anzeiger Not available
ProLink Il ProLink > Configuration > Display > Display Options > Display Status LED Blinking
ProLink Il Device Tools > Configuration > Transmitter Display > General
Handterminal Configure > Manual Setup > Display > Display Variable Menu Features > Status LED Blinking
Uberblick

StandardmaRig blinkt die Status-LED, um noch nicht bestatigte Alarme anzuzeigen. Wird
die Option Status LED Blinking (Status-LED blinkt) deaktiviert, blinkt die Status-LED weder bei
neuen noch bei bereits bestdtigten Alarmen. Die LED wechselt jedoch weiterhin ihre Farbe,
um aktive Alarme anzuzeigen.

Verfahren
Status LED Blinking (Status-LED blinkt) aktivieren oder deaktivieren.

Die Voreinstellung ist Enabled (Aktiviert).

5.2 Aktivieren oder Deaktivieren von
Bedieneraktionen iliber das Display

Die Auswerteelektronik kann so konfiguriert werden, dass der Bediener bestimmte
Aktionen mithilfe des Displays ausfiihren kann.

Folgendes ist konfigurierbar:

. Zahler Start/Stopp

. Zahler rlicksetzen

. Alle Alarme bestéatigen

5.2.1 Aktivieren oder Deaktivieren des Start/Stopp des Zahlers
liber das Display
Anzeiger OFF-LINE MAINT > OFF-LINE CONFG > DISPLAY > TOTALS STOP
ProLink Il ProLink > Configuration > Display > Display Options > Display Start/Stop Totalizers
ProLink Il Device Tools > Configuration > Totalizer Control Methods
Handterminal Configure > Manual Setup > Display > Display Variable Menu Features > Start/Stop Totalizers
Uberblick

Es kann festgelegt werden, ober der Bediener Zahler und Gesamtzéhler tiber das Display
starten und stoppen kann.
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5.2.2
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Einschrankungen

Die Zdhler kénnen Gber das Display nicht individuell gestartet und gestoppt werden. Alle
Zdhler werden gemeinsam gestartet und gestoppt.

Gesamtzdhler kénnen nicht separat von Zahlern gestartet oder gestoppt werden. Wenn ein
Zahler gestartet oder gestoppt wird, wird der zugehorige Gesamtzéhler ebenfalls gestartet
oder gestoppt.

Wenn die Anwendung Mineral6lmessung auf Ihrem Computer installiert ist, muss der
Bediener das Offline-Passwort eingeben, um diese Funktion durchzufiihren, selbst wenn das
Offline-Passwort nicht aktiviert ist.

Verfahren

1.
2.

Sicherstellen, dass mindestens ein Zahler als eine Displayvariable konfiguriert ist.

Totalizer Reset (Zahler zurlicksetzen) wie gewlinscht aktivieren oder deaktivieren.

Option Beschreibung

Enabled (Aktiviert) Bediener konnen Zéhler und Gesamtzahler vom Display aus start-
en und stoppen, wenn mindestens ein Zahler als Displayvariable
konfiguriert ist.

Disabled (Deaktiviert) Bediener konnen Zédhler und Gesamtzahler nicht vom Display aus
(Standard) starten und stoppen.

Aktivieren oder Deaktivieren der Funktion ,Zahler
zurlicksetzen“ vom Display

Anzeiger OFF-LINE MAINT > OFF-LINE CONFG > DISPLAY > TOTALS RESET

ProLink Il ProLink > Configuration > Display > Display Options > Display Totalizer Reset

ProLink Il Device Tools > Configuration > Totalizer Control Methods

Handterminal Configure > Manual Setup > Display > Display Variable Menu Features > Totalizer Reset
Uberblick

Der Bediener kann (iber das Display Zdhler zurlicksetzen.

Einschrankungen

Dieser Parameter bezieht sich nicht auf Gesamtzahler. Mit dem Display kénnen keine
Gesamtzdhler zurliickgesetzt werden.

Mit dem Display konnen nicht alle Zéhler als Gruppe zuriickgesetzt werden. Die Zéhler
missen individuell zuriickgesetzt werden.

Wenn die Anwendung Mineralélmessung auf lhrem Computer installiert ist, muss der
Bediener das Offline-Passwort eingeben, um diese Funktion durchzufiihren, selbst wenn das
Offline-Passwort nicht aktiviert ist.

Verfahren

1.

Darauf achten, dass die Zdhler, die zuriickgesetzt werden sollen, als Displayvariablen
konfiguriert sind.
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Wenn der Zahler nicht als Displayvariable konfiguriert ist, kann der Bediener diesen

nicht zurticksetzen.

2. Zuriicksetzen des Zahlers je nach Bedarf aktivieren oder deaktivieren.
Option Beschreibung
Enabled (Aktiviert) Bediener konnen einen Zdhler vom Display aus zuriicksetzen,
sofern der Zahler als Displayvariable konfiguriert ist.
Disabled (Deaktiviert) Bediener kénnen die Zahler nicht Gber das Display zuriickset-
(Standard) zen.
5.2.3 Aktivieren oder Deaktivieren des Display-Befehls

~Acknowledge All Alarms* (Alle Alarme bestdtigen)

Anzeiger OFF-LINE MAINT > OFF-LINE CONFG > DISPLAY > ACK

ProLink Il ProLink > Configuration > Display > Display Options > Display Ack All Alarms

ProLink Il Device Tools > Configuration > Transmitter Display > Ack All

Handterminal Configure > Manual Setup > Display > Offline Variable Menu Features > Acknowledge Al
Uberblick

Es kann festgelegt werden, ob der Bediener alle Alarme mit einem einzigen Befehl (iber das

Display bestatigen kann.

Verfahren

1. Sicherstellen, dass (iber das Display auf das Alarmmenii zugegriffen werden kann.

Bediener miissen Zugriff auf das Alarmment haben, um Alarme tiber das Display

bestdtigen zu kénnen.

2. Acknowledge All Alarms (Alle Alarme bestatigen) nach Bedarf aktivieren oder deaktivieren.

Option

Beschreibung

Enabled (Aktiviert) (Stand-
ard)

Bediener kénnen mit einem einzigen Displaybefehl alle Alarme
gleichzeitig bestdtigen.

Disabled (Deaktiviert)

Konfigurations- und Bedienungsanleitung

Bediener konnen nicht alle Alarme gleichzeitig bestdtigen. Dies
muss individuell erfolgen.
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5.3
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Konfigurieren der Sicherheitseinstellungen fiir
Display-Meniis

Anzeiger OFF-LINE MAINT > OFF-LINE CONFG > DISPLAY

ProLink Il ProLink > Configuration > Display > Display Options

ProLink Il Device Tools > Configuration > Transmitter Display > Display Security

Handterminal Configure > Manual Setup > Display > Offline Variable Menu Features
Uberblick

Der Bedienerzugriff auf unterschiedliche Bereiche des Offline-Meniis des Displays lasst sich
einschranken. Es kann auch ein Passwort fiir den Zugriff festgelegt werden.

Verfahren

1. Umden Bedienerzugriff auf den Wartungsbereich des Offline-Menis
einzuschranken, Off-Line Menu (Offline-Menli) aktivieren oder deaktivieren.

Option Beschreibung

Enabled (Aktiviert) Der Bediener kann auf den Wartungsbereich des Offline-Men(s zugrei-

(Standard) fen. Dieser Zugriff ist fiir die Konfiguration und Kalibrierung erforder-
lich; erist jedoch nicht erforderlich, um Alarme anzuzeigen oder auf
Smart Meter Verification zuzugreifen (falls zutreffend).

Disabled (Deaktiviert) | Der Bediener hat keinen Zugriff auf den Wartungsbereich des Offline-
Mends.

2. Umden Zugriff von Bedienern auf das Alarmmen( zu steuern, Alarm Menu (Alarmmenti)

aktivieren oder deaktivieren.

Option Beschreibung
Enabled (Aktiviert) Der Bediener hat Zugriff auf das Alarmmend. Dieser Zugriff ist fiir die
(Standard) Anzeige und Bestdtigung von Alarmen erforderlich; erist jedoch
nicht erforderlich fir Smart Meter Verification (falls zutreffend), Kon-
figuration oder Kalibrierung.
Disabled (Deaktiviert) Der Bediener hat keinen Zugriff auf das Alarmmenti.
Anmerkung

Die Status-LED der Auswerteelektronik wechselt ihre Farbe und zeigt damit an, dass aktive
Alarme vorhanden sind. Spezifische Alarme werden jedoch nicht angezeigt.

3. Um den Bedienerzugriff auf den Wartungsbereich des Offline-Meniis und des Mentis
Smart Meter Verification einzuschrdnken, Off-Line Password (Offline-Passwort) aktivieren

oder deaktivieren.
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Option Beschreibung

Enabled (Aktiviert) Der Bediener wird aufgefordert, dass Offline-Passwort nach Offnen
des MeniisSmart Meter Verification (falls zutreffend) oder nach Offnen
des Wartungsbereichs des Offline-Men(is einzugeben.

Disabled (Deaktiviert) | Der Zugriff auf das Meni Smart Meter Verification (falls zutreffend)

(Standard) oder der Zugriff auf den Wartungsbereich des Offline-Meniis erfordert
kein Passwort.

4, Um den Zugriff auf das Alarmmenii mit einem Passwort zu schiitzen, Alarm Password

(Alarm-Passwort) aktivieren oder deaktivieren.

Option

Beschreibung

Enabled (Aktiviert)

Der Bediener wird aufgefordert, beim Offnen des Alarmme-
nis ein Offline-Passwort einzugeben.

Disabled (Deaktiviert) (Stand- | Zum Offnen des Alarmmeniis ist kein Passwort erforderlich.

ard)

Wenn sowohl das Off-Line Password (Offline-Passwort) als auch das Alarm Password (Alarm-
Passwort) aktiviert sind, wird der Bediener aufgefordert, das Offline-Passwort
einzugeben, um das Offline-Mendi 6ffnen zu kdnnen. Danach erfolgt keine weitere
Eingabeaufforderung.

5. (Optional) Off-Line Password (Offline-Passwort) auf den gewiinschten Wert einstellen.

Derselbe Wert wird fiir das Offline-Passwort und das Alarm-Passwort verwendet. Der
voreingestellte Wert ist 1234. Der Auswahlbereich ist 0000 bis 9999.

Hinweis

Das Passwort an einem sicheren Ort aufbewahren.

5.4 Konfigurieren von Antwortzeitparametern

Die Haufigkeit, mit der die Prozessdaten abgefragt und Prozessvariablen berechnet

werden, ist konfigurierbar.

Die Parameter der Antwortzeit umfassen:

o Update Rate

. Calculation Speed (Antwortzeit)

5.4.1 Konfigurieren der Messwertaktualisierung
Anzeiger Not available
ProLink Il ProLink > Configuration > Device > Update Rate
ProLink Il Device Tools > Configuration > Process Measurement > Response > Update Rate
Handterminal Configure > Manual Setup > Measurements > Update Rate

Konfigurations- und Bedienungsanleitung

81



Gerdteoptionen und Praferenzen konfigurieren

82

Uberblick

Update Rate steuert die Rate, mit der die Prozessdaten abgefragt und Prozessvariablen
berechnet werden. Update Rate = Special bietet eine schnellere Reaktion auf
Prozessdnderungen, die jedoch mit “h6herem Rauschen” verbunden ist. Nicht den Modus
Special verwenden, es sei denn, die Anwendung erfordert dies.

Hinweis
Bei Systemen mit einem Standard Core Prozessor kann der Modus Special die Leistung fiir

Anwendungen mit Gaseinschliissen oder Leer-Voll-Leer-Bedingungen verbessern. Das betrifft keine
Systeme mit Core Prozessor mit erweiterter Funktionalitat.

Vorbereitungsverfahren

Vor dem Einstellen von Update Rate auf Special:

o Priifen Sie die Auswirkungen des Modus Special auf bestimmte Prozessvariablen.
. Kontaktieren Sie Micro Motion.

Verfahren

1. Setzen Sie Update Rate wie gew(inscht.

Option Beschreibung

Normal | Alle Prozessdaten werden 20 x pro Sekunde abgefragt (20 Hz).
Alle Prozessvariablen werden bei einer Frequenz von 20 Hz berechnet.
Diese Option kann fiir die meisten Anwendungen verwendet werden.

Special | Eine einzige benutzerdefinierte Prozessvariable wird 100 x pro Sekunde abgefragt
(100 Hz). Andere Prozessdaten werden mit einer Frequenz von 6,25 Hz abgefragt.
Einige Prozess-, Diagnose- und Kalibrierdaten werden nicht abgefragt.

Alle verfligbaren Prozessvariablen werden bei einer Frequenz von 100 Hz berech-
net.

Diese Option nur verwenden, wenn die Anwendung dies erfordert.
Wenn Update Rate gedandert wird, werden die Einstellungen fiir Flow Damping, Density
Damping und Temperature Damping automatisch angepasst.

2. Wenn Update Rate auf Special gesetzt wird, sollte die Abfrage der Prozessvariable mit
100 Hz durchgefiihrt werden.

Effekte der Aktualisierungsrate = Spezial
Inkompatible Merkmale und Funktionen

Der Spezial-Modus ist mit den folgenden Merkmalen und Funktionen nicht kompatibel:

. Erweiterte Ereignisse Verwenden Sie stattdessen Basisereignisse.

. Alle Kalkibrierverfahren.

. Nullpunktverifizierung.

. Wiederherstellen des Nullpunktwerts des Herstellers speichern oder des vorherigen

Nullpunktwerts.
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Im Bedarfsfall konnen Sie in den Normal-Modus schalten, die gewiinschten Verfahren
durchfiihren und dann zuriick in den Spezial-Modus wechseln.

Aktualisierungen der Prozessvariablen

Einige Prozessvariablen werden nicht aktualisiert, wenn der Spezial-Modus aktiviert wird.

Tabelle 5-1: Spezial-Modus und Prozessvariablen-Aktualisierungen

Immer abgefragt und aktualisiert

Nur aktualisiert, wenn die Anwen-
dung Mineralélmessung deaktiviert
ist

Nie aktualisiert

Massedurchfluss
Volumendurchfluss
Gas-Standardvolumendurchfluss
Dichte

Temperatur

Antriebsverstarkung

Li Aufnehmerspule Amplitude
Status [enthdlt Ereignis 1 und
Ereignis 2 (Basisereignisse)]
Messrohrfrequenz
Masse-Summenzahler
Volumen-Summenzahler
Gas-Standardvolumen-Summen-
zdhler

Temperaturkorrigierter Volumen-
Summenzéhler
Temperaturkorrigierte Dichte
Temperaturkorrigierter Volumen-
durchfluss

Gewichteter Temperaturmittel-
wert pro Dosiervorgang
Gewichteter Dichtemittelwert pro
Dosiervorgang

e Re Aufnehmerspule Amplitude

e Platinentemperatur

e CoreProzesso- Eingangsspannung

e Masse-Gesamtzdhler

¢ Volumen-Gesamtzahler

e Gas-Standardvolumen-Gesamt-
zdhler

Alle anderen Prozessvariablen und Ka-
librierdaten. Behalten die Werte, die
bei Aktivierung des Spezial-Modus ein-
gestellt waren.

5.4.2

Berechnungsgeschwindigkeit (Reaktionszeit) konfigurieren

Anzeiger Not available
ProLink Il ProLink > Configuration > Device > Response Time
ProLink Il Device Tools > Configuration > Process Measurement > Response > Calculation Speed

Handterminal

Not available

Uberblick

Berechnungsgeschwindigkeit wird verwendet, um einen alternativen Algorithmus fiir die
Berechnung der Prozessvariablen aus den originalen Prozessdaten zu verwenden.
Berechnungsgeschwindigkeit = Spezial bietet eine schnellere Reaktion auf Prozessdanderungen,
die jedoch mit “héherem Rauschen” verbunden ist.

In ProLink Il wird Berechnungsgeschwindigkeit als Reaktionszeit bezeichnet.

Konfigurations- und Bedienungsanleitung
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5.5

5.5.1

84

Einschrankung

Berechnungsgeschwindigkeit ist nur auf Systemen mit Core Prozessor mit erweiterter Funktionalitdt
verfligbar.

Hinweis

Sie kdnnen Berechnungsgeschwindigkeit = Spezial mit beiden Einstellungen fiir die Messwertaktualisierung
verwenden. Die Parameter steuern unterschiedliche Aspekte der Verarbeitung der vom Durchfluss-
Messsystem gelieferten Werte.

Verfahren

Setzen Sie Berechnungsgeschwindigkeit wie gewlinscht.

Option Beschreibung

Normal | Die Auswerteelektronik berechnet die Prozessvariablen mit der normalen Geschwindig-
keit.

Spezial = Die Auswerteelektronik berechnet die Prozessvariablen mit einer hdheren Geschwindig-
keit.

Konfigurieren der Alarmverwaltung

Die Alarmverwaltungsparameter steuern die Reaktion der Auswerteelektronik auf Prozess-
und Gerdtebedingungen.

Die Alarmverwaltungsparameter umfassen:
. Fehler-Timeout
. Status Alarmstufe

Konfigurieren von Storung-Timeout

Anzeiger Not available

ProLink Il ProLink > Configuration > Analog Output > Last Measured Value Timeout

ProLink > Configuration > Frequency/Discrete Output > Frequency > Last Measured Value Timeout

ProLink Il Device Tools > Configuration > Fault Processing
Handterminal Configure > Alert Setup > Alert Severity > Fault Timeout
Uberblick

Fault Timeout steuert die Verzogerung, bevor Stéraktionen eingeleitet werden.

Einschrankung

Fault Timeout findet nur auf die folgenden Alarme Anwendung (aufgelistet nach Statusalarmcode):
A003, A004, A005, A008, A016, A017, A033. Bei allen anderen Alarmen werden Stéraktionen
durchgefiihrt, sobald ein Alarm erkannt wird.
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Verfahren
Fault Timeout wie gew(inscht einstellen.
Der Standardwert ist 0 Sekunden. Der Bereich liegt bei 0 bis 60 Sekunden.

Wenn Fault Timeout auf 0 eingestellt wird, werden Storaktionen durchgefiihrt, sobald eine
Alarmbedingung erkannt wird.

Die Zeitspanne Storung-Timeout beginnt, sobald die Auswerteelektronik eine
Alarmbedingung erkennt. Wahrend der Zeitspanne Stérung-Timeouts gibt die
Auswerteelektronik weiterhin die zuletzt giiltigen Messwerte aus.

Wenn Stérung-Timeout ablauft und der Alarm noch aktiv ist, werden die Stéraktionen
durchgefiihrt. Wenn die Alarmbedingung nicht mehr aktiv ist, bevor Stérung-Timeout
ablduft, wird keine Storaktionen durchgefiihrt.

Hinweis
ProLink llermdglicht die Einstellung von Fault Timeout in zwei Bereichen. Allerdings gibt es nur einen
Parameter und dieselbe Einstellung gilt fiir alle Ausgénge.

5.5.2 Konfigurieren von Status Alarmstufe
Anzeiger Not available
ProLink Il ProLink > Configuration > Alarm > Severity
ProLink Il Device Tools > Configuration > Alert Severity
Handterminal Configure > Alert Setup > Alert Severity > Set Alert Severity
Uberblick

Verwenden Sie Status Alarm Severity, um Storaktionen zu steuern, die die
Auswerteelektronik ausfiihrt, wenn eine Alarmbedingung erkannt wird.

Einschrankungen

. Fiir einige Alarme ist Status Alarm Severity nicht konfigurierbar.
. Fiir einige Alarme kann Status Alarm Severity nur auf zwei der drei Optionen eingestellt werden.
Hinweis

Micro Motion empfiehlt, die Standardeinstellungen fiir Status Alarm Severity zu verwenden, es sei
denn, es bestehen spezielle Anforderungen, diese zu dndern.

Verfahren
1. Wabhlen Sie einen Statusalarm aus.
2. Setzen Sie Status Alarm Severity wie gewiinscht fir den ausgewdhlten Statusalarm.
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Option

Beschreibung

Fault

MaRnahmen bei Erkennung einer Stérung:

* Der Alarm wird in der Alarmliste angezeigt.

» Die Ausgdnge werden auf die konfigurierte Storaktion gesetzt (nach Ablauf
von Fault Timeout, falls zutreffend).

* Die digitale Kommunikation wird auf die konfigurierte Stéraktion gesetzt
(nach Ablauf von Fault Timeout, falls zutreffend).

 Die Farbe der Status-LED (falls vorhanden) wechselt auf rot oder gelb (abhén-
gig von der Alarmstufe).

MaRnahmen, wenn der Alarm gel6scht wird:

* Die Ausgdnge kehren zu ihrem normalen Verhalten zuriick.

 Die digitale Kommunikation kehrt zu ihrem normalen Verhalten zuriick.

* Die Farbe der Status-LED (falls vorhanden) wechselt zu griin und die LED kann
ggf. blinken.

Informa-
tional

MaRnahmen bei Erkennung einer Stérung:

e Der Alarm wird in der Alarmliste angezeigt.

* Die Farbe der Status-LED (falls vorhanden) wechselt auf rot oder gelb (abhén-
gig von der Alarmstufe).

MaRnahmen, wenn der Alarm geléscht wird:

* Die Farbe der Status-LED (falls vorhanden) wechselt zu griin und die LED kann
ggf. blinken.

Ignore

Keine Aktion

Statusalarme und Optionen fiir Status-Alarmstufe

Tabelle 5-2: Statusalarme und Status-Alarmstufe

Voreingestellte Konfigurier-

Alarm Code Statusmeldung Alarmstufe Hinweise bar?

A001 EEPROM-Fehler (Core-Pro- | Stérung Nein
zessor)

A002 RAM-Fehler (Core-Prozes- | Storung Nein
sor)

A003 Keine Antwort vom Sensor | Storung IE

A004 Messbereichsiiberschrei- | Stdrung Nein
tung fiir Temperatur

A005 Messbereichsiiberschrei- | Storung Ja
tung fiir Massedurchfluss

A006 Charakterisierung erfor- Stérung Ja
derlich

A008 Dichte Bereichsiiberschrei- | Stérung Ja
tung

A009 Auswerteelektronik Initiali- = Stérung Ja
sierung/Aufwarmphase

A010 Kalibrierfehler Storung Nein

A0T1 Nullpunktkalibrierung fehl- | Stérung Ja
geschlagen: Tief
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Tabelle 5-2: Statusalarme und Status-Alarmstufe (Fortsetzung)

Voreingestellte Konfigurier-
Alarm Code Statusmeldung Alarmstufe Hinweise bar?
A012 Nullpunktkalibrierung fehl- | Stérung Ja
geschlagen: Hoch
A013 Nullpunktkalibrierung fehl- | Stérung Ja
geschlagen: Instabil
A014 Auswerteelektronikfehler | Stérung Nein
A016 Sensor-RTD-Fehler Stdrung Ja
A017 T-Serien-RTD-Fehler Storung Ja
A018 EEPROM-Fehler (Auswer- | Stdrung Nein
teelektronik)
A019 RAM-Fehler (Auswertee- Stdrung Nein
lektronik)
A020 K.wrt f. k. Drchflss Stdrung Ja
A021 Falscher Sensortyp (K1) Stérung Nein
A022 Konfigurationsdatenbank | Stdrung Betrifft nur Durchflussmesser mit  Nein
beschédigt (Core-Prozes- Core-Prozessor mit Standard-Funk-
sor) tionalitat.
A023 Interne Zahler beschadigt | Stérung Betrifft nur Durchflussmesser mit | Nein
(Core-Prozessor) Core-Prozessor mit Standard-Funk-
tionalitat.
A024 Programm beschadigt Storung Betrifft nur Durchflussmesser mit | Nein
(Core-Prozessor) Core-Prozessor mit Standard-Funk-
tionalitat.
A025 Bootsektorfehler (Core- Stérung Betrifft nur Durchflussmesser mit  Nein
Prozessor) Core-Prozessor mit Standard-Funk-
tionalitat.
A026 Sensor-/Auswerteelektro- | Storung Nein
nik-Kommunikationsfehler
A027 Sicherheitsverstol Stdrung Nein
A028 Core-Prozessor-Schreib- Storung Nein
fehler
A031 Spannung zu niedrig Stérung Betrifft nur Durchflussmesser mit | Nein
Core-Prozessor mit erweiterter
Funktionalitat.
A032 Systemverifizierung lauft: | Unterschiedlich | Betrifft nur Auswerteelektroniken | Nein
Ausgange zu Fehler mit Smart-Systemverifizierung.
Wenn Ausgédnge auf Zuletzt gemess-
ener Wert gesetzt sind, ist die Alarm-
stufe Info. Wenn die Ausgdnge auf
Fehler gesetzt sind, ist die Alarm-
stufe Storung.
A033 Unzureichendes Signal von | Stdrung Betrifft nur Durchflussmesser mit | Ja
rechter/linker Aufnehmer- Core-Prozessor mit erweiterter
spule Funktionalitat.
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Tabelle 5-2: Statusalarme und Status-Alarmstufe (Fortsetzung)

Voreingestellte Konfigurier-
Alarm Code Statusmeldung Alarmstufe Hinweise bar?
A034 Systemverifizierung fehl- | Informativ Betrifft nur Auswerteelektroniken | |a
geschlagen mit Smart-Systemverifizierung.
A035 Systemverifizierung abge- | Informativ Betrifft nur Auswerteelektroniken | Ja
brochen mit Smart-Systemverifizierung.
A100 mA-Ausgang 1 gesattigt | Informativ Kann entweder auf Informativoder | Ja
Ignorieren gesetzt werden, aber
nicht auf Storung.
A101 mA-Ausgang 1 fest Informativ Kann entweder auf Informativoder | |a
Ignorieren gesetzt werden, aber
nicht auf Stérung.
A102 Antrieb Bereichsiibers- Informativ Ja
chreitung
A103 Maglicher Datenverlust Informativ Betrifft nur Durchflussmesser mit | Ja
(Zahler und Besténde) Core-Prozessor mit Standard-Funk-
tionalitat.
Kann entweder auf Informativ oder
Ignorieren gesetzt werden, aber
nicht auf Storung.
A104 Kalibrierung lauft Informativ Kann entweder auf Informativoder | Ja
Ignorieren gesetzt werden, aber
nicht auf Storung.
A105 Schwallstrémung Informativ Ja
A106 Burst-Betriebsart aktiviert | Informativ Kann entweder auf Informativoder | |a
Ignorieren gesetzt werden, aber
nicht auf Storung.
A107 Spannungsunterbrechung | Informativ Normales Verhalten der Auswer- Ja
eingetreten teelektronik; tritt nach jedem Aus-/
Einschalten der Stromversorgung
auf.
A108 Basisereignis 1 Ein Informativ Betrifft nur Basisereignisse. Ja
A109 Basisereignis 2 Ein Informativ Betrifft nur Basisereignisse. Ja
A110 Frequenzausgang gesadt- Informativ Kann entweder auf Informativoder | |a
tigt Ignorieren gesetzt werden, aber
nicht auf Storung.
AT Frequenzausgang fixiert Informativ Kann entweder auf Informativoder | Ja
Ignorieren gesetzt werden, aber
nicht auf Storung.
A112 Auswerteelektronik-Soft- | Informativ Betrifft nur Systeme mit Auswer- | Ja
ware aktualisieren teelektronik-Software vor v5.0.
A113 mA-Ausgang 2 gesdttigt Informativ Kann entweder auf Informativoder | |a
Ignorieren gesetzt werden, aber
nicht auf Storung.
Al114 mA-Ausgang 2 fest Informativ Kann entweder auf Informativoder | Ja
Ignorieren gesetzt werden, aber
nicht auf Storung.
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Tabelle 5-2: Statusalarme und Status-Alarmstufe (Fortsetzung)

Voreingestellte Konfigurier-

Alarm Code Statusmeldung Alarmstufe Hinweise bar?

A115 Kein externer Eingang oder | Informativ IE
abgefragte Daten

A116 Messbereichstiberschrei- | Informativ Betrifft nur Auswerteelektroniken | Ja
tung der Temperatur (Min- mit der Anwendung Mineralolmes-
eralol) sung.

A117 Messbereichsiiberschrei- | Informativ Betrifft nur Auswerteelektroniken | Ja
tung der Dichte (Mineraldl) mit der Anwendung Mineral6lmes-

sung.

A118 Bindrer mA Ausgang 1 fix | Informativ Kann entweder auf Informativoder | |a

Ignorieren gesetzt werden, aber
nicht auf Storung.
A119 Bindrer mA Ausgang 2 fix | Informativ Kann entweder auf Informativoder | |a
Ignorieren gesetzt werden, aber
nicht auf Storung.

A120 Kurvenanpassung fehlges- | Informativ Betrifft nur Auswerteelektroniken | Nein
chlagen (Konzentration) mit der Anwendung Mineral6lmes-

sung.

A121 Extrapolationsalarm (Kon- | Informativ Betrifft nur Auswerteelektroniken | Ja
zentration) mit der Anwendung Mineral6lmes-

sung.

A131 Systemverifizierung lauft: | Informativ Betrifft nur Auswerteelektroniken | Ja
Ausgange auf zuletzt ge- mit Smart-Systemverifizierung.
messenen Wert

A132 Sensorsimulation aktiv Informativ Betrifft nur Durchflussmesser mit | Ja

Core-Prozessor mit erweiterter
Funktionalitat.

Kann entweder auf Informativ oder
Ignorieren gesetzt werden, aber
nicht auf Storung.

A141 DDC-Trigger abgeschlos- | Informativ Betrifft nur Durchflussmesser mit | Ja
sen Core-Prozessor mit erweiterter

Funktionalitat.

Kann entweder auf Informativ oder
Ignorieren gesetzt werden, aber
nicht auf Storung.

5.6

Informationsparameter konfigurieren

Die Informationsparameter kdnnen verwendet werden, um das Durchflussmessgerat zu

identifizieren oder zu beschrieben. Sie werden jedoch nicht fiir die Verarbeitung in der
Auswerteelektronik bendétigt und sind auch nicht erforderlich.

Die Informationsparameter umfassen:

. Gerdteparameter

- Beschreibung
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5.6.1

5.6.2
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- Nachricht
- Datum
. Sensorparameter
- Sensor Seriennummer
- Sensor Werkstoff
- Sensor Auskleidungswerkstoff
- Sensor Flanschtyp

Konfigurieren der Beschreibung

Anzeiger Not available

ProLink Il ProLink > Configuration > Device > Descriptor

ProLink Il Device Tools > Configuration > Informational Parameters > Transmitter

Handterminal Configure > Manual Setup > Info Parameters > Transmitter Info > Descriptor
Uberblick

Mit Descriptor kann eine Beschreibung im Speicher der Auswerteelektronik gespeichert
werden. Die Beschreibung wird nicht fiir die Verarbeitung benétigt und ist nicht
erforderlich.

Verfahren
Eine Beschreibung fiir die Auswerteelektronik eingeben.

Es kdnnen bis zu 16 Zeichen als Beschreibung eingegeben werden.

Nachricht konfigurieren

Anzeiger Not available

ProLink Il ProLink > Configuration > Device > Message

ProLink Il Device Tools > Configuration > Informational Parameters > Transmitter

Handterminal Configure > Manual Setup > Info Parameters > Transmitter Info > Message
Uberblick

Nachricht ermdglicht das Speichern einer kurzen Nachricht im Speicher der
Auswerteelektronik. Dieser Parameter wird nicht fiir die Verarbeitung in der
Auswerteelektronik bendétigt und ist auch nicht erforderlich.

Verfahren
Geben Sie eine kurze Nachricht fir die Auswerteelektronik ein.

Die Nachricht kann bis zu 32 Zeichen lang sein.

Micro Motion® Auswerteelektronik Modell 2700 mit eigensicheren Ausgédngen



Gerdteoptionen und Praferenzen konfigurieren

5.6.3

5.6.4

5.6.5

Konfigurieren des Datums

Anzeiger Not available
ProLink Il ProLink > Configuration > Device > Date
ProLink Il Device Tools > Configuration > Informational Parameters > Transmitter

Handterminal

Configure > Manual Setup > Info Parameters > Transmitter Info > Date

Uberblick

Mittels Date kann eine statisches Datum (wird nicht durch die Auswerteelektronik
aktualisiert) im Speicher der Auswerteelektronik gespeichert werden. Dieser Parameter
wird nicht fiir die Verarbeitung benétigt und ist nicht erforderlich.

Verfahren

Das Datum im Format MM/TT/JJJJ eingeben.

Hinweis

ProLink Il und ProLink Il bietet einen Kalender, der die Auswahl des Datums erleichtert.

Sensor Seriennummer konfigurieren

Anzeiger Not available
ProLink Il ProLink > Configuration > Sensor > Sensor S/N
ProLink Il Device Tools > Configuration > Informational Parameters > Sensor

Handterminal

Configure > Manual Setup > Info Parameters > Sensor Information > Sensor Serial Number

Uberblick

Sensor Seriennummer ermdglicht Ihnen das Speichern der Seriennummer der Sensor-
Komponente des Durchflussmessgerdts im Speicher der Auswerteelektronik. Dieser
Parameter wird nicht fiir die Verarbeitung in der Auswerteelektronik benétigt und ist auch

nicht erforderlich.

Verfahren
1. Siefinden die Seriennummer des Sensors in der Sensor Kennzeichnung.
2. Geben Sie die Seriennummer in das Feld Sensor Seriennummer ein.

Sensor Werkstoff konfigurieren

Anzeiger Not available
ProLink Il ProLink > Configuration > Sensor > Sensor Mat|
ProLink Il Device Tools > Configuration > Informational Parameters > Sensor

Handterminal

Configure > Manual Setup > Info Parameters > Sensor Information > Tube Wetted Material
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5.6.6

5.6.7
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Uberblick

Sensor Werkstoff ermdglicht Thnen das Speichern der Art des Werkstoffs, die fiir die
mediumberiihrten Teile des Sensors verwendet werden, im Speicher der
Auswerteelektronik. Dieser Parameter wird nicht fir die Verarbeitung in der
Auswerteelektronik bendétigt und ist auch nicht erforderlich.

Verfahren

1. Der flir die mediumberiihrten Teile des Sensors verwendete Werkstoff ist in den
Dokumenten aufgefiihrt, die im Lieferumfang des Sensors enthalten sind, bzw. aus
einem Code in der Modellnummer des Sensor ersichtlich.

Eine Aufschliisselung der Modellnummer ist im Produktdatenblatt des jeweiligen
Sensors zu finden.

2. Setzen Sie Sensor Werkstoff auf die entsprechende Option.

Sensor Auskleidungswerkstoff konfigurieren

Anzeiger Not available

ProLink Il ProLink > Configuration > Sensor > Liner Mat|

ProLink Il Device Tools > Configuration > Informational Parameters > Sensor

Handterminal Configure > Manual Setup > Info Parameters > Sensor Information > Tube Lining
Uberblick

Sensor Auskleidungswerkstoff ermdglicht hnen das Speichern der Art des Werkstoffs, die fiir
die Auskleidung des Sensors verwendet wird, im Speicher der Auswerteelektronik. Dieser
Parameter wird nicht fiir die Verarbeitung in der Auswerteelektronik benétigt und ist auch
nicht erforderlich.

Verfahren

1. Der Auskleidungswerkstoff des Sensors ist in den Dokumenten aufgefiihrt, die im
Lieferumfang des Sensors enthalten sind, bzw. aus einem Code in der
Modellnummer des Sensors ersichtlich.

Eine Aufschliisselung der Modellnummer ist im Produktdatenblatt des jeweiligen
Sensors zu finden.

2. Setzen Sie Sensor Auskleidungswerkstoff auf die entsprechende Option.

Sensor Flanschtyp konfigurieren

Anzeiger Not available

ProLink Il ProLink > Configuration > Sensor > Flange

ProLink Il Device Tools > Configuration > Informational Parameters > Sensor

Handterminal Configure > Manual Setup > Info Parameters > Sensor Information > Sensor Flange
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Uberblick

Sensor Flanschtyp ermdglicht Ihnen das Speichern des Flanschtyps Ihres Sensors im Speicher
der Auswerteelektronik. Dieser Parameter wird nicht fiir die Verarbeitung in der
Auswerteelektronik bendétigt und ist auch nicht erforderlich.

Verfahren

1. Der Flanschtyp des Sensors ist in den Dokumenten aufgefthrt, die im Lieferumfang
des Sensors enthalten sind, bzw. aus einem Code in der Modellnummer des Sensors
ersichtlich.

Eine Aufschliisselung der Modellnummer ist im Produktdatenblatt des jeweiligen
Sensors zu finden.

2. Setzen Sie Sensor Flanschtyp auf die entsprechende Option.
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6.1
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Integrieren des Messgerates mit dem
Steuersystem

In diesem Kapitel behandelte Themen:

*  Konfigurieren der Auswerteelektronikkandle
*  mAAusgang konfigurieren

*  Frequenzausgang konfigurieren

*  Konfigurieren des Bindrausgangs

. Konfigurieren von Ereignissen

e Konfigurieren der digitalen Kommunikation

Konfigurieren der Auswerteelektronikkandle

Anzeiger OFF-LINE MAINT > OFF-LINE CONFG>10>CH B

ProLink Il ProLink > Configuration > Channel

ProLink Il Device Tools > Configuration > /0 > Channels

Handterminal Configure > Manual Setup > Inputs/Outputs > Channels > Channel B
Uberblick

Kanal B der Auswerteelektronik kann so konfiguriert werden, dass er als Frequenzausgang
oder als Bindrausgang fungiert. Die Kanalkonfiguration muss der Verdrahtung an den
Anschlussklemmen der Auswerteelektronik entsprechen.

Vorbereitungsverfahren

Vermeiden von Prozessstorungen:
. Konfigurieren Sie die Kandle, bevor Sie die Ausgdnge konfigurieren.

. Vor dem Andern der Kanalkonfiguration sicherstellen, dass alle durch diesen Kanal
betroffenen Regelkreise manuell gesteuert werden.

Verfahren

Kanal B wie gewiinscht einstellen.

Option Beschreibung
Frequenzausgang Kanal B arbeitet als Frequenzausgang.
Bindrausgang Kanal B arbeitet als Bindrausgang.
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6.2

6.2.1

Nachbereitungsverfahren

Fiir jeden konfigurierten Kanal die entsprechende Eingangs- oder Ausgangskonfiguration
durchfiihren bzw. (iberpriifen. Wenn die Konfiguration eines Kanals sich andert, wird das
Verhalten des Kanals durch die Konfiguration geregelt, die fiir den ausgewdhlten
Eingangs- oder Ausgangstyp gespeichert ist. Die gespeicherte Konfiguration ist fir den
bestimmten Prozess mdglicherweise nicht geeignet.

Nach dem Uberpriifen der Kanal- und Ausgangskonfiguration die automatische Steuerung
des Regelkreises wieder aktivieren.

mA Ausgang konfigurieren

Der mA Ausgang wird zum Ausgeben der konfigurierten Prozessvariablen verwendet. Die
mA Ausgangsparameter steuern, wie die Prozessvariable ausgegeben wird. Ihre
Auswerteelektronik hat zwei mA Ausgange: Kanal A und Kanal C.

Die Parameter des mA Ausgangs umfassen:

. mA Ausgang Prozessvariable

. Lower Range Value (LRV) und Upper Range Value (URV)

. Analogausgang Abschaltung

. Zusétzliche Dampfung

o AOQ Fault Action und AO Fault Value

Wichtig

Immer wenn Sie einen Parameter des mA Ausgangs dndern, priifen Sie alle anderen Parameter des
mA Ausgangs, bevor Sie das Durchfluss-Messsystem wieder in Betrieb nehmen. In einigen
Situationen |adt die Auswerteelektronik automatisch einige gespeicherte Werte und es kann sein,
dass diese Werte nicht passend fiir lhre Anwendung sind.

mA Ausgang Prozessvariable konfigurieren

Anzeiger e OFF-LINE MAINT > OFF-LINE CONFG>10>CH A

e OFF-LINE MAINT > OFF-LINE CONFG>10>CH C
ProLink Il ProLink > Configuration > Analog Output
ProLink Il Device Tools > Configuration > /O > Outputs > mA Output
Handterminal ¢ Configure > Manual Setup > Inputs/Outputs > mA Output 1

*  Configure > Manual Setup > Inputs/Outputs > mA Output 2

Uberblick

Verwenden Sie mA Ausgang Prozessvariable, um die Variable auszuwdhlen, die Giber den mA
Ausgang ausgegeben wird.

Vorbereitungsverfahren

. Wenn Sie vorhaben, den Ausgang zu konfigurieren, um Volumendurchfluss
auszugeben, stellen Sie sicher, dass Sie die Volumendurchfluss-Art wie gewiinscht
eingestellt haben: Fliissigkeit oder Gas-Standardvolumen.
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Wenn Sie vorhaben einen Ausgang zu konfigurieren, um eine Prozessvariable der
Konzentrationsmessung auszugeben, stellen Sie sicher, dass die Anwendung
Konzentrationsmessung so konfiguriert ist, dass die gewlinschte Variable verfligbar

ist.

Wenn Sie die HART Variablen verwenden, seien Sie sich bewusst, dass das Andern
der Konfiguration der mA Ausgang Prozessvariablen die Konfiguration der HART
Primarvariablen (PV) dndert.

Wenn Sie die HART Variablen verwenden, seien Sie sich bewusst, dass das Andern
der Konfiguration der mA Ausgang Prozessvariable die Konfiguration der HART
Primadrvariablen (PV) und/oder die HART Sekundarvariablen (SV) dndert.

Wenn Sie Displayvariable 1 zum Verfolgen der mA Ausgang Prozessvariablen konfiguriert
haben, seien Sie sich bewusst, dass das Andern der Konfiguration der mA Ausgang
Prozessvariablen den Inhalt der Displayvariablen 1 andern wird.

Verfahren

Setzen Sie die mA Ausgang Prozessvariable wie gewiinscht.

Die Voreinstellung ist Massedurchfluss.
Die Voreinstellungen sind:

Primarer mA Ausgang: Massedurchfluss

e Sekunddrer mA Ausgang: Dichte

Optionen fiir mA Ausgang Prozessvariable

Die Auswerteelektronik liefert einen Grundoptionssatz fiir Ausgang Prozessvariable,
einschlieRlich mehrerer anwendungsspezifischer Optionen. Verschiedene
Kommunikations-Hilfsmittel verwenden u. U. unterschiedliche Kennzeichnungen fiir die
Optionen.

Tabelle 6-1: Optionen fiir mA Ausgang Prozessvariable

Bezeichnung

gierte Dichte

gierte Dichte

Temperature

Prozessvariable Display ProLink Il Handterminal
Standard

Massedurchflussrate | MFLOW Massendurchfluss Mass Flow Rate Massedurchfluss
Volumendurchfluss- | VFLOW Volumendurchflussrate Volume Flow Rate Volumendurchfluss
rate

Gas Standard Volu- GSVF Gas Std Volumendurch- | Gas Standard Volume Gasvolumendurchfluss
mendurchfluss fluss Flow Rate

Temperatur TEMP Temperatur Temperature Temp

Dichte DICHTE Dichte Density Dichte

Externer Druck EXTP Externer Druck External Pressure Externer Druck
Externe Temperatur EXTT Externe Temperatur External Temperature Externe Temperatur
Antriebsverstarkung | DGAIN Antriebsverstarkung Drive Gain Steuersignal
Mineral6lmessung

Temperaturkorri- TCDEN API: Temperaturkorri- Density at Reference TC-Dichte
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Tabelle 6-1: Optionen fiir mA Ausgang Prozessvariable (Fortsetzung)

Bezeichnung

Prozessvariable Display ProLink II Handterminal

Temperaturkorrigiert- | TCVOL AP!I: Temperaturkorrigiert- = Volume Flow Rate at Ref- = TC-Volumen

er (Standard) Volu- er Volumendurchfluss erence Temperature

mendurchfluss

Durchschnittliche kor- | AVE D API: Durchschnittsdichte | Durchschnittsdichte Durchschnittliche TC-

rigierte Dichte Dichte

Durchschnittstemper- | AVE T API: Durchschnittstemper- | Durchschnittstemperatur | Durchschnittliche TC-

atur atur Temperatur

Konzentrationsmessung

Dichte bei Referenz- | RDENS CM: Dichte bei Referenz- | Density at Reference ED-Dichte bei Referenz

bedingungen werten Temperature

Spezifisches Gewicht | SGU CM: Dichte (feste SG-Ein- | Density (Fixed SG Units) | ED-Dichte (SGU)
heiten)

Standard-Volumen- STDV CM: Standardvolumen- Volume Flow Rate at Ref- | ED-Standardvolumen-

durchfluss durchflussrate erence Temperature durchfluss

Netto-Massedurch- NET M CM: Nettomassedurch- Net Mass Flow Rate ED-Nettomassedurchfluss

fluss flussrate

Netto-Volumendurch- | NETV CM: Nettovolumendurch- | Net Volume Flow Rate ED-Nettovolumendurch-

fluss flussrate fluss

Konzentration CONC CM: Konzentration Concentration ED-Konzentration

Baume BAUME CM: Dichte (feste Baume | Baume ED-Dichte (Baume)

Einheiten)

6.2.2

Messanfang (LRV) und Messende (URV) konfigurieren

Anzeiger

e OFF-LINE MAINT > OFF-LINE CONFG > 10> CHA/C >4 mA
e OFF-LINE MAINT > OFF-LINE CONFG > 0> CH A/IC>20 mA

ProLink Il

*  ProLink > Configuration > Analog Output > Primary/Secondary Output > Lower Range Value
*  ProLink > Configuration > Analog Output > Primary/Secondary Output > Upper Range Value

ProLink Il

Device Tools > Configuration > /O > Outputs > mA Output

Handterminal

*  Configure > Manual Setup > Inputs/Outputs > mA Output X > mA Output Settings > PV/SV LRV
*  Configure > Manual Setup > Inputs/Outputs > mA Output X > mA Output Settings > PV/SV URV

Uberblick

Der Messanfang (LRV) und das Messende (URV) werden verwendet, um den mA Ausgang zu
skalieren, d. h. das Verhaltnis zwischen der mA Ausgang Prozessvariablen und dem mA
Ausgangswert zu definieren.

Anmerkung

Wenn Sie bei Auswerteelektronik Software v5.0 und héher LRV und URV von den werkseitig
voreingestellten Werten andern und Sie spdter die mA Ausgang Prozessvariable dndern, werden LRV
und URV nicht auf die voreingestellten Werte zuriickgesetzt. Wenn Sie beispielsweise die mA Ausgang
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Prozessvariable auf Massedurchfluss setzen und LRV und URV dndern, dann die mA Ausgang Prozessvariable
auf Dichte setzen und schlieBlich die mA Ausgang Prozessvariable zuriick auf Massedurchfluss andern,
werden LRV und URV fiir Massedurchfluss auf die konfigurierten Werte zuriickgesetzt. In fiiheren
Versionen der Auswerteelektronik Software werden LRV und URV auf die werkseitig voreingestellten
Werte zuriickgesetzt.

Verfahren
Setzen Sie LRV und URV wie gew(inscht.

e LRVist der Wert der mA Ausgang Prozessvariablen, der durch einen Ausgang von 4 mA
reprasentiert wird. Der voreingestellte Wert fiir LRV ist von der Einstellung der mA
Ausgang Prozessvariablen abhdngig. Geben Sie den Wert fiir LRV in den Messeinheiten ein,
die fiir die mA Ausgang Prozessvariable konfiguriert wurden.

e URVist der Wert der mA Ausgang Prozessvariablen, der durch einen Ausgang von 20 mA
reprasentiert wird. Der voreingestellte Wert fiir URV ist von der Einstellung der mA
Ausgang Prozessvariablen abhdngig. Geben Sie URV in den Messeinheiten ein, die fiir die
mA Ausgang Prozessvariable konfiguriert wurden.

Hinweise

Fiir optimale Leistungsmerkmale:

o Setzen Sie LRV > LSL (untere Sensorgrenze).

e Setzen Sie URV < USL (obere Sensorgrenze).

» Setzen Sie diese Werte so, dass die Differenz zwischen URV und LRV > Min Spanne
(Mindestmessspanne) ist.

Die Festlegung von URV und LRV innerhalb der empfohlenen Werte fiir Min Spanne, LSL und USL sorgt
dafiir, dass die Auflésung des mA Ausgang Signals innerhalb des Bereichs der Bitgenauigkeit des
D/A-Wandlers liegt.

Anmerkung

Sie kdnnen URV unterhalb von LRV setzen. Zum Beispiel konnen Sie URV auf 50 und LRV auf 100
setzen.

Der mA Ausgang verwendet einen Bereich von 4-20 mA zur Darstellung der mA Ausgang
Prozessvariablen. Zwischen LRV und URV ist der mA Ausgang linear zur Prozessvariablen.
Féllt die Prozessvariable unter LRV oder steigt tiber URV, setzt die Auswerteelektronik
einen Séttigungsalarm.

Voreingestelle Werte fiir Messanfang (LRV) und Messende (URV)

Jede Option fiir die mA Ausgang Prozessvariable hat ihre eigenen LRV und URV. Wenn Sie die
Konfiguration der mA Ausgang Prozessvariable andern, werden die korrospondierenden LRV
und URV geladen und verwendet.

Tabelle 6-2: Voreingestelle Werte fiir Messanfang (LRV) und Messende (URV)

Prozessvariable Messanfang Messende
Alle Massedurchfluss-Variablen | -200,000 g/s 200,000 g/s
Alle Flissigkeits-Volumen- -0,2001/s 0,2001/s
durchfluss-Variablen

Alle Dichtevariablen 0,000 g/cm? 10,000 g/cm3
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Tabelle 6-2: Voreingestelle Werte fiir Messanfang (LRV) und Messende (URV)

(Fortsetzung)
Prozessvariable Messanfang Messende
Alle Temperaturvariablen -240,000 °C 450,000 °C
Antriebsverstarkung 0,00 % 100,00 %
Gas-Standardvolumendurch- -423,78 SCFM 423,78 SCFM
fluss
Externe Temperatur -240,000°C 450,000 °C
Externer Druck 0,000 bar 100,000 bar
Konzentration 0% 100 %
Baume 0 10
Spezifisches Gewicht 0 10
6.2.3 Analogausgang Abschaltung konfigurieren
Anzeiger Not available
ProLink Il ProLink > Configuration > Analog Output > Primary/Secondary Output > AO Cutoff
ProLink Il Device Tools > Configuration > /O > Outputs > mA Output
Handterminal ¢ Configure > Manual Setup > Inputs/Outputs > mA Output 1 > mA Output Settings > MAO Cutoff
*  Configure > Manual Setup > Inputs/Outputs > mA Output 2 > mA Output Settings > MAO Cutoff
Uberblick

AOQ Cutoff (Analogausgang Abschaltung) spezifiziert den niedrigsten Massedurchfluss,
Volumendurchfluss oder Gas Standard Volumendurchfluss, der durch den mA Ausgang
ausgegeben wird. Jeder Durchfluss unterhalb der Analogausgang Abschaltung wird als 0
ausgegeben.

Einschrankung

Die Analogausgang Abschaltung wird nur angewandt, wenn die mA Ausgang Prozessvariable auf
Massedurchfluss, Volumendurchfluss oder Gas Standard Volumendurchfluss gesetzt ist. Ist die mA Ausgang
Prozessvariable auf eine andere Prozessvariable gesetzt, ist die Analogausgang Abschaltung nicht
konfigurierbar und die Auswerteelektronik implementiert die Funktion der Analogausgang
Abschaltung nicht.

Verfahren
Setzen Sie die Analogausgang Abschaltung wie gewiinscht.

Die voreingestellten Werte fiir Analogausgang Abschaltung sind:
e Primdrer mA Ausgang: 0,0 g/s

e Sekundirer mA Ausgang: Not-A-Number
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Hinweis
Fiir die meisten Anwendungen sollte der voreingestellte Wert der Analogausgang Abschaltung

verwendet werden. Setzen Sie sich mit dem Micro Motion Kundenservice in Verbindung, bevor Sie
die Analogausgang Abschaltung andern.

Wechselwirkung zwischen AO-Abschaltung und
Prozessvariablen-Abschaltungen

Wenn die mA-Ausgang-Prozessvariable auf eine Durchflussvariable (beispielsweise
Massendurchfluss oder Volumendurchfluss) gesetzt ist, dann hat die AO-Abschaltung
Wechselwirkungen mit der Massendurchfluss-Abschaltung oder der Volumendurchfluss-
Abschaltung. Die Auswerteelektronik setzt die Abschaltung beim hochsten Durchfluss ein,
bei dem diese anwendbar ist.

Beispiel: Wechselwirkung bei Abschaltung

Konfiguration:

. mA-Ausgang-Prozessvariable = Massedurchfluss

J Frequenzausgang-Prozessvariable = Massedurchfluss
AQ-Abschaltung =10 g/s

. Massedurchfluss-Abschaltung = 15 g/s

Ergebnis: Fallt der Massedurchfluss unter 15 g/s, geben alle Ausgange, die den
Massedurchfluss reprasentieren, null Durchfluss aus.

Beispiel: Wechselwirkung bei Abschaltung

Konfiguration:

U mA-Ausgang-Prozessvariable = Massedurchfluss

° Frequenzausgang-Prozessvariable = Massedurchfluss
. AO-Abschaltung = 15 g/s

. Massedurchfluss-Abschaltung = 10 g/s

Ergebnis:

. Fallt der Massedurchfluss unter 15 g/s aber nicht unter 10 g/s:
- gibt der mA-Ausgang null Durchfluss aus.
- gibt der Frequenzausgang den aktuellen Durchfluss aus.

. Fallt der Massedurchfluss unter 10 g/s, geben beide Ausgange null Durchfluss aus.

100 Micro Motion® Auswerteelektronik Modell 2700 mit eigensicheren Ausgédngen



Integrieren des Messgerdtes mit dem Steuersystem

Zusatzliche Dampfung konfigurieren

Anzeiger Not available

ProLink Il ProLink > Configuration > Analog Output > Primary/Secondary Output > AO Added Damp

ProLink Il Device Tools > Configuration > 1/O > Outputs > mA Output

Handterminal *  Configure > Manual Setup > Inputs/Outputs > mA Output 1 > mA Output Settings > PV Added
Damping

*  Configure > Manual Setup > Inputs/Outputs > mA Output 2 > mA Output Settings > SV Added
Damping
Uberblick

Die Ddmpfung wird verwendet, um kleine, pl6tzlich auftretende Schwankungen des
Prozessmesswerts zu gldtten. Damping Value gibt die Zeitdauer (in Sekunden) an, iiber die
die Auswerteelektronik die Anderungen in der ausgegebenen Prozessvariable verteilt. Am
Ende des Intervalls spiegelt die ausgegebene Prozessvariable 63 % der Anderung des
eigentlichen gemessenen Wertes wider. Zusétzliche Dampfung steuert den Wert der
Dampfung, die fiir den mA Ausgang angewandt werden soll. Sie beeinflusst nur die
Ausgabe der mA Ausgang Prozessvariablen durch den mA Ausgang. Sie beeinflusst nicht die
Ausgabe der Prozessvariablen mittels einer anderen Methode (z. B. dem Frequenzausgang
oder der digitalen Kommunikation) oder den Wert der Prozessvariablen, der fiir
Berechnungen verwendet wird.

Anmerkung

Zusétzliche Dampfung wird nicht auf den mA Ausgang angewandt, wenn dieser fixiert ist (z. B. wahrend
des Messkreistests) oder wenn der mA Ausgang eine Stérung ausgibt. Zusatzliche Dampfung wird
angewandt, wadhrend die Sensor Simulation aktiv ist.

Verfahren
Setzen Sie Zusatzliche Ddmpfung auf den gew(linschten Wert.
Der voreingestellte Wert ist 0,0 Sekunden.

Wenn Sie einen Wert fiir Added Damping setzen, rundet die Auswerteelektronik den Wert
automatisch auf den nachsten Wert nach unten ab.

Anmerkung

Die Werte fiir Zuséatzliche Dampfung werden durch das Setzen der Messwertaktualisierung und der 100 Hz
Variablen beeinflusst.

Tabelle 6-3: Giiltige Werte fiir Zusétzliche Dampfung

Beeinflusste

Messwer-
Einstellung der Messwertak- taktualisier-
tualisierung Prozessvariable ung Giiltige Werte fiir Zusatzliche Dampfung
Normal k.A. 20 Hz 0,0,0,1,0,3,0,75, 1,6, 3,3, 6,5, 13,5, 27,5, 55,

110, 220, 440

Konfigurations- und Bedienungsanleitung

101



Integrieren des Messgerdtes mit dem Steuersystem

Tabelle 6-3: Giiltige Werte fiir Zusétzliche Dampfung (Fortsetzung)

Beeinflusste
Messwer-
Einstellung der Messwertak- taktualisier-
tualisierung Prozessvariable ung Giiltige Werte fiir Zusatzliche Dampfung
Spezial 100 Hz Variable (wenn ei- 100 Hz 0,0, 0,04, 0,12, 0,30, 0,64, 1,32, 2,6, 5,4, 11, 22,
nem mA Ausgang zugeord- 44,188,176, 350
net)
100 Hz Variable (keinem mA | 6,25 Hz 0,0, 0,32, 0,96, 2,40, 5,12, 10,56, 20,8, 43,2, 88,
Ausgang zugeordnet) 176, 352
Alle anderen Prozessvaria-
blen

6.2.5

102

Interaktion zwischen Zusatzdampfung und
Prozessvariablendampfung

Wenn die mA-Ausgang-Prozessvariable auf eine Durchflussvariable, Dichte oder Temperatur
gesetzt ist, dann hat die Zusatzliche Dampfung Wechselwirkungen mit der Durchflussdampfung,
Dichtedampfung oder Temperaturddmpfung. Wenn mehrere Dampfungsparameter verwendet
werden, wird zuerst der Effekt der Dampfung der Prozessvariablen berechnet, und die
zusdtzliche Dampfung wird auf das Ergebnis dieser Berechnung angewandt.

Beispiel: Wechselwirkung bei Dampfung

Konfiguration:

. Durchflussdampfung = 1 Sekunde

. mA-Ausgang-Prozessvariable = Massedurchfluss

. Zusétzliche Dampfung = 2 Sekunden

Ergebnis: Eine Anderung des Massedurchflusses wirkt sich am mA-Ausgang nach mehr als

3 Sekunden aus. Die genaue Zeit wird durch die Auswerteelektronik berechnet, gemaR
einem internen Algorithmus, der nicht konfiguriert werden kann.

mA Ausgang Storaktion und mA Ausgang Storwert
konfigurieren

Anzeiger Not available

ProLink Il *  ProLink > Configuration > Analog Output > Primary/Secondary Output > AO Fault Action
*  ProLink > Configuration > Analog Output > Primary/Secondary Output > AO Fault Level

ProLink Il Device Tools > Configuration > Fault Processing

Handterminal ¢ Configure > Manual Setup > Inputs/Outputs > mA Output 1 > MA01 Fault Settings

*  Configure > Manual Setup > Inputs/Outputs > mA Output 2 > MA02 Fault Settings

Uberblick

Die mA Ausgang Storaktion steuert das Verhalten des mA Ausgangs, wenn die
Auswerteelektronik eine interne Stérbedingung erkennt.
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Anmerkung

Nur fiir manche Fehler: Wenn Zuletzt gemessener Wert - Zeitiiberschreitung auf einen Wert ungleich null
gesetzt ist, wird die Auswerteelektronik die Storaktion erst nach Ablauf der Zeitiiberschreitung
implementieren.

Verfahren
1. Setzen Sie die mA Ausgang Stdraktion auf den gewiinschten Wert.

Die Voreinstellung ist Abwarts.

2. Wenn Sie mA Ausgang Storaktion auf Aufwarts oder Abwarts setzen, setzen Sie den mA
Ausgang Stdrwert wie gewiinscht.

Optionen fiir mA Ausgang Stéraktion und mA Ausgang Storwert

Tabelle 6-4: Optionen fiir mA Ausgang Storaktion und mA Ausgang Storwert

Option mA Ausgang Verhalten mA Ausgang Storwert

Aufwarts Geht auf den konfigurierten Storwert Default: 22,0 mA
Bereich: 21 bis 24 mA

Abwarts (Voreinstellung) Geht auf den konfigurierten Stérwert Voreinstellung: 3,2 mA
Bereich: 3,2 bis 3,6 mA

Interner Nullpunkt Geht auf den mA-Ausgangswert, der Nicht zutreffend
dem Wert der Prozessvariablen von 0
(Null) zugeordnet ist, wie durch die Mes-
sanfang und Messende Werte Einstellun-
gen.

Keine Ubertragungsdaten fiir die zugeordnete  Nicht zutreffend
Prozessvariable, keine Stéraktion

A\ VORSICHT!

Wenn Sie die mA-Ausgang-Storaktion oder Frequenzausgang-Storaktion auf Keine setzen, stellen Sie
sicher, dass auch Digitale Kommunikations-Storaktion auf Keine gesetzt ist. Andernfalls gibt der
Ausgang nicht die aktuellen Prozessdaten aus und dies kann Messfehler erzeugen oder
ungewollte Konsequenzen fiir Ihren Prozess haben.

Einschrdankung

Wenn Sie die Digitale Kommunikations-Storaktion auf NAN setzen, kénnen Sie die mA-Ausgang-Stéraktion
oder Frequenzausgang-Storaktion nicht auf Keine setzen. Wenn Sie dies versuchen, akzeptiert die
Auswerteelektronik die Konfiguration nicht.

6.3 Frequenzausgang konfigurieren

Der Frequenzausgang wird zum Ausgeben einer Prozessvariablen verwendet. Die
Parameter fiir den Frequenzausgang steuern, wie die Prozessvariable ausgegeben wird.
Ihre Auswerteelektronik kann keinen oder einen Frequenzausgang haben: Channel B kann
als Frequenzausgang oder Bindrausgang konfiguriert werden.
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6.3.1
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Die Parameter Frequenzausgang umfassen:

J Frequenzausgang Prozessvariable

° Frequenzausgang Polaritat

. Frequenzausgang Skaliermethode

. Frequenzausgang max. Impulsbreite

. Frequency Output Fault Action und Frequency Output Fault Value

Wichtig

Immer wenn Sie einen Parameter des Frequenzausgangs dndern, priifen Sie alle anderen Parameter
des Frequenzausgangs, bevor Sie das Durchfluss-Messsystem wieder in Betrieb nehmen. In einigen
Situationen ladt die Auswerteelektronik automatisch einige gespeicherte Werte und es kann sein,
dass diese Werte nicht passend fiir hre Anwendung sind.

Frequenzausgang Prozessvariable konfigurieren

Anzeiger OFF-LINE MAINT > OFF-LINE CONFG >10>CH B>SET FO>FO SRC

ProLink Il ProLink > Configuration > Frequency/Discrete Output > Frequency > Tertiary Variable

ProLink Il Device Tools > Configuration > /O > Outputs > Frequency Output

Handterminal Configure > Manual Setup > Inputs/Outputs > Frequency Output > FO Settings > Third Variable
Uberblick

Die Frequenzausgang Prozessvariable steuert die Variable, die (iber den Frequenzausgang
ausgegeben wird.

Vorbereitungsverfahren

Wenn Sie vorhaben, den Ausgang zu konfigurieren, um Volumendurchfluss auszugeben,
stellen Sie sicher, dass Sie die Volumendurchfluss-Art wie gewiinscht eingestellt haben:
Fliissigkeit oder Gas-Standardvolumen.

Wenn Sie vorhaben einen Ausgang zu konfigurieren, um eine Prozessvariable der
Konzentrationsmessung auszugeben, stellen Sie sicher, dass die Anwendung
Konzentrationsmessung so konfiguriert ist, dass die gewlinschte Variable verfligbar ist.

Wenn Sie die HART Variablen verwenden, seien Sie sich bewusst, dass das Andern der
Konfiguration der Frequenzausgang Prozessvariable die Konfiguration der HART
Tertidrvariablen (TV) dndert.

Verfahren
Setzen Sie die Frequenzausgang Prozessvariable wie gewiinscht.

Die Voreinstellung ist Massedurchfluss.

Optionen fiir Frequenzausgang Prozessvariable

Die Auswerteelektronik liefert einen Grundoptionssatz fiir Ausgang Prozessvariable,
einschlieRlich mehrerer anwendungsspezifischer Optionen. Verschiedene
Kommunikations-Hilfsmittel verwenden u. U. unterschiedliche Kennzeichnungen fir die
Optionen.
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Tabelle 6-5: Optionen fiir Frequenzausgang Prozessvariable

Aufkleber

Prozessvariable Display ProLink I ProLink Ill Handterminal
Standard
Massedurchfluss MFLOW Massedurchfluss Mass Flow Rate Massedurchfluss
Volumendurchfluss VFLOW Volumendurchfluss Volume Flow Rate Volumendurchfluss
Gas Standard Volumendurch- | GSVF Gas Std Volumen- Gas Standard Volume | Gasvolumendurchfluss
fluss durchfluss Flow Rate
Mineraldlmessung
Temperaturkorrigierter (Stand- | TCVOL Std Vol Flow Volume Flow Rate at | TC-Volumen
ard) Volumendurchfluss Reference Tempera-

ture
Konzentrationsmessung
Standard-Volumendurchfluss | STDV ED : Std Vol Durchfluss ' Volume Flow Rate at ED-Standardvolumen-

Reference Tempera- durchfluss

ture
Netto Massedurchfluss NETM ED : Netto Masse- Net Mass Flow Rate ED-Nettomassedurch-

durchfluss fluss
Net volume flow NETV ED : Net Vol Durchfluss | Net Volume Flow Rate = ED-Nettovolumen-
durchfluss

6.3.2

Frequenzausgang Polaritat konfigurieren

Anzeiger

OFF-LINE MAINT > OFF-LINE CONFG >10 > CH B> SET FO>FO POLAR

ProLink Il

ProLink > Configuration > Frequency/Discrete Output > Frequency > Freq Output Polarity

ProLink Il

Device Tools > Configuration > /0 > Outputs > Frequency Output

Handterminal

Configure > Manual Setup > Inputs/Outputs > Frequency Output > FO Settings > FO Polarity

Uberblick

Die Frequenzausgang Polaritat steuert, wie der Ausgang einen Status EIN (aktiv) anzeigt. Der
voreingestellte Wert Aktiv Hoch ist fiir die meisten Anwendungen anwendbar. Es kann sein,
dass Aktiv Niedrig fiir Anwendungen mit niederfrequentem Signal benétigt wird.

Verfahren

Setzen Sie die Frequenzausgang Polaritdt wie gewiinscht.

Die vorgegebene Einstellung ist Aktiv Hoch.
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Optionen fiir Frequenzausgang Polaritat

Tabelle 6-6: Optionen fiir Frequenzausgang Polaritat

Polaritat Referenzspannung (AUS) Impulsspannung (ON)

Aktiv hoch IL 0 Bestimmt durch Spannungs-
versorgung, Pull-up-Wider-
stand und Biirde (siehe Installa-
tionsanleitung lhrer Auswer-
teelektronik)

Aktiv niedrig T Bestimmt durch Spannungs- 0
versorgung, Pull-up-Wider-
stand und Biirde (siehe Installa-
tionsanleitung Ihrer Auswer-
teelektronik)

6.3.3 Frequenzausgang Skaliermethode konfigurieren
Anzeiger OFF-LINE MAINT > OFF-LINE CONFG > 0> CH B > SET FO > FO SCALE
ProLink Il ProLink > Configuration > Frequency/Discrete Output > Frequency > Scaling Method
ProLink Il Device Tools > Configuration > /0 > Outputs > Frequency Output
Handterminal Configure > Manual Setup > Inputs/Outputs > Frequency Output > FO Scaling
Uberblick

Die Frequenzausgang Skaliermethode definiert das Verhaltnis zwischen Ausgangsimpulsen und
Durchflusseinheiten. Setzen Sie die Frequenzausgang Skaliermethode entsprechend den
Anforderungen lhres frequenzempfangenden Gerates.

Verfahren
1. Setzen Sie die Frequenzausgang Skaliermethode.
Option Beschreibung
Frequenz = Durchfluss (Vor- | Frequenz berechnet vom Durchfluss
einstellung)
Impulse/Einheit Eine durch den Anwender spezifizierte Impulszahl reprasentiert
eine Durchflusseinheit
Einheiten/Impulse Ein Impuls reprasentiert eine durch den Anwender spezifizierte
Anzahl an Durchflusseinheiten
2. Setzen Sie zusatzlich erforderlicher Parameter.

e Wenn Sie die Frequency Output Scaling Method auf Frequency=Flow setzen, setzen Sie
den Rate Factor und Frequency Factor.

*  Wenn Sie die Frequency Output Scaling Method auf Pulses/Unit setzen, definieren Sie
die Anzahl der Impulse, die eine Durchflusseinheit reprasentieren soll.

* Wenn Sie die Frequency Output Scaling Method auf Units/Pulse setzen, definieren Sie
die Einheiten, die jeder Impuls anzeigen soll.
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Frequenz anhand des Durchflusses berechnen

Die Option Frequenz = Durchfluss wird verwendet, um den Frequenzausgang lhrer
Anwendung kundenspezifisch anzupassen, wenn Sie die entsprechenden Werte fiir
Einheiten/Impuls oder Impulse/Einheit nicht kennen.

Wenn Sie Frequenz = Durchfluss wahlen, miissen Sie die Werte fiir Durchflussfaktor und
Frequenzfaktor angeben:

Durchflussfaktor Der max. Durchfluss, den der Frequenzausgang ausgeben soll. Oberhalb
dieses Durchflusses gibt die Auswerteelektronik A110: Frequenzausgang
geséttigt aus.

Frequenzfaktor  Ein Wert wird wie folgt berechnet:

RateFactor x N

FrequencyFactor = T

wobei:

T Faktor zum Umrechnen der gewahlten Zeitbasis in Sekunden

N Anzahl der Impulse pro Durchflusseinheit gemaR Konfiguration am
empfangenden Gerat

Der resultierende Frequenzfaktor muss innerhalb des Frequenzbereichs des Ausgangs liegen
(von 0 bis 10 000 Hz).

o Ist der Frequenzfaktor kleiner als 1 Hz, konfigurieren Sie das empfangende Gerat auf
einen hoheren Wert fir Impulse/Einheit.

. Ist der Frequenzfaktor gréRer als 10.000 Hz, konfigurieren Sie das empfangende Gerdt
auf einen niedrigeren Wert fiir Impulse/Einheit.

Hinweis

Ist die Frequenzausgang-Skaliermethode auf Frequenz = Durchfluss gesetzt und Max. Impulsbreite fiir
Frequenzausgang auf einen Wert ungleich Null gesetzt, empfiehlt MicroMotion die Einstellung des
Frequenzfaktors auf einen Wert kleiner als 200 Hz.

Beispiel: Frequenz = Durchfluss konfigurieren

Wenn Sie mochten, dass der Frequenzausgang alle Durchfliisse bis 2000 kg/min ausgeben
soll.

Das frequenzempfangende Gerat ist auf 10 Impulse/kg konfiguriert.

Losung:

FrequencyFactor = M XN
FrequencyFactor = % x 10

FrequencyFactor = 333.33

Setzen Sie die Parameter wie folgt.
. Durchflussfaktor: 2000
° Frequenzfaktor; 333,33
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6.3.4 Frequenzausgang max. Impulsbreite konfigurieren
Anzeiger Not available
ProLink Il ProLink > Configuration > Frequency/Discrete Output > Frequency > Freq Pulse Width
ProLink Il Device Tools > Configuration > /0O > Outputs > Frequency Output
Handterminal Configure > Manual Setup > Inputs/Outputs > Frequency Output > FO Settings > Max Pulse Width
Uberblick

Die Frequenzausgang max. Impulsbreite stellt sicher, dass die Dauer des EIN Signals lang genug
ist, damit das Frequenz empfangende Gerdt es erkennt.

Das EIN Signal kann die hohe Spannung sein oder 0,0 V, abhdngig von der Frequenzausgang
Polaritat.

Tabelle 6-7: Wechselwirkung von Frequenzausgang max. Impulsbreite und Frequenzausgang

Polaritat
Polaritat Impulsbreite
Aktiv hoch —
+—> < > < > —>
Aktiv niedrig
Verfahren

Setzen Sie die Frequenzausgang max. Impulsbreite wie gew{inscht.

Der voreingestellte Wert ist 277 ms. Sie kdnnen den Frequenzausgang max. Impulsbreite auf
0 ms oder einen Wert zwischen 0,5 ms und 277,5 ms einstellen. Die Auswerteelektronik
setzt den eingegebenen Wert automatisch auf den nachsten giiltigen Wert.

Hinweis

Micro Motion empfiehlt, den voreingestellten Wert fiir die Frequenzausgang max. Impulsbreite nicht zu
dndern. Wenden Sie sich an den Micro Motion Kundendienst, wenn Sie die Frequenzausgang max.
Impulsbreite andern mochten.
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6.3.5 Frequenzausgang Storaktion und Frequenzausgang Storwert
konfigurieren

Anzeiger Not available

ProLink Il *  ProLink > Configuration > Frequency/Discrete Output > Frequency > Freq Fault Action
e ProLink > Configuration > Frequency/Discrete Output > Frequency > Freq Fault Level

ProLink Il Device Tools > Configuration > Fault Processing
Handterminal *  Configure > Manual Setup > Inputs/Outputs > Frequency Output > FO Fault Parameters > FO
Fault Action
*  Configure > Manual Setup > Inputs/Outputs > Frequency Output > FO Fault Parameters > FO
Fault Level
Uberblick

Frequenzausgang Storaktion steuert das Verhalten des Frequenzausgangs, wenn die
Auswerteelektronik eine interne Stérbedingung erkennt.

Anmerkung

Nur fiir manche Fehler: Wenn Zuletzt gemessener Wert — Zeitiiberschreitung auf einen Wert ungleich null
gesetzt ist, wird die Auswerteelektronik die Storaktion erst nach Ablauf der Zeitiiberschreitung
implementieren.

Verfahren
1. Setzen Sie die Frequenzausgang Stdraktion wie gewlinscht.

Der voreingestellte Wert ist Abwarts (0 Hz).

2. Wenn Sie die Frequenzausgang Storaktion auf Aufwérts setzen, setzen Sie den
Frequenzausgang Storwert auf den gewlinschten Wert.

Der voreingestellte Wert ist 15000 Hz. Der Bereich ist 10 bis 15000 Hz.

Optionen fiir Frequenzausgang Storaktion

Tabelle 6-8: Optionen fiir Frequenzausgang Stéraktion

Bezeichnung Frequenzausgang Verhalten

Upscale Geht zum konfigurierten Aufwarts Wert:
e Bereich: 10 Hz bis 15000 Hz
e Standardwert: 15000 Hz

Downscale 0Hz

Interner Nullpunkt 0Hz

Keine (Voreinstellung) Ubertragungsdaten fiir die zugeordnete Prozessvariable, keine
Storaktion
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6.4

6.4.1
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A\ VORSICHT!

Wenn Sie die mA-Ausgang-Stéraktion oder Frequenzausgang-Storaktion auf Keine setzen, stellen Sie
sicher, dass auch Digitale Kommunikations-Storaktion auf Keine gesetzt ist. Andernfalls gibt der
Ausgang nicht die aktuellen Prozessdaten aus und dies kann Messfehler erzeugen oder
ungewollte Konsequenzen fiir Ihren Prozess haben.

Einschrdankung

Wenn Sie die Digitale Kommunikations-Storaktion auf NAN setzen, kénnen Sie die mA-Ausgang-Storaktion
oder Frequenzausgang-Storaktion nicht auf Keine setzen. Wenn Sie dies versuchen, akzeptiert die
Auswerteelektronik die Konfiguration nicht.

Konfigurieren des Bindrausgangs

Der Binarausgang wird verwendet, um spezifische Durchfluss-Messsystem oder
Prozessbedingungen auszugeben. Die Parameter des Bindrausgangs steuern welche
Bedingung ausgegeben wird und wie. lhre Auswerteelektronik kann keinen oder einen
Bindrausgang haben: Channel B kann als Frequenzausgang oder als Bindrausgang
konfiguriert werden.

Die Parameter Binarausgang enthalt:

. Bindrausgang Quelle

. Bindrausgang Polaritat

J Bindrausgang Storaktion

Einschrdankung

Bevor Sie den Bindrausgang konfigurieren kénnen, missen Sie einen Kanal konfigurieren der als
Bindrausgang arbeitet.

Wichtig

Immer wenn Sie einen Parameter des Bindrausgangs dndern, priifen Sie alle anderen Parameter des
Bindrausgangs bevor Sie das Durchfluss-Messsystem wieder in Betrieb nehmen. In einigen
Situationen |adt die Auswerteelektronik automatisch einige gespeicherte Werte und es kann sein,
dass diese Werte nicht passend fiir lhre Anwendung sind.

Konfigurieren der Bindrausgangsquelle

Anzeiger OFF-LINE MAINT > OFF-LINE CONFG > 10 >CH B > SET DO > DO SRC

ProLink Il ProLink > Configuration > Frequency/Discrete Output > Discrete Output > DO Assignment

ProLink Il Device Tools > Configuration > I/O > Outputs > Discrete Output

Handterminal Configure > Manual Setup > Inputs/Outputs > Discrete Output > DO Assignment
Uberblick

Die Discrete Output Source steuert welche Bedingung oder Prozessvariable des Durchfluss-
Messsystems (iber den Bindrausgang ausgegeben wird.
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Verfahren

Discrete Output Source auf die gewiinschte Option einstellen.

Die Standardeinstellung fiir Discrete Output Source ist Flow Direction.

Optionen fiir Bindrausgang Quelle

Tabelle 6-9: Optionen fiir Bindrausgang Quelle

Bezeichnung

Bindrausgang

Option Display ProLink Il ProLink Ill Handterminal Zustand Spannung
Binarereignis DEVx Discrete Enhanced Event | Discrete EIN Anwenderspe-
1-5(1) Event x 1 Eventx zifisch
Enhanced Event AUS oV
2
Enhanced Event
3
Enhanced Event
4
Enhanced Event
5
Ereignis 1-22)  EVNT1 Event 1 Event 1 Event 1 EIN Anwenderspe-
EVNT2 Ereignis 2 Event 2 Ereignis 2 zifisch
ET1OR2 Ereignis 1 oder = EventTorEvent  Ereignis 1 oder = AUS oV
Ereignis 2 2 Status Ereignis 2
Durchflussschal- = FL SW Flow Switch In- | Flow Switch Indi- | Flow Switch EIN Anwenderspe-
ter dication cator zifisch
AUS oV
Durchflussrich- FLDIR Forward/Re- Forward Reverse = Forward/Re- Vorwarts- oV
tung verse Indica- Indicator verse durchfluss
tion Rickwarts- Anwenderspe-
durchfluss zifisch
Kalibrierung lauft | ZERO Calibrationin | Calibrationin Pro- Calibrationin ' EIN Anwenderspe-
Progress gress Progress zifisch
AUS oV
Stérung FAULT Fault Condition | Fault Indication | Fault EIN Anwenderspe-
Indication zifisch
AUS oV
Wichtig

In dieser Tabelle wird davon ausgegangen, dass Bindrausgang Polaritat auf Aktiv Hoch eingestellt ist. Ist
die Bindrausgang Polaritdt auf Aktiv Niedrig gesetzt, Spannungswerte umkehren.

(1) Mithilfe des erweiterten Ereignismodells konfigurierte Ereignisse

(2) Mithilfe des Basis-Ereignismodells konfigurierte Ereignisse
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Wichtig
Ist der Durchflussschalter dem Bindrausgang zugeordnet, miissen auRerdem die Durchflussvariable,
der Durchflussschalter-Sollwert und die Hysterese spezifiziert werden.

Parameter Durchflussschalter konfigurieren

Anzeiger OFF-LINE MAINT > OFF-LINE CONFG >0 > CH B> SET DO > CONFIG FL SW

ProLink Il *  ProLink > Configuration > Flow > Flow Switch Variable

e ProLink > Configuration > Flow > Flow Switch Setpoint
*  ProLink > Configuration > Flow > Flow Switch Hysteresis

ProLink IlI Device Tools > Configuration > /0O > Outputs > Discrete Output

Handterminal *  Configure > Manual Setup > Inputs/Outputs > Discrete Output > Flow Switch Source

*  Configure > Manual Setup > Inputs/Outputs > Discrete Output > Flow Switch Setpoint
*  Configure > Manual Setup > Inputs/Outputs > Discrete Output > Hysteresis

Uberblick

Der Durchflussschalter wird dazu verwendet, anzuzeigen, dass der Durchfluss (gemessen
durch die konfigurierte Durchflussvariable) den konfigurierten Sollwert (iber- oder
unterschritten hat. Der Durchflussschalter wird mit einer anwenderkonfigurierbaren
Hysterese implementiert.

Verfahren

1. Setzen Sie die Discrete Output Source auf Flow Switch, wenn Sie dies noch nicht getan
haben.

2. Setzen Sie die Flow Switch Variable auf die Durchflussvariable, die zum Steuern des
Durchflussschalters verwendet werden soll.

3. Setzen Sie den Flow Switch Setpoint auf den Wert, bei dem der Durchflussschalter
(nach Anwendung der Hysteresis) ausgel6st werden soll.
* Wenn der Durchfluss unter diesem Wert liegt, ist der Bindrausgang EIN.
* Wenn der Durchfluss iber diesem Wert liegt, ist der Bindrausgang AUS.

4,  Setzen Sie die Hysteresis auf die prozentuale Abweichung oberhalb und unterhalb des
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Sollwertes, die als Totzone dient.

Die Hysteresis definiert einen Bereich um den Sollwert, innerhalb derer sich der
Durchflussschalter nicht dndert. Die Voreinstellung ist 5 %. Der giltige Bereich liegt
zwischen 0,1 % und 10 %.

Beispiel: Wenn der Flow Switch Setpoint = 100 g/s und die Hysteresis =5 % ist und der
erste gemessene Durchfluss (iber 100 g/s liegt, ist der Bindrausgang AUS. Der
Bindrausgang bleibt AUS, bis der Durchfluss unter 95 g/s fallt. In diesem Fall wird der
Bindrausgang auf EIN gesetzt und bleibt auf EIN, bis der Durchfluss tiber 105 g/s
steigt. An diesem Punkt wechselt er auf AUS und bleibt auf AUS bis der Durchfluss
unter 95 g/s fallt.
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6.4.2 Konfigurieren derPolaritat des Bindrausgangs
Anzeiger OFF-LINE MAINT > OFF-LINE CONFG > 10 > CH B > SET DO > DO POLAR
ProLink Il ProLink > Configuration > Frequency/Discrete Output > Discrete Output > DO Polarity
ProLink Il Device Tools > Configuration > /0 > Outputs > Discrete Output

Handterminal

Configure > Manual Setup > Inputs/Outputs > Discrete Output > DO Polarity

Uberblick

Bindrausgdnge haben zwei Zustande: EIN (aktiv) und AUS (inaktiv). Zwei unterschiedliche
Spannungswerte werden verwendet, um diese Zustdnde zu reprdsentieren. Die Discrete
Output Polarity steuert welcher Spannungswert welchen Zustand reprasentiert.

Verfahren

Discrete Output Polarity wie gewiinscht einstellen.

Die Standardeinstellung ist Active High.

Optionen fiir Bindrausgang Polaritat

Tabelle 6-10: Optionen fiir Bindrausgang Polaritat

Polaritat Beschreibung

Aktiv hoch * Wenn die festgelegte Bedingung fiir den
Bindrausgang zutrifft, erzeugt der Schal-
tung eine entsprechende Pull-up Span-
nung, max. 30 V.

* Wenn die festgelegte Bedingung fiir den
Bindrausgang nicht zutrifft, erzeugt die
Schaltung 0 V.

Aktiv niedrig * Wenn die festgelegte Bedingung fiir den
Bindrausgang zutrifft, erzeugt die Schal-
tungOV.

* Wenn die festgelegte Bedingung fiir den
Bindrausgang nicht zutrifft, erzeugt die
Schaltung eine entsprechende Pull-up-
Spannung, max. 30 V.
6.4.3 Konfigurieren von Bindrausgang Stdraktion

Anzeiger Not available

ProLink Il ProLink > Configuration > Frequency/Discrete Output > Discrete Output > DO Fault Action

ProLink Il Device Tools > Configuration > Fault Processing

Handterminal Configure > Manual Setup > Inputs/Outputs > Discrete Output > DO Fault Action
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Uberblick

Discrete Output Fault Action steuert das Verhalten des Binarausgangs, wenn die
Auswerteelektronik eine interne Stérbedingung erkennt.

Anmerkung

Nur fiir manche Fehler: Wenn Zuletzt gemessener Wert - Zeitiiberschreitung auf einen Wert ungleich null
gesetzt ist, wird die Auswerteelektronik die Stdraktion erst nach Ablauf der Zeitliberschreitung
implementieren.

A\ VORSICHT!

Verwenden Sie Discrete Output Fault Action nicht als Stéranzeige. Moéglicherweise ldsst sich eine
Storbedingung nicht von einem normalen Betriebszustand unterscheiden.

SieheStéranzeige mit dem Bindrausgang, wenn der Bindrausgang als Storindikator verwendet
werden soll.

Verfahren
Discrete Output Fault Action wie gewiinscht einstellen.

Die Standardeinstellung ist None.

Optionen fiir Bindrausgang Storaktion

Tabelle 6-11: Optionen fiir Bindrausgang Stéraktion

Bindrausgang Verhalten
Bezeichnung Polaritdt = Aktiv Hoch Polaritdt = Aktiv Niedrig
Upscale e Storung: Bindrausgang ist EIN e Storung: Bindrausgang ist AUS
(anwenderspezifische Span- (%))
nung) e Keine Stérung: Bindrausgang
e Keine Stérung: Bindrausgang wird durch seine Zuweisung
wird durch seine Zuweisung gesteuert
gesteuert
Downscale e Storung: Bindrausgangist AUS | ¢ Storung: Bindrausgang ist EIN
(ov) (anwenderspezifische Span-
* Keine Stérung: Bindrausgang nung)
wird durch seine Zuweisung * Keine Stérung: Bindrausgang
gesteuert wird durch seine Zuweisung
gesteuert
Keine (Voreinstellung) | Bindrausgang wird durch seine Zuweisung gesteuert

Storanzeige mit dem Bindrausgang

Um Stérungen iber den Bindrausgang anzuzeigen, setzen Sie die Parameter wie folgt:
. Bindrausgang-Quelle = Stdrung
. Bindrausgang-Storaktion = Keine
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Anmerkung

Wenn Bindrausgang-Quelle auf Stdrung gesetzt ist und eine Stérung eintritt, ist der Bindrausgang immer
EIN. Die Einstellung Bindrausgang-Storaktion wird ignoriert.

6.5 Konfigurieren von Ereignissen

Ein Ereignis tritt ein, wenn der Echtzeitwert einer anwenderspezifizierten Prozessvariable
den anwenderspezifizierten Sollwert tiberschreitet. Ereignisse werden verwendet, um bei
Prozessanderungen Meldungen zu erzeugen oder spezifische Aktionen der
Auswerteelektronik auszufiihren wenn eine Prozessdnderung eintritt.

Die Auswerteelektronik unterstiitzt zwei Ereignismodelle:

. Basis Ereignismodell
o Erweitertes Ereignismodell
6.5.1 Konfigurieren eines Basisereignisses

Anzeiger Not available
ProLink Il ProLink > Configuration > Events
ProLink Il Device Tools > Configuration > Events > Basic Events
Handterminal Not available

Uberblick

Ein Basisereignis dient dazu, Benachrichtigungen bei Prozessveranderungen zu liefern. Ein
Basisereignis tritt ein (ist EIN), wenn der Real-Time Wert einer anwenderspezifizierten
Prozessvariablen den anwenderspezifizierten Sollwert (HI) (iberschreitet oder (LO)
unterschreitet. Sie kdnnen bis zu zwei Basisereignisse definieren. Der Ereignisstatus kann
mittels digitaler Kommunikation abgefragt werden und es kann ein Bindrausgang
konfiguriert werden, um den Ereignisstatus auszugeben.

Verfahren

1. Das Ereignis auswdhlen, das konfiguriert werden soll.
2.  Spezifizieren Sie die Ereignisart.

Options Description
HI x>A

Das Ereignis tritt ein, wenn der Wert der zugeordneten Prozessvariable
(x) groRer als der Sollwert (Sollwert A) ist (Endpunkt nicht eingeschlossen).

LO X<A

Das Ereignis tritt ein, wenn der Wert der zugeordneten Prozessvariable
(x) kleiner als der Sollwert (Sollwert A) ist (Endpunkt nicht eingeschlossen).

3. Prozessvariable dem Ereignis zuordnen.
Einen Wert fir Sollwert A festlegen.

5.  (Optional) Einen Bindrausgang konfigurieren, um den Status entsprechend dem
Ereignisstatus zu wechseln.
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6.5.2
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Konfigurieren eines erweiterten Ereignisses

Anzeiger Not available
ProLink Il ProLink > Configuration > Discrete Events
ProLink Il Device Tools > Configuration > Events > Enhanced Events

Handterminal

Configure > Alert Setup > Discrete Events

Uberblick

Ein erweitertes Ereignis wird verwendet, um Meldungen zu Prozessdnderungen zu liefern
und um spezielle Auswerteelektronik Aktionen auszufiihren wenn ein Ereignis eintritt. Das
Erweiterte Ereignis tritt ein (ist EIN), wenn der Real-Time Wert einer
anwenderspezifizierten Prozessvariablen den anwenderspezifizierten Sollwert (HI)
berschreitet oder (LO) unterschreitet oder im Bereich (IN) oder ausserhalb des Bereichs
(OUT) liegt, unter Beriicksichtigung zweier anwenderspezifizierten Sollwerte. Sie konnen
bis zu fiinf Erweiterte Ereignisse konfigurieren. Fiir jedes Erweiterte Ereigniss kdnnen Sie
eine oder mehrere Aktionen zuordnen, die die Auswerteelektronik ausfiihrt, wenn das
Erweiterte Ereigniss eintritt.

Verfahren

1. Das Ereignis auswahlen, das konfiguriert werden soll.

2. Spezifizieren Sie die Ereignisart.

Options
HI

Description
X>A

Das Ereignis tritt ein, wenn der Wert der zugeordneten Prozessvariable
(x) groBer als der Sollwert (Sollwert A) ist (Endpunkt nicht eingeschlossen).

LO

X<A
Das Ereignis tritt ein, wenn der Wert der zugeordneten Prozessvariable
(x) kleiner als der Sollwert (Sollwert A) ist (Endpunkt nicht eingeschlossen).

A<x<B

Das Ereignis tritt ein, wenn der Wert der zugeordneten Prozessvariable
(x) sich innerhalb “des Bereichs befindet,” d. h. zwischen Sollwert A und
Soliwert B (Endpunkte eingeschlossen).

AUS

x<Aoderx=B

Das Ereignis tritt ein, wenn der Wert der zugeordneten Prozessvariable
(x) sich “auRerhalb des Bereichs befindet,” d. h. kleiner als Sollwert A oder
groBer als Sollwert B ist (Endpunkte eingeschlossen).

3. Prozessvariable dem Ereignis zuordnen.

Setzen Sie die Werte fiir die erforderlichen Sollwerte.

* BeiHI- und LO-Ereignissen Sollwert A festlegen.

* BeiIN- und OUT-Ereignissen Sollwert A und Sollwert B festlegen.

5. (Optional) Einen Bindrausgang konfigurieren, um den Status entsprechend dem
Ereignisstatus zu wechseln.

6.  (Optional) Spezifizieren Sie die Aktion oder Aktionen die die Auswerteelektronik
ausfiihren soll, wenn das Ereignis eintritt.
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e Mit dem Display: OFF-LINE MAINT > OFF-LINE CONFG > 10> CH C > SET DI > DI ACT
e Mit ProLink II: ProLink > Configuration > Discrete Input

* Mit ProLink Ill:Device Tools > Configuration > /O > Action Assignment

e Mit Handterminal: Configure > Alert Setup > Discrete Events > Assign Discrete Action

Optionen fiir Erweitertes Ereignisaktion

Tabelle 6-12: Optionen fiir Erweiterte Ereignisaktion

Kennzeichnung

Aktion Display ProLink Il ProLink 1l Handterminal
Standard

Keine (Voreinstellung) = KEINE Keine None Keine

Start Sensor Null- START NULLPUNKTKA- | Start Sensor Zero Start Sensor Zero Automatische Nullpunkt-
punktkalibrierung LIBRIERUNG kalibrierung durchfiihren
Start/Stopp aller Z&h- | START/STOPP Start/Stop All Totalization | Start/Stopp aller Zahlun- | Start/Stopp Zahler

ler gen

Masse-Summenzihler | MASSE ZURUCKSET- Reset Mass Total Reset Mass Total Masse-Summenzahler
zurlicksetzen ZEN zuriicksetzen
Zuriicksetzen Volu- VOL ZURUCKSETZEN Reset Volume Total Reset Volume Total Volumen-Summenzahler
men Summenzdhler zuriicksetzen
Gas-Standardvolu- GSVT ZURUCKSETZEN  Reset Gas Std Volume Gas-Standardvolumen- Gas-Standardvolumen-
men-Summenzahler Total Summenzahler zurlickset- | Summenzahler zuriickset-
zurlicksetzen zen zen

Alle Zihler zuriickset- = ALLE ZURUCKSETZEN | Reset All Totals Reset All Totals Zahler zurlicksetzen
zen

Mineral6lmessung

Temperaturkorri- TCVOL API-Referenzvolumen- Reset Volume Total at Korrigierten Volumenzéh-
gierte Volumen-Sum- Summenzahler zuriickset- | Reference Temperature | ler zuriicksetzen
menzéhler zurlickset- zen

zen

Konzentrationsmessung

CM Referenzvolumen | STDV ZURUCKSETZEN | Reset CM Ref Vol Total | Reset Volume Total at Nicht verfiigbar
Summenzéhler zur- Reference Temperature

licksetzen

CM Nettomasse-Sum- = NET M ZURUCKSETZEN | Reset CM Net Mass Total | Reset Net Mass Total Nicht verfiighar
menzdhler zurlickset-

zen

CM Nettovolumen- NET V ZURUCKSETZEN | Reset CM Net Vol Total | Reset Net Volume Total  Nicht verfiighar
Summenzéhler zur-

licksetzen

CM-Matrix fortschal- | KURVE FORTSCH Aktuelle CM-Kurve for- Konzentrationsmatrix er- | Nicht verfligbar

ten tschalten héhen

Systemverifizierung
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Tabelle 6-12: Optionen fiir Erweiterte Ereignisaktion (Fortsetzung)

Kennzeichnung

Aktion Display ProLink II ProLink Ill Handterminal
Systemverifizier- START VERFI Systemverifizierung start- | Systemverifizierung start- ~ Nicht verfligbar
ungstest starten en en

6.6

6.6.1

118

A\ VORSICHT!

Bevor Sie Aktionen einem erweitertem Ereignis oder einem Bindreingang zuordnen, priifen Sie
den Status des Ereignisses oder des externen Eingangsgerates. Ist es auf EIN, werden alle
Aktionen ausgefiihrt, wenn die neue Kanalkonfiguration implementiert wird. Ist dies nicht
akzeptabel, warten Sie auf einen geeigneten Zeitpunkt, um Aktionen dem Ereignis oder
Bindreingang zuzuordnen.

Konfigurieren der digitalen Kommunikation

Die Parameter der digitalen Kommunikation steuern die digitale Kommunikation der
Auswerteelektronik.

Die Auswerteelektronik unterstiitzt die folgenden Typen digitaler Kommunikation:

. HART/Bell 202 iber die primdren mA Anschlussklemmen

. Modbus RTU iiber Service Port

Anmerkung

Der Service Port reagiert automatisch auf eine Vielzahl von Anschlussanfragen. Er ist nicht
konfigurierbar.

HART/Bell 202 Kommunikation konfigurieren

Anzeiger OFF-LINE MAINT > OFF-LINE CONFG > COMM

ProLink Il ProLink > Configuration > Device > Digital Comm Settings

ProLink Il Device Tools > Configuration > Communications > Communications (HART)

Handterminal Configure > Manual Setup > Inputs/Outputs > Communications > HART Communications
Uberblick

Die HART/Bell 202 Kommunikationsparameter unterstiitzen die HART Kommunikation
mittels der primdren mA Anschlussklemmen der Auswerteelektronik (iber ein
HART/Bell 202 Netzwerk.

Die HART/Bell 202 Kommunikationsparameter umfassen:

. HART Adresse (Polling Adresse)

. Messkreis Strommodus (ProLink I1) oder mA Ausgang Aktion (ProLink IIl)

. Burst Parameter (optional)

. HART Variablen (optional)
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Verfahren
1. HART Address auf eindeutigen Wert im Netzwerk einstellen.

Giiltige Adresswerte liegen im Bereich von 0 und 15. Die voreingestellte Adresse (0)
wird normalerweise verwendet, auRer in einer Multidrop-Umgebung.

Hinweis

Gerdte, die das HART-Protokoll zur Kommunikation mit der Auswerteelektronik verwenden,
konnen entweder die HART Address or HART Tag (Software Tag) zur Identifizierung der
Auswerteelektronik verwenden. Entweder irgendeine oder beide Adressen entsprechend den
Anforderungen der anderen HART Gerate konfigurieren.

2. Stellen Sie sicher, dass Messkreis Strommodus (mA Ausgang Aktion) ordnungsgemald
konfiguriert ist.

Options Description
Aktiviert ‘ Der primdre mA Ausgang gibt die Prozessdaten wie konfiguriert aus.
Deaktiviert Der primare mA Ausgang ist auf 4 mA fixiert und gibt keine Prozess-
daten aus.
Wichtig

Wenn Sie ProLink Il oder ProLink Il verwenden, um die HART Adresse auf 0 zu setzen, aktiviert
das Programm den Messkreis Strommodus automatisch. Wenn Sie ProLink Il oder ProLink Il
verwenden, um die HART Adresse auf einen anderen Wert zu setzen, deaktiviert das Programm
den Messkreis Strommodus automatisch. Dies erfolgt fiir eine einfache Konfiguration der
Auswerteelektronik zum entsprechenden Verhalten. Achten Sie stets darauf, dass Sie den
Messkreis Strommodus (iberpriifen, nachdem Sie die HART Adresse gesetzt haben.

3. (Optional) Aktivieren und konfigurieren Sie die Burst Parameter.

Hinweis
In typischen Installationen ist der Burst-Modus deaktiviert. Aktivieren Sie den Burst-Modus
nur dann, wenn andere Gerate im Netzwerk die Burst-Modus-Kommunikation erfordern.

4.  (Optional) Konfigurieren Sie die HART Variablen.

Konfigurieren der Burst-Parameter

Anzeiger Not available

ProLink Il ProLink > Configuration > Device > Burst Setup

ProLink Il Device Tools > Configuration > Communications > Communications (HART)

Handterminal Configure > Manual Setup > Inputs/Outputs > Communications > Set Up Burst Mode
Uberblick

Der Burst-Modus ist ein Kommunikationsmodus, in dem die Auswerteelektronik in
regelmdBigen Abstanden digitale HART Informationen (iber denprimdren mA sendet. Die
Burst-Parameter steuern die Informationen, die gesendet werden, wenn der Burst-Modus
aktiviert ist.
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Hinweis
In typischen Installationen ist der Burst-Modus deaktiviert. Aktivieren Sie den Burst-Modus nur dann,
wenn andere Gerate im Netzwerk die Burst-Modus-Kommunikation erfordern.

Verfahren
1. Burst Modus aktivieren.
2. Burst Mode Output wie gewiinscht einstellen.
Anzeige
ProLink I ProLink Ill Handterminal | Beschreibung
Priméarvariable Quelle (Primarvari- = PV Die Auswerteelektronik sendet die
able) Priméarvariable (PV) in den konfi-
gurierten Messeinheiten in jedem
Burst (z. B. 14,0 g/s, 13,5 g/s,
12,09/s).
PV Strom & % vom | Primarvariable % range/current Die Auswerteeletronik sendet den
Bereich (Prozentbereich/ Prozentbereich der Priméarvariablen
Strom) und den aktuellen mA Wert in je-

dem Burst (z. B. 25 %, 11,0 mA).

Dynamic Var & PV | Prozessvariablen/ | Process variables/ | Die Auswerteelektronik sendet PV-,
Strom Strom current SV-, TV-Und QV-Werte in Messein-
heiten und den eigentlichen Milli-
ampere-Wert der Primdrvariablen
in jedem Burst (z. B. 50 g/s, 23 °C,
50g/s, 0,0023 g/cm3, 11,8 mA).

Auswerteelektronik | Auswerteelektronik | Fid dev var Die Auswerteelektronik sendet vier
Var Variablen anwenderspezifizierte Prozessvar-
iablen bei jedem Burst.

3. Sicherstellen, dass die Burst-Ausgangsvariablen ordnungsgeman eingestellt sind.

*  Wenn Burst Mode Output eingestellt wird, um vier benutzerdefinierte Variablen zu
senden, die vier Prozessvariablen so einstellen, dass sie in jedem Burst gesendet
werden.

* Wenn Burst Mode Output auf eine andere Option eingestellt wird, sicherstellen,
dass die HART Variablen wie gewl(inscht eingestellt sind.

HART Variablen (PV, SV, TV, QV) konfigurieren

Anzeiger Not available

ProLink Il ProLink > Configuration > Variable Mapping

ProLink Il Device Tools > Configuration > Communications > Communications (HART)
Handterminal Configure > Manual Setup > Inputs/Outputs > Variable Mapping
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Uberblick

Die HART Variablen sind ein Satz mit vier Variablen, vordefiniert fiir die HART Verwendung.
Die HART Variablen beinhalten die Primdrvariable (PV), Sekunddrvariable (SV),
Tertidrvariable (TV) und Quatarvariable (QV). Sie konnen den HART Variablen spezielle
Prozessvariablen zuordnen und verwenden dann die Standard HART Methoden, um die
zugeordneten Prozessdaten zu lesen oder zu senden.

HART Variablen Optionen

Tabelle 6-13: HART Variablen Optionen

Prozessvariable

Primarvaria-
ble (PV)

Vierte Varia-
ble (QV)

Dritte Varia-
ble (TV)

Sekundarvari-
able (SV)

Standard

Massedurchfluss

Bruttoleitungsvolumen-Durchflussrate

Temperatur

Dichte

Antriebsverstarkung

NIENENENIEN

NENENENEN

Masse-Summenzahler

Rohrleitung (gesamt) Volumen Summenzdhler

Masse-Gesamtzdhler

Rohrleitung (gesamt) Volumen Gesamtzdhler

Messrohrfrequenz

Sensortemperatur

Li Aufnehmerspule Amplitude

Re Aufnehmerspule Amplitude

Platinentemperatur

Externer Druck

Externe Temperatur

N

N

Gas Standard Volumendurchfluss

Gas-Standardvolumen-Summenzahler

Gas-Standardvolumen-Gesamtzahler

Nullpunktwert

NEN RN N RN NN NN N RN EN RN ENEN RN EN RN ENEN

Mineral6lmessung

API-Dichte

APl Volumendurchfluss

API Volumen (Summe)

APIVolumen (gesamt)

API Durchschnittsdichte

<

API mittlere Temperatur

APICTL

NENENENENENEN

Konzentrationsmessung
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Tabelle 6-13: HART Variablen Optionen (Fortsetzung)

Prozessvariable Primdrvaria- | Sekunddrvari- Dritte Varia- | Vierte Varia-
ble (PV) able (SV) ble (TV) ble (QV)
ED-Dichte bei Referenztemperatur v v v
ED Spezifische Dichte v v v
ED Standard-Volumendurchfluss v v v v
ED Standard Volumen (Summe) v
ED Standard Volumen Gesamtzahler v
ED Netto Massedurchfluss v v v v
ED Netto Masse (Summe) v
ED Netto Masse Gesamtzahler v
ED Netto Volumendurchfluss v v v v
ED Netto Volumen (Summe) v
ED Netto Volumen Gesamtzahler v
ED Konzentration v v v
ED Baume v v v

Wechselwirkung HART-Variablen und Auswerteelektronik-
Ausgdnge
Die HART-Variablen werden automatisch durch spezielle Ausgdnge der

Auswerteelektronik ausgegeben. Sie kdnnen auch tiber den HART-Burstmodus
ausgegeben werden, falls dieser in Ihrer Auswerteelektronik aktiviert ist.

Tabelle 6-14: HART-Variablen und Auswerteelektronik-Ausgdnge

HART-Variable Ausgegeben iiber Bemerkungen
Primarvariable (PV) Primdrer mA-Ausgang Hat sich eine Zuordnung gedndert, &ndert sich die andere
automatisch und umgekehrt.

Sekundarvariable (SV) Nicht mit einem Ausgang Die SV muss direkt konfiguriert werden, und der Wert der
verbunden SVist nur iber die digitale Kommunikation verfiigbar.

Tertidrvariable (TV) Frequenzausgang (fallsan  Hat sich eine Zuordnung gedndert, dndert sich die andere
Ihrer Auswerteelektronik vo- = automatisch und umgekehrt. Hat Ihre Auswerteelektronik
rhanden) keinen Frequenzausgang, muss die TV direkt konfiguriert

werden und der Wert der TV ist nur Gber die digitale Kom-
munikation verfligbar.

Quartdrvariable (QV) Nicht mit einem Ausgang Die QV muss direkt konfiguriert werden, und der Wert der
verbunden QV ist nur iber die digitale Kommunikation verfiigbar.

122 Micro Motion® Auswerteelektronik Modell 2700 mit eigensicheren Ausgédngen



Integrieren des Messgerdtes mit dem Steuersystem

6.6.2 Digitale Kommunikation Storaktion konfigurieren
Anzeiger Nicht verfiigbar
ProLink Il ProLink > Configuration > Device > Digital Comm Settings > Digital Comm Fault Setting
ProLink Il Device Tools > Configuration > Fault Processing
Handterminal Configure > Alert Setup > I/O Fault Actions > Comm Fault Action
Uberblick

Die Digital Communications Fault Action spezifiziert den Wert der mittels digitaler
Kommunikation ausgegeben wird, wenn die Auswerteelektronik eine interne
Stoérbedingung erkennt.

Verfahren
Digital Communications Fault Action wie gewiinscht einstellen.

Die Standardeinstellung ist Keine.

Optionen fiir Digitale Kommunikation Storaktion

Tabelle 6-15: Optionen fiir Digitale Kommunikation Stdraktion

Bezeichnung

ProLink I ProLink Ill Handterminal Beschreibung

Upscale Upscale Upscale e Die Prozessvariablenwerte zeigen, dass der
Wert hoher als der obere Sensorgrenzwert
ist.

e Zahlerfortschaltung stoppen.

Downscale Downscale Downscale e Die Prozessvariablenwerte zeigen, dass der
Wert hoher als der obere Sensorgrenzwert
ist.

e Zahlerfortschaltung stoppen.

Nullpunkt Zero IntZero-All 0 e Durchflussvariablen gehen auf einen Wert,
der einen Durchfluss von 0 darstellt.

e Dichte wird als 0 ausgegeben.

e Temperaturwird als 0 °C ausgegeben oder
aquivalent, wenn andere Einheiten ver-
wendet werden (z. B. 32 °F).

e Antriebsverstirkung wird wie gemessen
ausgegeben.

e Zdhlerfortschaltung stoppen.

Not-A-Number (NAN) Not a Number Not-a-Number e Prozessvariablen werden als IEEE NAN aus-
gegeben.

e Antriebsverstarkung wird wie gemessen
ausgegeben.

e Modbus skalierte Integer werden als Max Int
ausgegeben.

e Zahlerfortschaltung stoppen.
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Tabelle 6-15: Optionen fiir Digitale Kommunikation Stéraktion (Fortsetzung)

Bezeichnung

ProLink I

ProLink Ill Handterminal Beschreibung

Durchfluss auf Null

Flow to Zero IntZero-Flow 0 e Durchfliisse werden als 0 ausgegeben.

* Andere Prozessvariablen werden wie ge-
messen ausgegeben.

e Zdhlerfortschaltung stoppen.

Keine (Voreinstellung) | None Keine (Voreinstellung) | ¢ Alle Prozessvariablen werden wie gemes-

sen ausgegeben.
e Zdhlerfortschaltung wenn sie laufen.
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A\ VORSICHT!

Wenn Sie die mA-Ausgang-Storaktion oder Frequenzausgang-Storaktion auf Keine setzen, stellen Sie
sicher, dass auch Digitale Kommunikations-Storaktion auf Keine gesetzt ist. Andernfalls gibt der
Ausgang nicht die aktuellen Prozessdaten aus und dies kann Messfehler erzeugen oder
ungewollte Konsequenzen fiir Ihren Prozess haben.

Einschrankung

Wenn Sie die Digitale Kommunikations-Storaktion auf NAN setzen, kénnen Sie die mA-Ausgang-Stéraktion
oder Frequenzausgang-Storaktion nicht auf Keine setzen. Wenn Sie dies versuchen, akzeptiert die
Auswerteelektronik die Konfiguration nicht.
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7 Abschluss der Konfiguration

In diesem Kapitel behandelte Themen:

e Testen oder Anpassen des Systems mittels Sensorsimulation
e  Backup der Auswerteelektronik Konfiguration
*  Schreibschutz der Auswerteelektronik Konfiguration aktivieren

7.1 Testen oder Anpassen des Systems mittels
Sensorsimulation

Verwenden Sie Sensor Simulation, um die Reaktion des Systems auf eine Vielzahl von
Prozessbedingungen zu testen. Dazu gehoéren Grenz-, Problem- und Alarmbedingungen
sowie die Abstimmung des Messkreises.

Einschrankung

Die Sensorsimulation ist nur an Durchflussmesssystemen verfiigbar, die mit einem Core Prozessor
mit erweiterter Funktionalitdt ausgestattet sind.

Vorbereitungsverfahren

Bevor Sie die Sensor Simulation aktivieren, stellen Sie sicher, dass der Prozess die
Auswirkungen der simulierten Prozesswerte tolerieren kann.

Verfahren
1. Navigieren Sie zum Sensorsimulationsmen(.
Kommunikations-Hilfsmittel Meniipfad
Anzeiger Nicht verfiighar
ProLink I ProLink > Configuration > Sensor Simulation
ProLink IlI Device Tools > Diagnostics > Testing > Sensor Simulation
Handterminal Service Tools > Simulate > Simulate Sensor

Aktivieren Sie die Sensor Simulation.

Fir Massedurchfluss setzen Sie Wellenform wie gew{inscht und geben Sie die
erforderlichen Werte ein.

Option Erforderliche Werte
Fixed Fester Wert
Sawtooth Periode

Minimum

Maximum
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Option Erforderliche Werte
Sine Periode
Minimum
Maximum
4. Fiir Dichte setzen Sie Wellenform wie gew(inscht und geben Sie die erforderlichen
Werte ein.
Option Erforderliche Werte
Fixed Fester Wert
Sawtooth Periode
Minimum
Maximum
Sine Periode
Minimum
Maximum
5. Fiir Temperatur setzen Sie Wellenform wie gew{inscht und geben Sie die

erforderlichen Werte ein.

Option Erforderliche Werte
Fixed Fester Wert
Sawtooth Periode
Minimum
Maximum
Sine Periode
Minimum
Maximum

6. Beobachten Sie die Reaktion des Systems auf die simulierten Werte und nehmen Sie
nach Bedarf entsprechende Anderungen an der Konfiguration der
Auswerteelektronik oder am System vor.

7. Modifizieren Sie die simulierten Werte und wiederholen Sie die
Simulationsverfahren.

8. Nachdem Sie alle Test- oder Simulationsverfahren abgeschlossen haben,
deaktivieren Sie die Sensor Simulation.

Sensorsimulation

Mit der Sensorsimulation kénnen Sie das System testen oder den Messkreis einstellen,
ohne die Testbedingungen in Ihrem Prozess erstellen zu miissen. Bei aktivierter
Sensorsimulation gibt die Auswerteelektronik die simulierten Werte fiir Massedurchfluss,
Dichte und Temperatur aus und ergreift alle erforderlichen MaRnahmen. Beispielsweise
kann die Auswerteelektronik eine Abschaltung durchfiihren, ein Ereignis aktivieren oder
einen Alarm setzen.
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7.2

Ist der Simulationsmodus aktiv, werden die simulierten Werte im gleichen Speicher wie die
Prozessdaten vom Sensor abgelegt. Dann werden die simulierten Werte wahrend des
Betriebs der Auswerteelektronik verwendet. Zum Beispie beeinflusst die Simulation:

. Alle Werte wie Massedurchfluss, Temperatur oder Dichte, die auf dem Display
angezeigt oder mittels Ausgdngen oder digitaler Kommunikation ausgegeben
werden

. Die Summen- und Gesamtzahler fiir Masse

o Alle Volumenberechnungen und Daten, inkl. ausgegebener Werte, Volumen-

Summenzahler und Volumen-Gesamtzahler

. Alle im Datenlogger gespeicherten Werte fiir Masse, Dichte oder Volumen
Die Sensorsimulation dandert keine Diagnosewerte.

Im Gegensatz zu tatsdchlichen Massedurchfluss- und Dichtewerten sind die simulierten
Werte nicht temperaturkompensiert (d. h. angepasst an den Temperatureinfluss auf die
Sensormessrohre).

Backup der Auswerteelektronik Konfiguration

ProLink Il und ProLink Ill bieten Upload- und Download-Funktionen fiir die Konfiguration,
um Konfigurationssatze auf lhrem PC zu speichern. Dies ermdglicht ein Sichern und
Wiederherstellen der Auswerteelektronik Konfiguration. AuBerdem ist dies eine bequeme
Methode, um eine Konfiguration tiber mehrere Gerate hinweg zu zu reproduzieren.

Vorbereitungsverfahren

Eine der folgenden Versionen:
o Eine aktive Verbindung von ProLink Il

o Eine aktive Verbindung von ProLink Il

Einschrankung
Diese Funktion ist mit keinem anderen Kommunikations-Hilfsmittel verfiigbar.

Verfahren
. Sichern der Auswerteelektronik Konfiguration mittels ProLink II:

1. File >. Load from Xmtr to File auswahlen.

2. Einen Namen und einen Speicherort fiir die Sicherungsdatei auswahlen und auf
Save klicken.

3. Die Optionen auswahlen, die die Sicherungsdatei enthalten soll, und auf Download
Configuration klicken.

. Backup der Auswerteelektronik Konfiguration mittels ProLink IlI:

1. Device Tools > Configuration Transfer > Save or Load Configuration Data auswahlen.

2. Im Gruppenfeld Configuration die Konfigurationsdaten auswahlen, die gesichert
werden sollen.

3. Auf Save klicken und den Dateinamen und den Speicherort auf Ihrem Computer
auswdhlen.

4. Klicken Sie auf Start Save.

Konfigurations- und Bedienungsanleitung 127



Abschluss der Konfiguration

Die Sicherungsdatei wird mit dem ausgewdhlten Namen und an dem ausgewahlten
Speicherort gespeichert. Sie wird als Textdatei gespeichert und kann mittels beliebigem
Text-Editor gedffnet werden.

7.3 Schreibschutz der Auswerteelektronik
Konfiguration aktivieren

Anzeiger OFF-LINE MAINT > CONFIG > LOCK

ProLink Il ProLink > Configuration > Device > Enable Write Protection

ProLink Il Device Tools > Configuration > Write-Protection

Handterminal Configure > Manual Setup > Info Parameters > Transmitter Info > Write Protect
Uberblick

Wenn die Auswerteelektronik schreibgeschiitzt ist, ist die Konfiguration gesperrt und kann
nicht gedndert werden. Zum Andern der Konfiguration muss die Sperre aufgehoben
werden. Dadurch werden unbeabsichtigte oder unbefugte Anderungen an den
Konfigurationsparametern der Auswerteelektronik verhindert.
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8 Einstellungen der eichamtlichen
Transfer Anwendung

In diesem Kapitel behandelte Themen:

»  Eichamtliche Transfer Anwendung

e Einrichtung der eichamtlichen Transfer Anwendung unter Verwendung von
ProLink Il

e Einrichtung der eichamtlichen Transfer Anwendung unter Verwendung von
ProLink Il

Die Informationen in diesem Kapitel sind nur anwendbar, wenn lhre Auswerteelektronik
mit der eichamtlichen Transfer Anwendung bestellt wurde.

8.1 Eichamtliche Transfer Anwendung

Die eichamtliche Transfer Anwendung wird verwendet fiir Prozessdaten bei gesetzlichen
eichamtlichen Transfer Anwendungen, wenn eine zugelassene Methode zum Lesen oder
Erlangen der Messung verwendet wird.

Aufsichtsbehorden

Wenn die Micro Motion eichamtliche Transfer Anwendung gemdR den Empfehlungen
installiert, konfiguriert und eingesetzt wird, ist sie von den folgenden Aufsichtsbehérden
zertifiziert:

. NTEP (National Type Evaluation Program); NTEP Auflagen gelten in den USA und
Kanada.

. OIML (Organization of Legal Metrology); OIML Auflagen gelten in den restlichen
Landern der Welt.

Je nach der fiir Ihre Installation zustandigen Aufsichtsbehorde sind Einstellung,
Konfiguration und Betriebsmethoden unterschiedlich.

Gesichert und ungesichert

Bei der Installation der eichamtlichen Transfer Anwendung ist die Auswerteelektronik
immer auf “gesichert” oder “ungesichert eingestellt.” Die werkseitige Einstellung der
Auswerteelektronik ist ungesichert, und der Statusalarm A027 Sicherheitsverletzung ist
aktiv. AuBerdem kann die Durchflussmessung deaktiviert sein. Die Messdaten von einer
nicht gesicherten Auswerteelektronik diirfen nicht fiir eichamtliche Transfer
Anwendungen verwendet werden.

Um den Alarm zu |6schen und die Durchflussmessung zu aktivieren, muss die eichamtliche
Transfer Anwendung konfiguriert und die Auswerteelektronik gesichert werden. Sobald
die Auswerteelektronik gesichert ist, erfolgt die Loschung des Alarms und die Aktivierung
der Auswerteelektronik automatisch.

Sicherheitstypen und Anforderungen

Bevor die Auswerteelektronik fiir eichamtliche Transfer Anwendungen verwendet wird,
muss die metrologische und physikalische Sicherheit gewahrleistet werden.
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Metrologische Die metrologische Sicherheit schiitzt die Auswerteelektronik vor allen

Sicherheit Verdanderungen, die sich auf die Messwerte auswirken kénnen. Hierzu
gehéren Anderungen der Konfiguration und bestimmte
Wartungsverfahren.
Micro Motion implementiert die metrologische Sicherheit tiber
“Software-Sicherheit.” Software-Sicherheit ist eine Einstellung in der
Auswerteelektronik, die unzuldssige Vorgange tiber das Programm
blockiert. Die Software-Sicherheit kann ProLink Il und ProLink IlI
aktiviert bzw. deaktiviert werden. In der Praxis bedeutet diese
Software-Sicherheit einen vollstandigen Schutz gegen jegliche
unzuldssige Anderungen oder Vorginge.

Physikalische  Die physikalische Sicherheit wird durch eine von einem zertifizierten

Sicherheit eichamtlichen Priifer angebrachte Plombe gewahrleistet. Die Plombe
verhindert den Zugang zu den Service Port Anschlussklemmen.
Die Plombe ldsst sich zwar leicht zerstéren, kann jedoch nur von
einem eichamtlichen Priifer ersetzt werden. Auf diese Weise ist eine
Sicherheitsverletzung sofort erkennbar. Wenn die Plombe nicht intakt
ist, sind die Messwerte der Auswerteelektronik fiir den eichamtlichen
Transfer nicht zulassig.

Konfigurationsmethoden

Zur Konfiguration der eichamtlichen Transfer Parameter miissen ProLink Il oder ProLink IlI
und ein Service Port Anschluss verwendet werden.

Einrichtung der eichamtlichen Transfer
Anwendung unter Verwendung von ProLink i

Wenn lhre Auswerteelektronik so eingerichtet ist, dass sie die Anforderungen von OIML
oder NTEP erfiillt und die Auswerteelektronik “gesichert” ist, sind ausgewdhlte Messdaten
von der Auswerteelektronik fiir die eichamtlichen Transfer Anwendungen zugelassen.

Vorbereitungsverfahren

Wichtig
Priifen Sie die Anforderungen fiir den eichamtlichen Transfer fiir lhren Standort und vergewissern Sie
sich, dass diese sowie die Anforderungen von OIML oder NTEP erfiillt sind.

Falls erforderlich fiir lhre Installation, bitten Sie einen zertifizierten eichamtlichen Priifer
um einen Besuch und stellen Sie sicher, dass der Priifer den entsprechenden Teilen des
Verfahrens beiwohnt.

Vergewissern Sie sich, dass die Auswerteelektronik fiir die Sicherung bereit ist, d. h. dass
sie richtig konfiguriert ist und alle nétigen Tests und Einstellungen durchgefiihrt wurden.
Nach der Sicherung der Auswerteelektronik kann die Konfiguration nicht mehr gedndert
werden, viele Wartungsvorgange sind nicht zuldssig und auch bestimmte
Bedienereingriffe sind nicht erlaubt.

Verfahren
1. Stellen Sie eine Service Port Verbindung von ProLink Il zu Ihrer Auswerteelektronik
her.
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2. Navigieren Sie zum Men(i fiir die eichamtliche Transfer-Anwendung: ProLink >
Configuration > System.

3. Setzen Sie die Approval auf die entsprechende Behorde fiir lhre Anwendung.

4, Stellen Sie die Totalizer Reset Options nach Bedarf ein.

Option Beschreibung

Nicht (iber Bedieninterface Wenn die Auswerteelektronik gesichert ist, kdnnen die Sum-

oder digitale Kommunikation menzahler nicht (iber das Bedieninterface oder digitale Kom-

riicksetzbar munikation zuriickgesetzt werden.

Nur Uber digitale Kommunika- | Wenn die Auswerteelektronik gesichert ist, miissen die Sum-

tion riicksetzbar menzahler Giber die digitale Kommunikation zuriickgesetzt
werden.

Uber Bedieninterface und digi- = Wenn die Auswerteelektronik gesichert ist, kdnnen die Sum-
tale Kommunikation riicksetz- | menzéhler entweder iber das Bedieninterface oder digitale
bar Kommunikation zurliickgesetzt werden.

Nur iiber Bedieninterface riick- | Wenn die Auswerteelektronik gesichert ist, miissen die Sum-
setzbar menzdhler Giber das Bedieninterface zuriickgesetzt werden.

Alle Ubertragungsmethoden mittels Modbus- oder HART-Kommunikation fiir die
Auswerteelektronik werden als “digitale Kommunikation” bezeichnet. Hierzu
gehoren ProLink II, ProLink Ill der Handterminal und alle Hosts.

5. Falls fiir Ihre Installation erforderlich, konfigurieren Sie Ihre Auswerteelektronik fiir
zwei Frequenzausgange und stellen Sie diese auf Quadraturbetrieb ein.

a. Wabhlen Sie ProLink > Configuration > Channel.

b. Stellen Sie Channel B Type Assignmen auf Frequency Output ein und klicken Sie auf
Apply.

c. Stellen Sie Channel C Type Assignment auf Frequency Output ein und klicken Sie auf
Apply.

d. Widhlen Sie ProLink > Configuration > Frequency und stellen Sie den Freq Output Mode
auf Quadrature.

6. Falls fir Ihre Installation erforderlich, aktivieren Sie das Alarmmeni-Passwort fiir die
Anzeige: ProLink > Configuration > Display.

Ein Alarmmenii-Passwort ist in Deutschland fiir die PTB-Zulassung fiir Gasanwendungen
erforderlich und kann auch an anderen Standorten und fiir andere Anwendungen
vorgeschrieben sein.

7. Falls fiir Ihre Installation erforderlich, lesen und notieren Sie die Firmware-
Prifsummenwerte fiir die Auswerteelektronik und den Core Prozessor: ProLink >
Konfiguration > Device.

Die Werte der Priifsumme der Auswerteelektronik Firmware und der Core Prozessor
Firmware miissen wahrend der Inbetriebnahme gelesen werden, um den
Anforderungen fiir den eichamtlichen Transfer fiir Gasanwendungen in Deutschland
zu entsprechen. Diese kénnen ebenfalls fiir die MID/Welmec 7.2 Testberichte
hilfreich sein.

8. Falls fiir Ihre Installation erforderlich, konfigurieren Sie den Field Verification Zero (FVZ)
als Displyvariable. Beobachten und notieren Sie dann den aktuellen Wert fiir FVZ:
ProLink > Configuration > Display.
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FVZist eine Diagnosevariable, die den Nullpunktwert (iber einen Zeitraum von

3 Minuten Gberwacht. Sie muss bei der Inbetriebnahme des Messgerats abgelesen
werden, um die Anforderungen fiir eichamtliche Transfer-Anwendungen in der
Messgerate Richtlinie (MID) 2004/22/EG zu erfiillen. Detaillierte Anweisungen
hierzu finden Sie in den Standard Arbeitsanweisungen.

9. Software-Sicherheit aktivieren:

a. Wabhlen Sie Plug-ins > Enable/Disable Custody Transfer.
b. Klicken Sie auf Enable Custody Transfer.

Wichtig
Je nach ortlich geltenden Gesetzen muss dieser Vorgang moglicherweise von einem
zertifizierten eichamtlichen Priifer beaufsichtigt werden.

Nach diesem Schritt ist die Auswerteelektronik metrologisch sicher. Die
Auswerteelektronik fiihrt folgende Aktionen durch:

 Sicherung aller Messparameter. Die aktuellen Konfigurationen kénnen
abgelesen, aber nicht gedandert werden.

* Loschen des Statusalarms A027: Sicherheitsverletzung

10.  Anbringen der Plombe

Wichtig

In den meisten Installationen muss die Draht-Plombe von einem zertifizierten eichamtlichen
Priifer angebracht werden. Der Priifer stellt die Plombe bereit. Die Plombe wird durch die
Sperrklammer der Auswerteelektronik (falls vorhanden an Ihrer Auswerteelektronik)
eingesetzt.

Einrichtung der eichamtlichen Transfer
Anwendung unter Verwendung von ProLink Il

Wenn lhre Auswerteelektronik so eingerichtet ist, dass sie die Anforderungen von OIML
oder NTEP erfiillt und die Auswerteelektronik “gesichert” ist, sind ausgewahlte Messdaten
von der Auswerteelektronik fiir die eichamtlichen Transfer Anwendungen zugelassen.

Vorbereitungsverfahren

Wichtig
Priifen Sie die Anforderungen fiir den eichamtlichen Transfer fiir Ihren Standort und vergewissern Sie
sich, dass diese sowie die Anforderungen von OIML oder NTEP erfiillt sind.

Falls erforderlich fir lhre Installation, bitten Sie einen zertifizierten eichamtlichen Priifer
um einen Besuch und stellen Sie sicher, dass der Priifer den entsprechenden Teilen des
Verfahrens beiwohnt.

Vergewissern Sie sich, dass die Auswerteelektronik fiir die Sicherung bereit ist, d. h. dass
sie richtig konfiguriert ist und alle nétigen Tests und Einstellungen durchgefiihrt wurden.
Nach der Sicherung der Auswerteelektronik kann die Konfiguration nicht mehr gedndert
werden, viele Wartungsvorgange sind nicht zuldssig und auch bestimmte
Bedienereingriffe sind nicht erlaubt.
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Verfahren
1. Stellen Sie eine Service Port Verbindung von ProLink Ill zu Ihrer Auswerteelektronik
her.

2. Wdhlen Sie Device Tools > Configuration > Weights & Measures und setzen Sie die
Aufsichtsbehdrde auf die entsprechende Behérde fiir lhre Anwendung.

3. Waihlen Sie Device Tools > Configuration > Totalizer Control Methods und stellen Sie die
Zahler Steuerungsmethoden nach Bedarf ein.

Parameter Option
Summenzahler von dem Bedie- e Aktiviert: Sie kénnen die Summenzahler von dem Bedie-
ninterface zuriicksetzen ninterface zuriicksetzen, gleichgiltig, ob die Auswertee-

lektronik gesichert ist oder nicht.

e Deaktiviert: Sie kdnnen die Summenzahler von dem Be-
dieninterface zuriicksetzen, aber nur wenn die Auswer-
teelektronik nicht gesichert ist.

Ricksetzen der Summenzahler | Aktiviert: Sie konnen die Summenzéhler Giber digitale

iiber externe Kommunikation Kommunikation zurlicksetzen, gleichgiltig, ob die Aus-
werteelektronik gesichert ist oder nicht.

e Deaktiviert: Sie kdnnen die Summenzahler tiber digitale
Kommunikation zurlicksetzen, aber nur wenn die Aus-
werteelektronik nicht gesichert ist.

Alle Ubertragungsmethoden mittels Modbus- oder HART-Kommunikation fiir die
Auswerteelektronik werden als “digitale Kommunikation” bezeichnet. Hierzu
gehoren ProLink I, ProLink Ill der Handterminal und alle Hosts.

4, Falls fiir Ihre Installation erforderlich, konfigurieren Sie Ihre Auswerteelektronik fiir
zwei Frequenzausgange und stellen Sie diese auf Quadraturbetrieb ein.
a. Wahlen Sie Device Tools > Configuration > I/0 > Channels.

b. Fiir Channel B stellen Sie den Channel Type auf Frequency Output ein und klicken Sie
auf Apply.

c. Fiir Channel C stellen Sie den Channel Type auf Frequency Output ein und klicken Sie
auf Apply.

d. Wahlen Sie Device Tools > Configuration > I/0 > Outputs > Frequency Output Mode und
dann Quadrature.

5. Falls fiir Ihre Installation erforderlich, wdhlen Sie Device Tools > Configuration >
Transmitter Display > Display Security. Aktivieren und konfigurieren Sie dann ein
Passwort fiir das Alarmmendi.

Die Sicherung des Alarmmeniis ist in Deutschland fiir PTB-Zulassungen fiir
Gasanwendungen gesetzlich vorgeschrieben.

6. Falls fiir Ihre Installation erforderlich, wahlen Sie Device Tools > Device Information. Dann
lesen und notieren Sie die Firmware-Priifsummenwerte fir die Auswerteelektronik
und den Core Prozessor.
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Die Werte der Priifsumme der Auswerteelektronik Firmware und der Core Prozessor
Firmware miissen wahrend der Inbetriebnahme gelesen werden, um den
Anforderungen fiir den eichamtlichen Transfer fiir Gasanwendungen in Deutschland
zu entsprechen. Diese kénnen ebenfalls fiir die MID/Welmec 7.2 Testberichte
hilfreich sein.

Falls fiir Ihre Installation erforderlich, Giberwachen Sie den Nullpunktwert lhres
Systems:

a. Waihlen Sie Device Tools > Configuration > Transmitter Display > Display Variables und
konfigurieren Sie Field Verification Zero (FVZ) als Displayvariable.

b. Lesen und notieren Sie den aktuellen Wert fiir FVZ auf der Anzeige der
Auswerteelektronik.

FVZist eine Diagnosevariable, die den Nullpunktwert iber einen Zeitraum von

3 Minuten iberwacht. Sie muss bei der Inbetriebnahme des Messgerats abgelesen
werden, um die Anforderungen fiir eichamtliche Transfer-Anwendungen in der
Messgerate Richtlinie (MID) 2004/22/EG zu erfiillen. Detaillierte Anweisungen
hierzu finden Sie in den Standard Arbeitsanweisungen.

Software-Sicherheit aktivieren: Device Tools > Configuration > Weights & Measures >
Software Security.

Wichtig
Je nach értlich geltenden Gesetzen muss dieser Vorgang moglicherweise von einem
zertifizierten eichamtlichen Priifer beaufsichtigt werden.

Nach diesem Schritt ist die Auswerteelektronik metrologisch sicher. Die
Auswerteelektronik fiihrt folgende Aktionen durch:

 Sicherung aller Messparameter. Die aktuellen Konfigurationen kénnen
abgelesen, aber nicht geandert werden.

* Loschen des Statusalarms A027: Sicherheitsverletzung

Anbringen der Plombe

Wichtig

In den meisten Installationen muss die Draht-Plombe von einem zertifizierten eichamtlichen
Priifer angebracht werden. Der Priifer stellt die Plombe bereit. Die Plombe wird durch die
Sperrklammer der Auswerteelektronik (falls vorhanden an Ihrer Auswerteelektronik)
eingesetzt.
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Teil Il

Geschaftstatigkeit, wartung sowie
Fehlersuche und -beseitigung

In diesem Teil enthaltene Kapitel:

. Auswerteelektronikbetrieb

Betrieb der Auswerteelektronik mit der eichamtlichen Transfer Anwendung
. Messunterstiitzung

e Stérungsanalyse und -behebung
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9 Auswerteelektronikbetrieb

In diesem Kapitel behandelte Themen:

*  Notieren der Prozessvariablen

*  Anzeigen von Prozessvariablen

*  Auswerteelektronik-Status anhand der Status-LED anzeigen
e Anzeigen und Bestdtigen von Statusalarmen

*  Lesenvon Gesamt- und Summenzdhlerwerten

e Starten und Stoppen von Gesamt- und Summenzdéhlern

e Zdbhler zuriicksetzen

e Gesamtzdhler zurticksetzen

9.1 Notieren der Prozessvariablen

Micro Motion empfiehlt die Aufzeichnung von speziellen Messungen von Prozessvariablen
einschlieRlich des akzeptablen Messbereiches unter normalen Betriebsbedingungen. Mit
diesen Daten kénnen Sie leichter erkennen, wann Prozessvariablenwerte ungewdhnlich
hoch oder niedrig sind, und sie konnen Ihnen dabei helfen, Anwendungsprobleme besser
zu diagnostizieren und zu lésen.

Verfahren

Notieren Sie die folgenden Prozessvariablen unter normalen Betriebsbedingungen:

Messung

Prozessvariable Typischer Durchschnitt Typisch hoch Typisch niedrig

Durchfluss
Dichte

Temperatur

Messrohrfrequenz

Aufnehmerspannung

Antriebsverstarkung
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9.2 Anzeigen von Prozessvariablen

Anzeiger Bldttern Sie zur gewiinschten Prozessvariablen. Sofern AutoScroll aktiviert ist, warten Sie,
bis die gewlinschte Prozessvariable angezeigt wird. Weitere Informationen finden Sie in
Abschnitt 9.2.1.

ProLink Il ProLink > Process Variables
ProLink > API process variables (Mineral6lmessung)

ProLink > CM process variables (Konzentrationsmessung)

ProLink Il Die gewlinschte Variable kann auf dem Hauptbildschirm unter Process Variables ange-
zeigt werden. Weitere Informationen finden Sie in Abschnitt 9.2.2.

Handterminal Overview > Shortcuts > Variables > Process Variables

Uberblick

Prozessvariablen liefern Informationen (iber den Zustand des Prozessmediums, wie
Stromungsgeschwindigkeit, Dichte und Temperatur sowie (iber aktuelle Summen.
Prozessvariablen kénnen auRerdem Daten (iber den Betrieb des Durchflussmessgerats
bereitstellen, wie Antriebsverstarkung und Aufnehmerspannung. Diese Informationen
kénnen zum besseren Verstdandnis des Prozesses und zur Storungssuche und -beseitigung
verwendet werden.

9.2.1 Anzeigen von Prozessvariablen mittels Display

Zeigen Sie die gewiinschte(n) Prozessvariable(n) an.

StandardmaRig werden auf dem Display der Auswerteelektronik die Massedurchflussrate,
die Gesamtmasse, die Volumendurchflussrate, die Temperatur, die Dichte und die
Antriebsverstarkung angezeigt. Auf dem Display wird der abgekiirzte Name der
Prozessvariable (z. B. DENS fiir Dichte), der aktuelle Wert der Prozessvariable und die
zugehdrige Messeinheit (z. B. GICM3) angezeigt.

Bei Bedarf kann das Display so konfiguriert werden, dass andere Prozessvariablen, wie z. B.
Summen- und Gesamtzahler, angezeigt werden.

Sofern Auto Scroll aktiviert ist, werden auf dem Display nacheinander und fiir eine zuvor
vom Anwender festgelegte Zeitdauer die konfigurierten Display-Variablen angezeigt.
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9.2.2

9.3
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Abbildung 9-1: Auswerteelektronik-Displayfunktionen
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Status-LED
LC-Display
Prozessvariable

Optischer Schalter Scroll

Anzeige fiir optischen Schalter: leuchtet rot, wenn entweder Scroll oder Select aktiviert wird
Optischer Schalter Select

Messeinheit fiir Prozessvariable

Aktueller Wert der Prozessvariable

TomMTmoN®>

Anzeigen von Prozessvariablen mittels ProLink IlI

Sobald eine Verbindung zu einem Gerdt hergestellt ist, werden die Prozessvariablen auf
dem Hauptbildschirm von ProLink Il angezeigt.

Verfahren

Zeigen Sie die gewiinschte(n) Prozessvariable(n) an.

Hinweis

ProLink Il ermdglicht Ihnen das Auswahlen der Prozessvariablen, die auf dem Hauptbildschirm
angezeigt werden sollen. AuRBerdem kénnen Sie wahlen, ob die Daten in der Ansicht Analog Gauge
oder als Digitalanzeige angezeigt werden sollen, und Sie kénnen die Anzeigeeinstellungen anpassen.
Weitere Informationen finden Sie in der ProLink Il Betriebsanleitung.

Auswerteelektronik-Status anhand der Status-
LED anzeigen

Die Status-LED zeigt die aktuelle Alarmbedingung der Auswerteelektronik. Die Status-LED
befindet sich vorne an der Auswerteelektronik.
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Status-LED am Bedieninterface-Modul der Auswerteelektronik anzeigen.
* Bei einer Auswerteelektronik mit Display ist die Status-LED bei geschlossenem
Auswerteelektronik-Gehdusedeckel sichtbar.

* Beieiner Auswerteelektronik ohne Display ist die Status-LED nur sichtbar, wenn der
Auswerteelektronik-Gehdusedeckel entfernt wird.

Zur Interpretation der Status-LED siehe Tabelle 9-1.

Einschrdankung

Wenn LED Blinking deaktiviert ist, wird die Status-LED blinkt nur wihrend der Kalibrierung. Es wird
nicht blinken, um einen unbestdtigten Alarm geben.

Tabelle 9-1: Status-LED-Zustdnde

LED-Verhalten Alarmbedingung Beschreibung

Dauerhaft griin Kein Alarm Normalbetrieb

Gelb blinkend Kein Alarm Nullpunktkalibrierung lauft

Dauerhaft gelb Alarm niedriger Stufe Alarmbedingung, die keinen Messfehler verursacht

(Ausgange liefern weiterhin Prozessdaten)

Dauerhaft rot Alarm hoher Stufe Alarmbedingung, die einen Messfehler verursacht
(Ausgange sind auf Stérung)

9.4 Anzeigen und Bestdtigen von Statusalarmen

Die Auswerteelektronik gibt einen Statusalarm aus, sobald eine Prozessvariable die
definierten Grenzen Uberschreitet oder die Auswerteelektronik eine Stérung erkennt.
Aktive Alarme kénnen angezeigt und Alarme bestatigt werden.

9.4.1 Anzeigen und Bestdtigen von Alarmen mittels Display

Sie konnen eine Liste mit allen aktiven oder inaktiven aber unbestétigten Alarmen
anzeigen. Sie konnen einzelne Alarme auf dieser Liste bestatigen.

Anmerkung

Es werden nur Stérungs- und informative Alarme aufgefiihrt. Alarme mit Status Alarmstufe Ignorieren
werden von der Auswerteelektronik automatisch herausgefiltert.

Vorbereitungsverfahren

Der Anwenderzugriff auf das Alarmmeni muss aktiviert sein (Voreinstellung). Wenn der
Anwenderzugriff auf das Alarmmen( deaktiviert ist, muss eine andere Methode verwendet
werden, um Statusalarme anzeigen oder bestdtigen zu kénnen.

Verfahren

Siehe Abbildung 9-2.
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Abbildung 9-2: Verwenden des Displays, um Statusalarme anzeigen und bestdtigen zu konnen

Scroll und Select gleichzeitig
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v

SEE ALARM

A 4
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ACK ALL
Ja | Nein
Nein
A4
EXIT

v

Aktive/
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Alarme?
Ja Neir—
\ 4 \ 4
Alarmcode NO ALARM

|

ACK EXIT

Nachbereitungsverfahren

. Um die folgenden Alarme zu I6schen, missen Sie das Problem beheben, den Alarm
bestdtigen und anschlieBend die Auswerteelektronik aus- und wieder einschalten:
A001, A002,A010,A011, A012,A013,A018, A019, A022, A023, A024, A025, A028,

A029, A031.
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. Fir alle anderen Alarme:
- War der Alarm bei der Bestdtigung inaktiv, wird er aus der Liste geléscht.

- War der Alarm bei der Bestdtigung aktiv, wird er von der Liste entfernt, sobald
die Alarmbedingung gel6scht ist.

9.4.2 Anzeigen und Bestatigen von Alarmen mittels ProLink Il
Sie kdnnen eine Liste mit allen aktiven oder inaktiven aber unbestdtigten Alarmen
anzeigen. Sie konnen einzelne Alarme auf dieser Liste bestatigen.

1. Wahlen Sie ProLink > Alarm Log.
2. Wihlen Sie den Bereich High Priority oder Low Priority.

Anmerkung

Das Gruppieren von Alarmen in diese beiden Kategorien ist fest programmiert und wird durch
Status Alarm Severity nicht beeinflusst.

Alle aktiven oder nicht bestdtigten Alarme sind aufgefiihrt:
* Rote Anzeige: Alarm ist derzeit aktiv.

e Griine Anzeige: Alarm ist nicht aktiv, aber nicht bestdtigt.

Anmerkung

Es werden nur Stérungs- und informative Alarme aufgefiihrt. Alarme mit Status Alarmstufe
Ignorieren werden von der Auswerteelektronik automatisch herausgefiltert.

3. Markieren Sie das Kontrollkdstchen Ack, um einen Alarm zu bestdtigen.
Nachbereitungsverfahren

. Um die folgenden Alarme zu |6schen, miissen Sie das Problem beheben, den Alarm
bestdtigen und anschlieBend die Auswerteelektronik aus- und wieder einschalten:
A001, A002,A010,A011, A012,A013, A018, A019, A022, A023, A024, A025, A028,
A029, A031.

. Fiir alle anderen Alarme:
- War der Alarm bei der Bestdtigung inaktiv, wird er aus der Liste geléscht.

- War der Alarm bei der Bestdtigung aktiv, wird er von der Liste entfernt, sobald
die Alarmbedingung gel6scht ist.

9.4.3 Anzeigen und Bestatigen von Alarmen mittels ProLink Il

Sie konnen eine Liste mit allen aktiven, inaktiven oder unbestdtigten Alarmen anzeigen.
Bestimmte Alarme kénnen in der Liste bestdtigt oder alle Alarme als bestatigt ausgewahlt
werden.

1. Alle Alarme kénnen im ProLink Ill Hauptbildschirm unter Alerts angezeigt werden.

Alle aktiven oder unbestétigten Alarme werden aufgefiihrt und entsprechend den
folgenden Kategorien angezeigt:
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9.4.4
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Kategorie Beschreibung
Failed: Fix Now Ein Messgerétefehler ist aufgetreten und erfordert unverziigliche
MaRnahmen.

Maintenance: Fix Soon | Ein Zustand ist aufgetreten, der zu einem spdteren Zeitpunkt beho-
ben werden kann.

Advisory: Informational | Ein Zustand ist aufgetreten, der kein Eingreifen erfordert.

Anmerkungen
e Alle Fehleralarme werden in der Kategorie Failed: Fix Now angezeigt.

e Alle Informationsalarme werden entweder in der Kategorie Maintenance: Fix Soon oder
Advisory: Informational angezeigt. Die Kategoriezuweisung ist fest programmiert.

e Alarme mit Alert Severity Ignore werden von der Auswerteelektronik automatisch
herausgefiltert.

2. Markieren Sie das Kontrollkdstchen Ack fiir einen bestimmten Alarm, um diesen zu
bestdtigen. Klicken Sie auf Ack All, um alle Alarme auf einmal zu bestédtigen.

Nachbereitungsverfahren

. Um die folgenden Alarme zu I6schen, missen Sie das Problem beheben, den Alarm
bestdtigen und anschlieBend die Auswerteelektronik aus- und wieder einschalten:
A001, A002,A010,A011,A012,A013, A018, A019, A022, A023, A024, A025, A028,
A029, A031.

o Fiir alle anderen Alarme:
- War der Alarm bei der Bestatigung inaktiv, wird er aus der Liste geldscht.

- Warder Alarm bei der Bestdtigung aktiv, wird er von der Liste entfernt, sobald
die Alarmbedingung geldscht ist.

Anzeigen von Alarmen mit Handterminal

Sie kénnen eine Liste mit allen aktiven oder inaktiven aber unbestatigten Alarmen
anzeigen. Sie konnen einzelne Alarme auf dieser Liste bestatigen.

. Zur Anzeige von aktiven oder unbestatigten Alarmen, Service Tools > Alerts driicken.

Alle aktiven oder nicht bestatigten Alarme sind aufgefiihrt.

Anmerkung

Es werden nur Stérungs- und informative Alarme aufgefiihrt. Alarme mit Status Alarmstufe
Ignorieren werden von der Auswerteelektronik automatisch herausgefiltert.

o Zur Bestatigung eines Alarms Service Tools > Alerts driicken, den entsprechenden
Alarm wahlen und anschlieBend XXXXX driicken.

- Um die folgenden Alarme zu I6schen, miissen Sie das Problem beheben, den
Alarm bestatigen und anschlieBend die Auswerteelektronik aus- und wieder
einschalten: AO01, A002, A010, A011,A012,A013, A018, A019, A022, A023,
A024, A025, A028, A029, A031.

- Furalle anderen Alarme:

- War der Alarm bei der Bestatigung inaktiv, wird er aus der Liste geloscht.
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- War der Alarm bei der Bestdtigung aktiv, wird er von der Liste entfernt, sobald
die Alarmbedingung gel6scht ist.

. Zur Aktualisierung der Liste von aktiven oder unbestdtigten Alarmen, Service Tools >
Alerts > Refresh Alerts driicken.

9.4.5 Alarmdaten im Auswerteelektronik-Speicher

Die Auswerteelektronik speichert drei Datensets fiir jeden Alarm.

Fiir jedes Alarmvorkommen werden die folgenden drei Datensets im Auswerteelektronik-
Speicher gepflegt:

. Alarmliste
. Alarmstatistik

. Neueste Alarme

Tabelle 9-2: Alarmdaten im Auswerteelektronik-Speicher

Auswerteelektronik-Aktion bei Eintreten der Bedingung

Alarmdatenstruktur | Inhalt Loschen

Alarmliste Je nach Bestimmung durch die Alarmstatus- Bei jedem Aus-/Einschalten der Spannungsver-
bits; eine Liste mit: sorgung zur Auswerteelektronik geléscht und
e Allen derzeit aktiven Alarmen neu generiert

¢ Allen zuvor aktiven Alarmen, die noch
nicht bestétigt wurden

Alarmstatistik Ein Datensatz fiir jeden Alarm (nach Alarm- Nicht geldscht; gespeichert auch nach Aus-/

nummer), der seit der letzten Hauptriickset- | Einschalten der Auswerteelektronik

zung gesetzt wurde. Jeder Eintrag enthdlt:

* Eine Z&hlung der Vorkommen

e Zeitstempel fiir die neuesten gesetzten
und geldschten Alarme

Neueste Alarme 50 zuletzt gesetzte oder geldschte Alarme Nicht gel6scht; gespeichert auch nach Aus-/
Einschalten der Auswerteelektronik

9.5 Lesen von Gesamt- und Summenzdhlerwerten
Display Damit ein Gesamt- oder Summenzdhlerwert vom Display abgelesen werden kann, muss

er zuvor als Displayvariable konfiguriert worden sein.

ProLink Il ProLink > Totalizer Control

ProLink Il Die gewlinschte Variable kann auf dem Hauptbildschirm unter Process Variables ange-
zeigt werden.

Handterminal Service Tools > Variables > Totalizer Control
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Uberblick

Gesamtzadhler erfassen die von der Auswerteelektronik seit der letzten
Gesamtzahlerriicksetzung gemessene Masse und das Volumen. Summenzahler erfassen
die von der Auswerteelektronik seit der letzten Summenzahlerriicksetzung gemessene
Masse und das Volumen.

Hinweis
Die Summenzahler kdnnen als laufende Summe von Masse und Volumen (iber mehrere
Gesamtzdhlerriicksetzungen verwendet werden.

Starten und Stoppen von Gesamt- und
Summenzdhlern

Display Siehe Abschnitt 9.6.1.

ProLink Il ProLink > Totalizer Control > Start
ProLink > Totalizer Control > Stop

ProLink Il Device Tools > Totalizer Control > Totalizer and Inventories > Start All Totals

Device Tools > Totalizer Control > Totalizer and Inventories > Stop All Totals

Handterminal Service Tools > Variables > Totalizer Control > All Totalizers > Start Totalizers

Service Tools > Variables > Totalizer Control > All Totalizers > Stop Totalizers

Uberblick

Durch Starten eines Gesamtzdhlers werden Prozessmessungen tiberwacht. In einer
typischen Anwendung erhéht sich der Wert mit dem Durchfluss. Durch Stoppen eines
Gesamtzahlers wird die Uberwachung der Prozessmessungen gestoppt und sein Wert wird
nicht mehr durch den Durchfluss beeinflusst. Summenzéhler werden durch Starten und
Stoppen der Gesamtzahler automatisch gestartet und gestoppt.

Wichtig

Gesamt- und Summenzahler werden stets als Gruppe gestartet oder gestoppt. Wenn ein
Gesamtzdhler gestartet wird, werden gleichzeitig auch alle anderen Gesamt- und Summenzéhler
gestartet. Wenn ein Gesamtzdahler gestoppt wird, werden gleichzeitig auch alle anderen Gesamt-
und Summenzdhler gestoppt. Summenzahler kénnen nicht direkt gestartet oder gestoppt werden.

Starten und Stoppen der Summen- und Gesamtzahler
mit dem Display

Vorbereitungsverfahren

Die Displayfunktion ,Totalizer Start/Stop“ muss aktiviert sein.

Mindestens ein Summenzdhler muss als Displayvariable konfiguriert sein.

Verfahren

. So starten Sie alle Summen- und Gesamtzahler mit dem Display:

Micro Motion® Auswerteelektronik Modell 2700 mit eigensicheren Ausgédngen



Auswerteelektronikbetrieb

o vk wN

. Scrollen, bis das Wort TOTAL in der linken unteren Ecke des Displays angezeigt

wird.

Wichtig
Da alle Summenzdhler zusammen gestartet oder gestoppt werden, spielt es keine Rolle,
welche Summe verwendet wird.

Wiéhlen Sie Select.

Scrollen, bis START unter dem aktuellen Summenzahlerwert angezeigt wird.
Wiéhlen Sie Select.

Wabhlen Sie Select erneut, um die Auswahl zu bestdtigen.

Scrollen, bis EXIT erscheint.

. Stoppen aller Summen- und Gesamtzahler mit dem Display:

1.

o vk wWwN

Scrollen, bis das Wort TOTAL in der linken unteren Ecke des Displays angezeigt
wird.

Wichtig
Da alle Summenzéhler zusammen gestartet oder gestoppt werden, spielt es keine Rolle,
welche Summe verwendet wird.

Wabhlen Sie Select.

Scrollen, bis STOP unter dem aktuellen Summenzéhler angezeigt wird.
Wiéhlen Sie Select.

Wabhlen Sie Select erneut, um die Auswahl zu bestdtigen.

Scrollen, bis EXIT erscheint.

9.7 Zdhler zuriicksetzen

Display

Siehe Abschnitt 9.7.1.

ProLink Il

ProLink > Totalizer Control > Reset Mass Total
ProLink > Totalizer Control > Reset Volume Total
ProLink > Totalizer Control > Reset Gas Volume Total

ProLink > Totalizer Control > Reset

ProLink Il

Device Tools > Totalizer Control > Totalizer and Inventories > Reset Mass Total
Device Tools > Totalizer Control > Totalizer and Inventories > Reset Volume Total
Device Tools > Totalizer Control > Totalizer and Inventories > Reset Gas Total

Device Tools > Totalizer Control > Totalizer and Inventories > Reset All Totals

Handterminal Service Tools > Variables > Totalizer Control > Mass > Mass Total

Service Tools > Variables > Totalizer Control > Gas Standard Volume > Volume Total
Service Tools > Variables > Totalizer Control > Gas Standard Volume > GSV Total

Service Tools > Variables > Totalizer Control > All Totalizers > Reset All Totals
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Uberblick

Wenn der Zahler zuriickgesetzt wird, setzt die Auswerteelektronik seinen Wert auf 0.
Hierbei spielt es keine Rolle, ob der Zahler gestartet oder gestoppt wurde. Wenn der
Zahler gestartet wurde, wird die Uberwachung der Prozessmessung fortgefiihrt.

Hinweis
Wenn ein einzelner Zéhler zuriickgesetzt wird, werden die Werte der anderen Z&hler nicht
zurlickgesetzt. Gesamtzahlerwerte werden nicht zuriickgesetzt.

Summenzadhler mit dem Bedieninterface zurlicksetzen

Vorbereitungsverfahren
Die Bedieninterface Funktion Summenzdhler zuriicksetzen muss aktiviert sein.
Der Summenzdhler, den Sie zuriicksetzen méchten, muss als eine Displayvariable

konfiguriert sein. Beispiel:

. Wenn Sie den Masse Summenzahler zurlicksetzen moéchten, muss Mass Total als eine
Displayvariable konfiguriert sein.

. Wenn Sie den Volumen Summenzdhler zuriicksetzen mochten, muss Volume Total als
eine Displayvariable konfiguriert sein.
Verfahren

. So setzen Sie den Masse Summenzahler zuriick:

1. Scroll bis der Wert des Massezdhlers erscheint.
2. Wabhlen Sie Select.
3. Scroll bis RESET unterhalb des aktuellen Zahlerwertes erscheint.
4. Waihlen Sie Select.
5. Wabhlen Sie Select erneut, um die Auswahl zu bestdtigen.
6. Scroll zu EXIT.

7. Wabhlen Sie Select.

. So setzen Sie den Volumen Summenzahler zurlick:

1. Scroll bis der Wert des Volumenzahlers erscheint.
2. Wabhlen Sie Select.
3. Scroll bis RESET unterhalb des aktuellen Zahlerwertes erscheint.
4. Wabhlen Sie Select.
5. Wabhlen Sie Select erneut, um die Auswahl zu bestdtigen.
6. Scroll zu EXIT.

7. Wahlen Sie Select (Auswahlen).

. So setzen Sie den Gas Standard Volumen Summenzéhler zurlick:

1. Scroll bis der Wert des Gas Standard Volumen Summenzahlers erscheint.
2. Wabhlen Sie Select.

3. Scroll bis RESET unterhalb des aktuellen Zahlerwertes erscheint.
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4. Wihlen Sie Select.
5. Wabhlen Sie Select erneut, um die Auswahl zu bestdtigen.
6. Scroll zu EXIT.
7. Wahlen Sie Select.
9.8 Gesamtzdhler zuriicksetzen
ProLink I ProLink > Totalizer Control > Reset Inventories
ProLink > Totalizer Control > Reset Mass Inventory
ProLink > Totalizer Control > Reset Volume Inventory
ProLink > Totalizer Control > Reset Gas Volume Inventory
ProLink Il Device Tools > Totalizer Control > Totalizer and Inventories > Reset Mass Inventory
Device Tools > Totalizer Control > Totalizer and Inventories > Reset Volume Inventory
Device Tools > Totalizer Control > Totalizer and Inventories > Reset Gas Inventory
Device Tools > Totalizer Control > Totalizer and Inventories > Reset All Inventories
Uberblick

Wenn Sie einen Gesamtzahler zuriicksetzen, setzt die Auswerteelektronik den Wert auf 0.
Dabei spielt es keine Rolle, ob der Gesamtzdhler gestartet oder gestoppt wurde. Wenn der
Gesamtzadhler gestartet wurde, wird die Verfolgung der Prozessmessung fortgesetzt.

Hinweis
Wenn Sie einen einzelnen Gesamtzéhler zuriicksetzen, werden die Werte der anderen Gesamtzahler
nicht zuriickgesetzt. Die Werte der Summenzahler werden nicht zurlickgesetzt.

Vorbereitungsverfahren

Wenn Sie ProLink Il oder ProLink Ill zum Zuriicksetzen der Gesamtzahler verwenden
mochten, muss diese Funktion aktiviert sein.
. So aktivieren Sie das Zuriicksetzen von Gesamtzahlern in ProLink II:
1. Klicken Sie auf View > Preferences.
2. Markieren Sie das Kontrollfeld Enable Inventory Totals Reset.
3. Klicken Sie auf Apply.
. So aktivieren Sie das Zuriicksetzen von Gesamtzahlern in ProLink Ill:
1. Wabhlen Sie Tools > Options.
2. Wahlen Sie Reset Inventories from ProLink I1.
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148

Betrieb der Auswerteelektronik mit
der eichamtlichen Transfer
Anwendung

In diesem Kapitel behandelte Themen:

Betrieb der Auswerteelektronik, wenn die eichamtliche Transfer Anwendung
installiert ist

Umschalten zwischen gesichertem und ungesichertem Modus
L6schen des Statusalarms A027: Sicherheitsverletzung
Austausch des Core Prozessors in einer eichamtlichen Transfer-Installation

Die Informationen in diesem Kapitel sind nur anwendbar, wenn lhre Auswerteelektronik
mit der eichamtlichen Transfer Anwendung bestellt wurde.

Betrieb der Auswerteelektronik, wenn die
eichamtliche Transfer Anwendung installiert ist

Wenn die eichamtliche Transfer Anwendung installiert ist, sind viele Grundfunktionen der
Auswerteelektronik abgedndert.

Verbindungsherstellung:
- Wenn keine Plombe angebracht ist, sind alle unterstiitzten Anschlusstypen
maglich.

- Wenn eine Plombe angebracht ist, ist kein Service Port Anschluss mdglich. Alle
anderen unterstiitzten Anschlusstypen konnen verwendet werden.

Ablesen und Erfassen von Prozessdaten:

- Flirzugelassene Messungen muss eine zugelassene Methode verwendet werden.

- Wenn die Messung nicht zugelassen sein muss, sind alle verfligbaren Methoden
maoglich.

Wichtig

Das Verhalten der Auswerteelektronik Ausgange und Prozessvariablenwerte wird durch die
eichamtliche Transfer Anwendung verdndert. Sie miissen sicher sein, wie sich diese
Anwendung auf Ausgange und Prozessvariablenwerte auswirkt.

Zurticksetzen der Summenzahler:

- Wenn die Auswerteelektronik nicht gesichert ist, konnen die Summenzahler
zuriickgesetzt werden. Wird ein Summenzdhler zuriickgesetzt, werden alle
anderen Summenzdhler automatisch auch zuriickgesetzt.

- Wenn die Auswerteelektronik gesichert ist, kbnnen die Summenzéhler je nach
Konfiguration eventuell nicht zuriickgesetzt werden. Wenn die Summenzahler
Riicksetzfunktion aktiviert ist, ist die Riicksetzung nur bei einem Durchfluss von 0
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10.1.1

10.1.2

mdglich. Zum Riicksetzen der Summenzahler von dem Bedieninterface aus muss
eventuell das Alarmment(i Passwort eingegeben werden, selbst wenn es nicht
aktiviert wurde. Die Standardeinstellung fiir das Alarmmen(i Passwort ist 1234.

. Die Summenzahler konnen nicht angehalten werden, solange die
Auswerteelektronik gesichert ist.

. Die Gesamtzdhler kdnnen nicht zuriickgesetzt werden, solange die
Auswerteelektronik gesichert ist.

Zugelassene Methoden zum Ablesen oder Erfassen von
Prozessdaten
Wenn die eichamtliche Transfer Anwendung installiert ist, sind Prozessdaten nur dann fiir

eichpflichtige Transfer zuldssig, wenn eine genehmigte Methoden zum Ablesen oder
Erfassen verwendet wird.

Anmerkung

Am primdren mA Ausgang darf die HART/Bell 202-Kommunikation zusammen mit der Ausgabe von
Prozessdaten zur Abfrage von Temperatur oder Druck verwendet werden.

GroRe Zahlerwerte auf dem Display (nur OIML
Anwendungen)

Wenn Zulassung auf OIML eingestellt ist und der Zahlerwert sehr gro8 ist, wird eine spezielle
Anzeigemethode verwendet. Der angezeigte Wert entspricht u. U. nicht dem aktuellen
Wert.

Das Display kann maximal 8 Zeichen anzeigen, einschlieRlich Dezimalkomma. Fiir alle als
Displayvariablen definierten Zdhlerwerte wird die Position des Dezimalkommas auf dem
Display von der eingestellten Genauigkeit der Displayvariable bestimmt.

In diesem Fall passiert Folgendes, wenn der Zdhler den hochsten anzeigbaren Wert
erreicht:

. Die Ziffern springten auf Null zur(ick.

. Das Dezimalkomma verschiebt sich nicht.

. Die Stellenanzahl auf dem Display bleibt gleich.

. Der interne Zahler wird auf 0 zuriickgesetzt.

So zum Beispiel springt der Wert 99999,999 auf 00000,000 zurtick.

Hinweis
Wenn Sie nicht sicher sind, ob der Zéhlerwert auf der Anzeige auf Null zurlickgesetzt wurde, priifen
Sie den Wert anhand einer anderen Methode zum Ablesen der aktuellen Daten.

Anmerkungen
. Die Zahler fiir Masse und Volumen springen nicht unbedingt zur gleichen Zeit zurtick.
. Diese Funktion bezieht sich nicht auf Gesamtzéhler. GroRe Gesamtzahlerwerte werden auf

die tibliche Weise angezeigt.
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Auswirkung der eichamtlichen Transfer Anwendung auf
Prozessmessungen und Ausgdnge

Wenn die eichamtliche Transfer Anwendung installiert ist, werden Prozessmessungen und
Berichterstattung gedndert, um die unbefugte Nutzung der Daten zu verhindern. Bei
bestimmten Anderungen hangt es davon ab, ob die Auswerteelektronik gesichert oder

ungesichert ist.

Tabelle 10-1: Auswerteelektronik Ausgdange und Prozessdaten, wenn Zulassungen = NTEP

Auswerteelektronik Satus

Funktion Ungesichert Gesichert
Ausgdnge mA Ausgang Verhalten Beim ausgeben einer Durchflussvariablen | Normal
gibt der mA Ausgang Null Durchfluss aus.
Ansonsten normal.
Frequenzausgang Verhal- | Inaktiv (es werden keine Impulse erzeugt), Normal
ten selbst bei Storzustdnden
Bindrausgang Verhalten Normal Normal

Prozessvariablen

Alle Durchfliisse

Als Null ausgegeben

Normalerweise ausgegeben

Dichte Normalerweise ausgegeben Normalerweise ausgegeben

Temperatur Normalerweise ausgegeben Normalerweise ausgegeben
Summenzdhler | Werte Nicht erh6hen oder verringern Normal erh6hen
Gesamtzdhler | Werte Nicht erhéhen oder verringern Normal erhéhen

Tabelle 10-2: Auswerteelektronik-Ausgdnge und Prozessdaten, wenn Zulassungen = OIML

Auswerteelektronik Satus

fuhrt

Funktion Ungesichert Gesichert
Ausgdnge mA Ausgang Verhalten Konfigurierte Storaktion wird durchge- Normal
fihrt
Frequenzausgang Verhal- | Konfigurierte Storaktion wird durchge- Normal
ten fuhrt
Bindrausgang Verhalten | Konfigurierte Stéraktion wird durchge- Normal

Prozessvariablen

Alle Durchflisse

Normalerweise ausgegeben

Normalerweise ausgegeben

Dichte Normalerweise ausgegeben Normalerweise ausgegeben

Temperatur Normalerweise ausgegeben Normalerweise ausgegeben
Summenzdhler | Werte Nicht erhdhen oder verringern Normal erhéhen
Gesamtzahler Werte Nicht erhéhen oder verringern Normal erh6hen
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Betrieb und Wartung

Auswirkung der eichamtlichen Transfer Anwendung auf

Wenn die eichamtliche Transfer Anwendung installiert ist, sind bestimmte Funktionen und
Wartungsverfahren moglicherweise nicht zuldssig. Sie konnen auf den ungesicherten
Betrieb umschalten, die nétigen Vorgange durchfiihren und dann wieder auf den
gesicherten Betrieb schalten.

Tabelle 10-3: Verfiigbare Aktionen, wenn Zulassungen = NTEP

Auswerteelektronik Status

Funktion Ungesichert Gesichert
Verbindung von ProLink II, ProLink Ill, dem Handterminal oder | Alle unterstiitzten Ver-
einem Host bindungstypen sind ver-
fligbar.
Konfiguration Messwert Erlaubt Erlaubt
Andern Erlaubt Nicht erlaubt
Kalibrierung Nullpunkt Erlaubt Nicht erlaubt
Dichte Erlaubt Nicht erlaubt
Temperatur Erlaubt Nicht erlaubt
Smart Systemverifizierung Ausgadnge eingestellt auf For- | Erlaubt Erlaubt
tsetzung der Messung
Ausgdnge eingestellt auf Erlaubt Erlaubt
Stérung
Ausgdnge eingestellt aufzu- | Erlaubt Nicht erlaubt
letzt gemessenen Wert
Externe Druck- und Tempera- | Abgerufen durch Abfragen Erlaubt Erlaubt
turdaten Geschrieben von Modbus- Erlaubt Nicht erlaubt
oder HART-Host
Ausgdnge testen und abglei- | mA Ausgang Messkreistest Erlaubt Nicht erlaubt
chen mA Ausgangsabgleich Erlaubt Nicht erlaubt

Frequenzausgang Mes-
skreistest

Nicht erlaubt

Nicht erlaubt

Bindrausgang Messkreistest

Erlaubt

Nicht erlaubt

Summenzéhler Zuriicksetzen Erlaubt Wird ein einzel- | Je nach Konfiguration zulds-
ner Summenzdhlerzur- | sig oder nicht zuldssig. Kann
lickgesetzt, werden alle | nur durchgefiihrt werden,
anderen Summenzéhler | wenn der Durchfluss Null
automatisch auch zur- ist. Wird ein einzelner Sum-
lickgesetzt. menzdhler zuriickgesetzt,

werden alle anderen Sum-
menzdhler automatisch
auch zuriickgesetzt.
Starten Nicht erlaubt k.A.
Stoppen - Nicht erlaubt
Gesamtzdhler Zuriicksetzen Nicht erlaubt Nicht erlaubt
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Tabelle 10-3: Verfiigbare Aktionen, wenn Zulassungen = NTEP (Fortsetzung)

Auswerteelektronik Status

Funktion Ungesichert Gesichert

Sensorsimulation Erlaubt Nicht erlaubt

Tabelle 10-4: Verfiigbare Aktionen, wenn Zulassungen = OIML

Funktion Auswerteelektronik Satus
Ungesichert Gesichert
Verbindung von ProLink Il, ProLink Ill, dem Handterminal | Alle unterstiitzten Verbin-
oder einem Host dungstypen sind verfiig-
bar.
Konfiguration Messwert Erlaubt Erlaubt
Andern Erlaubt Nicht erlaubt
Kalibrierung Nullpunkt Erlaubt Nicht erlaubt
Dichte Erlaubt Nicht erlaubt
Temperatur Erlaubt Nicht erlaubt
Smart Systemverifizierung | Ausgdnge eingestellt auf Erlaubt Erlaubt
Fortsetzung der Messung
Ausgdnge eingestellt auf Erlaubt Erlaubt
Stérung
Ausgdnge eingestellt auf zu- | Erlaubt Nicht erlaubt
letzt gemessenen Wert
Externe Druck- und Tem- Abgerufen durch Abfragen | Erlaubt Erlaubt
peraturdaten Geschrieben von Modbus- Erlaubt Nicht erlaubt

oder HART-Host

Ausgdnge mA Ausgang Messkreistest | Erlaubt Nicht erlaubt
mA Ausgangsabgleich Erlaubt Nicht erlaubt
Frequenzausgang Mes- Erlaubt Nicht erlaubt
skreistest
Bindrausgang Messkreistest | Erlaubt Nicht erlaubt
Prozessvariablen Alle Durchfliisse Normalerweise ausgege- | Normalerweise ausgegeben
ben
Dichte Normalerweise ausgege- | Normalerweise ausgegeben
ben
Temperatur Normalerweise ausgege-  Normalerweise ausgegeben
ben
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Tabelle 10-4: Verfiigbare Aktionen, wenn Zulassungen = OIML (Fortsetzung)

Funktion Auswerteelektronik Satus
Ungesichert Gesichert
Summenzéhler Zuriicksetzen Erlaubt Wird ein einzelner  Je nach Konfiguration zuldssig

Summenzdhler zuriickge- | oder nicht zuldssig. Kann nur
setzt, werden alle anderen | durchgefiihrt werden, wenn
Summenzahler automa- der Durchfluss Null ist. Wird
tisch auch zuriickgesetzt. | ein einzelner Summenzdhler
zurlickgesetzt, werden alle
anderen Summenzéhler au-
tomatisch auch zuriickge-

setzt.
Starten Nicht erlaubt k.A.
Stoppen - Nicht erlaubt
Gesamtzahler Zuriicksetzen Erlaubt Nicht erlaubt
Sensorsimulation Erlaubt Nicht erlaubt

10.2

10.2.1

Umschalten zwischen gesichertem und
ungesichertem Modus

Zum Andern der Auswerteelektronik Konfiguration sowie fiir viele
Administrationsaufgaben ist der Wechsel auf den ungesicherten Betrieb erforderlich. Um
die eichamtlichen Transfer Anforderungen fiir Prozessmessungen zu erfiillen, missen Sie
danach wieder in den gesicherten Modus zuriickschalten.

Zum Umschalten der Betriebsmodus muss eines der folgenden Hilfsmittel verwendet
werden:

o ProLink Il
. ProLink IlI
. Das “Umschalt”-Hilfsprogramm fiir den eichamtlichen Transfer. Das Umschalt-

Hilfsprogramm ist kostenlos auf der Micro Motion Website erhaltlich:
www.micromotion.com/softwaredownloads.

Nur so ist der Zugriff auf die Steuererung moglich.

Umschalten zwischen gesichertem und ungesichertem
Modus unter Verwendung von ProLink I

Vorbereitungsverfahren

Vergewissern Sie sich vor dem Umschalten in den ungesicherten Betrieb, dass Sie in den
gesicherten Betrieb zuriickschalten kénnen. Da zum Umschalten in den ungesicherten
Betrieb die Plombe zerstért werden muss, muss zum Umschalten in den gesicherten
Modus ein zertifizierter eichamtlicher Priifer vor Ort eine neue Plombe anbringen.

Vergewissern Sie sich, dass die nétige Verdrahtung fiir einen Service Port Anschuss
vorhanden ist. Sie miissen moglicherweise die Plombe zerstoren und die Klemme
entfernen.
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10.2.2

10.2.3
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Verfahren
. So schalten Sie vom gesicherten zum ungesicherten Modus um:

1. Stellen Sie eine Service Port Verbindung zu Ihrer Auswerteelektronik her.
2. Wahlen Sie Plug-ins > Enable/Disable Custody Transfer.
3. Klicken Sie auf Disable Custody Transfer.

o So schalten Sie vom ungesicherten zum gesicherten Modus um:

1. Stellen Sie eine Service Port Verbindung zu Ihrer Auswerteelektronik her.
2. Wabhlen Sie Plug-ins > Enable/Disable Custody Transfer.
3. Klicken Sie auf Enable Custody Transfer.

Umschalten zwischen gesichertem und ungesichertem
Modus unter Verwendung von ProLink lI

Vorbereitungsverfahren

Vergewissern Sie sich vor dem Umschalten in den ungesicherten Betrieb, dass Sie in den
gesicherten Betrieb zuriickschalten kénnen. Da zum Umschalten in den ungesicherten
Betrieb die Plombe zerstort werden muss, muss zum Umschalten in den gesicherten
Modus ein zertifizierter eichamtlicher Priifer vor Ort eine neue Plombe anbringen.

Vergewissern Sie sich, dass die nétige Verdrahtung fiir einen Service Port Anschuss
vorhanden ist. Sie miissen moglicherweise die Plombe zerstéren und die Klemme
entfernen.

Verfahren
o So schalten Sie vom gesicherten zum ungesicherten Modus um:

1. Stellen Sie eine Service Port Verbindung zu Ihrer Auswerteelektronik her.
2. Wihlen Sie Device Tools > Configuration > Weights & Measures.
3. Setzen sie Software Security auf Disabled.

. So schalten Sie vom ungesicherten zum gesicherten Modus um:

1. Stellen Sie eine Service Port Verbindung zu Ihrer Auswerteelektronik her.
2. Wabhlen Sie Device Tools > Configuration > Weights & Measures.

3. Setzen Sie Software Security auf Enabled.

Umschalten zwischen gesichertem und ungesichertem
Modus unter Verwendung des Umschalt-
Hilfsprogramms

Vorbereitungsverfahren

Das Umschalt-Hilfsprogramm muss auf lhrem PC installiert sein. Das Umschalt-
Hilfsprogramm ist auf der Micro Motion Website erhaltlich: www.micromotion.com/
softwaredownloads.
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Vergewissern Sie sich vor dem Umschalten in den ungesicherten Betrieb, dass Sie in den
gesicherten Betrieb zuriickschalten kénnen. Da zum Umschalten in den ungesicherten
Betrieb die Plombe zerstort werden muss, muss zum Umschalten in den gesicherten
Modus ein zertifizierter eichamtlicher Priifer vor Ort eine neue Plombe anbringen.

Vergewissern Sie sich, dass die nétige Verdrahtung fiir einen Service Port Anschuss
vorhanden ist. Sie miissen mdglicherweise die Plombe zerstéren und die Klemme
entfernen.

Verfahren
. So schalten Sie vom gesicherten zum ungesicherten Modus um:

1. Starten Sie das Umschalt-Hilfsprogramm.
2. Wabhlen Sie den gewiinschten COM-Port fiir die Verbindung.
3. Klicken Sie auf Disable Custody Transfer.

o So schalten Sie vom ungesicherten zum gesicherten Modus um:

1. Starten Sie das Umschalt-Hilfsprogramm.
2. Widhlen Sie den gewiinschten COM-Port fiir die Verbindung.
3. Klicken Sie auf Enable Custody Transfer.

10.3 Loschen des Statusalarms A027:
Sicherheitsverletzung

Statusalarm A027 (Sicherheitsverletzung) wird ausgegeben, wenn die Auswerteelektronik
auf ungesicherten Modus umgeschaltet wird oder wenn die Auswerteelektronik feststellt,
dass sich die Kennung des Core Prozessors geandert hat.

1.  Wenn die Auswerteelektronik im gesicherten Modus betrieben wird, schalten Sie auf
den ungesicherten Modus um.
2. Fiihren Sie alle nétigen MaRnahmen zur Behebung der Ursache fr die
Sicherheitsverletzung durch.
3. Schalten Sie auf den gesicherten Modus um.
10.4 Austausch des Core Prozessors in einer

eichamtlichen Transfer-Installation

In einer eichamtlichen Transfer Installation muss beim Austausch des Core Prozessors die
Auswerteelektronik neu verplombt werden.

Wenn die Auswerteelektronik zum ersten Mal gesichert wird, wird die Gerdtekennung des
Core Prozessors in der Auswerteelektronik registriert. Wenn der Core Prozessor durch
einen anderen Core Prozessor ersetzt wird, gibt die Auswerteelektronik den Statusalarm
A026 (Sensor-/Auswerteelektronik-Kommunikationsfehler) aus. Um diesen Alarm zu
I6schen, muss die Auswerteelektronik in den ungesicherten Betrieb geschaltet und dann
erneut gesichert werden. Hierzu muss die Plombe zerstért und nach Abschluss des
Verfahrens eine neue Plombe angebracht werden.
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AuBerdem kénnen noch weitere Verfahren nétig sein. Detaillierte Informationen fiir Ihre
Installation finden Sie in der Dokumentation fiir den eichamtlichen Transfer.

Wichtig
In den meisten Fallen muss die Plombe von einem zertifizierten eichamtlichen Priifer angebracht
werden.
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11 Messunterstutzung

In diesem Kapitel behandelte Themen:

Optionen fiir den Messungs-Support

Verwendung der Smart Systemverifizierung
Nullpunktkalibrierung des Durchflussmesssystems

Messsystem validieren

(Standard) D1 und D2 Dichtekalibrierung durchfiihren

D3 und D4 Dichtekalibrierung durchfiihren (nur T-Serie Sensoren)
Durchftihren einer Temperaturkalibrierung

11.1 Optionen fiir den Messungs-Support

Micro Motion bietet verschiedene Support-Verfahren fiir Messungen, mit denen Sie die
Genauigkeit lhres Durchflussmessers beurteilen und erhalten konnen.

Die folgenden Methoden sind verfiigbar:

Die intelligente Systemverifizierung bewertet die strukturelle Integritdt der Sensor-
Messrohre durch Vergleich der aktuellen Steifigkeit der Messrohre mit der
Steifigkeit, die beim Hersteller gemessen wurde. Steifigkeit ist definiert als
Belastung pro Auslenkungseinheit oder Kraft dividiert durch die Auslenkung. Durch
die Anderung der strukturellen Integritit dndert sich die Reaktion des Sensors in
Bezug auf Masse und Dichte, dieser Wert kann als Leistungsmerkmal-Indikator der
Messung herangezogen werden.

Die Systemvalidierung vergleicht die von der Auswerteelektronik ausgegebenen
Messwerte des Durchflussmessgerdts mit einem externen Messnormal.
Systemvalidierung erfordert einen Datenpunkt.

Kalibrierung - Nachweis des Verhaltnisses zwischen einer Prozessvariablen und dem
Signal vom Sensor. Sie kénnen den Durchflussmesser auf Nullpunkt, Dichte und
Temperatur kalibrieren. Dichte- und Temperaturkalibrierung erfordern zwei
Datenpunkte (niedrig und hoch) und eine externe Messung fir jeden.

Hinweise

Um die besten Daten (ber die Leistung Ihres Systems zu erhalten, fiihren Sie regelmaRig eine
intelligente Systemverifizierung durch.

Nutzen Sie eine Systemvalidierung und die Verwendung von Gerdtefaktoren anstatt einer
Kalibrierung, um das Messsystem auf ein geeichtes Messnormal abzugleichen oder einen
Messfehler zu korrigieren.

Bevor Sie eine Feldkalibrierung durchfiihren, kontaktieren Sie Micro Motion, um
herauszufinden, ob es ggf. eine Alternative gibt. In vielen Féllen wirken sich
Feldkalibrierungen negativ auf die Messgenauigkeit aus.
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11.2

11.2.1

Verwendung der Smart Systemverifizierung

Sie kdnnen eine Smart Systemverifizierung durchfiihren, die Ergebnisse anzeigen und
auswerten sowie die automatische Ausfiihrung der Systemverifizierung einstellen.

Anforderungen an die intelligente Systemverifizierung

Um die intelligente Systemverifizierung zu verwenden, muss die Auswerteelektronik
zusammen mit einem Core-Prozessor mit erweiterter Funktionalitat eingesetzt werden
und die Option Systemverifizierung muss fiir die Auswerteelektronik installiert sein.

Mindestanforderungen an die Auswerteelektronik, den erweiterten Core-Prozessor und
das Kommunikations-Tool zur Unterstiitzung der intelligenten Systemverifizierung finden
Sie in Tabelle 11-1. (Wenn Sie die intelligente Systemverifizierung mit dem Digitalanzeiger
durchfiihren, treffen nur die Versionen der Auswerteelektronik und des Core-Prozessors
mit erweiterter Funktionalitdt zu.)

Tabelle 11-1: Mindestversion zur Unterstiitzung der intelligenten
Systemverifizierung

Position Mindestversion

Auswerteelektronik 6.0

Core-Prozessor mit erweiterter Funktionalitdt | 3.6

ProLink Il 2.9

ProLink IlI 1.0

Handterminal HART-Geratebeschreibung: Gerdteversion 6, DD
Rev. 2

Wenn lhre Gerdte oder Tools nicht die Mindestanforderungen fiir die intelligente
Systemverifizierung erfiillen, konnen Sie trotzdem Zugang zu einer &lteren
Systemverifizierungsversion haben, falls diese Option fiir Ihre Auswerteelektronik bestellt
wurde. Eine Beschreibung der Hauptunterschiede zwischen der dlteren
Systemverifizierung und der neuen intelligenten Systemverifizierung finden Sie in

Tabelle 11-2.

Tabelle 11-2: Hauptunterschiede zwischen der Systemverifizierung und der
intelligenten Systemverifizierung

Intelligente Systemverifizierung

Merkmal Systemverifizierung (alter) (neuer)

Messunterbrechung Unterbrochen wéhrend des Tests (3 | Keine Unterbrechung notwendig
Minuten)

Ergebnisspeicherung | In der Auswerteelektronik werden | Die letzten 20 Ergebnisse werden in
keine Ergebnisse gespeichert der Auswerteelektronik gespeichert

Ergebnisbericht Bestanden/Fehlgeschlagen/Ab- Bestanden/Fehlgeschlagen/Ab-
bruch bruch, Abbruchcode, Vergleichsta-

bellen und Diagramme fiir gespei-

cherte Testergebnisse(V)

(1) Detaillierte Testergebnisse wie Vergleichsdiagramme sind auf dem Digitalanzeiger nicht verfiigbar.
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Tabelle 11-2: Hauptunterschiede zwischen der Systemverifizierung und der
intelligenten Systemverifizierung (Fortsetzung)

Intelligente Systemverifizierung
Merkmal Systemverifizierung (dlter) (neuer)

Teststartmethoden Nur Manuell Manuell, geplant, auf Ereignisbasis

11.2.2 Vorbereitung auf den intelligenten
Systemverifizierungstest

Obwohl flir einen intelligenten Systemverifizierungstest die Werksbedingungen nicht
hergestellt werden miissen und die Auswerteelektronik nicht gedndert werden muss, lauft
der Test stabiler unteri stabilen Testbedingungen.

Die intelligente Systemverifizierung verfiigt tiber den Ausgangsmodus Kontinuierliche
Messung, mit dem die Auswerteelektronik wahrend des Tests weiter messen kann. Falls Sie
den Test stattdessen in den Betriebsarten Zuletzt gemessener Wert oder Storung durchgefiihrt
wird, werden die Ausgdnge der Auswerteelektronik wahrend der zweiminiitigen Testdauer
konstant gehalten. Wenn Regelkreise von den Ausgdngen der Auswerteelektronik
abhangig sind, ergreifen Sie entsprechende MaRnahmen.

Vermeiden Sie eine Prozessinstabilitdt wahrend des Tests. Wenn die Bedingungen zu
instabil sind, wird der intelligente Systemverifizierungstest abgebrochen. Prozessstabilitat

maximieren:

. Temperatur und Druck des Prozessmediums konstant halten.

. Schwankungen in der Zusammensetzung des Mediums (z. B. Zweiphasenstréomung,
Abscheidungen, usw.) vermeiden.

. Den Durchfluss konstant halten.

Hinweise

. Der intelligente Systemverifizierungstest lauft am besten, wenn der Durchfluss durch den

Sensor gestoppt wird.

. Die intelligente Systemverifizierung wird nicht durch Parameter, die fiir Durchfluss, Dichte
oder Temperatur konfiguriert wurden, beeinflusst.

11.2.3 Smart Systemverifizierung durchftihren

Smart Systemverifizierung durchfiihren mittels
Bedieninterface

1. Navigieren Sie zum Meni Smart Meter Verification.
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Abbildung 11-1: Smart Systemverifizierung - Oberste Ebene Menii

RUN VERFY

v

| Scroll and Select simultaneously :

for 4 seconds

Scroll

ENTER METER VERFY

SCHEDULE VERFY

RESULTS READ

Scroll

Scroll Scroll

v v

2. Wihlen Sie Run Verfy.
3. Wahlen Sie Outputs und das gewlinschte Ausgangsverhalten.

Option

Beschreibung

Messung fortset- | Wahrend des Tests geben alle Ausgdnge die zugewiesene Prozessvariable

zen weiterhin aus. Der Test lduft ca. 90 Sekunden.

Storung Wahrend des Tests geben alle Ausgdnge den zuletzt gemessenen Wert der
zugewiesenen Prozessvariable aus. Der Test lauft ca. 140 Sekunden.

Letzter Wert Wadhrend des Tests werden alle Ausgange auf ihre konfigurierte Storaktion

gesetzt. Der Test lduft ca. 140 Sekunden.

Wahrend der Ausfiihrung des Tests laufen Punkte (iber das Bedieninterface und der
Testfortschritt wird angezeigt.

Nachbereitungsverfahren

Sehen Sie sich die Testergebnisse an und treffen Sie entsprechende MaRnahmen.
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Flussdiagramm fiir Smart Systemverifizierung: Durchfiihren eines Tests mittels
Bedieninterface

Abbildung 11-2: Durchfiihren eines Smart Systemverifizierungstests mittels Bedieninterface

<

:I RUN VERFY

| OUTPUTS

Select

-

| CONTINUE MEASR FAULT LAST VALUE EXIT
[

| ARE YOU SURE/YES? |
—>| ............... x% SENSOR ABORT/YES? |
[ Scroll ] [ Select ]
Pass Test result -Abort
Fail
A 4 + A 4
| PASS VERFY | | CAUTION VERFY | | ABORTED VERFY |
| RESULTS VIEW/YES? | | Abort Type |
I Scroll l [ Select l
To Runcount | RERUN/YES? |
(see Results Read)
l—Yes—I—No—|
| Correct condition | Scroll
— —To Enter Meter Verfy- — -+

Smart Systemverifizierung durchfiihren mittels ProLink Il

1. Wahlen Sie Tools > Meter Verification > Run Meter Verification.

Sie miissen moglicherweise einige Sekunden warten, wéhrend ProLink Il die
Datenbank mit den Daten der Auswerteelektronik synchronisiert.
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2. Sehen Sie sich die auf dem Bildschirm angezeigten Informationen an und klicken Sie

dann auf Next.

3.  Geben Sie die gewiinschten Informationen auf dem Bildschirm Test Definition ein

und klicken Sie auf Next.

Alle Informationen auf diesem Bildschirm sind optional.

4.  Wabhlen Sie das gewlinschte Ausgangsverhalten.

Option Beschreibung
Ausgange fahren mit Mes- = Wahrend des Tests geben alle Ausgdnge die zugewiesene Prozess-
sung fort variable weiterhin aus. Der Test lduft ca. 90 Sekunden.
Ausgangswerte auf letzten = Wahrend des Tests geben alle Ausgdnge den zuletzt gemessenen
Wert halten Wert der zugewiesenen Prozessvariable aus. Der Test lduft ca.

140 Sekunden.
Ausgangswerte bei Fehler | Wéahrend des Tests werden alle Ausgange auf ihre konfigurierte
halten Storaktion gesetzt. Der Test lauft ca. 140 Sekunden.

5. Driicken Sie Start Meter Verification.

Der Fortschritt des Tests wird auf dem Bildschirm angezeigt.

Nachbereitungsverfahren

Sehen Sie sich die Testergebnisse an und treffen Sie entsprechende MaRnahmen.

Smart Systemverifizierung durchfiihren mittels ProLink llI

1. Wabhlen Sie Device Tools > Diagnostics > Meter Verification > Run Test.

Sie missen moglicherweise einige Sekunden warten, wahrend ProLink Il die
Datenbank mit den Daten der Auswerteelektronik synchronisiert.

2. Geben Sie die gewiinschten Informationen auf dem Bildschirm Test Definition ein
und klicken Sie auf Next.

Alle Informationen auf diesem Bildschirm sind optional.

3. Wabhlen Sie das gewiinschte Ausgangsverhalten.
Option Beschreibung
Mit Messung fortfah- = Wahrend des Tests geben alle Ausgidnge die zugewiesene Prozessvaria-
ren ble weiterhin aus. Der Test lduft ca. 90 Sekunden.
Auf letztem Wert hal- - Wahrend des Tests geben alle Ausgdnge den zuletzt gemessenen Wert
ten der zugewiesenen Prozessvariable aus. Der Test lduft ca. 140 Sekunden.
Bei Fehler halten Wahrend des Tests werden alle Ausgdnge auf ihre konfigurierte Storak-

tion gesetzt. Der Test lduft ca. 140 Sekunden.

4, Driicken Sie Start.

Der Fortschritt des Tests wird auf dem Bildschirm angezeigt.

Nachbereitungsverfahren

Sehen Sie sich die Testergebnisse an und treffen Sie entsprechende MaRnahmen.
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Smart Systemverifizierung durchfiihren mittels
Handterminal

1. Navigieren Sie zum Meni Smart Meter Verification:

« Ubersicht > Verkniipfungen > Systemverifizierung

» Service Tools > Maintenance > Routine Maintenance > Meter Verification
Wahlen Sie Manual Verification.

Wahlen Sie Start.

Setzen Sie das Ausgangsverhalten wie gewlinscht und driicken Sie OK, wenn die
entsprechende Aufforderung erscheint.

Option Beschreibung

Mit Messung fortfahren | Wahrend des Tests geben alle Ausgiange die zugewiesene Prozess-
variable weiterhin aus. Der Test lduft ca. 90 Sekunden.

Ausgangswerte auf letzt- | Wahrend des Tests geben alle Ausgdnge den zuletzt gemessenen
en Wert halten Wert der zugewiesenen Prozessvariable aus. Der Test lduft ca.
140 Sekunden.

Ausgangswerte bei Feh- | Wahrend des Tests werden alle Ausgange auf ihre konfigurierte
ler halten Storaktion gesetzt. Der Test lduft ca. 140 Sekunden.

Der Fortschritt des Tests wird auf dem Bildschirm angezeigt.

Nachbereitungsverfahren

Sehen Sie sich die Testergebnisse an und treffen Sie entsprechende MaRnahmen.

11.2.4 Testdaten anzeigen

Sie konnen die Ergebnisse des aktuellen Tests ansehen. Sie kénnen auBerdem die
Ergebnisse vorhergehender Tests anzeigen.

Die Auswerteelektronik speichert die folgenden Informationen tiber die letzten 20
intelligenten Systemverifizierungen:

o Eingeschaltete Stunden zum Testzeitpunkt.

. Testergebnisse (Bestanden, Fehlgeschlagen, Abbruch).

. Steifigkeit des linken und des rechten Aufnehmers, gezeigt als eine prozentuale
Abweichung von der Werkseinstellung. Wenn der Test abgebrochen wurde, wird fiir
diese Werte 0 gespeichert.

. Abbruchcode, falls zutreffend.
Dartiber hinaus geben ProLink Il und ProLink lll einen detaillierten Testbericht- und

Analyserahmen. Diese Informationen werden auf dem PC gespeichert, auf dem ProLink Il
oder ProLink Ill installiert sind. Die Informationen umfassen:

. Zeitstempel vom PC-Dock

. Aktuelle Durchflussmesser-Kenndaten

o Aktuelle Konfigurationsparameter fiir Durchfluss und Dichte
. Aktuelle Nullpunktwerte
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Aktuelle Prozesswerte fiir den Massedurchfluss, den Volumendurchfluss, die Dichte,
die Temperatur und den externen Druck

Kunde und Testbeschreibungen (falls vom Benutzer eingegeben)

Wenn Sie zur Ausfiihrung eines Test ProLink Il oder ProLink Ill verwenden, werden eine
Testergebnistabelle und ein Testbericht beim Abschluss des Tests angezeigt.
Bildschirmanweisungen zur Manipulation der Testdaten oder zum Export der Daten in eine
CSV-Datei zur Offline-Analyse werden gegeben.

Testergebnisdaten mittels Bedieninterface anzeigen

1.

Wenn Sie einen Test gerade ausgefiihrt haben, werden die Ergebnisse am Ende des
Tests automatisch angezeigt.

So zeigen Sie die Ergebnisse friiherer Tests an:

a. Navigieren Sie zum Menii Smart Meter Verification.

Abbildung 11-3: Smart Systemverifizierung - Oberste Ebene Menii

| Scroll and Select simultaneously :
for 4 seconds |

Scroll

ENTER METER VERFY

Scroll

v v v

b. Scrollen Sie zu Results Read und driicken Sie Select.

Der Zéhler der Durchlaufe fiir den zuletzt durchgefiihrten Test wird angezeigt.

c. Zum Anzeigen der Daten fiir diesen Test driicken Sie Select und dann Scroll, um
die Testdaten zu durchlaufen.

d. Zum Auswahlen eines anderen Tests driicken Sie Scroll und dann Select, wenn die
Auswerteelektronik Results More? anzeigt. Wenn der gewiinschte Test gemaR der
Angabe durch den Zahler der Durchldufe erscheint, driicken Sie Select.
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Flussdiagramm flir Smart Systemverifizierung: Anzeigen der Testergebnisse
mittels Bedieninterface

Abbildung 11-4: Anzeigen der Testergebnisse der Smart Systemverifizierung mittels Bedieninterface

RESULTS READ

> RUNCOUNT x
; ]
Pass: Result type Abort:
Fail
A 4 l A 4
xx HOURS xx HOURS xx HOURS
PASS CAUTION Abort Type
xx L STF% xx L STF%
xx R STF% xx R STF%

!

RESULTS MORE?

l Select ‘ l Scroll ‘

I
| L —To Run Verfy- »

To Runcount x-1

Testergebnisse anzeigen mit ProLink Il

1. Wihlen sie Tools > Meter Verification > Run Meter Verification und klicken Sie auf View
Previous Test Results and Print Report.

Die Tabelle zeigt Testergebnisse aller Tests, die in der ProLink Il Datenbank
gespeichert sind.
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2. (Optional) Klicken Sie auf Next, um einen Testbericht anzuzeigen und zu drucken.

3. (Optional) Klicken Sie auf Export Data to CSV File, um die Daten in einer Datei auf dem
PC zu speichern.

Testergebnisse anzeigen mit ProLink Il

1. Wabhlen Sie Device Tools > Diagnostics > Meter Verification und klicken Sie auf Previous Test
Results.

Die Tabelle zeigt Testergebnisse aller Tests, die in der ProLink Ill Datenbank
gespeichert sind.

(Optional) Klicken Sie auf Next, um einen Testbericht anzuzeigen und zu drucken.

(Optional) Klicken Sie auf Export Data to CSV File, um die Daten in einer Datei auf dem
PC zu speichern.

Testergebnisse anzeigen mit Handterminal

1. Navigieren Sie zum Men( Smart Meter Verification:

e QOverview > Shortcuts > Meter Verification
¢ Service Tools > Maintenance > Routine Maintenance > Meter Verification

2. (Optional) Wenn die Handterminal Datenbank nicht mehr aktuell ist, wahlen Sie
Upload Results Data from Device.

3. Wiahlen Sie Most Recent Test Results, um die neuesten Testergebnisse anzuzeigen.

So zeigen Sie Daten aller Testergebnisse in der Handterminal Datenbank an:
a. Klicken Sie auf Show Results Table.

Es werden die Daten vom letzten Test angezeigt.

b. Klicken Sie auf OK, um die Daten von vorhergehenden Tests zu durchblattern.

c. Klicken Sie auf Abort, um die Ergebnistabelle zu verlassen.

Interpretation der intelligenten
Systemverifizierungsergebnisse

Wenn der Systemverifizierungstest beendet ist, wird das Ergebnis als Erfolgreich,
Fehlgeschlagen oder Abbruch angezeigt. (Einige Softwaretools geben das fehlgeschlagene
Ergebnis stattdessen als ,Vorsicht“ aus.)

Bestanden Das Testergebnis liegt innerhalb der Spezifikations-
Unsicherheitsgrenze. Mit anderen Worten, die Steifigkeit des linken
und des rechten Aufnehmers entspricht den Werkseinstellungen plus
oder minus der Spezifikations-Unsicherheitsgrenze. Wenn
Nullpunktwert und Konfiguration den Herstellerwerten entsprechen,
entspricht der Sensor den Spezifikationen des Herstellers fiir die
Durchfluss- und Dichtemessung. Es ist zu erwarten, dass der Sensor die
Systemverifizierung bei jedem Test jederzeit durchlauft.

Fehlgeschlagen Das Testergebnis liegt auRerhalb der Spezifikations-
Unsicherheitsgrenze. Micro Motion empfiehlt, dass Sie die
Systemverifizierung umgehend wiederholen. Wenn die Ausgdnge
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Abbruch

Tabelle 11-3:

beim fehlgeschlagenen Test auf Messung fortsetzen gesetzt waren,
setzen Sie die Ausgange stattdessen auf Stérung oder Zuletzt gemessener

Wert.

. Besteht das System den zweiten Test, kann das erste Ergebnis

ignoriert werden.

. Wenn das System den zweiten Test nicht besteht, sind
moglicherweise die Messrohre beschddigt. Nutzen Sie lhre
Prozesskenntnisse, um die Maglichkeiten einer Beschadigung
sowie alle entsprechenden AbhilfemaRnahmen zu bestimmen.
Diese MaRnahmen kénnen auch bedeuten, dass das Messgerat
ausgebaut und die Messrohre untersucht werden miissen.
Mindestens ist jedoch die Validierung des Durchflusses und die
Kalibrierung der Dichte durchzufihren.

Ein Problem ist wahrend des Systemverifizierungstests aufgetreten
(z.B. Instabilitdt des Prozesses) oder Sie haben den Test manuell
gestoppt. Eine Liste der Abbruchcodes, eine Beschreibung jedes Codes
sowie mogliche AbhilfemaRnahmen finden Sie in Tabelle 11-3.

Abbruchcodes der intelligenten Systemverifizierung

Code Beschreibung Empfohlene MaBnahmen

1 Vom Benutzer eingeleiteter Abbruch | Keine erforderlich. Vor Start eines weiteren
Tests 15 Sekunden warten.

3 Frequenzabweichung Sicherstellen, dass Temperatur, Durchfluss
und Dichte stabil sind und den Test erneut
durchfthren.

5 Hohe Antriebsverstarkung Sicherstellen, dass der Durchfluss stabil ist,
Gaseinschliisse auf ein Minimum reduzieren
und den Test erneut durchfiihren.

8 Instabiler Durchfluss Faktoren priifen, die eine Prozessinstabilitdt
verursachen konnen, dann den Test erneut
durchfiihren. Prozessstabilitdat maximieren:
e Temperatur und Druck des Prozessmedi-

ums konstant halten.
e Schwankungen in der Zusammenset-
zung des Mediums (z. B. Zweiphasen-
stromung, Abscheidungen, usw.) ver-
meiden.
e Den Durchfluss konstant halten.
13 Keine werksseitigen Bezugsdaten fiir | Kontaktieren Sie Micro Motion.
Systemverifizierungstests mit Luft

14 Keine werksseitigen Bezugsdaten fiir | Kontaktieren Sie Micro Motion.
Systemverifizierungstests mit Wass-
er

15 Keine Konfigurationsdaten fir die Kontaktieren Sie Micro Motion.
Systemverifizierung

Andere Allgemeiner Abbruch Test wiederholen. Wenn der Test wieder ab-

bricht, wenden Sie sich an Micro Motion.
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Zeitplan zur automatischen Ausfiihrung der Smart
Systemverifizierung

Sie kénnen einen einzelnen Test fiir einen vom Anwender definierten Zeitpunkt planen. Sie
kénnen Tests ebenso gemaR eines regelmaRigen Zeitplans einrichten und ausfiihren.

Testdurchfithrung mit Zeitplan mittels Bedieninterface

1. Navigieren Sie zum Meni Smart Meter Verification.

Abbildung 11-5: Smart Systemverifizierung - Oberste Ebene Menii

| Scroll and Select simultaneously
| for 4 seconds

Scroll

ENTER METER VERFY

RUN VERFY

Scroll

RESULTS READ SCHEDULE VERFY

Scroll

Se;em Select Select
3 7 i

Scrollen Sie zu Schedule Verfy und wahlen Sie Select.

So planen Sie einen einzelnen Test oder den ersten Test einer wiederkehrenden
Ausfiihrung:

a. Scrollen Sie zu Set Next und driicken Sie Select.

b. Geben Sie die Anzahl der Stunden ein, die die Auswerteelektronik wartet, bevor
der Test begonnen wird.

4, So planen Sie eine wiederkehrende Ausfiihrung:

a. Scrollen Sie zu Set Recur und driicken Sie Select.
b. Geben Sie die Anzahl der Stunden zwischen den Tests ein.
5. So deaktivieren Sie die zeitgesteuerte Ausfiihrung:
e Zum Deaktivieren der Ausfiihrung eines einzelnen geplanten Tests setzen Sie Set
Next auf 0.
e Zum Deaktivieren einer wiederkehrenden Ausfiihrung setzen Sie Set Recur auf 0.

* Zum Deaktivieren aller zeitgesteuerten Ausfiihrungen wdhlen Sie Turn Off Sched,
nachdem Sie das Menii Smart Meter Verification aufgerufen haben.
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Flussdiagramm fiir Smart Systemverifizierung: Planen der Testdurchfiihrung
mittels Bedieninterface

Abbildung 11-6: Planen der Testdurchfiihrung fiir Smart Systemverifizierung mittels Bedieninterface

SCHEDULE VERFY |«
No- Schedule set? Yes:
v v
SCHED IS OFF TURN OFF SCHED/YES?
Scroll
Scroll
Schedule deleted
A4 I—n
| HOURS LEFT |<7
I Scroll ] I Select ]
; |
| xx HOURS |
\ 4
—> SET NEXT —{_ soroll |}z SET RECUR EXIT
[ Scroll I I Select ]
| xx HOURS | | xx HOURS | I—
v v
| SAVE/YES? | | SAVE/YES? |
rNoJ—Yesn rNoJ—Yesn
[ Scroll l [ Select ] [ Scroll ] [ Select ]
) | . |

Testdurchfiihrung mit Zeitplan mittels ProLink I

1. Wahlen Sie Tools > Meter Verification > Schedule Meter Verification.

2. Zum Planen eines einzelnen Tests oder des ersten Tests einer wiederkehrenden

Ausfiihrung geben Sie einen Wert fiir Hours Until Next Run ein.

Zum Planen einer wiederkehrenden Ausfiihrung geben Sie einen Wert fiir Hours
Between Recurring Runs ein.

4.  Sodeaktivieren Sie die zeitgesteuerte Ausfiihrung:
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e Zum Deaktivieren der Ausfiihrung eines einzelnen geplanten Tests setzen Sie
Hours Until Next Run auf 0.

e Zum Deaktivieren wiederkehrender Ausfiihrungen setzen SieHours Between
Recurring Runs auf 0.

» Zum Deaktivieren aller geplanten Ausfiihrungen klicken Sie auf Turn Off Schedule.

Zeitgesteuerte Testausfiihrung verwalten mittels ProLink llI

1.
2.

Wahlen Sie Device Tools > Diagnostics > Meter Verification > Schedule Meter Verification.

Zum Planen eines einzelnen Tests oder des ersten Tests einer wiederkehrenden
Ausfiihrung geben Sie einen Wert fiir Stunden bis zum néchsten Lauf ein.

Zum Planen einer wiederkehrenden Ausfiihrung geben Sie einen Wert fiir Stunden
zwischen wiederkehrenden Laufen ein.

So deaktivieren Sie die zeitgesteuerte Ausfiihrung:
» Zum Deaktivieren der Ausfiihrung eines einzelnen geplanten Tests setzen Sie
Stunden bis zum néchsten Lauf auf 0.

* Zum Deaktivieren wiederkehrender Ausfiihrungen setzen Sie Stunden zwischen
wiederkehrenden Laufen auf 0.

e Zum Deaktivieren aller geplanten Ausfiihrungen klicken Sie auf Geplante
Ausfiihrung deaktivieren.

Testdurchfiihrung mit Zeitplan mittels Handterminal

1.

Navigieren Sie zum Meni Smart Meter Verification:

e Qverview > Shortcuts > Meter Verification
¢ Service Tools > Maintenance > Routine Maintenance > Meter Verification
Wahlen Sie Automatic Verification.

Zum Planen eines einzelnen Tests oder des ersten Tests einer wiederkehrenden
Ausfiihrung geben Sie einen Wert fiir Hrs Until Next Run ein.

Zum Planen einer wiederkehrenden Ausfiihrung geben Sie einen Wert fiir Set
Recurring Hours ein.

So deaktivieren Sie die zeitgesteuerte Ausfiihrung:

e Zum Deaktivieren der Ausfiihrung eines einzelnen geplanten Tests setzen Sie Hrs
Until Next Run auf 0.

* Zum Deaktivieren einer wiederkehrenden Ausfiihrung setzen Sie Set Recurring
Hours auf 0.

» Zum Deaktivieren aller geplanten Ausfiihrungen wéhlen Sie Turn Off Schedule.

Nullpunktkalibrierung des
Durchflussmesssystems

Die Nullpunktkalibrierung des Durchflussmesssystems etabliert einen Basiswert fiir die
Prozessmessung, indem der Sensorausgang analysiert wird, wenn kein Durchfluss im
Messrohr vorhanden ist.
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Wichtig
In den meisten Fallen ist die werksseitige Nullpunktkalibrierung genauer als die im Feld. Kalibrieren
Sie den Nullpunkt des Durchflussmesssystems nicht, es sei denn:

. Anlagenverfahren erfordern eine Nullpunktkalibrierung.

. Der gespeicherte Nullpunktwert besteht das Nullpunktverifizierungsverfahren nicht.

Vorbereitungsverfahren

Fiihren Sie vor der Nullpunktkalibrierung das Nullpunktverifizierungsverfahren aus, um
herauszufinden, ob eine Nullpunktkalibrierung die Messgenauigkeit verbessern kann.
Siehe Abschnitt 2.6.

Wichtig

Verifizieren bzw. kalibrieren Sie den Nullpunkt nicht, wenn ein Alarm mit hoher Prioritat aktiv ist. Das
Problem muss erst behoben werden, bevor der Nullpunkt des Durchflussmesssystems verifiziert
bzw. kalibriert wird. Sie kdnnen den Nullpunkt verifizieren bzw. kalibrieren, wenn ein Alarm mit
niedriger Prioritdt aktiv ist.

11.3.1 Nullpunktkalibrierung des Durchflussmesssystems
mittels Display
Die Nullpunktkalibrierung des Durchflussmesssystems etabliert einen Basiswert fiir die

Prozessmessung, indem der Sensorausgang analysiert wird, wenn kein Durchfluss im
Messrohr vorhanden ist.

Einschrankung

Die Einstellung Zero Time kann nicht (iber das Display gedndert werden. Die derzeitige Einstellung von
Zero Time wird bei der Nullpunktkalibrierung verwendet. Der Standardwert betragt 20 Sekunden.
Falls Zero Time gedndert werden soll, muss zuerst tiber ein Kommunikations-Hilsmittel wie z. B.
ProLink Il eine Verbindung zur Auswerteelektronik hergestellt werden.

Vorbereitungsverfahren

Weisen Sie die folgenden Werte als Displayvariablen zu:
. Live Zero oder Field Verification
. Drive Gain
o Temperature
. Density
Siehe Abschnitt 5.1.2 bzgl. weiterer Informationen.
Verfahren
1. Vorbereiten des Durchflussmesssystems:
a. Lassen Sie das Durchflussmesssystem nach dem Einschalten mindestens

20 Minuten aufwdrmen.

b. Lassen Sie das Prozessmedium durch den Sensor stromen, bis die
Sensortemperatur ungefdhr die normale Betriebstemperatur erreicht hat.

c. Stoppen Sie den Durchfluss durch den Sensor, indem Sie das in Flussrichtung
abwarts liegende Ventil und danach das in Flussrichtung aufwarts liegende Ventil
schlieBen (falls verfligbar).
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d. Stellen Sie sicher, dass der Sensor abgesperrt ist, kein Durchfluss mehr
vorhanden ist und der Sensor vollstandig mit dem Prozessmedium gefiillt ist.

e. Beobachten Sie die Werte fiir Antriebsverstarkung, Temperatur und Dichte. Sind
diese stabil, priifen Sie den Wert Live Zero oder Field Verification Zero. Wenn der
Mittelwert nahe bei 0 liegt, muss der Nullpunkt des Durchflussmesssystems
nicht kalibriert werden.

Navigieren Sie zu OFFLINE MAINT > ZERO > CAL ZERO und wahlen Sie CAL/YES?.
Waéhrend die Nullpunktkalibrierung des Durchflussmesssystems lauft, durchlaufen
Punkte das Display.

Lesen Sie das Ergebnis der Nullpunktkalibrierung auf dem Display ab.

Das Display zeigt CAL PASS an, wenn die Kalibrierung erfolgreich durchgefiihrt
wurde, und CAL FAIL, wenn die Kalibrierung fehlgeschlagen ist.

Nachbereitungsverfahren

Offnen Sie die Ventile, um den normalen Durchfluss durch den Sensor wieder herzustellen.

Bendétigen Sie Hilfe? Wenn die Nullpunktkalibrierung fehlschlagt:

Stellen Sie sicher, dass kein Durchfluss durch den Sensor erfolgt und wiederholen Sie das
Verfahren.

Entfernen oder reduzieren Sie elektromagnetisches Rauschen und wiederholen Sie das
Verfahren.

Setzen Sie Zero Time auf einen niedrigeren Wert und wiederholen Sie das Verfahren.

Sollte eine Nullpunktkalibrierung weiterhin nicht moglich sein, wenden Sie sich an
Micro Motion.

Wenn das Durchflussmesssystem mit einem zuvor verwendeten Nullpunktwert wieder in
Betrieb genommen werden soll:

- Wiederherstellen des werksseitig eingestellten Nullpunktwertes: OFFLINE MAINT > ZERO >
RESTORE ZERO > RESTORE/YES? . Diese Funktion erfordert den Core Prozessor mit
erweiterter Funktionalitat.

Einschrdankung

Den werksseitigen Nullpunkt nur dann wiederherstellen, wenn das Durchflussmesssystem als
eine Einheit erworben wurde, der Nullpunkt im Werk kalibriert wurde und die Originalteile
verwendet werden.

Nullpunktkalibrierung des Durchflussmesssystems
mittels ProLink Il

Die Nullpunktkalibrierung des Durchflussmesssystems etabliert einen Basiswert fiir die
Prozessmessung, indem der Sensorausgang analysiert wird, wenn kein Durchfluss im
Messrohr vorhanden ist.

Vorbereitungsverfahren

ProLink Il muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1.

Vorbereiten des Durchflussmesssystems:
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a. Lassen Sie das Durchflussmesssystem nach dem Einschalten mindestens
20 Minuten aufwdrmen.

b. Lassen Sie das Prozessmedium durch den Sensor strémen, bis die
Sensortemperatur ungefahr die normale Betriebstemperatur erreicht hat.

c. Stoppen Sie den Durchfluss durch den Sensor, indem Sie das in Flussrichtung
abwarts liegende Ventil und danach das in Flussrichtung aufwarts liegende Ventil
schlieBen (falls verfligbar).

d. Stellen Sie sicher, dass der Sensor abgesperrt ist, kein Durchfluss mehr
vorhanden ist und der Sensor vollstandig mit dem Prozessmedium gefiillt ist.

e. Beobachten Sie die Werte fiir Antriebsverstdrkung, Temperatur und Dichte. Sind
diese stabil, priifen Sie den Wert Live Zero oder Field Verification Zero. Wenn der
Mittelwert nahe bei 0 liegt, muss der Nullpunkt des Durchflussmesssystems
nicht kalibriert werden.

Wiéhlen Sie ProLink > Calibration > Zero Verification and Calibration.

Klicken Sie auf Calibrate Zero.

Andern Sie Zero Time falls gewiinscht.

Unter Zero Time versteht man die Zeit, die der Auswerteelektronik vorgegeben wird,
um den Referenzpunkt bei einem Durchfluss von Null zu bestimmen. Die

voreingestellte Zero Time betrdgt 20 Sekunden. Fiir die meisten Anwendungen ist die
voreingestellte Zero Time ausreichend.

5. Klicken Sie auf Perform Auto Zero.
Die Anzeige Calibration in Progress leuchtet wahrend der Nullpunktkalibrierung rot.
Am Ende des Verfahrens:

* Wenn die Nullpunktkalibrierung erfolgreich war, leuchtet die Anzeige Calibration
in Progress wieder griin und ein neuer Nullpunktwert wird angezeigt.

* Wenn die Kalibrierung fehlgeschlagen ist, leuchtet die Anzeige Calibration Failure
rot.

Nachbereitungsverfahren

Offnen Sie die Ventile, um den normalen Durchfluss durch den Sensor wieder herzustellen.

Bendétigen Sie Hilfe? Wenn die Nullpunktkalibrierung fehlschlégt:

. Stellen Sie sicher, dass kein Durchfluss durch den Sensor erfolgt und wiederholen Sie das
Verfahren.

. Entfernen oder reduzieren Sie elektromagnetisches Rauschen und wiederholen Sie das
Verfahren.

. Setzen Sie Zero Time auf einen niedrigeren Wert und wiederholen Sie das Verfahren.

. Sollte eine Nullpunktkalibrierung weiterhin nicht méglich sein, wenden Sie sich an

Micro Motion.

. Wenn das Durchflussmesssystem mit einem zuvor verwendeten Nullpunktwert wiederin
Betrieb genommen werden soll:

- Wiederherstellen des werksseitig eingestellten Nullpunktwertes: ProLink > Zero Verification
and Calibration > Calibrate Zero > Restore Factory Zero .Diese Funktion erfordert den Core
Prozessor mit erweiterter Funktionalitt.
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- Wiederherstellen des zuletzt giiltigen Nullpunktwertes vom Speicher der
Auswerteelektronik: ProLink > Zero Verification and Calibration > Calibrate Zero > Restore Prior
Zero . Restore Prior Zero ist nur dann verfiigbar, wenn das Fenster Flow Calibration angezeigt
wird. Wenn das Fenster Flow Calibration geschlossen wird, kann der vorige Nullpunktwert
nicht mehr wiederhergestellt werden.

Einschrankung

Den werksseitigen Nullpunkt nur dann wiederherstellen, wenn das Durchflussmesssystem als eine
Einheit erworben wurde, der Nullpunkt im Werk kalibriert wurde und die Originalteile verwendet
werden.

Nullpunktkalibrierung des Durchflussmesssystems
mittels ProLink Il

Die Nullpunktkalibrierung des Durchflussmesssystems etabliert einen Basiswert fiir die
Prozessmessung, indem der Sensorausgang analysiert wird, wenn kein Durchfluss im
Messrohr vorhanden ist.

Vorbereitungsverfahren
ProLink Il muss laufen und muss mit der Auswerteelektronik verbunden sein.
Verfahren
1. Vorbereiten des Durchflussmesssystems:
a. Lassen Sie das Durchflussmesssystem nach dem Einschalten mindestens

20 Minuten aufwdarmen.

b. Lassen Sie das Prozessmedium durch den Sensor stromen, bis die
Sensortemperatur ungefahr die normale Betriebstemperatur erreicht hat.

c. Stoppen Sie den Durchfluss durch den Sensor, indem Sie das in Flussrichtung
abwarts liegende Ventil und danach das in Flussrichtung aufwadrts liegende Ventil
schlieRen (falls verfiigbar).

d. Stellen Sie sicher, dass der Sensor abgesperrt ist, kein Durchfluss mehr
vorhanden ist und der Sensor vollstandig mit dem Prozessmedium gefillt ist.

e. Beobachten Sie die Werte fiir Antriebsverstarkung, Temperatur und Dichte. Sind
diese stabil, priifen Sie den Wert Live Zero oder Field Verification Zero. Wenn der
Mittelwert nahe bei 0 liegt, muss der Nullpunkt des Durchflussmesssystems
nicht kalibriert werden.

Wiéhlen Sie Device Tools > Calibration > Zero Verification and Calibration.

Klicken Sie auf Calibrate Zero.

Andern Sie Zero Time falls gewiinscht.

Unter Zero Time versteht man die Zeit, die der Auswerteelektronik vorgegeben wird,
um den Referenzpunkt bei einem Durchfluss von Null zu bestimmen. Die

voreingestellte Zero Time betrdgt 20 Sekunden. Fiir die meisten Anwendungen ist die
voreingestellte Zero Time ausreichend.

5. Klicken Sie auf Calibrate Zero.
Die Meldung Calibration in Progress wird angezeigt. Wenn die Kalibrierung
abgeschlossen ist:

*  Wenn die Nullpunktkalibrierung erfolgreich war, wird die Meldung Calibration
Success angezeigt und ein neuer Nullpunktwert wird angezeigt.
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» Wenn die Nullpunktkalibrierung fehlgeschlagen ist, wird die Meldung Calibration
Failed angezeigt.

Nachbereitungsverfahren

Offnen Sie die Ventile, um den normalen Durchfluss durch den Sensor wieder herzustellen.

Bendétigen Sie Hilfe? Wenn die Nullpunktkalibrierung fehlschlagt:

. Stellen Sie sicher, dass kein Durchfluss durch den Sensor erfolgt und wiederholen Sie das
Verfahren.

. Entfernen oder reduzieren Sie elektromagnetisches Rauschen und wiederholen Sie das
Verfahren.

. Setzen Sie Zero Time auf einen niedrigeren Wert und wiederholen Sie das Verfahren.

. Sollte eine Nullpunktkalibrierung weiterhin nicht moglich sein, wenden Sie sich an

Micro Motion.

. Wenn das Durchflussmesssystem mit einem zuvor verwendeten Nullpunktwert wieder in
Betrieb genommen werden soll:

- Wiederherstellen des werksseitig eingestellten Nullpunktwertes: Device Tools > Zero
Verification and Calibration > Calibrate Zero > Restore Factory Zero . Diese Funktion erfordert den
Core Prozessor mit erweiterter Funktionalitat.

- Wiederherstellen des zuletzt giiltigen Nullpunktwertes vom Speicher der
Auswerteelektronik: Device Tools > Zero Verification and Calibration > Calibrate Zero > Restore Prior
Zero . Restore Prior Zero ist nur dann verfiigbar, wenn das Fenster Flow Calibration angezeigt
wird. Wenn das Fenster Flow Calibration geschlossen wird, kann der vorige Nullpunktwert
nicht mehr wiederhergestellt werden.

Einschrankung

Den werksseitigen Nullpunkt nur dann wiederherstellen, wenn das Durchflussmesssystem als eine
Einheit erworben wurde, der Nullpunkt im Werk kalibriert wurde und die Originalteile verwendet
werden.

11.3.4 Nullpunktkalibrierung des Durchflussmesssystems
mittels Handterminal

Die Nullpunktkalibrierung des Durchflussmesssystems etabliert einen Basiswert fiir die
Prozessmessung, indem der Sensorausgang analysiert wird, wenn kein Durchfluss im
Messrohr vorhanden ist.

1. Vorbereiten des Durchflussmesssystems:
a. Lassen Sie das Durchflussmesssystem nach dem Einschalten mindestens
20 Minuten aufwdrmen.

b. Lassen Sie das Prozessmedium durch den Sensor stromen, bis die
Sensortemperatur ungefahr die normale Betriebstemperatur erreicht hat.

c. Stoppen Sie den Durchfluss durch den Sensor, indem Sie das in Flussrichtung
abwarts liegende Ventil und danach das in Flussrichtung aufwadrts liegende Ventil
schlieRen (falls verfiigbar).

d. Stellen Sie sicher, dass der Sensor abgesperrt ist, kein Durchfluss mehr
vorhanden ist und der Sensor vollstandig mit dem Prozessmedium gefillt ist.
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e. Beobachten Sie die Werte flir Antriebsverstdrkung, Temperatur und Dichte. Sind
diese stabil, priifen Sie den Wert Live Zero oder Field Verification Zero. Wenn der
Mittelwert nahe bei 0 liegt, muss der Nullpunkt des Durchflussmesssystems
nicht kalibriert werden.

Driicken Sie Service Tools > Maintenance > Zero Calibration > Perform Auto Zero.

Andern Sie Zero Time falls gewiinscht.

Unter Zero Time versteht man die Zeit, die der Auswerteelektronik vorgegeben wird,
um den Referenzpunkt bei einem Durchfluss von Null zu bestimmen. Die

voreingestellte Zero Time betrdgt 20 Sekunden. Fiir die meisten Anwendungen ist die
voreingestellte Zero Time ausreichend.

4, Driicken Sie OK, um die Nullpunktkalibrierung zu starten, und warten Sie, bis die
Kalibrierung abgeschlossen ist.

5. Nach der Nullpunktkalibrierung werden die Daten angezeigt.

 Driicken Sie OK, um die Daten zu akzeptieren und die Werte zu speichern.

 Driicken Sie ABORT, um die Daten zu verwerfen und die vorigen Nullpunktdaten
zu verwenden.

Nachbereitungsverfahren

Offnen Sie die Ventile, um den normalen Durchfluss durch den Sensor wieder herzustellen.

Benotigen Sie Hilfe? Wenn die Nullpunktkalibrierung fehlschlégt:

. Stellen Sie sicher, dass kein Durchfluss durch den Sensor erfolgt und wiederholen Sie das
Verfahren.

. Entfernen oder reduzieren Sie elektromagnetisches Rauschen und wiederholen Sie das
Verfahren.

. Setzen Sie Zero Time auf einen niedrigeren Wert und wiederholen Sie das Verfahren.

. Sollte eine Nullpunktkalibrierung weiterhin nicht méglich sein, wenden Sie sich an

Micro Motion.

. Wenn das Durchflussmesssystem mit einem zuvor verwendeten Nullpunktwert wiederin
Betrieb genommen werden soll:

- Wiederherstellen des werksseitig eingestellten Nullpunktwertes: Service Tools > Maintenance
> Zero Calibration > Restore Factory Zero . Diese Funktion erfordert den Core Prozessor mit
erweiterter Funktionalitdt.

Einschrdankung

Den werksseitigen Nullpunkt nur dann wiederherstellen, wenn das Durchflussmesssystem als eine
Einheit erworben wurde, der Nullpunkt im Werk kalibriert wurde und die Originalteile verwendet
werden.
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11.4 Messsystem validieren
Anzeiger OFF-LINE MAINT > CONFG > UNITS > MTR F
ProLink Il ProLink > Configuration > Flow
ProLink Il Device Tools > Configuration > Process Measurement > Flow

Device Tools > Configuration > Process Measurement > Density

Handterminal Configure > Manual Setup > Measurements > Flow

Configure > Manual Setup > Measurements > Density

Uberblick

Die Systemvalidierung vergleicht die von der Auswerteelektronik ausgegebenen
Messwerte des Durchflussmessgerdts mit einem externen Messnormal. Weicht der von
der Auswerteelektronik ausgegebene Massdurchfluss-, Volumendurchfluss- oder
Dichtemesswert signifikant vom externen Messnormal ab, sollte der entsprechende
Gerdtefaktor gesetzt werden. Der tatsdchliche Messwert des Durchflussmessgerats wird
mit dem Geratefaktor multipliziert und der resultierende Wert wird ausgegeben und fiir
die weitere Verarbeitung verwendet.

Vorbereitungsverfahren

Identifizieren Sie den/die Geratefaktor(en), den/die Sie berechnen und setzen werden. Sie
kénnen jede Kombination der drei Geratefaktoren setzen: Massedurchfluss,
Volumendurchfluss und Dichte. Beachten Sie, dass alle drei Gerdtefaktoren unabhdngig

sind:

. Der Geratefaktor fiir Massedurchfluss beeinflusst nur den ausgegebenen Wert des
Massedurchflusses.

. Der Geratefaktor fiir Dichte beeinflusst nur den ausgegebenen Wert der Dichte.

. Der Geratefaktor fiir Volumendurchfluss beeinflusst nur den ausgegebenen Wert
des Volumendurchflusses oder des Gas Standard Volumendurchflusses.

Wichtig

Zum Justieren des Volumendurchflusses ist der Gerdtefaktor fiir Volumendurchfluss zu setzen. Das
Setzen des Geratefaktors fiir Massedurchfluss und des Gerdtefaktors fiir Dichte erzeugt nicht das
gewd(inschte Ergebnis. Die Berechnung des Volumendurchflusses basiert auf den originalen
Massedurchfluss- und Dichtewerten, bevor der entsprechende Gerdtefaktor angewendet wird.

Wenn Sie vorhaben, den Geratefaktor des Volumendurchflusses zu berechnen, sollten Sie
beachten, dass das Validieren des Volumens in der Anlage kostspielig sein kann. Dieser
Vorgang kann bei manchen Prozessmedien auRerdem gefahrlich sein. Da das Volumen
umgekehrt proportional zur Dichte ist, ist die Berechnung des Geratefaktors fir
Volumendurchfluss von dem Gerdtefaktor fiir Dichte eine alternative zur direkten
Messung. Anweisungen fiir diese Methode finden Sie in Abschnitt Abschnitt 11.4.1.

Stellen Sie ein Referenzgerdt (ein externes Messgerdt) fiir die entsprechende
Prozessvariable bereit.

Wichtig
Das Referenzgerat muss duBerst genau sein, um zuverldssige Ergebnisse zu erzielen.
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Verfahren
1. Bestimmen Sie den Gerdtefaktor wie folgt:

a. Nehmen Sie eine Probemessung mit dem Durchflussmessgerdt vor.
b. Messen Sie die gleiche Probe mit dem Referenzgerit.
c. Berechnen Sie den Geratefaktor mit folgender Formel:

Referenzmessung

NeuerGeratefaktor = KonfigurierterGeratefaktor x
Durchfluss-MesssystemMessung

2. Stellen Sie sicher, dass der berechnete Gerdtefaktor zwischen 0,8 und 1,2 liegt
(inklusive). Wenn der Gerdtefaktor auerhalb dieser Grenzen liegt, setzen Sie sich
mit dem Micro Motion Kundenservice in Verbindung.

3. Konfigurieren Sie den Gerdtefaktor in der Auswerteelektronik.

Beispiel: Gerdtefaktor fiir Massedurchfluss berechnen

Das Durchflussmesssystem wird zum ersten Mal installiert und verifiziert. Der von der
Auswerteelektronik gemessene Massedurchfluss betrdgt 250,27 Ib. Der vom
Referenzgerdt gemessene Massedurchfluss betrdgt 250 Ib. Der Geratefaktor fiir
Massedurchfluss wird wie folgt berechnet:

Geratefaktormassedure _ 1 x i = 0,9989

hfluss 250 27

Der erste Geratefaktor fiir Massedurchfluss ist 0,9989.

Ein Jahr spater wird das Durchflussmesssystem erneut validiert. Der von der
Auswerteelektronik gemessene Massedurchfluss betragt 250,07 Ib. Der vom
Referenzgerdt gemessene Massedurchfluss betrdgt 250,25 Ib. Der neue Gerdtefaktor fiir
Massedurchfluss wird wie folgt berechnet:

atefakt
Geréitefaktormassedure _ 0.0989 X 250,25 _ 0,9996

hfluss 250’07

Der neue Geratefaktor fiir Massedurchfluss ist 0.9996.

Alternative Methode fiir die Berechnung des
Geratefaktors fiir Volumendurchfluss

Die alternative Methode fiir die Berechnung des Gerdtefaktors fiir Volumendurchfluss wird
verwendet, um die Schwierigkeiten zu vermeiden, die bei Verwendung der
Standardmethode auftreten kdnnen.

Diese alternative Methode basiert auf der Tatsache, dass das Volumen umgekehrt
proportional zur Dichte ist. Sie bietet eine Teilkorrektur der Volumendurchflussmessung
durch Justierung des Anteils des Gesamt Offsets, der durch den Offset der Dichtemessung
begriindet ist. Verwenden Sie diese Methode nur dann, wenn keine Referenz fiir den
Volumendurchfluss verfiigbar ist, jedoch eine Referenz fiir die Dichte.
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Verfahren
1. Berechnen Sie den Gerdtefaktor fiir Dichte unter Verwendung der
Standardmethode (siehe Abschnitt 11.4).
2. Berechnen Sie den Geratefaktor fiir Volumendurchfluss vom Geratefaktor fiir die
Dichte:
. 1
Geratefaktorvolumen =
Geratefaktorpichte
Anmerkung

Die folgende Gleichung ist mathematisch dquivalent zur ersten Gleichung. Sie kénnen die
Gleichung verwenden, die Sie bevorzugen.

.. . . . Dichtepurchfluss-Messsystem
Geratefaktorvoumen = KonfigurierterGeratefaktorpichte X d

DiChteReferenzgerét

3. Stellen Sie sicher, dass der berechnete Geratefaktor zwischen 0,8 und 1,2 liegt
(inklusive). Wenn der Geratefaktor auRerhalb dieser Grenzen liegt, setzen Sie sich
mit dem Micro Motion Kundenservice in Verbindung.

4.  Konfigurieren Sie den Gerdtefaktor fir Volumendurchfluss in der
Auswerteelektronik.

11.5 (Standard) D1 und D2 Dichtekalibrierung
durchfiihren

Mittels der Dichtekalibrierung wird das Verhaltnis zwischen der Mediumsdichte bei
Dichtekalibrierung und dem vom Sensor erzeugten Signal ermittelt. Die
Dichtekalibrierung umfasst das Kalibrieren der Kalibrierpunkte D1 (niedrige Dichte) und
D2 (hohe Dichte).

Wichtig

Micro Motion Auswerteelektroniken werden werksseitig kalibriert und miissen normalerweise nicht
vor Ort kalibriert werden. Fiihren Sie eine Kalibrierung des Durchflussmessers nur dann durch, wenn
dies durch gesetzliche Bestimmungen gefordert wird. Wenden Sie sich an Micro Motion, bevor Sie
den Durchflussmesser kalibrieren.

Hinweis

Micro Motion empfiehlt eine Systemvalidierung und die Verwendung von Geratefaktoren anstatt
einer Kalibrierung, um den Durchflussmesser auf ein geeichtes Messnormal abzugleichen oder einen
Messfehler zu korrigieren.
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Durchfiihren einer D1- und D2-Dichtekalibrierung
mittels ProLink Il

Vorbereitungsverfahren

Wahrend der Dichtekalibrierung muss der Sensor komplett mit dem
Kalibriermedium gefiillt sein und der Durchfluss durch den Sensor muss so klein
sein, wie es lhre Anwendung ermdglicht. Dies wird normalerweise durch SchlieRen
des auslaufseitig vom Sensor befindlichen Absperrventils erreicht. AnschlieRend
fillen Sie den Sensor mit dem entsprechenden Medium.

Die D1 und D2 Dichtekalibrierung erfordert ein D1 Medium (niedrige Dichte) und
ein D2 Medium (hohe Dichte). Hierfiir kdnnen Sie Luft und Wasser nehmen.

Wenn LD Optimization in Ihrem System aktiviert ist, deaktivieren Sie diese Funktion.
Hierzu wahlen Sie ProLink > Configuration > Sensor und stellen sicher, dass das
Kontrollkdstchen nicht markiert ist. Die Funktion LD Optimization wird nur mit groRen
Sensoren in Kohlenwasserstoffanwendungen verwendet. In einigen Installationen
hat nur der Micro Motion Kundendienst Zugriff auf diesen Parameter. Verstdndigen
Sie in diesem Fall Micro Motion, bevor Sie fortfahren.

Die Kalibrierverfahren miissen ohne Unterbrechung in der gezeigten Reihenfolge
durchgefiihrt werden. Stellen Sie sicher, dass Sie das Verfahren ohne
Unterbrechungen abschlieRen kénnen.

Bevor Sie die Kalibrierung durchfiihren, notieren Sie die aktuellen
Kalibrierparameter. Sie konnen dies tun, in dem Sie die aktuelle Konfiguration als
Datei auf dem PC speichern. Sollte die Kalibrierung fehlschlagen, konnen die alten
Werte zuriickgespeichert werden.

Einschrdankung

Bei Sensoren der T-Serie muss die D1-Kalibrierung mit Luft und die D2-Kalibrierung mit Wasser
durchgefihrt werden.

Verfahren

Siehe Abbildung 11-7.
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Abbildung 11-7: D1- und D2-Dichtekalibrierung mittels ProLink II

D1 D2
Kalibrierung Kalibrierung
Absperrventil schliessen, .| Sensor mit D1 Medium .| Sensor mit D2 Medium
auslaufseitig vom Sensor g fiillen 7 fillen
A 4 ) 4
ProLink Menu > ProLink Menii >
Calibration > Calibration >
Density cal — Point 1 Density cal — Point 2
) 4 ) 4
Dichte des D1 Mediums Dichte des D2 Mediums
eingeben eingeben
[Kalibrierung austhren] [Kalibrierung austhren]
Calibration in Progress Calibration in Progress
LED wechselt auf rot LED wechselt auf rot
Calibration in Progress LED Calibration in Progress LED
wechselt auf grin wechselt auf grin
Schliessen Schliessen
|
Fertig

Nachbereitungsverfahren

Wenn Sie die Funktion LD Optimization vor dem Kalibrierverfahren deaktiviert haben,
aktivieren Sie diese wieder.

11.5.2 Durchfiihren einer D1- und D2-Dichtekalibrierung
mittels ProLink Il

Vorbereitungsverfahren

o Wiéhrend der Dichtekalibrierung muss der Sensor komplett mit dem
Kalibriermedium gefiillt sein und der Durchfluss durch den Sensor muss so klein
sein, wie es lhre Anwendung ermdglicht. Dies wird normalerweise durch SchlieBen
des auslaufseitig vom Sensor befindlichen Absperrventils erreicht. AnschlieRend
fiillen Sie den Sensor mit dem entsprechenden Medium.

. Die D1 und D2 Dichtekalibrierung erfordert ein D1 Medium (niedrige Dichte) und
ein D2 Medium (hohe Dichte). Hierflir kdnnen Sie Luft und Wasser nehmen.

. Wenn LD Optimization in Ihrem System aktiviert ist, deaktivieren Sie diese Funktion.
Hierzu wahlen Sie Device Tools > Configuration > LD Optimization. Die Funktion LD
Optimization wird nur mit groRen Sensoren in Kohlenwasserstoffanwendungen
verwendet. In einigen Installationen hat nur der Micro Motion Kundendienst Zugriff
auf diesen Parameter. Verstandigen Sie in diesem Fall Micro Motion, bevor Sie
fortfahren.
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. Die Kalibrierverfahren miissen ohne Unterbrechung in der gezeigten Reihenfolge
durchgefiihrt werden. Stellen Sie sicher, dass Sie das Verfahren ohne
Unterbrechungen abschlieBen kdnnen.

. Bevor Sie die Kalibrierung durchfiihren, notieren Sie die aktuellen
Kalibrierparameter. Sie konnen dies tun, in dem Sie die aktuelle Konfiguration als
Datei auf dem PC speichern. Sollte die Kalibrierung fehlschlagen, kénnen die alten
Werte zuriickgespeichert werden.

Einschrdankung

Bei Sensoren der T-Serie muss die D1-Kalibrierung mit Luft und die D2-Kalibrierung mit Wasser
durchgefiihrt werden.

Verfahren

Siehe Abbildung 11-8.

Abbildung 11-8: D1- und D2-Dichtekalibrierung mittels ProLink Il

Absperrventil schliessen,
auslaufseitig vom Sensor

D1 D2
Kalibrierung b Kalibrierung
Sensor mit D1 Medium | Sensor mit D2 Medium
fiillen g fiillen
Device Tools > Device Tools >
Calibration > Calibration >
Density Calibration > Density Calibration >
Density Calibration — Point 1 (Air) Density Calibration — Point 2 (Water)
Dichte des D1 Mediums Dichte des D2 Mediums
eingeben eingeben
Schliessen Schliessen
\ 4 l
Fertig

Nachbereitungsverfahren

Wenn Sie die Funktion LD Optimization vor dem Kalibrierverfahren deaktiviert haben,
aktivieren Sie diese wieder.
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11.5.3 D1- und D2-Dichtekalibrierung durchfiihren mittels
Handterminal

Vorbereitungsverfahren

. Wahrend der Dichtekalibrierung muss der Sensor komplett mit dem
Kalibriermedium gefiillt sein und der Durchfluss durch den Sensor muss so klein
sein, wie es lhre Anwendung ermdglicht. Dies wird normalerweise durch SchlieRen
des auslaufseitig vom Sensor befindlichen Absperrventils erreicht. AnschlieRend
fullen Sie den Sensor mit dem entsprechenden Medium.

. Die D1 und D2 Dichtekalibrierung erfordert ein D1 Medium (niedrige Dichte) und
ein D2 Medium (hohe Dichte). Hierfiir kdnnen Sie Luft und Wasser nehmen.

. Wenn LD Optimization in Ihrem System aktiviert ist, deaktivieren Sie diese Funktion.
Hierzu wahlen Sie Configure > Manual Setup > Measurements > LD Optimization. Die Funktion
LD Optimization wird nur mit groBen Sensoren in Kohlenwasserstoffanwendungen
verwendet. In einigen Installationen hat nur der Micro Motion Kundendienst Zugriff
auf diesen Parameter. Verstandigen Sie in diesem Fall Micro Motion, bevor Sie
fortfahren.

o Die Kalibrierverfahren miissen ohne Unterbrechung in der gezeigten Reihenfolge
durchgefiihrt werden. Stellen Sie sicher, dass Sie das Verfahren ohne
Unterbrechungen abschlieRen kénnen.

. Bevor Sie die Kalibrierung durchfiihren, notieren Sie die aktuellen
Kalibrierparameter. Sollte die Kalibrierung fehlschlagen, kénnen die alten Werte
zuriickgespeichert werden.

Einschrdankung

Bei Sensoren der T-Serie muss die D1-Kalibrierung mit Luft und die D2-Kalibrierung mit Wasser
durchgefiihrt werden.

Verfahren

Siehe Abbildung 11-9.
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Abbildung 11-9: D1- und D2-Dichtekalibrierung mittels Handterminal
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Nachbereitungsverfahren

Wenn Sie die Funktion LD Optimization vor dem Kalibrierverfahren deaktiviert haben,

aktivieren Sie diese wieder.

11.6

Bei T-Serie Sensoren kann die optionale D3 und D4 Kalibrierung moglicherweise die
Genauigkeit der Dichtemessung verbessern, wenn die Dichte des Prozessmediums
niedriger als 0,8 g/cm?3 oder hoher als 1,2 g/cm?3 ist.

Bei der Durchfiihrung der D3 und D4 Kalibrierung ist Folgendes zu beachten:
. Fiihren Sie keine D1 und D2 Kalibrierung durch.

. Fiihren Sie die D3 Kalibrierung durch, wenn Sie (iber ein kalibriertes Medium
verfligen.

184

Micro Motion® Auswerteelektronik Modell 2700 mit eigensicheren Ausgédngen

D3 und D4 Dichtekalibrierung durchfiihren
(nur T-Serie Sensoren)




Messunterstiitzung

. Fiihren Sie sowohl die D3 als auch die D4 Kalibrierung durch, wenn Sie {iber zwei
kalibrierte Medien verfligen (andere als Luft und Wasser). Die Kalibrierverfahren
miissen ohne Unterbrechung in der gezeigten Reihenfolge durchgefiihrt werden.
Stellen Sie sicher, dass Sie das Verfahren ohne Unterbrechungen abschlieRen
kénnen.

11.6.1 Durchfiihren einer D3- oder D4-Dichtekalibrierung
mittels ProLink Il

Vorbereitungsverfahren

. Wahrend der Dichtekalibrierung muss der Sensor komplett mit dem
Kalibriermedium gefiillt sein und der Durchfluss durch den Sensor muss so klein
sein, wie es lhre Anwendung ermdglicht. Dies wird normalerweise durch SchlieRen
des auslaufseitig vom Sensor befindlichen Absperrventils erreicht. AnschlieRend
fiillen Sie den Sensor mit dem entsprechenden Medium.

o Fir die D3-Dichtekalibrierung muss das Medium folgenden Anforderungen
entsprechen:

- Min. Dichte von 0,6 g/cm?3

- Min. Dichteabweichung von 0,1 g/cm?3 zwischen D3-Medium und Wasser. Die
Dichte des D3-Mediums kann héher oder niedriger als die Dichte des Wassers
sein.

. Fir die D4-Dichtekalibrierung muss das Medium folgenden Anforderungen
entsprechen:

- Min. Dichte von 0,6 g/cm?

- Min. Dichteabweichung von 0,1 g/cm?3 zwischen D4-Medium und D3-Medium.
Die Dichte des D4-Mediums muss hoher sein als die Dichte des D3-Mediums.

- Min. Dichteabweichung von 0,1 g/cm?3 zwischen D4-Medium und Wasser. Die
Dichte des D4-Mediums kann hoher oder niedriger als die Dichte von Wasser
sein.

. Bevor Sie die Kalibrierung durchfiihren, notieren Sie die aktuellen
Kalibrierparameter. Sie konnen dies tun, in dem Sie die aktuelle Konfiguration als
Datei auf dem PC speichern. Sollte die Kalibrierung fehlschlagen, konnen die alten
Werte zuriickgespeichert werden.

Verfahren

Siehe Abbildung 11-10.
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Abbildung 11-10: D3- oder D3- und D4-Dichtekalibrierung mittels ProLink Il
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Durchfiihren einer D3- oder einer D3- und D4-
Dichtekalibrierung mittels ProLink Il

Vorbereitungsverfahren

Wahrend der Dichtekalibrierung muss der Sensor komplett mit dem
Kalibriermedium gefiillt sein und der Durchfluss durch den Sensor muss so klein
sein, wie es lhre Anwendung ermdglicht. Dies wird normalerweise durch SchlieRen
des auslaufseitig vom Sensor befindlichen Absperrventils erreicht. AnschlieRend
fullen Sie den Sensor mit dem entsprechenden Medium.

Fiir die D3-Dichtekalibrierung muss das Medium folgenden Anforderungen
entsprechen:

- Min. Dichte von 0,6 g/cm?

- Min. Dichteabweichung von 0,1 g/cm?3 zwischen D3-Medium und Wasser. Die
Dichte des D3-Mediums kann héher oder niedriger als die Dichte des Wassers
sein.

Fiir die D4-Dichtekalibrierung muss das Medium folgenden Anforderungen
entsprechen:

- Min. Dichte von 0,6 g/cm?3

- Min. Dichteabweichung von 0,1 g/cm? zwischen D4-Medium und D3-Medium.
Die Dichte des D4-Mediums muss hoher sein als die Dichte des D3-Mediums.
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- Min. Dichteabweichung von 0,1 g/cm?3 zwischen D4-Medium und Wasser. Die

Dichte des D4-Mediums kann héher oder niedriger als die Dichte von Wasser
sein.

Bevor Sie die Kalibrierung durchfiihren, notieren Sie die aktuellen
Kalibrierparameter. Sie konnen dies tun, in dem Sie die aktuelle Konfiguration als

Datei auf dem PC speichern. Sollte die Kalibrierung fehlschlagen, konnen die alten
Werte zuriickgespeichert werden.

Verfahren

Siehe Abbildung 11-11.

Abbildung 11-11: D3- oder D3- und D4-Dichtekalibrierung mittels ProLink IlI
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Durchfiihren einer D3- oder einer D3- und D4-
Dichtekalibrierung mittels Handterminal

Vorbereitungsverfahren

Wahrend der Dichtekalibrierung muss der Sensor komplett mit dem
Kalibriermedium gefiillt sein und der Durchfluss durch den Sensor muss so klein
sein, wie es lhre Anwendung ermdglicht. Dies wird normalerweise durch SchlieRen
des auslaufseitig vom Sensor befindlichen Absperrventils erreicht. AnschlieRend
fillen Sie den Sensor mit dem entsprechenden Medium.

Fiir die D3-Dichtekalibrierung muss das Medium folgenden Anforderungen
entsprechen:

- Min. Dichte von 0,6 g/cm?
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- Min. Dichteabweichung von 0,1 g/cm?3 zwischen D3-Medium und Wasser. Die

Dichte des D3-Mediums kann hoher oder niedriger als die Dichte des Wassers
sein.

. Fiir die D4-Dichtekalibrierung muss das Medium folgenden Anforderungen
entsprechen:

- Min. Dichte von 0,6 g/cm?

- Min. Dichteabweichung von 0,1 g/cm? zwischen D4-Medium und D3-Medium.
Die Dichte des D4-Mediums muss hoher sein als die Dichte des D3-Mediums.

- Min. Dichteabweichung von 0,1 g/cm?3 zwischen D4-Medium und Wasser. Die
Dichte des D4-Mediums kann héher oder niedriger als die Dichte von Wasser
sein.

. Bevor Sie die Kalibrierung durchfiihren, notieren Sie sich die aktuellen
Kalibrierparameter. Sollte die Kalibrierung fehlschlagen, kénnen die alten Werte
zuriickgespeichert werden.

Verfahren

Siehe Abbildung 11-12.

Abbildung 11-12: D3- oder D3- und D4-Dichtekalibrierung mittels Handterminal
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11.7

11.7.1

Durchfiihren einer Temperaturkalibrierung

Die Temperaturkalibrierung stellt die Beziehung zwischen der Temperatur der
Kalibriermedien und dem vom Sensor erzeugten Signal her.

Durchfiihren einer Temperaturkalibrierung mit ProLink Il

Die Temperaturkalibrierung stellt die Beziehung zwischen der Temperatur der
Kalibriermedien und dem vom Sensor erzeugten Signal her.

Vorbereitungsverfahren

Die Temperaturkalibrierung ist ein zweiteiliges Verfahren: die Kalibrierung des
Temperatur-Offsets und die Kalibrierung der Temperatursteigung Die beiden
Kalibrierverfahren miissen ohne Unterbrechung in der gezeigten Reihenfolge
durchgefiihrt werden. Stellen Sie sicher, dass Sie das Verfahren ohne Unterbrechungen
abschlieBen kdnnen.

Wichtig
Wenden Sie sich an Micro Motion, bevor Sie eine Temperaturkalibrierung durchfiihren. Unter
normalen Umstédnden ist der Temperaturkreis stabil und sollte nicht eingestellt werden mdissen.

Verfahren

Siehe Abbildung 11-13.
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Abbildung 11-13: Temperaturkalibrierung mit ProLink I
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Durchfiihren einer Temperaturkalibrierung mit
ProLink Il

Die Temperaturkalibrierung stellt die Beziehung zwischen der Temperatur der
Kalibriermedien und dem vom Sensor erzeugten Signal her.

Vorbereitungsverfahren

Die Temperaturkalibrierung ist ein zweiteiliges Verfahren: die Kalibrierung des
Temperatur-Offsets und die Kalibrierung der Temperatursteigung Die beiden
Kalibrierverfahren miissen ohne Unterbrechung in der gezeigten Reihenfolge
durchgefiihrt werden. Stellen Sie sicher, dass Sie das Verfahren ohne Unterbrechungen
abschlieBen kdnnen.

Wichtig
Wenden Sie sich an Micro Motion, bevor Sie eine Temperaturkalibrierung durchfiihren. Unter
normalen Umstanden ist der Temperaturkreis stabil und sollte nicht eingestellt werden miissen.

Verfahren

Siehe Abbildung 11-14.
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Abbildung 11-14: Temperaturkalibrierung mit ProLink IlI
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12

12.1

192

Storungsanalyse und -behebung

In diesem Kapitel behandelte Themen:

Status LED-Zustéinde

Status Alarme

Probleme bei Durchflussmessungen

Probleme bei Dichtemessungen

Probleme bei der Temperaturmessung

Probleme bei mA-Ausgdngen

Probleme beim Frequenzausgang

Verwenden der Sensorsimulation zur Stérungsanalyse und -beseitigung
Verdrahtung der Spannungsversorgung priifen

Priifen der Verdrahtung vom Sensor zur Auswerteelektronik
Erdung (iberpriifen

Messkreistests durchfiihren

mA Ausgdnge abgleichen

HART Kommunikationskreis prifen

Priifen der HART Adresse und des Messkreis Strommodus
HART Burst Modus priifen

Priifen von Messanfang und Messende

mA Ausgang Stdraktion prifen

Priifung auf hochfrequente Stérungen (RFI)
Frequenzausgang max. Impulsbreite priifen
Frequenzausgang Skaliermethode priifen
Frequenzausgang Storaktion priifen

Priifen der Durchflussrichtung

Priifen der Abschaltungen

Priifen auf Schwallstrémung (Zweiphasenstrémung)
Antriebsverstdrkung priifen

Aufnehmerspannung priifen

Priifen auf elektrische Kurzschliisse

Core Prozessor LED prtifen.

Core Prozessor Widerstandstest durchfiihren

Status LED-Zustdande

Die Status-LED an der Auswerteelektronik gibt an, ob ein Alarm aktiv ist. Wenn ein Alarm
aktiv ist, die Alarmliste anzeigen, um die Alarme zu identifizieren und dann die
entsprechenden KorrekturmaRnahmen ergreifen, um die Alarmbedingung zu beheben.
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Die Auswerteelektronik verfiigt nur (iber eine Status-LED, wenn sie mit einem

Bedieninterface ausgestattet ist.

Wenn die Auswerteelektronik iber ein Bedieninterface verfligt und LED Blinking deaktiviert
ist, blinkt die Status-LED nicht, um einen unbestatigten Alarm anzuzeigen.

Tabelle 12-1: Status-LED Zustdande

Zustand Parameter LED Blinking = LED Verhalten
Normalbetrieb (kein Alarm) k.A. Griin
Unbestatigte korrigierte Bedingung (kein Aktiviert Griin blinkend
Alarm) Deaktiviert Griin
Bestdtigter Alarm niedriger Stufe (Ausgdnge k.A. Gelb
melden weiterhin Prozessdaten)
Unbestatigter Alarm niedriger Stufe (Ausgange | Aktiviert Gelb blinkend
melden weiterhin Prozessdaten) Deaktiviert Gelb
Bestdtigter Alarm hoher Stufe (Ausgange stehen | k.A. Dauerhaft rot
auf Stérung)
Unbestdtigter Alarm hoher Stufe (Ausgange ste- | Aktiviert Rot blinkend
hen auf Stérung) Deaktiviert Dauerhaft rot

12.2 Status Alarme

Tabelle 12-2: Statusalarme und empfohlene MaBnahmen
Alarm Code Beschreibung Empfohlene MaBnahmen
A001 EEPROM-Fehler (Core-Prozes- | Die Auswerteelektronik hat ein Problem bei der Kommunikation
sor) mit dem Sensor erkannt. Das Messsystem Aus/Einschalten und
priifen, ob der Zustand sich beheben lasst. Andernfalls muss der
Core Prozessor ausgetauscht werden.
A002 RAM-Fehler (Core-Prozessor) | Die Auswerteelektronik hat ein Problem bei der Kommunikation

mit dem Sensor erkannt. Das Messsystem Aus/Einschalten und
priifen, ob der Zustand sich beheben lasst. Andernfalls muss der
Core Prozessor ausgetauscht werden.
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Tabelle 12-2: Statusalarme und empfohlene MaBnahmen (Fortsetzung)

Alarm Code

Beschreibung

Empfohlene MaBnahmen

A003

Keine Antwort vom Sensor

Die Auswerteelektronik empfangt keine elektrischen Signale
vom Sensor. Das kann bedeuten, dass die Verdrahtung zwischen
Sensor und Auswerteelektronik beschddigt ist oder dass der Sen-
sorim Werk Gberpriift werden muss.

1.

3.
4.

Die Antriebsverstarkung und die Aufnehmerspannung prii-

fen. (Siehe Abschnitt 12.26 und Abschnitt 12.27.)

Die Verdrahtung zwischen Sensor und Auswerteelektronik

prifen.

a. Priifen Sie an Hand der Installationsanleitung fiir Ihre
Auswerteelektronik, ob diese entsprechend der Anwei-
sung mit dem Sensor verbunden ist. Beachten Sie beim
Offnen der Anschlussraume alle Sicherheitshinweise.

b. Priifen Sie, ob die Adern guten Kontakt mit den Ans-
chlussklemmen haben.

c. RTD-Widerstdnde und auf Kurzschliisse am Gehduse prii-
fen (siehe Abschnitt 12.28.1).

d. Die Verdrahtung zwischen Auswerteelektronik und Sen-
sor priifen.

Auf elektrische Kurzschliisse priifen. Siehe Abschnitt 12.28.

Die Unversehrtheit der Sensormessrohre priifen.

A004

Messbereichstiberschreitung
flr Temperatur

Der Widerstandsthermometer des Sensors signalisiert einen Wi-
derstand, der auBerhalb des Betriebsbereichs des Sensors liegt.

1.

Die Widerstandsthermometer Widerstandswerte und auf
Widerstandsthermometer Kurzschliisse zum Gehduse tiber-
priifen. (Siehe Abschnitt 12.28.1.)

Die Verdrahtung zwischen Sensor und Auswerteelektronik

priifen.

a. Prifen Sie an Hand der Installationsanleitung fir Ihre
Auswerteelektronik, ob diese entsprechend der Anwei-
sung mit dem Sensor verbunden ist. Beachten Sie beim
Offnen der Anschlussraume alle Sicherheitshinweise.

b. Prifen Sie, ob die Adern guten Kontakt mit den Ans-
chlussklemmen haben.

¢. RTD-Widerstande und auf Kurzschliisse am Gehause prii-
fen (siehe Abschnitt 12.28.1).

d. Die Verdrahtung zwischen Auswerteelektronik und Sen-
sor priifen.

Die Temperatur-Charakterisierungsparameter (Temperaturkali-

brierfaktor) priifen.

Uberpriifen Sie Ihre Prozessbedingungen anhand der vom

Durchflussmesser gemeldeten Werte.
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Tabelle 12-2: Statusalarme und empfohlene MaBnahmen (Fortsetzung)

Alarm Code

Beschreibung

Empfohlene MaBnahmen

A005

Messbereichsiiberschreitung
fiir Massedurchfluss

Der Sensor signalisiert eine Durchfluss, die auRerhalb des Sen-
sorbereichs liegt.

1.

Sind andere Alarme vorhanden, diese Alarmbedingungen
zuerst beheben. Besteht der aktuelle Alarm weiterhin, fahren
Sie mit den Empfehlungen hier fort.

Uberpriifen Sie Ihre Prozessbedingungen anhand der vom

Durchflussmesser gemeldeten Werte.

Auf Schwallstromung (Zweiphasenstromung) priifen.

a. Aufdurch Schwallstrémung ausgeltste Alarme priifen.
Wird das Problem durch Schwallstrdmung verursacht,
werden Alarme ausgegeben.

b. Prozess auf Kavitation, Dampfbildung oder Leckagen
prifen.

c. Die Dichte des Prozessmediumausgangs unter normalen
Prozessbedingungen {iberwachen.

A006

Charakterisierung erforderlich

Die Kalibrierfaktoren fiir den Sensor wurden nicht eingegeben,
der Sensortyp ist falsch oder die Kalibrierfaktoren sind fiir diesen
Sensortyp falsch.

1.

Priifen Sie, ob alle Charakterisierungsparameter den Daten
auf dem Sensor-Tag entsprechen.

Den Widerstand von Adern Langenkompensator (LLC) prii-
fen. (Siehe Abschnitt 12.28.1.)

Den Parameter Sensor Type priifen und sicherstellen, dass
dieser mit dem Sensortyp (ibereinstimmt.

WennSensor Type auf Curved Tube gesetzt ist, sicherstellen,
dass keine der Parameter fiir Geradrohrsensoren gesetzt
worden sind.

Wenn alle Parameter korrekt sind und der Alarm weiterhin
besteht, den Core Prozessor austauschen.
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Tabelle 12-2: Statusalarme und empfohlene MaBnahmen (Fortsetzung)

Alarm Code Beschreibung Empfohlene MaBnahmen

A008 Dichte Bereichsiiberschreitung | Der Sensor signalisiert einen Dichtewert unter 0 g/cm?3 oder iiber
10 g/cm3. Hiufige Ursachen fiir diesen Alarm sind teilweise ge-
fiillte Messrohre, extreme Gaseinschliisse oder Dampfbildung,
Rohrablagerungen (im Rohr festsitzende Fremdkorper, un-
gleichmaRige Ablagerungen im Rohrinneren oder ein ver-
stopftes Rohr) oder Rohrverformungen (eine permanente Ve-
randerung der Rohrgeometrie verursacht durch Uberdruck oder
Schlageinwirkung).

1. Sind andere Alarme vorhanden, diese Alarmbedingungen
zuerst beheben. Besteht der aktuelle Alarm weiterhin, fahren
Sie mit den Empfehlungen hier fort.

2. Uberpriifen Sie Ihre Prozessbedingungen anhand der vom
Durchflussmesser gemeldeten Werte.

3. Priifen, ob Luftin den Messrohren vorhanden ist, die Mess-
rohre nicht gefillt sind oder sich Fremdkorper oder Ablager-
ungen in den Messrohren befinden.

4. Auf Schwallstromung priifen (zweiphasiger Durchfluss).

a. AufSchwallstromungs-Alarme priifen. Verursacht die
Schallstrémung Probleme, werden Alarme ausgeldst.

b. Prozess auf Kavitation, Dampfbildung oder Leckagen
prifen.

c. Die Dichte Ihres Prozessmediumausgangs unter normal-
en Prozessbedingungen tiberwachen.

d. Die Werte von Schwallstrémungsanfang, Schwallstrdmung-
sende und Schwallstrdmungsdauer priifen.

5. Wenn zusétzlich ein AO03 Alarm besteht, auf elektrische
Kurzschliisse zwischen den Sensor Anschussklemmen und
dem Sensorgehduse priifen.

6. Priifen Sie, ob alle Charakterisierungsparameter den Daten
auf dem Sensor-Tag entsprechen.

7. Die Sensorspulen priifen (siehe Abschnitt 12.28.7).

8. Die Antriebsverstarkung und die Aufnehmerspannung prii-
fen.

9. Dichtekalibrierung durchfiihren.

10. Wenden Sie sich an Micro Motion.

A009 Auswerteelektronik Initialisier- | Die Auswerteelektronik befindet sich im Einschaltmodus. Wart-
ung/Aufwarmphase en Sie die Warmlaufzeit ab. Der Alarm sollte automatisch ge-
|6scht werden.

Wenn der Alarm nicht gel6scht wird:

1. Sicherstellen, dass der Core Prozessor mit ausreichend Span-
nung versorgt wird. Es sollten mindestens 11,5 VDC an den
Anschlussklemmen des Core Prozessors anliegen. Ist die
Spannung, die an den Anschlussklemmen des Core Prozes-
sors anliegt, zu niedrig, priifen, dass die Auswerteelektronik
mit ausreichend Spannung an den Klemmen versorgt wird.

2. Sicherstellen, dass die Messrohre vollstandig mit Prozessme-
dium gefiillt sind.

3. Die Verdrahtung zwischen Sensor und Auswerteelektronik
prifen.
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Alarm Code

Beschreibung

Empfohlene MaBnahmen

A010

Kalibrierfehler

Dieser Alarm wird normalerweise ausgeldst, wenn bei der Null-

punktkalibrierung ein Durchfluss im Sensor herrscht oder durch

einen Nullpunkt Offset, die auBerhalb des Bereichs liegt. Die

Auswerteelektronik Aus/Einschalten, um diesen Alarm zu 16-

schen.

1. Die Spannungsversorgung des Messsystems Aus/Einschal-
ten.

2. Sicherstellen, dass kein Durchfluss im Sensor vorhanden ist.

Die Nullpunktkalibrierung wiederholen.

4. Spannungsversorgung der Auswerteelektronik Aus/Einschal-
ten.

w

AO011

Nullpunktkalibrierung fehlges-
chlagen: Tief

Dieser Alarm wird ausgel6st, wenn ein Riickwartsdurchfluss

wahrend der Nullpunktkalibrierung im Sensor vorhanden ist

oder durch einen Nullpunkt Offset, der unterhalb des giltigen

Bereichs liegt. Dieser Alarm tritt zusammen mit A010 auf. Die

Auswerteelektronik muss Aus/Einschalten werden, um diesen

Alarm zu l6schen.

1. Die Spannungsversorgung des Messsystems Aus/Einschal-
ten.

2. Sicherstellen, dass kein Durchfluss im Sensor vorhanden ist.

Die Nullpunktkalibrierung wiederholen.

4. Spannungsversorgung der Auswerteelektronik Aus/Einschal-
ten.

w

A012

Nullpunktkalibrierung fehlges-
chlagen: Hoch

Dieser Alarm wird ausgel6st, wenn ein positiver Durchfluss wah-

rend der Nullpunktkalibrierung im Sensor vorhanden ist oder

durch einen Nullpunkt Offset, die oberhalb des giiltigen Bereichs

liegt. Dieser Alarm tritt zusammen mit A010 auf. Die Auswertee-

lektronik Aus/Einschalten, um diesen Alarm zu I6schen.

1. Die Spannungsversorgung des Messsystems Aus/Ein schal-
ten.

2. Sicherstellen, dass kein Durchfluss im Sensor vorhanden ist.

Die Nullpunktkalibrierung wiederholen.

4. Spannungsversorgung der Auswerteelektronik Aus/Einschal-
ten.

w

A013

Nullpunktkalibrierung fehlges-
chlagen: Instabil

Zu hohe Instabilitdat wahrend der Kalibrierung. Die Auswertee-
lektronik Aus/Einschalten, um diesen Alarm zu I6schen.
1. Elektromechanische Stérungen (z. B. Pumpen, Vibrationen,

Rohrleitungsspannungen) eliminieren bzw. reduzieren.

e Die Antriebsverstdrkung und die Aufnehmerspannung
priifen, um sicherzustellen, dass sich der Sensor in einem
stabilen Zustand befindet.

e Das Verfahren wiederholen.

2. Spannungsversorgung aus-/einschalten und erneut versu-
chen.
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Alarm Code

Beschreibung
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A014

Auswerteelektronikfehler

1. Prifen, dass alle Abdeckungen des Anschlussklemmenge-
hduses ordnungsgemag installiert sind

2. Priifen, dass die an die Auswerteelektronik angeschlossene
Verdrahtung den Spezifikationen entspricht und dass alle Ka-
belabschirmungen ordnungsgemadf aufgelegt sind.

3. Priifen, dass der Sensor und die Auswerteelektronik ord-
nungsgemaf geerdet sind.

4. Die Umgebung auf Quellen mit hoher elektromagnetischer
Storung (EMI) untersuchen und die Auswerteelektronik oder
die Verdrahtung ggf. neu positionieren.

A016

Sensor-RTD-Fehler

Der Widerstandsthermometer des Sensors signalisiert einen Wi-

derstand, der auBerhalb des Betriebsbereichs des Sensors liegt.

1. Die Verdrahtung zwischen Sensor und Auswerteelektronik
priifen.

a. Prifen Sie an Hand der Installationsanleitung fir Ihre
Auswerteelektronik, ob diese entsprechend der Anwei-
sung mit dem Sensor verbunden ist. Beachten Sie beim
Offnen der Anschlussraume alle Sicherheitshinweise.

b. Prifen Sie, ob die Adern guten Kontakt mit den Ans-
chlussklemmen haben.

¢. RTD-Widerstande und auf Kurzschliisse am Gehause prii-
fen (siehe Abschnitt 12.28.1).

d. Die Verdrahtung zwischen Auswerteelektronik und Sen-
sor priifen.

2. Uberpriifen Sie Ihre Prozessbedingungen anhand der vom

Durchflussmesser gemeldeten Werte.

3. Wenden Sie sich an Micro Motion.

A017

T-Serien-RTD-Fehler

Der Widerstandsthermometer des Sensors signalisiert einen Wi-

derstand, der auBerhalb des Betriebsbereichs des Sensors liegt.

1. Die Verdrahtung zwischen Sensor und Auswerteelektronik
priifen.

a. Prifen Sie an Hand der Installationsanleitung fir Ihre
Auswerteelektronik, ob diese entsprechend der Anwei-
sung mit dem Sensor verbunden ist. Beachten Sie beim
Offnen der Anschlussraume alle Sicherheitshinweise.

b. Prifen Sie, ob die Adern guten Kontakt mit den Ans-
chlussklemmen haben.

¢. RTD-Widerstande und auf Kurzschliisse am Gehause prii-
fen (siehe Abschnitt 12.28.1).

d. Die Verdrahtung zwischen Auswerteelektronik und Sen-
sor priifen.

2. Uberpriifen Sie Ihre Prozessbedingungen anhand der vom
Durchflussmesser gemeldeten Werte. Die Temperatur sollte
zwischen -200 °F und +400 °F liegen.

3. Priifen Sie, ob alle Charakterisierungsparameter den Daten
auf dem Sensor-Tag entsprechen.

4. Wenden Sie sich an Micro Motion.
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Alarm Code Beschreibung Empfohlene MaBnahmen
A018 EEPROM-Fehler (Auswerteelek- = Die Auswerteelektronik Aus/Einschalten, um diesen Alarm zu |6-
tronik) schen.

1. Priifen, dass alle Abdeckungen des Anschlussklemmenge-
hduses ordnungsgemadR installiert sind

2. Prifen, dass die an die Auswerteelektronik angeschlossene
Verdrahtung den Spezifikationen entspricht und dass alle
Abschirmungen ordnungsgemaR aufgelegt sind.

3. Priifen, dass der Sensor und die Auswerteelektronik ord-
nungsgemaR geerdet sind.

4. Die Umgebung auf Quellen mit hoher elektromagnetischer
Stérung (EMI) untersuchen und die Auswerteelektronik oder
die Verdrahtung ggf. neu positionieren.

5. Die Spannungsversorgung der Auswerteelektronik aus- und
einschalten.

6. Wenn das Problem nicht beseitigt werden kann, die Auswer-
teelektronik austauschen.

A019 RAM-Fehler (Auswerteelektro- | Die Auswerteelektronik Aus/Einschalten, um diesen Alarm zu |6-

nik) schen.

1. Priifen, dass alle Abdeckungen des Anschlussklemmenge-
hduses ordnungsgemaR installiert sind

2. Prifen, dass die an die Auswerteelektronik angeschlossene
Verdrahtung den Spezifikationen entspricht und dass alle
Abschirmungen ordnungsgemaR aufgelegt sind.

3. Priifen, dass der Sensor und die Auswerteelektronik ord-
nungsgemaR geerdet sind.

4. Die Umgebung auf Quellen mit hoher elektromagnetischer
Stérung (EMI) untersuchen und die Auswerteelektronik oder
die Verdrahtung ggf. neu positionieren.

5. Die Spannungsversorgung der Auswerteelektronik Aus/Ein-
schalten

6. Wenn das Problem nicht beseitigt werden kann, die Auswer-
teelektronik austauschen.

A020 K.wrt f. k. Drchflss Der Durchflusskalibrierfaktor und/oder K1 wurden seit dem
letzten Master Reset nicht eingegeben. Priifen Sie, ob alle Char-
akterisierungsparameter den Daten auf dem Sensor-Tag en-
tsprechen. Wenn das Problem weiterhin besteht:

1. Prifen, dass der Sensortyp (gebogen oder gerade) ord-
nungsgemaf ausgewahlt wurde.

2. Uberpriifen, dass keine Kalibrierparameter der T-Serie ge-
setzt wurden, wenn dies ein Sensor mit gebogenem Mess-
rohrist.
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Alarm Code

Beschreibung

Empfohlene MaBnahmen

A021

Falscher Sensortyp (K1)

Der Sensor wird als Geradrohr erkannt, aber der K1 Wert deutet
auf einen Sensor mit gebogenem Messrohr hin oder umgekehrt.
Priifen Sie, ob alle Charakterisierungsparameter den Daten auf
dem Sensor-Tag entsprechen. Wenn das Problem weiterhin bes-
teht:

1. Prifen, dass der Sensortyp (gebogen oder gerade) ord-
nungsgemaf ausgewahlt wurde.

2. Uberpriifen, dass keine Kalibrierparameter der T-Serie ge-
setzt wurden, wenn dies ein Sensor mit gebogenem Mess-
rohrist.

3. Wenn dieser Alarm zusammen mit AQ06 auftritt, den Adern
Ldngenkompensator (LLC) Widerstand und auf Kurzschliisse
zum Gehause Uberpriifen (Abschnitt 12.28.7).

A022

Konfigurationsdatenbank be-
schadigt (Core-Prozessor)

Priifen Sie durch Aus- und Einschalten der Spannungsversorgung
zum Messsystem, ob der Alarm geléscht wird. Wenn der Alarm
weiterhin besteht, den Core-Prozessor ersetzen.

A023

Interne Zahler beschadigt
(Core-Prozessor)

Priifen Sie durch Aus- und Einschalten der Spannungsversorgung
zum Messsystem, ob der Alarm gel&scht wird. Wenn der Alarm
weiterhin besteht, den Core-Prozessor ersetzen.

A024

Programm beschadigt (Core-
Prozessor)

Priifen Sie durch Aus- und Einschalten der Spannungsversorgung
zum Messsystem, ob der Alarm geldscht wird. Wenn der Alarm
weiterhin besteht, den Core-Prozessor ersetzen.

A025

Bootsektorfehler (Core-Prozes-
sor)

Priifen Sie durch Aus- und Einschalten der Spannungsversorgung
zum Messsystem, ob der Alarm gel6scht wird. Wenn der Alarm
weiterhin besteht, den Core-Prozessor ersetzen.

A026

Sensor-/Auswerteelektronik-
Kommunikationsfehler

Die Auswerteelektronik hat die Kommunikation mit dem Core

Prozessor am Sensor verloren. Dieser Alarm kann auf ein Prob-

lem mit dem Core Prozessor oder mit der Auswerteelektronik

hindeuten und erfordert moglicherweise den Austausch der ei-

nen oder der beiden Komponenten.

1. Die Verdrahtung zwischen Sensor und Auswerteelektronik
priifen.

a. Prifen Sie an Hand der Installationsanleitung fiir Ihre
Auswerteelektronik, ob diese entsprechend der Anwei-
sung mit dem Sensor verbunden ist. Beachten Sie beim
Offnen der Anschlussrdume alle Sicherheitshinweise.

b. Prifen Sie, ob die Adern guten Kontakt mit den Ans-
chlussklemmen haben.

¢. RTD-Widerstande und auf Kurzschliisse am Gehause prii-
fen (siehe Abschnitt 12.28.1).

d. Die Verdrahtung zwischen Auswerteelektronik und Sen-
sor priifen.

2. Core Prozessor LED priifen.
3. Wenn keine definitive KorrekturmaRnahme gefunden wer-
den kann, den Core Prozessor austauschen.

a. Kann das Problem nicht behoben werden, den Original
Core Prozessor wieder installieren und die Auswerteelek-
tronik austauschen.

b. Kann das Problem nicht behoben werden, die Auswer-
teelektronik und den Core Prozessor austauschen.
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Beschreibung

Empfohlene MaBnahmen

A027

SicherheitsverstoR

1. Die ID des HART-Gerdts priifen.

2. Die Gewichts- und Mess-Sicherheitsfunktion der Auswertee-
lektronik ist aktuell auf “unsicher” eingestellt. Stellen Sie die
Auswerteelektronik auf “sicher” ein, um den Alarm zu |6-
schen. Um die Auswerteelektronik wieder zu sichern, kann
ein autorisiertes Verfahren erforderlich sein.

A028

Core-Prozessor-Schreibfehler

Esist ein Fehler in der Elektronik der Auswerteelektronik aufge-
treten. Das Messsystem Aus/Einschalten und priifen, ob der
Alarm gel6scht werden kann. Wenn der Alarm weiterhin bes-
teht, den Core Prozessor austauschen.

A029

PIC/Tochterboard-Kommuni-
kationsfehler

Dies kann ein Hinweis sein, dass die Kommunikation zwischen
Auswerteelektronik und dem Bedieninterfacemodul unterbro-
chen wurde. Das Messsystem Aus/Einschalten und priifen, ob
der Alarm gel6scht werden kann. Falls moglich, das Bedieninter-
facemodul austauschen.

A030

Falscher Platinentyp

Die Firmware oder die in die Auswerteelektronik geladene Konfi-
guration ist inkompatibel mit dem Platinentyp. Wenn dieser
Alarm zusammen mit einem Versuch auftritt, eine Konfiguration
in die Auswerteelektronik zu laden, sicherstellen, dass die Aus-
werteelektronik dieselbe Modellbezeichnung aufweist, wie die,
von der die Konfiguration ibertragen wurde.

Das Messsystem Aus/Einschalten und priifen, ob der Alarm ge-
|6scht werden kann. Wenn das Problem weiterhin besteht, Micro
Motion bzgl. weiterer Hilfe kontaktieren.

A031

Spannung zu niedrig

Der Core Prozessor am Sensor erhdlt zu wenig Spannung. Die
Verdrahtung zwischen Auswerteelektronik und Sensor priifen.
Die Auswerteelektronik muss Aus/Einschalten werden, um die-
sen Alarm zu |6schen.

1. Priifen Sie an Hand der Installationsanleitung fiir lhre Aus-
werteelektronik, ob diese entsprechend der Anweisung mit
dem Sensor verbunden ist. Beachten Sie beim Offnen der
Anschlussraume alle Sicherheitshinweise.

2. Prifen Sie, ob die Adern guten Kontakt mit den Anschluss-
klemmen haben.

3. Die Verdrahtung zwischen Auswerteelektronik und Sensor
priifen.

4. Spannungsversorgung aus-/einschalten und erneut versu-
chen.

5. Die Spannung an den Anschlussklemmen des Core Prozes-
sors priifen. Es missen zu jeder Zeit mindestens 11,5 V anlie-
gen.

a. Liegenwenigerals 11,5V an, sicherstellen, dass die Aus-
werteelektronik mit ausreichend Spannung versorgt
wird. (Weitere Informationen sind in der Installationsan-
leitung zu finden.)

b. Wenn die Auswerteelektronik mit ausreichend Spannung
versorgt wird und das Problem weiterhin besteht, die
Auswerteelektronik austauschen.

A032

Systemverifizierung lauft: Aus-
gange zu Fehler

Systemverifizierung lauft, Ausgdnge sind auf Stérung oder Zuletzt
Gemessener Wert gesetzt.
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Alarm Code Beschreibung Empfohlene MaBnahmen

A033 Unzureichendes Signal von re- | Das Signal, das von den Sensor Aufnehmerspulen kommt, ist zu

chter/linker Aufnehmerspule | schwach und deutet darauf hin, dass die Messrohre nicht in der

natirlichen Frequenz schwingen kénnen. Dieser Alarm tritt oft
zusammen mit Alarm A102 auf.

1. Auf mogliche Fliissigkeits-Separation priifen, indem der
Dichtewert iberwacht wird und die Ergebnisse mit den er-
warteten Dichtewerten verglichen werden.

2. AufVerstopfung, Ablagerung oder Schwallstromung priifen.

3. Die Beseitigung von einem zweiphasigen oder einem drei-
phasigen Medium kann diesen Alarm, selbst bei voll gefiill-
ten Messrohren, auslésen. Aus diesem Grund muss der Sen-
sor moglicherweise neu ausgerichtet werden. Weitere Infor-
mationen bzgl. Sensorausrichtung sind im Installationshand-
buch zu finden.

A035 Systemverifizierung abgebro- | Die Systemverifizierung konnte nicht erfolgreich abgeschlossen
chen werden, weil sie moglicherweise manuell abgebrochen wurde.
1. Priifen Sie die Prozessbedingungen und fiihren Sie dann den
Test erneut durch.

2. Wenden Sie sich an Micro Motion.

A100 mA-Ausgang 1 gesittigt Der berechnete mA Ausgangswert liegt auRerhalb der konfigur-

ierten Bereichs des Messsystems.

1. Die Parameter Upper Range Value und Lower Range Value pri-
fen. Sind sie korrekt gesetzt?

2. Uberpriifen Sie Ihre Prozessbedingungen anhand der vom
Durchflussmesser gemeldeten Werte.

3. Priifen Sie, ob die Messeinheiten fiir hre Anwendung korrekt
konfiguriert sind.

4. Messrohre spiilen.

5. Die Prozessbedingungen priifen, insbesondere, ob Luft in
den Messrohren vorhanden ist, ob die Messrohre nicht ge-
fllt sind oder ob sich Fremdkorper oder Ablagerungen in
den Messrohren befinden.

A101 mA-Ausgang 1 fest Die konfigurierte HART-Adresse war ungleich Null, oder der mA-
Ausgang wurde zum Senden eines Direktwerts konfiguriert.

1. Priifen Sie, ob der Ausgang im Messkreistest-Modus ist. Sol-
Ite das der Fall sein, den Ausgang l6sen.

2. Abgleich des mA-Ausgangs gegebenenfalls beenden.

Die HART-Abfrageadresse priifen.

4. Priifen Sie, ob der Ausgang (iber die digitale Kommunikation
auf einen konstanten Wert eingestellt wurde.

w
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A102

Antrieb Bereichsiiberschrei-
tung

Die Antriebsleistung (Spannung) hat die Maximalleistung er-
reicht.

1. Die Antriebsverstdrkung und die Aufnehmerspannung prii-
fen.

2. Aufelektrische Kurzschliisse zwischen Sensorklemmen oder
zwischen Sensorklemmen und Sensorgehduse priifen.

3. Auf teilweise gefiillte Messrohre, Rohrablagerungen, besché-
digte Messrohre und extreme Gaseinschliisse oder Dampfbil-
dung priifen.

4. Die Beseitigung von einem zweiphasigen oder einem drei-
phasigen Medium kann diesen Alarm auslésen, selbst wenn
die Messrohre vollstidndig gefiillt sind. Das kann bedeuten,
dass der Sensor neu ausgerichtet werden muss. Weitere In-
formationen bzgl. Sensorausrichtung sind im Installation-
shandbuch zu finden.

A103

Moglicher Datenverlust (Zdhle
und Bestdnde)

r

Die Zdhler werden nicht ordnungsgemaR gespeichert. Der Core

Prozessor konnte die Zahler beim letzten Herunterfahren nicht

speichern und muss zuvor gespeicherte Zdhler verwenden. Die

gespeicherten Zadhler konnen bereits seit zwei Stunden nicht

mehr aktuell sein.

1. Sicherstellen, dass die Auswerteelektronik und der Core Pro-
zessor mit ausreichend Spannung versorgt werden.

2. Die Spannungsversorgung und deren Verdrahtung priifen.

A104

Kalibrierung lauft

Ein Kalibrierverfahren l3uft.

A105

Schwallstrémung

Die Dichte des Prozesses hat die vom Anwender definierten
Dichtegrenzwerte iberschritten. Auf Schwallstrémung (Zwei-
phasenstromung) prifen.

A106

Burst-Betriebsart aktiviert

HART-Burstmodus ist aktiviert.

A107

Spannungsunterbrechung ein-
getreten

Die Auswerteelektronik wurde neu gestartet.

A108

Basisereignis 1 Ein

Keine MaRBnahme erforderlich.

A109

Basisereignis 2 Ein

Keine MaRBnahme erforderlich.

A110

Frequenzausgang gesattigt

Der berechnete Frequenzausgang liegt auRerhalb des konfigur-

ierten Bereichs.

1. Den Parameter Frequency Output Scaling Method priifen.

2. Uberpriifen Sie Ihre Prozessbedingungen anhand der vom
Durchflussmesser gemeldeten Werte.

3. Die Prozessbedingungen priifen, insbesondere, ob Luft in
den Messrohren vorhanden ist, ob die Messrohre nicht ge-
fiillt sind oder ob sich Fremdkorper oder Ablagerungen in
den Messrohren befinden.

4. Priifen Sie, ob die Messeinheiten fiir Ihre Anwendung korrekt

konfiguriert sind.
5. Messrohre spiilen.
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A111 Frequenzausgang fixiert Der Frequenzausgang wurde zum Senden eines Direktwerts kon-
figuriert.

1. Das Anhalten des Zdhlers bewirkt, dass der Frequenzausgang
auf Null gestellt wird. Das Aus/Einschalten der Auswerteelek-
tronik oder das erneute Starten des Zéhlers setzt den Fre-
quenzausgang wieder in den normalen Betrieb zuriick.

2. Prifen Sie, ob der Ausgang im Messkreistest-Modus ist. Sol-
Ite das der Fall sein, den Ausgang l6sen.

3. Priifen Sie, ob der Ausgang (iber die digitale Kommunikation
auf einen konstanten Wert eingestellt wurde.

A112 Auswerteelektronik-Software | Micro Motion kontaktieren.
aktualisieren
A113 mA-Ausgang 2 gesdttigt 1. Uberpriifen Sie lhre Prozessbedingungen anhand der vom
Durchflussmesser gemeldeten Werte.

2. Die Prozessbedingungen priifen, insbesondere, ob Luftin
den Messrohren vorhanden ist, ob die Messrohre nicht ge-
fullt sind oder ob sich Fremdkérper oder Ablagerungen in
den Messrohren befinden.

3. Priifen Sie, ob die Messeinheiten fiir hre Anwendung korrekt
konfiguriert sind.

4. Messrohre spiilen.

5. Die Parameter Upper Range Value und Lower Range Value prii-
fen. Sind sie korrekt gesetzt?

A114 mA-Ausgang 2 fest 1. Priifen Sie, ob der Ausgang im Messkreistest-Modus ist. Sol-
Ite das der Fall sein, den Ausgang lésen.

2. Abgleich des mA-Ausgangs gegebenenfalls beenden.

3. Priifen Sie, ob der Ausgang (iber die digitale Kommunikation
auf einen konstanten Wert eingestellt wurde.

A115 Kein externer Eingang oder ab- = Die HART-Abfrageverbindung zum externen Gerét ist fehlges-
gefragte Daten chlagen. Keine Antwort vom abgefragten Gerat.

1. Den externen Gerdtebetrieb priifen.

2. Verdrahtung zwischen Auswerteelektronik und externem
Gerét prifen.

3. Die HART-Abfragekonfiguration priifen.

A116 Messbereichsiiberschreitung | 1. Uberpriifen Sie lhre Prozessbedingungen anhand der vom
der Temperatur (Mineralol) Durchflussmesser gemeldeten Werte.

2. Die Konfiguration der Mineral6lmessung gemaR der Tabelle
fir Typ und Temperatur priifen.

A117 Messbereichsiiberschreitung | 1. Uberpriifen Sie Ihre Prozessbedingungen anhand der vom
der Dichte (Mineral6l) Durchflussmesser gemeldeten Werte.

2. Die Konfiguration der Mineral6lmessung gemaR der Tabelle
fiir Typ und Dichte priifen.

A118 Bindrer mA Ausgang 1 fix Der Bindrausgang wurde zum Senden eines Direktwerts konfi-
guriert.
A120 Kurvenanpassung fehlgeschla- | Die Konfiguration der Anwendung Konzentrationsmessung prii-
gen (Konzentration) fen.
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Tabelle 12-2: Statusalarme und empfohlene MaBnahmen (Fortsetzung)

Alarm Code Beschreibung Empfohlene MaBnahmen
A121 Extrapolationsalarm (Konzen- | Wenn das Produkt im Sensor Temperatur- bzw. Dichteeigen-
tration) schaften aufweist, die auBerhalb der durch die Konzentration-
smesskurve festgelegten Parameter liegen, liegt hier ein Merk-
mal vor, was jedoch aber keine MaRRnahme erforderlich macht.
Dieser Alarm wird gel6scht, wenn das Prozessmedium wieder in
den Normalbereich zuriickkehrt.
Wenn das Problem weiterhin besteht, die Konfiguration der An-
wendung zur Konzentrationsmessung priifen.
Al131 Systemverifizierung lauft: Aus- | Systemverifizierung lauft, Ausgange sind auf Zuletzt Gemessener
gange auf zuletzt gemessenen | Wert gesetzt.
Wert
A132 Sensorsimulation aktiv Simulationsmodus ist aktiviert.
A133 EEPROM-Fehler (Display) Das Bedieninterfacemodul austauschen. Wenn das Problem wei-
terhin besteht, Micro Motion kontaktieren.
A141 DDC-Trigger abgeschlossen Keine MaBnahme erforderlich.
k.A. Dichte-FD-Kalibrierung lauft Keine MaBnahme erforderlich.
k.A. Dichte-D1-Kalibrierung lauft Keine MaBnahme erforderlich.
k.A. Dichte-D2-Kalibrierung lduft Keine MaBnahme erforderlich.
k.A. Dichte-D3-Kalibrierung lauft Keine MaBnahme erforderlich.
k.A. Dichte-D4-Kalibrierung lduft Keine MaBnahme erforderlich.
k.A. Nullpunktkalibrierung lauft Keine MaRBnahme erforderlich.
k.A. Rickwartsdurchfluss Keine MaRBnahme erforderlich.

12.3

Probleme bei Durchflussmessungen

Tabelle 12-3: Probleme bei Durchflussmessungen und AbhilfemaBnahmen

Problem

Maogliche Ursachen

Empfohlene MaBnahmen

Durchflussrichtung-
sanzeige bei Null-
durchfluss oder Null-
punktverschiebung

bei neuen Installationen)

e Falscher Sensor-Nullpunkt

¢ Nicht fluchtende Rohrleitung (speziell .

¢ Offenes oder undichtes Ventil

Priifen Sie, ob alle Charakterisierungspara-

meter den Daten auf dem Sensor-Tag en-

tsprechen.

¢ Ist der gemessene Durchfluss nicht besond-
ers hoch, die Echtzeit-Nullpunktkalibrierung
prifen. Sie miissen die Werkseinstellung fir
die Nullpunktkalibrierung wiederherstellen.

* Auf offene oder undichte Ventile oder Dich-
tungen priifen.

¢ Den Sensor auf Montagespannungen priifen
(z. B. Sensor zur Abstlitzung von Rohrleitun-
gen, nicht fluchtende Rohrleitungen).

e Wenden Sie sich an Micro Motion.

Konfigurations- und Bedienungsanleitung
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Tabelle 12-3: Probleme bei Durchflussmessungen und AbhilfemaBnahmen (Fortsetzung)

Problem Magliche Ursachen Empfohlene MaBnahmen
Sprunghafter Durch- | ¢ Leckage an Ventil oder Abdichtung e Priifen, ob die Sensor-Einbaulage zu lhrer An-
fluss bei Nulldurch- e Slug flow wendung passt (siehe Sensor-Installationsan-
flussbedingungen e Messrohr verstopft oder beschichtet leitung).

e Falsche Sensor-Einbaulage e Antriebsverstirkung und Aufnehmerspan-

e Verdrahtungsproblem nung priifen. Siehe Abschnitt 12.26 und

e Vibrationen der Rohrleitung nahe der Abschnitt 12.27.

Sensor Messrohrfrequenz e Befindet sich in der Verdrahtung zwischen
e Dampfungswert zu niedrig Sensor und Auswerteelektronik ein 9-Leiter-
e Montagespannungen auf dem Sensor Segment, muss gepriift werden, ob die Schir-

mung des 9-Leiter-Kabel korrekt geerdet ist.

¢ Die Verdrahtung zwischen Sensor und Aus-
werteelektronik priifen. Siehe
Abschnitt 12.70.

e Bei Sensoren mit Anschlusskasten die Feuch-
tigkeit im Anschlusskasten priifen.

e Messrohre spiilen.

* Auf offene oder undichte Ventile oder Dich-
tungen priifen.

¢ Die Ursache der Vibration priifen.

e Die Dampfungskonfiguration priifen.

 Priifen Sie, ob die Messeinheiten fiir hre An-
wendung korrekt konfiguriert sind.

e Auf Schwallstromung priifen. Siehe
Abschnitt 12.25.

e Auf HF-Stérungen priifen. Siehe
Abschnitt 12.79.

e Wenden Sie sich an Micro Motion.
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Tabelle 12-3: Probleme bei Durchflussmessungen und AbhilfemaBnahmen (Fortsetzung)

Empfohlene MaBnahmen

Problem Magliche Ursachen

Sprunghafter Durch- | ¢ Slug flow

fluss bei stabilem e Dampfungswert zu niedrig
Durchfluss e Messrohr verstopft oder beschichtet

e Problem mit der Ausgangsverdrahtung
e Problem mit dem empfangenden Gerat
e Verdrahtungsproblem

Priifen, ob die Sensor-Einbaulage zu Ihrer An-
wendung passt (siehe Sensor-Installationsan-
leitung).

Antriebsverstarkung und Aufnehmerspan-
nung priifen. Siehe Abschnitt 12.26 und
Abschnitt 12.27.

Befindet sich in der Verdrahtung zwischen
Sensor und Auswerteelektronik ein 9-Leiter-
Segment, muss gepriift werden, ob die Schir-
mung des 9-Leiter-Kabel korrekt geerdet ist.
Auf Luftanteile, Verschmutzung, Dampfbil-
dung oder Beschadigung des Messrohres
prifen.

Die Verdrahtung zwischen Sensor und Aus-
werteelektronik priifen. Siehe

Abschnitt 12.10.

Bei Sensoren mit Anschlusskasten die Feuch-
tigkeit im Anschlusskasten priifen.
Messrohre spiilen.

Auf offene oder undichte Ventile oder Dich-
tungen priifen.

Die Ursache der Vibration priifen.

Die Dampfungskonfiguration priifen.

Priifen Sie, ob die Messeinheiten fiir Ihre An-
wendung korrekt konfiguriert sind.

Auf Schwallstrémung priifen. Siehe
Abschnitt 12.25.

Auf HF-Stérungen priifen. Siehe

Abschnitt 12.19.

Wenden Sie sich an Micro Motion.

Ungenauer Durchfluss = ¢ Verdrahtungsproblem

oder Batchmenge ¢ Ungeeignete MaReinheit

 Falscher Durchflusskalibrierfaktor

e Falscher Gerdtefaktor

* Falsche Dichtekalibrierfaktoren

¢ Falsche Erdung des Durchflussmessers
e Slugflow

e Problem mit dem empfangenden Gerat

Die Verdrahtung zwischen Sensor und Aus-
werteelektronik priifen. Siehe

Abschnitt 12.10.

Priifen Sie, ob die Messeinheiten fir Ihre An-
wendung korrekt konfiguriert sind.

Priifen Sie, ob alle Charakterisierungspara-
meter den Daten auf dem Sensor-Tag en-
tsprechen.

Nullpunktkalibrierung des Messsystems.
Erdung priifen. Siehe Abschnitt 12.11.

Auf Schwallstrémung priifen. Siehe
Abschnitt 12.25.

Das empfangende Gerat sowie die Verdrah-
tung zwischen Auswerteelektronik und Core-
Prozessor priifen.

Den Widerstand der Sensorspule und auf
Kurzschliisse am Gehduse priifen. Siehe
Abschnitt 12.28.1.

Kern-Prozessor oder Auswerteelektronik aus-
tauschen.

Konfigurations- und Bedienungsanleitung
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12.4

Probleme bei Dichtemessungen

Tabelle 12-4: Probleme bei Dichtemessungen und AbhilfemaBnahmen

Problem

Magliche Ursachen

Empfohlene MaBnahmen

Ungenauer Dichte-
wert

¢ Problem mit dem Prozessmedium

* Falsche Dichtekalibrierfaktoren

e Verdrahtungsproblem

e Falsche Erdung des Durchflussmessers

e Slug flow

e Messrohr verstopft oder beschichtet

e Falsche Sensor-Einbaulage

e Fehlerhafter Widerstandsthermometer

e Physikalische Charakteristik des Sensors
hat sich gedndert

Die Verdrahtung zwischen Sensor und Aus-
werteelektronik priifen. Siehe

Abschnitt 12.70.

Erdung priifen. Siehe Abschnitt 12.11.
Uberpriifen Sie Ihre Prozessbedingungen an-
hand der vom Durchflussmesser gemeldeten
Werte.

Priifen Sie, ob alle Charakterisierungspara-
meter den Daten auf dem Sensor-Tag en-
tsprechen.

Auf Schwallstrémung priifen. Siehe
Abschnitt 12.25.

Zwei Sensoren mit dahnlicher Frequenz tren-
nen, wenn sie sich zu nahe nebeneinander
befinden.

Messrohre spiilen.

Ungewdhnlich hoher
Dichtewert

e Messrohr verstopft oder beschichtet

e Falscher K2-Wert

e Falsche Temperaturmessung

e Widerstandsthermometerproblem

¢ InHochfrequenzmessgerdten kann dies
ein Anzeichen fiir Erosion oder Korrosion
sein

¢ In Niederfrequenzmessgerdten kann
dies auf Rohrablagerungen hindeuten

Priifen Sie, ob alle Charakterisierungspara-
meter den Daten auf dem Sensor-Tag en-
tsprechen.

Messrohre spiilen.

Auf Ablagerungen in den Messrohren priifen.

Ungewdhnlich nie-
driger Dichtewert

e Slugflow

e Falscher K2-Wert

¢ In Niederfrequenzmessgerdten kann
dies ein Anzeichen fiir Erosion oder Kor-
rosion sein

Uberpriifen Sie Ihre Prozessbedingungen an-
hand der vom Durchflussmesser gemeldeten
Werte.

Priifen Sie, ob alle Charakterisierungspara-
meter den Daten auf dem Sensor-Tag en-
tsprechen.

Die Verdrahtung zwischen Sensor und Aus-
werteelektronik priifen. Siehe

Abschnitt 12.70.

Die Messrohre auf Erosion priifen, insbeson-
dere, wenn das Prozessmedium abrasiv ist.
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12.5 Probleme bei der Temperaturmessung

Tabelle 12-5: Probleme bei der Temperaturmessung und AbhilfemaBnahmen
Problem Magliche Ursachen Empfohlene MaBnahmen
Temperaturwert e Fehlerhafter Widerstandsthermometer ¢ Die Anschlussdose auf Feuchtigkeit und
weicht signifikantvon | ¢ Verdrahtungsproblem Griinspan priifen.
der Prozesstempera- e Am Widerstandsthermometer Wider-
turab standspriifungen durchfiihren und auf

Kurzschliisse zum Gehduse priifen (siehe
Abschnitt 12.28.1).

e Bestdtigen, dass der Temperaturkalibrier-
faktor mit dem Wert auf dem Typenschild
des Sensors {ibereinstimmt.

¢ Siehe Status-Alarme (insbesondere RTD-
Fehleralarme).

e Externe Temperaturkompensation deakti-
vieren.

e Temperaturkalibrierung prifen.

¢ Die Verdrahtung zwischen Sensor und Aus-
werteelektronik priifen. Siehe
Abschnitt 12.70.

Temperaturwert e Sensortemperatur noch nicht angeglichen | ¢« Das Widerstandsthermometer hat eine
weicht geringvonder | « Sensor Warmeverlust Spezifikation von +1 °C. Wenn sich der Feh-
Prozesstemperatur ab lerin diesem Bereich bewegt, liegt kein

Problem vor. Wenn sich die Temperatur-
messung auBBerhalb der Spezifikation des
Sensors befindet, Micro Motion kontaktie-
ren.

¢ Die Temperatur des Mediums dndert sich
moglicherweise schnell. Dem Sensor aus-
reichend Zeit geben, sich an das Prozess-
medium anzupassen.

* Den Sensor falls erforderlich isolieren.

e Am Widerstandsthermometer Wider-
standspriifungen durchfiihren und auf
Kurzschliisse zum Gehduse priifen (siehe
Abschnitt 12.28.1).

e Das Widerstandsthermometer hat mogli-
cherweise keinen guten Kontakt mit dem
Sensor. Der Sensor muss moglicherweise
ausgetauscht werden.
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12.6

Probleme bei mA-Ausgdngen

Tabelle 12-6: Probleme bei mA-Ausgdangen und empfohlene MaRnahmen

Problem

Magliche Ursachen

Empfohlene MaBnahmen

Kein mA-Ausgang

Verdrahtungsproblem

Storung im Schaltkreis

Kanal nicht fiir gewiinschten Ausgang kon-
figuriert

Ausgang hat keine Spannungsversorgung

Die Spannungsversorgung und deren Ver-
drahtung priifen. Siehe Abschnitt 12.9.

Die mA-Ausgangsverdrahtung tberpriifen.
Die Einstellungen fiir Storaktion priifen.
Siehe Abschnitt 12.18.

Gleichspannung an den Ausgangsklem-
men messen, um zu priifen, ob der Aus-
gang aktiv ist.

Wenden Sie sich an Micro Motion.

Messkreistest fehler-
haft

Problem mit der Spannungsversorgung
Verdrahtungsproblem

Storung im Schaltkreis

Kanal nicht fiir gewiinschten Ausgang kon-
figuriert

Falsche Konfiguration der internen/exter-
nen Spannungsversorgung

Ausgang hat keine Spannungsversorgung

Die Spannungsversorgung und deren Ver-
drahtung priifen. Siehe Abschnitt 12.9.

Die mA-Ausgangsverdrahtung tberpriifen.
Die Einstellungen fiir Stéraktion priifen.
Siehe Abschnitt 12.18.

Wenden Sie sich an Micro Motion.

mA-Ausgang unter 4
mA

Offene Verdrahtung

Schlechter Ausgangskreis
Prozessbedingungen unterhalb LRV

LRV und URV sind nicht korrekt gesetzt
Stérbedingungen liegen vor, wenn die
Storaktion auf intern Null oder abwarts ste-
hen

Schlechtes, empfangendes mA Gerat

Uberpriifen Sie Ihre Prozessbedingungen
anhand der vom Durchflussmesser gemel-
deten Werte.

Das empfangende Gerat sowie die Ver-
drahtung zwischen Auswerteelektronik
und Core-Prozessor priifen.

Bei I.S.-Auswerteelektronik die Ausgangs-
verdrahtung Giberpriifen, ob am Ausgang
mit Spannung versorgt wird.

Die Einstellungen fiir Messende (URV) und
Messanfang (LRV) Gberpriifen. Siehe
Abschnitt 12.17.

Die Einstellungen fir Stdraktion priifen.
Siehe Abschnitt 12.18.

Konstanter mA-Aus-
gang

Falsche dem Ausgang zugewiesene Pro-
zessvariable

Stérung besteht

Eine HART-Adresse ungleich Null (mA-Aus-
gang 1)

Ausgang ist fir den Messkreistestmodus
konfiguriert.

Fehlerhafte Nullpunktkalibrierung

Ausgangsvariablen-Zuordnung priifen.
Bestehende Alarmzustdnde anzeigen und
beheben.

HART-Adresse und mA-Messkreis-Modus prii-
fen. Siehe Abschnitt 12.15.

Uberprl'jfen Sie, ob ein Messkreistest lauft
(der Ausgang ist fixiert).
HART-Burst-Modus-Konfiguration priifen.
Siehe Abschnitt 12.16.

Bei einer fehlerhaften Nullpunktkalibrier-
ung die Spannungsversorgung zum Mess-
system aus-/einschalten und die Null-
punktkalibrierung zu wiederholen versu-
chen.
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Tabelle 12-6: Probleme bei mA-Ausgangen und empfohlene MaRBnahmen (Fortsetzung)

StérmaBnahme auf aufwarts oder abwarts
steht
LRV und URV sind nicht korrekt gesetzt

Problem Magliche Ursachen Empfohlene MaBnahmen

mA-Ausgang dauer- e Falsche dem Ausgang zugewiesene Pro- e Ausgangsvariablen-Zuordnung priifen.
haft auBerhalb des zessvariable oder Einheiten e Die fiir den Ausgang konfigurierten Mes-
Bereichs e Storbedingungen liegen vor, wenn die seinheiten Gberpriifen.

Die Einstellungen fiir Storaktion priifen.
Siehe Abschnitt 12.18.

Die Einstellungen fiir Messende (URV) und
Messanfang (LRV) tiberpriifen. Siehe
Abschnitt 12.17.

Abgleich des mA-Ausgangs Uberpriifen.
Siehe Abschnitt 12.13.

Konstant ungenaue .

Problem im Messkreis

Abgleich des mA-Ausgangs tiberpriifen.

gang bei niedriger
Spannung, jedoch ink-
orrekt bei hoherer
Spannung

eingestellt sein

mA-Messung e Ausgang nicht richtig abgeglichen Siehe Abschnitt 12.13.
¢ Falsche Durchfluss Messeinheit konfigur- | ¢ Priifen Sie, ob die Messeinheiten fiir Ihre
iert Anwendung korrekt konfiguriert sind.
e Falsche Prozessvariable konfiguriert e Zuordnung der Prozessvariablen zum mA-
e LRV und URV sind nicht korrekt gesetzt Ausgang prifen.
e Die Einstellungen fir Messende (URV) und
Messanfang (LRV) Giberpriifen. Siehe
Abschnitt 12.17.
Korrekter mA-Aus- e mA-Messkreiswiderstand kann zu hoch e Priifen, ob die Last am mA-Ausgang 1 un-

terhalb der max. Last liegt (siehe Installa-
tionsanleitung lhrer Auswerteelektronik).

Konfigurations- und Bedienungsanleitung
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12.7 Probleme beim Frequenzausgang

Tabelle 12-7: Probleme beim Frequenzausgang und empfohlene MaBnahmen

Problem

Magliche Ursachen

Empfohlene MaBnahmen

Kein Frequenzaus-
gang

Zdhler stoppen

Prozessbedingungen unterhalb Abschal-
tung

Storbedingungen liegen vor, wenn die
Storaktion auf intern Null oder abwadrts
stehen

Slug flow

Durchfluss in umgekehrter Richtung
zum konfigurierten Parameter der
Durchflussrichtung

Schlechtes, empfangendes Frequenz
Gerat

Ausgangspegel nicht kompatibel zum
empfangenden Gerat

Schlechter Ausgangskreis

Falsche Konfiguration der internen/ex-
ternen Spannungsversorgung

Falsche Konfiguration der Impulsbreite
Ausgang hat keine Spannungsversor-
gung

Verdrahtungsproblem

Priifen Sie, ob die Prozessbedingungen un-
terhalb der Schleichmengenabschaltung
liegen. Konfigurieren Sie die Schleichmenge-
nabschaltung gegebenenfalls neu.

Die Einstellungen fiir Stéraktion priifen. Siehe
Abschnitt 12.18.

Priifen Sie, ob die Zahler nicht gestoppt wur-
den. Durch einen gestoppten Zahler wird der
Frequenzausgang gesperrt.

Auf Schwallstrémung priifen. Siehe
Abschnitt 12.25.

Durchflussrichtung priifen. Siehe

Abschnitt 12.23.

Das empfangende Geradt sowie die Verdrah-
tung zwischen Auswerteelektronik und Core-
Prozessor priifen.

Uberpriifen Sie, ob der Kanal verdrahtet und
als Frequenzausgang konfiguriert ist.
Uberpriifen Sie die Spannungsversorgung fiir
den Frequenzausgang (intern und extern).
Impulsbreite priifen. Siehe Abschnitt 12.20.
Bei I.S.-Auswerteelektronik die Ausgangsver-
drahtung tiberpriifen, ob am Ausgang mit
Spannung versorgt wird.

Messkreistest durchfiihren Siehe

Abschnitt 12.12.

Konstant ungenaue
Frequenzmessung

Ausgang nicht richtig skaliert
Falsche Durchfluss Messeinheit konfi-
guriert

Die Skalierung des Frequenzausgangs (iber-
prifen. Siehe Abschnitt 12.21.

Priifen Sie, ob die Messeinheiten fiir Ihre An-
wendung korrekt konfiguriert sind.

UngleichmaRiger Fre-
quenzausgang

Hochfrequenzstérungen

Auf HF-Stérungen priifen. Siehe
Abschnitt 12.79.

12.8 Verwenden der Sensorsimulation zur
Storungsanalyse und -beseitigung

Bei aktivierter Sensorsimulation gibt die Auswerteelektronik benutzerdefinierte Werte fiir
Massedurchfluss, Temperatur und Dichte aus. Hiermit konnen unterschiedliche
Prozessbedingungen reproduziert bzw. das System gepriift werden.

Mit der Sensorsimulation kann zwischen tatsachlichem Prozessrauschen und extern
verursachten Varianten unterschieden werden. Sie haben beispielsweise ein
empfangendes Gerdt, das einen unerwartet ungleichmaRigen Durchflusswert ausgibt.
Wenn die Sensorsimulation aktiviert ist und die gemessene Durchflussrate nicht mit dem
simulierten Wert (ibereinstimmt, so liegt die Ursache des Problems wahrscheinlich
zwischen Auswerteelektronik und empfangendem Gerit.
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Wichtig

Wenn die Sensorsimulation aktiviert ist, wird der simulierte Wert bei allen Ausgédngen und
Berechnungen der Auswerteelektronik, einschlieRlich Zahler und Summen, Volumendurchfluss- und
Konzentrationsberechnungen, verwendet. Alle mit den Ausgdngen der Auswerteelektronik in
Verbindung stehenden automatischen Funktionen deaktivieren und den Messkreis auf Handbetrieb
setzen. Den Simulationsmodus nur aktivieren, wenn die Anwendung diese Auswirkungen toleriert.
Sicherstellen, dass der Simulationsmodus nach den Tests wieder deaktiviert wird.

Siehe Abschnitt 7.1 bzgl. weiterer Informationen zur Verwendung der Sensorsimulation.

12.9 Verdrahtung der Spannungsversorgung priifen

Wenn die Verdrahtung der Spannungsversorgung beschddigt oder falsch angeschlossen
ist, wird die Auswerteelektronik moglicherweise nicht ausreichend mit Spannung versorgt.

Vorbereitungsverfahren
Weitere Informationen sind in der Installationsanleitung der Auswerteelektronik zu finden.
Verfahren

1. Die Spannungsversorgung trennen, bevor deren Verdrahtung tberpriift wird.

A\ VORSICHT!

Befindet sich die Auswerteelektronik in einer explosionsgefahrdeten Umgebung, nach
dem Trennen der Spannungsversorgung fiinf Minuten warten.

2. Priifen, ob die richtige externe Sicherung verwendet wird.
Eine falsche Sicherung kann den Strom zur Auswerteelektronik begrenzen und so
das Hochfahren verhindern.

3. Stellen Sie sicher, dass die Adern der Spannungsversorgung an den richtigen
Anschlussklemmen angeschlossen sind.

4, Priifen Sie, ob die Adern der Spannungsversorgung guten Kontakt haben und nicht
Gber die Isolierung angeklemmt sind.

5. Kontrollieren Sie die Spannungsangabe auf dem Schild an der Innenseite des
Anschlussraums fiir die Feldverdrahtung.

Die Spannung fiir die Auswerteelektronik muss mit der auf dem Typenschild
tibereinstimmen.

6. Erneut Spannung an der Auswerteelektronik anlegen.

/A VORSICHT!

Wenn die Auswerteelektronik in einer explosionsgefahrdeten Umgebung installiert ist,
nicht erneut Spannung bei entferntem Gehduse anlegen. Das Anlegen von Spannung an
die Auswerteelektronik bei entferntem Gehdusedeckel kann zu einer Explosion fiihren.

7. Priifen Sie mit einem Spannungsmessgerat die Spannung an den
Anschlussklemmen der Auswerteelektronik.
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12.10

12.11

12.12

214

Die Spannung muss sich innerhalb der festgelegten Grenzwerte befinden. Bei einer
DC Spannung kann eine Kabelauslegung erforderlich sein.

Priifen der Verdrahtung vom Sensor zur
Auswerteelektronik

Es konnen eine Reihe von Problemen mit der Spannungsversorgung und dem Ausgang
auftreten, wenn die Verdrahtung zwischen dem Sensor und der Auswerteelektronik nicht
ordnungsgemdl angeschlossen ist oder wenn die Verdrahtung beschadigt wird.

Vorbereitungsverfahren

Weitere Informationen sind in der Installationsanleitung der Auswerteelektronik zu finden.

Verfahren
1. Vordem Offnen des Anschlussgehiuses die Spannungsquelle abklemmen.
A\ VORSICHT!

Befindet sich die Auswerteelektronik in einem explosionsgefdhrdeten Bereich, nach
dem Trennen der Stromversorgung fiinf Minuten warten.

2. Uberpriifen, dass die Auswerteelektronik an den Sensor entsprechend den
Informationen, die in der Installationsanleitung angegeben sind, angeschlossen ist.

3. Uberpriifen, dass die Adern guten Kontakt mit den Anschlussklemmen haben.

Die Verdrahtung aller Kabel von der Auswerteelektronik zum Sensor priifen.

Erdung tiberpriifen

Sensor und Auswerteelektronik miissen geerdet sein. Ist der Core Prozessor ein Teil der
Auswerteelektronik oder des Sensors, so ist er automatisch geerdet. Ist der Core Prozessor
separat installiert, muss er auch separat geerdet werden.

Vorbereitungsverfahren

Sie benotigen:

. Installationsanleitung fiir lhren Sensor
. Installationsanleitung fiir lhre Auswerteelektronik
Verfahren

Anforderungen und Hinweise zur Erdung finden Sie in der Installationsanleitung des
Sensors und der Auswerteelektronik.

Messkreistests durchfiihren

Ein Messkreistest erméglicht die Uberpriifung, ob Auswerteelektronik und externes Gerit
ordnungsgemaR kommunizieren. Ein Messkreistest hilft Ihnen ebenso bei der
Entscheidung, ob die mA Ausgidnge abgeglichen werden miissen.
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12.12.1 Messkreistests mittels Bedieninterface durchfiihren

Ein Messkreistest erméglicht die Uberpriifung, ob Auswerteelektronik und externes Gerét
ordnungsgemaR kommunizieren. Ein Messkreistest hilft Ihnen ebenso bei der
Entscheidung, ob die mA Ausgdnge abgeglichen werden miissen.

Vorbereitungsverfahren

Bevor Sie den Messkreistest durchfiihren, konfigurieren Sie die Kandle der Ein-/Ausgdnge
der Auswerteelektronik, die fiir hre Anwendung konfiguriert sind.

Folgen Sie den entsprechenden Vorgehensweisen, um sicherzustellen, dass die
Messkreistests existierende Mess- und Regelkreise nicht beeintrachtigen.

Verfahren
1.  Testen Sie den oder die mA Ausgdnge.
a. Wahlen Sie OFFLINE MAINT > SIM > AO1 SIM oder OFFLINE MAINT > SIM > AO2 SIM
und legen Sie einen Messanfang, z. B. 4 mA, fest.
Punkte durchlaufen das Display, wahrend der Ausgang fixiert wird.
b. Lesen Sie den mA Wert am empfangenden Gerét ab und vergleichen diesen mit
dem Ausgang der Auswerteelektronik.
Die Werte miissen nicht exakt tibereinstimmen. Weichen die Werte nur
geringfligig voneinander ab, kénnen Sie diese Abweichung durch Abgleichen des
Ausgangs korrigieren.
c. Driicken Sie an der Auswerteelektronik die Taste Select.
d. Navigieren Sie zum Messende und legen Sie ein Messende, z. B. 20 mA, fest.
Punkte durchlaufen das Display, wahrend der Ausgang fixiert wird.
e. Lesen Sie den mA Wert am empfangenden Gerat ab und vergleichen diesen mit
dem Ausgang der Auswerteelektronik.
Die Werte miissen nicht exakt (ibereinstimmen. Weichen die Werte nur
geringfligig voneinander ab, kénnen Sie diese Abweichung durch Abgleichen des
Ausgangs korrigieren.
f. Drlcken Sie an der Auswerteelektronik die Taste Select.
2.  Testen Sie den oder die Frequenzausgdnge.
a. Wadhlen Sie OFFLINE MAINT > SIM > FO SIM, und legen Sie den

Frequenzausgangswert fest.

Der Frequenzausgang kann auf 1, 10 oder 15 kHz gesetzt werden.

Anmerkung

Ist eine eichamtliche Anwendung (Weights & Measures) auf der Auswerteelektronik
aktiviert, ist es nicht moglich, einen Messkreistest des Frequenzausgangs durchzufiihren.
Dies trifft auch zu, wenn die Auswerteelektronik im ungesicherten Modus betrieben wird.

Punkte durchlaufen das Display, wahrend der Ausgang fixiert wird.
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b. Lesen Sie das Frequenzsignal am empfangenden Gerdt ab und vergleichen dieses
mit dem Ausgang der Auswerteelektronik.

c. Driicken Sie an der Auswerteelektronik die Taste Select.

3. Testen Sie den oder die Bindrausgange.
a. Wabhlen Sie OFFLINE MAINT > SIM > DO SIM wdhlen Sie SET ON.

Punkte durchlaufen das Display, wahrend der Ausgang fixiert wird.

o

Priifen Sie das Signal am empfangenden Gerét.
Driicken Sie an der Auswerteelektronik die Taste Select.
Navigieren Sie zu SET OFF und wdhlen Sie diesen Wert.
Priifen Sie das Signal am empfangenden Gerét.

oD AN

Driicken Sie an der Auswerteelektronik die Taste Select.

Nachbereitungsverfahren

. Weicht der mA Ausgangswert am empfangenden Gerdt geringfiigig vom Wert an
der Auswerteelektronik ab, konnen Sie diese Abweichung durch Abgleichen des
Ausgangs korrigieren.

o Weicht der mA Ausgangswert am empfangenden Gerdt signifikant ab oder war der
Messwert bei einem Schritt fehlerhaft, priifen Sie die Verdrahtung zwischen der
Auswerteelektronik und dem externen Gerat und wiederholen Sie den Test.

. Wird der Messwert des Bindrausgangs umgekehrt angezeigt, priifen Sie die
Einstellung der Discrete Output Polarity.

Messkreistests durchfiihren mittels ProLink Il

Ein Messkreistest erméglicht die Uberpriifung, ob Auswerteelektronik und externes Gerit
ordnungsgemaR kommunizieren. Ein Messkreistest hilft Ihnen ebenso bei der
Entscheidung, ob die mA Ausgadnge abgeglichen werden miissen.

Vorbereitungsverfahren

Bevor Sie den Messkreistest durchfiihren, konfigurieren Sie die Kandle der Ein-/Ausgdnge
der Auswerteelektronik, die fiir Ihre Anwendung konfiguriert sind.

Folgen Sie den entsprechenden Vorgehensweisen, um sicherzustellen, dass die
Messkreistests existierende Mess- und Regelkreise nicht beeintrachtigen.

ProLink Il muss laufen und muss mit der Auswerteelektronik verbunden sein.
Verfahren
1.  Testen Sie den oder die mA Ausgdnge.

a. Wabhlen Sie ProLink > Test > Fix Milliamp 1 oder ProLink > Test > Fix Milliamp 2.
b. Geben Sie 4 mAin Set Output To ein.
Klicken Sie auf Fix mA.

a n

Lesen Sie den mA Wert am empfangenden Gerat ab und vergleichen diesen mit
dem Ausgang der Auswerteelektronik.
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Die Werte miissen nicht exakt tibereinstimmen. Weichen die Werte nur
geringfligig voneinander ab, kénnen Sie diese Abweichung durch Abgleichen des
Ausgangs korrigieren.

Klicken Sie auf UnFix mA.
Geben Sie 20 mA in Set Output To ein.

Klicken Sie auf Fix mA.

TKa ~ oo

Lesen Sie den mA Wert am empfangenden Gerat ab und vergleichen diesen mit
dem Ausgang der Auswerteelektronik.

Die Werte missen nicht exakt Gibereinstimmen. Weichen die Werte nur
geringfligig voneinander ab, kénnen Sie diese Abweichung durch Abgleichen des
Ausgangs korrigieren.

i. Klicken Sie auf UnFix mA.

2.  Testen Sie den oder die Frequenzausgdnge.

Anmerkung

Ist eine eichamtliche Anwendung (Weights & Measures) auf der Auswerteelektronik aktiviert,
ist es nicht moglich, einen Messkreistest des Frequenzausgangs durchzufiihren. Dies trifft
auch zu, wenn die Auswerteelektronik im ungesicherten Modus betrieben wird.

Wahlen Sie ProLink > Test > Fix Freq Out.

Geben Sie den Frequenzausgangswert in Set Output To ein.

o o

n

Klicken Sie auf Fix Frequency.

e

Lesen Sie das Frequenzsignal am empfangenden Gerat ab und vergleichen dieses
mit dem Ausgang der Auswerteelektronik.

e. Klicken Sie auf UnFix Freq.

3. Testen Sie den oder die Bindrausgdnge.

Wahlen Sie ProLink > Test > Fix Discrete Output.
Wiéhlen Sie On.

Priifen Sie das Signal am empfangenden Gerét.
Wiéhlen Sie Off.

Priifen Sie das Signal am empfangenden Gerét.

m PN oo

Klicken Sie auf UnFix.
Nachbereitungsverfahren

. Weicht der mA Ausgangswert am empfangenden Gerdt geringfiigig vom Wert an
der Auswerteelektronik ab, konnen Sie diese Abweichung durch Abgleichen des
Ausgangs korrigieren.

o Weicht der mA Ausgangswert am empfangenden Gerdt signifikant ab oder war der
Messwert bei einem Schritt fehlerhaft, priifen Sie die Verdrahtung zwischen der
Auswerteelektronik und dem externen Gerat und wiederholen Sie den Test.

. Wird der Messwert des Bindrausgangs umgekehrt angezeigt, priifen Sie die
Einstellung der Discrete Output Polarity.
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Messkreistests durchfiihren mittels ProLink Il

Ein Messkreistest erméglicht die Uberpriifung, ob Auswerteelektronik und externes Gerét
ordnungsgemaR kommunizieren. Ein Messkreistest hilft Ihnen ebenso bei der
Entscheidung, ob die mA Ausgdnge abgeglichen werden miissen.

Vorbereitungsverfahren

Bevor Sie den Messkreistest durchfiihren, konfigurieren Sie die Kandle der Ein-/Ausgdnge
der Auswerteelektronik, die fiir hre Anwendung konfiguriert sind.

Folgen Sie den entsprechenden Vorgehensweisen, um sicherzustellen, dass die
Messkreistests existierende Mess- und Regelkreise nicht beeintrachtigen.

ProLink Il muss laufen und muss mit der Auswerteelektronik verbunden sein.
Verfahren
1.  Testen Sie den oder die mA Ausgdnge.
a. Wabhlen Sie Device Tools > Diagnostics > Testing > mA Output 1 Test oder Device Tools >
Diagnostics > Testing > mA Output 2 Test.
b. Geben Sie 4 in Fix to: ein.
c. Klicken Sie auf Fix mA.
d. Lesen Sie den mA Wert am empfangenden Gerét ab und vergleichen diesen mit

dem Ausgang der Auswerteelektronik.

Die Werte miissen nicht exakt ibereinstimmen. Weichen die Werte nur
geringfligig voneinander ab, kénnen Sie diese Abweichung durch Abgleichen des
Ausgangs korrigieren.

Klicken Sie auf UnFix mA.
Geben Sie 20 in Fix to: ein.
Klicken Sie auf Fix mA.

Ta - oo

Lesen Sie den mA Wert am empfangenden Gerat ab und vergleichen diesen mit
dem Ausgang der Auswerteelektronik.

Die Werte miissen nicht exakt (ibereinstimmen. Weichen die Werte nur
geringfligig voneinander ab, kénnen Sie diese Abweichung durch Abgleichen des
Ausgangs korrigieren.

i. Klicken Sie auf UnFix mA.

2.  Testen Sie den oder die Frequenzausgdnge.

Anmerkung

Ist eine eichamtliche Anwendung (Weights & Measures) auf der Auswerteelektronik aktiviert,
ist es nicht maoglich, einen Messkreistest des Frequenzausgangs durchzufiihren. Dies trifft
auch zu, wenn die Auswerteelektronik im ungesicherten Modus betrieben wird.

a. Waihlen Sie Device Tools > Diagnostics > Testing > Frequency Output Test.
b. Geben Sie den Frequenzausgangswert in Fix to ein.

c. Klicken Sie auf Fix FO.

Micro Motion® Auswerteelektronik Modell 2700 mit eigensicheren Ausgédngen



Stérungsanalyse und -behebung

d. Lesen Sie das Frequenzsignal am empfangenden Gerét ab und vergleichen dieses
mit dem Ausgang der Auswerteelektronik.

e. Klicken Sie auf UnFix FO.

3. Testen Sie den oder die Bindrausgange.

a. Wabhlen Sie Device Tools > Diagnostics > Testing > Discrete Output Test.
b. Setzen Sie Fix To: auf ON.

Priifen Sie das Signal am empfangenden Gerét.

Setzen Sie Fix To: auf OFF.

Priifen Sie das Signal am empfangenden Gerét.

oo N

Klicken Sie auf UnFix.
Nachbereitungsverfahren

. Weicht der mA Ausgangswert am empfangenden Gerdt geringfiigig vom Wert an
der Auswerteelektronik ab, konnen Sie diese Abweichung durch Abgleichen des
Ausgangs korrigieren.

. Weicht der mA Ausgangswert am empfangenden Gerit signifikant ab oder war der
Messwert bei einem Schritt fehlerhaft, priifen Sie die Verdrahtung zwischen der
Auswerteelektronik und dem externen Gerat und wiederholen Sie den Test.

. Wird der Messwert des Bindrausgangs umgekehrt angezeigt, priifen Sie die
Einstellung der Discrete Output Polarity.

12.12.4 Messkreistest durchfiihren mittels Handterminal

Ein Messkreistest ermdglicht die Uberpriifung, ob Auswerteelektronik und externes Gerat
ordnungsgemaR kommunizieren. Ein Messkreistest hilft Ihnen ebenso bei der
Entscheidung, ob die mA Ausgdnge abgeglichen werden miissen.

Vorbereitungsverfahren

Bevor Sie den Messkreistest durchfiihren, konfigurieren Sie die Kanéle der Ein-/Ausgdnge
der Auswerteelektronik, die fiir hre Anwendung konfiguriert sind.

Folgen Sie den entsprechenden Vorgehensweisen, um sicherzustellen, dass die
Messkreistests existierende Mess- und Regelkreise nicht beeintrachtigen.

Verfahren
1.  Testen Sie den oder die mA Ausgdnge.

a. Wahlen Sie Service Tools > Simulate > Simulate Outputs > mA Qutput 1 Loop Test oder
Service Tools > Maintenance > Simulate Outputs > mA Output 2 Loop Test und wahlen Sie 4
mA.

b. Lesen Sie den mA Wert am empfangenden Gerat ab und vergleichen diesen mit
dem Ausgang der Auswerteelektronik.

Die Werte missen nicht exakt Gibereinstimmen. Weichen die Werte nur
geringfligig voneinander ab, kénnen Sie diese Abweichung durch Abgleichen des
Ausgangs korrigieren.

c. Driicken Sie OK.
d. Wahlen Sie 20 mA.
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e. Lesen Sie den mA Wert am empfangenden Gerat ab und vergleichen diesen mit
dem Ausgang der Auswerteelektronik.

Die Werte missen nicht exakt Gibereinstimmen. Weichen die Werte nur
geringfligig voneinander ab, kénnen Sie diese Abweichung durch Abgleichen des
Ausgangs korrigieren.

f. Drlcken Sie OK.
g. Wabhlen Sie End.

Testen Sie den oder die Frequenzausgange.

Anmerkung

Ist eine eichamtliche Anwendung (Weights & Measures) auf der Auswerteelektronik aktiviert,
ist es nicht maoglich, einen Messkreistest des Frequenzausgangs durchzufiihren. Dies trifft
auch zu, wenn die Auswerteelektronik im ungesicherten Modus betrieben wird.

a. Drticken Sie Service Tools > Simulate > Simulate Outputs > Frequency Output Test und
wdhlen Sie den Frequenzausgangswert.

b. Lesen Sie das Frequenzsignal am empfangenden Gerdt ab und vergleichen dieses
mit dem Ausgang der Auswerteelektronik.

c. Wahlen Sie End.

Testen Sie den oder die Bindrausgange.

Driicken Sie Service Tools > Simulate > Simulate Outputs > Discrete Output Test.
Wabhlen Sie Off.

Priifen Sie das Signal am empfangenden Gerét.

Driicken Sie OK.

Wabhlen Sie On.

Priifen Sie das Signal am empfangenden Gerét.

Driicken Sie OK.

Wahlen Sie End.

oo

o ™m0 a0

Nachbereitungsverfahren

220

Weicht der mA Ausgangswert am empfangenden Gerdt geringfligig vom Wert an
der Auswerteelektronik ab, kdnnen Sie diese Abweichung durch Abgleichen des
Ausgangs korrigieren.

Weicht der mA Ausgangswert am empfangenden Gerat signifikant ab oder war der
Messwert bei einem Schritt fehlerhaft, priifen Sie die Verdrahtung zwischen der
Auswerteelektronik und dem externen Gerat und wiederholen Sie den Test.

Wird der Messwert des Bindrausgangs umgekehrt angezeigt, priifen Sie die
Einstellung der Discrete Output Polarity.
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12.13 mA Ausgdnge abgleichen

Beim Abgleich eines mA Ausgangs wird der mA Ausgang der Auswerteelektronik
entsprechend des empfangenden Gerits kalibriert. Wenn die aktuellen Abgleichswerte
nicht richtig sind, wird der Ausgang durch die Auswerteelektronik tiber- oder
unterkompensiert.

12.13.1  Abgleichen der mA Ausgange mittels ProLink Il

Der Abgleich des mA Ausgangs erzeugt einen gemeinsamen Messkreis zwischen der
Auswerteelektronik und dem Gerét, das den mA Ausgang empfangt.

Wichtig
Der Abgleich des Ausgangs muss an beiden Punkten (4 mA und 20 mA) durchgefiihrt werden, um

sicherzustellen, dass eine entsprechende Kompensation iber den gesamten Ausgangsbereich
erfolgt.

Vorbereitungsverfahren

Stellen Sie sicher, dass der mA Ausgang mit dem empfangenden Gerat verdrahtet ist, das
bei der Produktion verwendet wird.

Verfahren

Wahlen Sie ProLink > Calibration > Milliamp 1 Trim oder ProLink > Calibration > Milliamp 2 Trim.

2.  Folgen Sie den Anweisungen der gefiihrten Methode.

Wichtig

Wenn eine HART/Bell 202 Verbindung verwendet wird, beeinflusst das tiber dem priméren
mA Ausgang liegende HART Signal den mA Messwert. Trennen Sie die kabelgebundene
Verbindung zwischen ProLink Il und den Anschlussklemmen der Auswerteelektronik, wenn
der mA Ausgang am empfangenden Gerdt abgerufen wird. Stellen Sie die Verbindung wieder
her, um mit dem Abgleich fortzufahren.

3. Prifen Sie die Abgleichswerte und wenden Sie sich an den Micro Motion
Kundenservice, wenn ein Wert kleiner als =200 Mikroampere oder groRer als
+200 Mikroampere ist.

12.13.2  Abgleichen der mA Ausgdnge mittels ProLink Il

Der Abgleich des mA Ausgangs erzeugt einen gemeinsamen Messkreis zwischen der
Auswerteelektronik und dem Gerdt, das den mA Ausgang empfangt.

Wichtig

Der Abgleich des Ausgangs muss an beiden Punkten (4 mA und 20 mA) durchgefiihrt werden, um
sicherzustellen, dass eine entsprechende Kompensation tiber den gesamten Ausgangsbereich
erfolgt.

Vorbereitungsverfahren

Stellen Sie sicher, dass der mA Ausgang mit dem empfangenden Gerat verdrahtet ist, das
bei der Produktion verwendet wird.
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Verfahren

1. Wabhlen Sie Device Tools > Calibration > MA Output Trim > mA Output 1 Trim .

2. Wahlen Sie Device Tools > Calibration > MA Output Trim > mA Output 1 Trim oder Device Tools
> Calibration > MA Output Trim > mA Output 2 Trim .

3. Folgen Sie den Anweisungen der gefiihrten Methode.

Wichtig

Wenn eine HART/Bell 202 Verbindung verwendet wird, beeinflusst das (iber dem primaren
mA Ausgang liegende HART Signal den mA Messwert. Trennen Sie die kabelgebundene
Verbindung zwischen ProLink Ill und den Anschlussklemmen der Auswerteelektronik, wenn
der mA Ausgang am empfangenden Gerat abgerufen wird. Stellen Sie die Verbindung wieder
her, um mit dem Abgleich fortzufahren.

4.  Priifen Sie die Abgleichswerte und wenden Sie sich an den Micro Motion
Kundenservice, wenn ein Wert kleiner als =200 Mikroampere oder groRer als
+200 Mikroampere ist.

12.13.3  Abgleichen der mA Ausgdange mittels Handterminal

Der Abgleich des mA Ausgangs erzeugt einen gemeinsamen Messkreis zwischen der
Auswerteelektronik und dem Gerédt, das den mA Ausgang empfangt.

Wichtig
Der Abgleich des Ausgangs muss an beiden Punkten (4 mA und 20 mA) durchgefiihrt werden, um

sicherzustellen, dass eine entsprechende Kompensation iber den gesamten Ausgangsbereich
erfolgt.

Vorbereitungsverfahren

Stellen Sie sicher, dass der mA Ausgang mit dem empfangenden Gerdt verdrahtet ist, das
bei der Produktion verwendet wird.

Verfahren

1. Wahlen Sie ..

2. Folgen Sie den Anweisungen der gefiihrten Methode.

Wichtig

Das HART Signal auf dem primaren mA Ausgang hat einen Einfluss auf den mA Wert. Trennen
Sie die kabelgebundene Verbindung zwischen Handterminal und den Anschlussklemmen der
Auswerteelektronik, wenn der mA Ausgang am empfangenden Gerdt abgerufen wird. Stellen
Sie die Verbindung wieder her, um mit dem Abgleich fortzufahren.

3. Wabhlen Sie.
Folgen Sie den Anweisungen der gefiihrten Methode.

5.  Prifen Sie die Abgleichswerte und wenden Sie sich an den Micro Motion
Kundenservice, wenn ein Wert kleiner als —200 Mikroampere oder groRer als
+200 Mikroampere ist.
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12.14 HART Kommunikationskreis priifen

Wenn Sie keine HART Kommunikation herstellen oder aufrechterhalten kdnnen, ist der
HART Kreis moglicherweise falsch verdrahtet.

Vorbereitungsverfahren

Sie benétigen:

o Eine Kopie lhrer Auswerteelektronik Installationsanleitung

o Ein Handterminal

. Optional: HART Application Guide, verfligbar unter www.hartcomm.org
Verfahren

1. Priifen Sie, ob die Leitungsadern gemaR dem Anschlussschema der

Installationsanleitung der Auswerteelektronik angeschlossen sind.

Ist Ihr HART Netzwerk komplexer als das Anschlussschema in der
Installationsanleitung, wenden Sie sich an Micro Motion oder an die HART
Communication Foundation.

2. Trennen Sie die Verdrahtung des primaren mA Ausgangs von der
Auswerteelektronik.

3. Installieren Sie einen 250-1000 Q Widerstand tiber die Anschlussklemmen des
primdren mA Ausgangs der Auswerteelektronik.

4.  Priifen Sie den Spannungsabfall tiber dem Widerstand (4-20 mA = 1-5 VDC).

Ist der Spannungsabfall weniger als 1 VDC, erhéhen Sie den Widerstand, um einen
Spannungsabfall von mehrals 1 VDC zu erreichen.

5. SchlieRen Sie ein Handterminal direkt Gber den Widerstand an und versuchen Sie,
eine Kommunikation herzustellen (Abfrage).

Wenn keine Kommunikation mit der Auswerteelektronik hergestellt werden kann,
muss die Auswerteelektronik ggf. gewartet werden. Kontaktieren Sie Micro Motion.

12.15 Priifen der HART Adresse und des Messkreis
Strommodus

Wenn die Auswerteelektronik einen festen Strom am mA Ausgang ausgibt, wird der
Parameter Loop Current Mode moglicherweise deaktiviert.

Wenn Loop Current Mode deaktiviert ist, erzeugt der mA Ausgang eine festen Wert und
meldet keine Prozessdaten bzw. implementiert nicht die zugehorigen FehlermaRnahmen

Wenn die HART Address geandert wird, dndern einige Konfigurations-Hilfsmittel
automatisch Loop Current Mode.

Hinweis
Stets Loop Current Mode nach dem Einstellen oder dem Andern von HART Address (iberpriifen.
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12.16

12.17

12.18

12.19

224

Verfahren
1. HART Address entsprechend den Anforderungen des HART Netzwerks einstellen.
Die Standardadresse ist 0. Das ist der empfohlene Wert, es sei denn, die

Auswerteelektronik befindet sich in einem Multidrop-Netzwerk.

2. Loop Current Mode auf Enabled einstellen.

HART Burst Modus priifen

Der HART Burst Modus kann dazu fiihren, dass die Auswerteelektronik unerwartete Werte
ausgibt. Der Burst Modus ist normalerweise deaktiviert und sollte nur dann aktiviert
werden, wenn ein anderes Gerat innerhalb des Netzwerks eine HART Kommunikation im
Burst Modus verlangt.

1. Priifen Sie, ob der Burst Modus aktiviert oder deaktiviert ist.

2. Ist der Burst Modus aktiviert, deaktivieren Sie den Modus.

Priifen von Messanfang und Messende

Wenn die Prozessbedingungen unter den konfigurierten Lower Range Value (LRV) fallen oder
tiber den konfigurierten Upper Range Value (URV) steigen, kdnnen unerwartete Werte (iber
die Ausgange der Auswertelektronik ausgegeben werden.

1. Bewerten Sie die aktuellen Prozessbedingungen.
2. Priifen Sie die Konfiguration von LRV und URV.

mA Ausgang Storaktion priifen

Die mA Ausgang Storaktion steuert das Verhalten des mA Ausgangs, wenn die
Auswerteelektronik eine interne Stérbedingung erkennt. Wenn der mA Ausgang einen
konstanten Wert unter 4 mA oder (iber 20 mA ausgibt, weist die Auswerteelektronik
maoglicherweise eine Stérbedingung auf.

1. In diesem Fall die Statusalarme auf aktive Stérbedingungen priifen.

2. Wenn keine aktiven Storbedingungen vorhanden sind, funktioniert die
Auswerteelektronik ordnungsgemaR. Wenn Sie das Verhalten des
Frequenzausgangs dndern mochten, haben Sie folgende Mdéglichkeiten:

+ Andern Sie die Einstellung der mA Ausgang Storaktion.
« Andern Sie fiir die relevanten Statusalarme die Einstellung Alarmstufe auf Ignorieren.

3. Wenn keine aktiven Stérbedingungen vorhanden sind, setzen Sie die
Storungsanalyse und -beseitigung fort.

Priifung auf hochfrequente Stérungen (RFI)

Der Frequenzausgang bzw. der Bindrausgang der Auswerteelektronik kann durch
hochfrequente Stoérungen (RFI) beeinflusst werden. Mdgliche RFI-Quellen sind Sender von
Funkemissionen bzw. groRe Transformatoren, Pumpen oder Motoren, die ein starkes
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elektromagnetisches Feld erzeugen kénnen. Es gibt mehrere Methoden zur Reduzierung
hochfrequenter Storungen. Verwenden Sie eine oder mehrere der folgenden
Empfehlungen entsprechend der jeweiligen Installation.

Verfahren

. Hochfrequente Storquelle eliminieren.

. Auswerteelektronik versetzen.

. Abgeschirmte Kabel fiir den Frequenz- bzw. Bindrausgang verwenden.

- Kabelschirm am Ausgangsgerdt auflegen. Ist dies nicht méglich, den Schirm an
der Kabelverschraubung oder der Kabelschutzrohrverschraubung auflegen.

- Den Schirm nicht im Inneren des Anschlussraumes auflegen.
- Ein 360° Schirmabschluss ist nicht erforderlich.

12.20 Frequenzausgang max. Impulsbreite priifen

Wenn die Frequenzausgang max. Impulsbreite falsch eingestellt ist, kann der Frequenzausgang
einen falschen Wert ausgeben.

Priifen Sie die Konfiguration der Frequenzausgang max. Impulsbreite.

Fiir die meisten Anwendungen ist der fir Frequenzausgang max. Impulsbreite voreingestellte
Wert geeignet. Dieser Wert entspricht einem Impuls/Pause-Verhaltnis von 50 %.

12.21 Frequenzausgang Skaliermethode priifen

Wenn die Frequenzausgang Skaliermethode falsch eingestellt ist, kann der Frequenzausgang
einen falschen Wert ausgeben.

1. Priifen Sie die Konfiguration von Frequenzausgang Skaliermethode.

2. Wenn Sie die Einstellung flir Frequenzausgang Skaliermethode gedndert haben, priifen
Sie alle anderen Parameter des Frequenzausgangs.

12.22 Frequenzausgang Storaktion priifen

Die Frequenzausgang Storaktion steuert das Verhalten des Frequenzausgangs, wenn die
Auswerteelektronik eine interne Stérbedingung erkennt. Wenn der Frequenzausgang
einen konstanten Wert ausgibt, liegt moglicherweise eine Stérbedingung der
Auswerteelektronik vor.

1. In diesem Fall die Statusalarme auf aktive Stérbedingungen priifen.

2. Wenn keine aktiven Storbedingungen vorhanden sind, funktioniert die
Auswerteelektronik ordnungsgemaR. Wenn Sie das Verhalten des
Frequenzausgangs dandern mochten, haben Sie folgende Méglichkeiten:
 Andern der Einstellung Frequenzausgang Storaktion.

* Andern Sie fiir die relevanten Statusalarme die Einstellung Alarmstufe auf Ignorieren.

3. Wenn keine aktiven Stérbedingungen vorhanden sind, setzen Sie die
Storungsanalyse und -beseitigung fort.
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Priifen der Durchflussrichtung

Wenn die Durchflussrichtung fiir lhren Prozess nicht korrekt eingestellt ist, zeigt die
Auswerteelektronik méglicherweise unerwartete Durchflusswerte oder Zahler an.

Der Parameter Durchflussrichtung interagiert mit der eigentlichen Durchflussrichtung und
hat somit Auswirkungen auf Durchflusswerte, Durchflusszahler und -summen und das
Ausgangsverhalten. Der einfachste Betrieb wird erreicht, indem der eigentliche
Prozessfluss mit dem Richtungspfeil fiir den Durchfluss auf der Seite des Sensorgehduses
tibereinstimmt.

Verfahren

1. Die eigentliche Durchflussrichtung des Prozessflusses durch den Sensor tiberpriifen.
2. DieKonfiguration der Durchflussrichtung priifen.

Priifen der Abschaltungen

Wenn die Abschaltungen der Auswerteelektronik falsch konfiguriert sind, kann die
Auswerteelektronik bei vorhandenem Durchfluss oder bei sehr geringen
Durchflussmengen einen Null Durchfluss ausgeben.

Es gibt separate Abschaltparameter fiir Massedurchfluss, Volumendurchfluss, Standard-
Gasvolumen-Durchfluss (falls zutreffend) und Dichte. Fiir jeden mA-Ausgang an der
Auswerteelektronik gibt es eine separate Abschaltung. Die Wechselwirkung zwischen den
Abschaltungen kann zu unerwarteten Ergebnissen fiihren.

Verfahren

Die Konfiguration der Abschaltungen tiberpriifen.

Hinweis
Bei typischen Anwendungen empfiehlt Micro Motion, Mass Flow Cutoff auf den

Nullpunktstabilitatswert des Sensors multipliziert mit 10 einzustellen. Nullpunktstabilitatswerte sind
im Produktdatenblatt des Sensors zu finden.

Priifen auf Schwallstromung
(Zweiphasenstromung)

Schwallstrémung (Zweiphasenstromung, Gaseinschliisse) kann zu Spitzenwerten bei der
Antriebsverstdrkung fiihren. Dies kann dazu fiihren, dass die Auswerteelektronik Null
Durchfluss oder mehrere unterschiedliche Alarme meldet.

1. Aufdurch Schwallstromung ausgeldste Alarme priifen.

Wenn die Auswerteelektronik keine Schwallstromalarme erzeugt, ist
Schwallstromung nicht die Ursache des Problems.

Prozess auf Kavitation, Dampfbildung oder Leckagen priifen.

Die Dichte des Prozessmediumausgangs unter normalen Prozessbedingungen
tiberwachen.

4, Die Einstellungen fiir Slug Low Limit, Slug High Limit und Slug Duration priifen.
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Hinweis

Das Auftreten von Schwallstromalarmen kann durch die Einstellung von Slug Low Limit auf
einen niedrigeren Wert, Slug High Limit auf einen héheren oder Slug Duration auf einen héheren

Wert reduziert werden.

Antriebsverstarkung priifen

UbermiRige oder fehlerhafte Antriebsverstirkung kann auf vielfiltige
Prozessbedingungen, Sensor- oder Konfigurationsprobleme hindeuten.

Um herauszufinden, ob die Antriebsverstarkung zu hoch oder fehlerhaft ist, miissen Daten
in der Problemsituation gesammelt und mit den Daten der Antriebsverstarkung unter
normalen Betriebsbedingungen verglichen werden.

UbermaiRige (gesittigte) Antriebsverstirkung

Tabelle 12-8: Mdgliche Ursachen und AbhilfemaRBnahmen bei ibermaRiger
(gesattigter) Antriebsverstarkung

Magliche Ursache

Empfohlene MaBnahmen

Schwallstrémung

Auf Schwallstrémung priifen. Siehe Abschnitt 12.25.

Teilweise gefiilltes Durchfluss-
rohr

Prozessbedingungen so korrigieren, dass die Durchflussrohre ge-
fillt sind.

Verstopfte Messrohre

Aufnehmerspannungen priifen (siehe Abschnitt 12.27). Ist eine
der Spannungen fast null (aber keine null), kénnen verstopfte
Rohre die Ursache des Problems sein. Rohre spiilen. In Extremfall-
en kann es sein, dass der Sensor ersetzt werden muss.

Kavitation, Dampfbildung oder
Lufteinschluss; Abscheiden

von Zwei- oder Dreistromfliis-
sigkeiten

e Den einlaufseitigen oder auslaufseitigen Druck am Sensor er-
hohen.

e Befindet sich einlaufseitig vor dem Sensor eine Pumpe, den
Abstand zwischen Pumpe und Sensor vergréern.

e Der Sensor muss mdglicherweise neu ausgerichtet werden.
Weitere Informationen bzgl. der Sensorausrichtung sind im
Installationshandbuch zu finden.

Stérung in Antriebsplatine
oder Modul

Kontaktieren Sie Micro Motion.

Messrohr verbogen Aufnehmerspannungen priifen (siehe Abschnitt 12.27). Ist eine
der Spannungen fast null (aber keine null), sind die Messrohre
maoglicherweise verbogen. Der Sensor muss ausgetauscht wer-
den.

Messrohr gerissen Sensor austauschen.

Sensorunwucht Kontaktieren Sie Micro Motion.

Mechanische Verbindung am
Sensor

Stellen Sie sicher, dass der Sensor frei schwingen kann.

Offene Antriebs- oder Aufneh-
merspule links

Kontaktieren Sie Micro Motion.

Durchfluss auRerhalb des Be-
reichs

Stellen Sie sicher, dass der Durchfluss innerhalb der Sensorgren-
zen liegt.
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Tabelle 12-8: Mdogliche Ursachen und AbhilfemaBnahmen bei iibermaRiger
(gesattigter) Antriebsverstarkung (Fortsetzung)

Magliche Ursache Empfohlene MaBnahmen

Falsche Sensor-Charakterisier- | Charakterisierungsparameter priifen.

ung

Sprunghafte Antriebsverstarkung

Tabelle 12-9: Mégliche Ursachen und Abhilfema3nahmen bei fehlerhafter
Antriebsverstadrkung

Magliche Ursache Empfohlene MaBnahmen

Falsche K1-Charakterisierungskonstante fiir | Charakterisierungsparameter K1 priifen.
den Sensor

Polaritdt der Aufnehmer- oder Antriebsspule | Kontaktieren Sie Micro Motion.
vertauscht

Schwallstrémung Auf Schwallstrémung priifen. Siehe
Abschnitt 12.25.
Fremdkorper in den Messrohren e Messrohre spiilen.

e Sensor austauschen.

Daten der Antriebsverstarkung sammeln

Daten der Antriebsverstarkung kdnnen fiir die Diagnose einer Reihe von Prozess- und
Gerdtebedingungen verwendet werden. Die Daten der Antriebsverstarkung kénnen fiir
eine Zeitspanne wahrend des normalen Betriebs gesammelt und als Referenz zur
Stérungsanalyse/-beseitigung verwendet werden.

Verfahren
1. Zuden Daten der Antriebsverstarkung navigieren.
2.  Die Daten der Antriebsverstarkung tiber eine bestimmte Zeitspanne und unter

verschiedenen Prozessbedingungen beobachten und aufzeichnen.

Aufnehmerspannung priifen

Wenn die Aufnehmerspannungswerte ungewohnlich niedrig sind, ist es méglich, dass eine
von vielen méglichen Stérungen im Prozess oder bei der Ausriistung aufgetreten sind.

Um zu erfahren, ob die Aufnehmerspannung ungewohnlich niedrig ist, miissen
Aufnehmerspannungsdaten gesammelt werden, wahrend die Stérung vorherrscht, und
diese Daten dann mit Daten der Aufnehmerspannung wahrend des normalen Betriebs
verglichen werden.
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Tabelle 12-10: Mdégliche Ursachen und empfohlene MaRnahmen fiir eine niedrige

Aufnehmerspannung
Magliche Ursache Empfohlene MaBnahmen
Lufteinschliisse ¢ Den einlaufseitigen oder auslaufseitigen Druck am Sensor er-
hohen.

e Befindet sich einlaufseitig vor dem Sensor eine Pumpe, den
Abstand zwischen Pumpe und Sensor vergréRern.

e Der Sensor muss moglicherweise neu ausgerichtet werden.
Weitere Informationen bzgl. der Sensorausrichtung sind im In-
stallationshandbuch zu finden.

Fehlerhafte Verdrahtung zwi- | Verdrahtung zwischen Sensor und Auswerteelektronik priifen.
schen Sensor und Auswertee-

lektronik

Der Durchfluss befindet sich Stellen Sie sicher, dass der Durchfluss nicht auRerhalb des Sensor-
auBerhalb der Sensorgrenz- Messbereichs liegt.

werte.

Schwallstromung Auf Schwallstrémung priifen. Siehe Abschnitt 12.25.

Keine Schwingung der Sensor | ¢ Auf verstopfte Messrohre priifen.

Messrohre e Stellen Sie sicher, dass der Sensor frei schwingen kann (keine
mechanische Verbindungen).

e Verdrahtung priifen.

e Spulen am Sensor priifen. Siehe Abschnitt 12.28.1.

Feuchtigkeit in der Sensore- Beseitigen Sie die Feuchtigkeit in der Sensorelektronik.
lektronik

Der Sensor ist beschddigt oder | Sensor austauschen.
die Sensormagnete haben sich
entmagnetisiert.

12.27.1  Aufnehmer Spannungsdaten sammeln

Die Aufnehmer Spannungsdaten kénnen zur Diagnose einer Vielzahl von Prozess- und
Gerdtebedingungen verwendet werden. Die Aufnehmer Spannungsdaten kénnen fiir eine
Zeitspanne wahrend des normalen Betriebs gesammelt und als Referenz zur
Stérungsanalyse/-beseitigung verwendet werden.

Verfahren
1.  Die Aufnehmer Spannungsdaten aufrufen.
2. Die Daten fiir den linken und fiir den rechten Aufnehmer fiir einen bestimmte

Zeitspanne und unter verschiedenen Prozessbedingungen beobachten und
aufzeichnen.

12.28 Priifen auf elektrische Kurzschliisse

Kurzschliisse zwischen Sensor Anschlussklemmen oder Sensor Anschlussklemmen und
dem Sensorgehduse konnen einen Ausfall des Sensors bewirken.
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Tabelle 12-11: Mdégliche Ursachen und empfohlene MaRBnahmen bei elektrischen
Kurzschliissen

Magliche Ursache Empfohlene MaBnahme

Feuchtigkeit im Innern der Ans- Sicherstellen, dass die Anschlussdose trocken und ohne Kor-
chlussdose rosion ist.

Flissigkeit oder Feuchtigkeit im Micro Motion kontaktieren.

Sensorgehduse

Kurzschluss in interner Durchfiih- | Micro Motion kontaktieren.
rung

Fehlerhaftes Kabel Das Kabel austauschen.

UnsachgemaRe Kabelanschliisse Kabelanschlisse in der Sensor Anschlussdose priifen. Das
Micro Motion Dokument mit dem Titel Kabelvorbereitung und
Installationsanleitung fiir 9-adrige Durchfluss-Messsysteme kann
hierbei moglicherweise hilfreich sein.

12.28.1  Priifen der Sensorspulen

Das Priifen der Sensorspulen kann elektrische Kurzschliisse identifizieren.

Einschrankung

Dieses Verfahren betrifft nur 9-adrige extern montierte Auswerteelektroniken und externe
Auswerteelektroniken mit externen Core Prozessoren.

Verfahren
1. Spannungsversorgung des Messumformers abklemmen.
A\ VORSICHT!

Befindet sich die Auswerteelektronik in einer explosionsgefihrdeten Umgebung,
5 Minuten warten, bevor fortgefahren wird.

Gehausedeckel vom Core Prozessorgehause entfernen.

Die Anschlussklemmenbldcke von der Anschlussklemmenleiste am Core Prozessor
abziehen.

4. Unter Verwendung eines digitalen Multimeters die Aufnehmerspulen durch Anlegen
der Multimeteradern an die Anschlussklemmenblocke fir jedes
Anschlussklemmenpaar priifen. Siehe Tabelle 12-12 bzgl. einer Auflistung der
Spulen. Notieren Sie sich die Werte.

Tabelle 12-12: Spulen und Test-Anschlussklemmenpaare

Spule Sensor Modell Farben der Anschluss-
klemmen

Antriebsspule Alle Braun - rot

Linke Aufnehmerspule (LPO) Alle Griin - weiss

Rechte Aufnehmerspule (RPO) Alle Blau - grau

Widerstandsthermometer (RTD) Alle Gelb - violett
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Tabelle 12-12: Spulen und Test-Anschlussklemmenpaare (Fortsetzung)

Spule Sensor Modell Farben der Anschluss-
klemmen

Adern Laingenkompensator (LLC) Alle auRer T-Serie und Gelb - orange
CMF400 (siehe Hinweis)

Gemeinsame Widerstandsther- T-Serie Gelb - orange

mometer

Fester Widerstand (siehe Hinweis) | CMF400 Gelb - orange
Anmerkung

Der feste Widerstand des CMF400 betrifft nur bestimmte Versionen vom CMF400. Weiteren
Informationen erhalten Sie von Micro Motion.

Es diirfen keine offenen Messkreise, d. h. unendliche Widerstandsmesswerte
auftreten. Der Messwerte fiir den linken und den rechten Aufnehmer sollten gleich
sein bzw. sehr nahe beieinander liegen (£5 Q). Sollten uniibliche Werte auftauchen,
wiederholen Sie den Test an der Sensor Anschlussdose, um so mdgliche Kabelfehler
zu eliminieren. An beide Enden des entsprechenden Spulenpaars sollten die Werte
gleich sein.

5. Die Anschlussklemmen in der Sensoranschlussdose auf Kurzschliisse zum Geh&use
prifen.
Die Anschlussklemmenbldcke abgeklemmt lassen.
b. Den Deckel des Anschlussdose entfernen.
c. Die eine Ader des Multimeters an die Anschlussklemme und die andere am
Sensorgehduse anlegen, um jeweils eine Anschlussklemme zu priifen.

Setzen Sie das Multimeter auf den héchsten Bereich, da der Widerstandswert
jedes Ader unendlich sein sollte. Wird an einer Ader ein Widerstand gemessen,
liegt ein Kurzschluss zum Gehduse vor.

6. Den Widerstand der Anschlussklemmenpaare in der Anschlussdose priifen.
a. Die braune Anschlussklemme gegen alle anderen Anschlussklemmen auRer der
roten priifen.

b. Die rote Anschlussklemme gegen alle anderen Anschlussklemmen auBer der
braunen prifen.

c. Die griine Anschlussklemme gegen alle anderen Anschlussklemmen auRBer der
weilBen prifen.

d. Die weiRRe Anschlussklemme gegen alle anderen Anschlussklemmen auRer der
griinen priifen.

e. Die blaue Anschlussklemme gegen alle anderen Anschlussklemmen auRer der
grauen priifen.

f. Die graue Anschlussklemme gegen alle anderen Anschlussklemmen auRer der
blauen priifen.

g. Die orangefarbene Anschlussklemme gegen alle anderen Anschlussklemmen
auRer der violetten priifen.
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h. Die gelbe Anschlussklemme gegen alle anderen Anschlussklemmen auRer der
orangefarbenen und der violetten priifen.

i. Die violette Anschlussklemme gegen alle anderen Anschlussklemmen auBer der
gelben und orangefarbenen priifen.

Fiir jedes Paar sollte der Widerstand unendlich sein. Wird ein Widerstand gemessen,
liegt ein Kurzschluss zwischen den Anschliissen vor.

Nachbereitungsverfahren

Zum normalen Betrieb zurlickkehren:

1. Anschlussklemmenblécke wieder in die Anschlussplatine einsetzen.
2. Gehdusedeckel vom Core Prozessorgehause wieder anbringen.

3. Deckel der Anschlussdose am Sensor wieder anbringen.

Wichtig

Bei der Montage der Durchfluss-Messsystem Komponenten sicherstellen, dass die O-Ringe
eingefettet werden.

Core Prozessor LED priifen.

Der Core Prozessor verfiigt (iber eine LED, die die verschiedenen Zustande des
Messsystems anzeigt.

1. Auswerteelektronik mit Spannung versorgen.
2.  Beieiner externen 4-adrigen Installation oder einem externen Core Prozessor mit
externer Installation der Auswerteelektronik:
a. Gehdusedeckel des Core Prozessors entfernen. Der Core Prozessor ist
eigensicher und kann in jeder Umgebung ged&ffnet werden.
b. Den Zustand der Core Prozessor LED priifen.

3. Haben Sie eine integrierte Installation:

a. Die vier Kopfschrauben |6sen, mit der die Auswerteelektronik unten befestigt ist.

Abbildung 12-1: Komponenten der integrierten Installation

Auswerteelektronik

Montagering

4 x Kopfschrauben (4 mm)

Grundplatte
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b. Auswerteelektronik entgegen dem Uhrzeigersinn drehen, dass die
Kopfschrauben in der ungeschlossenen Position sind.

c. Auswerteelektronik vorsichtig gerade abheben und von den Kopfschrauben
[6sen.

Wichtig
Adern, die die Auswerteelektronik und den Core Prozessor verbinden, nicht abklemmen
oder beschadigen.

d. Den Zustand der Core Prozessor LED priifen.

4.  Haben Sie eine 9-adrige externe Installation:

a. Abschlussdeckel entfernen.

Abbildung 12-2: 9-adrige Installationskomponenten

Auswerteelektronik

Core Prozessor

Gehausedeckel

b. Im Core Prozessor Gehduse die drei Schrauben 16sen, die die Core Prozessor
Montageplatte befestigen.
Schrauben nicht entfernen.

c. Montageplatte so drehen, dass die Schrauben in der ungeschlossenen Position
sind.

d. Lasche der Montageplatte halten und langsam absenken, dass das Oberteil des
Core Prozessors sichtbar wird.

Wichtig
Adern, die die Auswerteelektronik und den Core Prozessor verbinden, nicht abklemmen
oder beschadigen.

e. Den Zustand der Core Prozessor LED priifen.

Nachbereitungsverfahren

Zum normalen Betrieb zurtickkehren:
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. Bei einer externen 4-adrigen Installation oder einem externen Core Prozessor mit

externer Installation der Auswerteelektronik, den Deckel des Core Prozessors wieder

anbringen.

. Bei einer integrierten Installation:

1. Die Auswerteelektronik unten aufsetzen, ohne an den Drdhten zu ziehen oder
diese einzuklemmen, und die Kopfschrauben in die Bohrungen einsetzen.

2. Auswerteelektronik im Uhrzeigersinn drehen, dass die Kopfschrauben in der
geschlossenen Position sind.

3. Die Kopfschrauben auf ein Anzugsmoment von 20 bis 30 in-lbs (2,3 bis 3,4 Nm)
anziehen.

. Bei einer 9-adrigen Installation:

1. Die Montageplatte in ihre Position schieben, ohne an den Drahten zu ziehen oder

diese einzuklemmen.

2. Montageplatte so drehen, dass die Schrauben in der geschlossenen Position sind.

3. Die Schrauben auf eine Anzugsmoment von 6 bis 8 in-Ibs (0,7 bis 0,9 Nm)
anziehen.

4. Abschlussdeckel wieder einsetzen.

Wichtig

Bei der Montage der Durchfluss-Messsystem Komponenten sicherstellen, dass die O-Ringe
eingefettet werden.

12.29.1

Core Prozessor-LED-Status

Tabelle 12-13: Standard Core Prozessor-LED-Status

LED-Status

Beschreibung

Empfohlene MaBnahmen

1 x Blinken pro Sekunde (AN 25
%, AUS 75%)

Normalbetrieb

Keine MaRnahme erforderlich.

1 x Blinken pro Sekunde (AN
75%, AUS 25%)

Schwallstromung (Zweiphasen-
strémung)

Siehe Abschnitt 12.25.

Stindig AN

Nullpunktkalibrierung oder Kali-
brierung lauft

Keine MaRnahme erforderlich.

Core Prozessor erhédlt 11,5 bis 5
\

Spannungsversorgung der Auswerteelektronik
priifen.

3 x schnelles Blinken mit ans-
chlieBender Pause

Sensor nicht erkannt

Die Verdrahtung zwischen Auswerteelektronik
und Sensor priifen.

Falsche Konfiguration

Sensor-Charakterisierungs-Parameter priifen.

Abgebrochener Pin zwischen
Sensor und Core Prozessor

Das Messgerat muss zur Reparatur ins Werk ein-
gesandt werden.

4 x Blinken pro Sekunde

Stérung

Alarmstatus priifen.
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Tabelle 12-13: Standard Core Prozessor-LED-Status (Fortsetzung)

LED-Status

Beschreibung

Empfohlene MaBnahmen

AUS

Core Prozessor erhdlt weniger
als5Vv

e Verdrahtung der Spannungsversorgung zum
Core Prozessor priifen.

e Leuchtet die Status-LED der Auswerteelektro-
nik, bekommt die Auswerteelektronik auch
Spannung. Spannung iiber den Klemmen 1
(VDC+) und 2 (VDC-) am Core Prozessor prii-
fen. Ist der Wert kleiner als 1 VDC, Verdrah-
tung der Spannungsversorgung zum Core Pro-
zessor priifen. Adern moglicherweise vertau-
schen.

e Leuchtet die Status-LED der Auswerteelektro-
nik nicht, bekommt die Auswerteelektronik
auch keine Spannung. Spannungsversorgung
prifen. Funktioniert die Spannungsversor-
gung, so kann die interne Auswerteelektronik,
das Display oder die LED fehlerhaft sein. Das
Messgerat muss moglicherweise zur Repara-
turins Werk eingeschickt werden.

Interner Fehler am Core Prozes-
sor

Das Messgerat muss zur Reparatur ins Werk ein-
gesandt werden.

Tabelle 12-14: LED-Status des Core Prozessors mit erweiterter Funktionalitat

LED-Status Beschreibung Empfohlene MaBnahme
Griin Normalbetrieb Keine MaRnahme erforderlich.
Gelb blinkend Nullpunktkalibrierung lduft Keine MaBnahme erforderlich.
Gelb Alarm niedriger Prioritdt Alarmstatus priifen.
Dauerhaft rot Alarm hoher Prioritdt Alarmstatus prifen.

Rot blinkend (80 % AN, 20 %
AUS)

Messrohre nicht gefiillt

¢ Wenn Alarm A105 (Schwallstromung) aktiv
ist, die entsprechenden MaBnahmen fiir die-
sen Alarm befolgen.

e Ist Alarm A033 (Messrohre nicht gefiillt) aktiv,
Prozess priifen. Auf Luft in den Durchflussroh-
ren, nicht gefiillte Messrohre, Fremdkorper
oder Ablagerungen in den Messrohren priifen.

Rot blinkend (50 % AN, 50 %
AUS)

Elektronikfehler

Das Messgerat muss zur Reparatur ins Werk ein-
gesandt werden.

Rot blinkend (50 % AN, 50 %
AUS, liberspringt jedes vierte)

Sensorfehler

Das Messgerat muss zur Reparatur ins Werk ein-
gesandt werden.
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Tabelle 12-14: LED-Status des Core Prozessors mit erweiterter Funktionalitat (Fortsetzung)

LED-Status Beschreibung Empfohlene MaBnahme
AUS Core Prozessor erhdlt weniger e Verdrahtung der Spannungsversorgung zum
als5Vv Core Prozessor priifen.

e Leuchtet die Status-LED der Auswerteelektro-
nik, bekommt die Auswerteelektronik auch
Spannung. Spannung iiber den Klemmen 1
(VDC+) und 2 (VDC-) am Core Prozessor prii-
fen. Ist der Wert kleiner als 1 VDC, Verdrah-
tung der Spannungsversorgung zum Core Pro-
zessor priifen. Adern moglicherweise vertau-
schen.

e Leuchtet die Status-LED der Auswerteelektro-
nik nicht, bekommt die Auswerteelektronik
auch keine Spannung. Spannungsversorgung
prifen. Funktioniert die Spannungsversor-
gung, so kann die interne Auswerteelektronik,
das Display oder die LED fehlerhaft sein. Das
Messgerat muss moglicherweise zur Repara-
turins Werk eingeschickt werden.

Interner Fehler am Core Prozes- | Das Messgerdt muss zur Reparatur ins Werk ein-
sor gesandt werden.

12.30 Core Prozessor Widerstandstest durchfiihren

1. Die Spannungsversorgung des Messumformers ausschalten.

2.  Beieiner4-adrigen externen Installation oder einem externen Core Prozessor mit
externer Installation der Auswerteelektronik den Deckel des Core Prozessors
entfernen.

3. Haben Sie eine integrierte Installation:

a. Die vier Kopfschrauben [6sen, mit der die Auswerteelektronik unten befestigt ist.

Abbildung 12-3: Komponenten der integrierten Installation

Auswerteelektronik

Montagering

4 x Kopfschrauben (4 mm)

Grundplatte

b. Auswerteelektronik entgegen dem Uhrzeigersinn drehen, dass die
Kopfschrauben in der ungeschlossenen Position sind.
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c. Auswerteelektronik vorsichtig gerade abheben und von den Kopfschrauben

[6sen.

4,  Haben Sie eine 9-adrige externe Installation:

a. Abschlussdeckel entfernen.

Abbildung 12-4: 9-adrige Installationskomponenten

Auswerteelektronik

Core Prozessor

Gehausedeckel

b. Im Core Prozessor Gehause die drei Schrauben 16sen, die die Core Prozessor
Montageplatte befestigen.

Schrauben nicht entfernen.

c. Montageplatte so drehen, dass die Schrauben in der ungeschlossenen Position

sind.

d. Lasche der Montageplatte halten und langsam absenken, dass das Oberteil des
Core Prozessors sichtbar wird.

5.  Das vieradrige Kabel am Core Prozessor zwischen Core Prozessor und
Auswerteelektronik abklemmen.

6. Den Widerstand zwischen den Anschlussklemmen 3-4, 2-3 und 2-4 am Core

Prozessor messen.

Anschlussklemmen-
paar Funktion Erwarteter Widerstand
3-4 RS-485/A und RS-485/B 40 kQ bis 50 kQ
2-3 VDC- und RS-485/A 20 kQ bis 25 kQ
2-4 VDC- und RS-485/B 20 kQ bis 25 kQ
7.  Isteiner der gemessenen Widerstdnde kleiner als spezifiziert, so ist der Core

Prozessor nicht in der Lage mit der Auswerteelektronik oder einem externen Host
Rechner zu kommunizieren. Das Messgerdt muss mdglicherweise zur Reparatur ins
Werk eingesandt werden.
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Nachbereitungsverfahren

Zum normalen Betrieb zurlickkehren:

o Bei einer vieradrigen externen Installation oder einem externen Core Prozessor mit
externer Installation der Auswerteelektronik:

1.

2.
3.

Das vieradige Kabel zwischen Core Prozessor und Auswerteelektronik wieder
anschlieRen.

Bringen Sie den Gehausedeckel des Core Prozessors wieder an.

Spannungsversorgung der Auswerteelektronik wieder herstellen.

o Bei einer integrierten Installation:

1.

5.

Das vieradrige Kabel zwischen Core Prozessor und Auswerteelektronik wieder
anschlieRen.

. Die Auswerteelektronik unten aufsetzen, ohne an den Drahten zu ziehen oder

diese einzuklemmen, und die Kopfschrauben in die Bohrungen einsetzen.

. Auswerteelektronik im Uhrzeigersinn drehen, dass die Kopfschrauben in der

geschlossenen Position sind.

Die Kopfschrauben auf ein Anzugsmoment von 20 bis 30 in-Ibs (2,3 bis 3,4 Nm)
anziehen.

Spannungsversorgung der Auswerteelektronik wieder herstellen.

. Bei einer neunadrigen Installation:

1.

Das vieradrige Kabel zwischen Core Prozessor und Auswerteelektronik wieder
anschlieRen.

Die Montageplatte in ihre Position schieben, ohne an den Drahten zu ziehen oder
diese einzuklemmen.

Montageplatte so drehen, dass die Schrauben in der geschlossenen Position sind.

4. Die Schrauben auf eine Anzugsmoment von 6 bis 8 in-lbs (0,7 bis 0,9 Nm)

anziehen.

5. Abschlussdeckel wieder einsetzen.

6. Spannungsversorgung der Auswerteelektronik wieder herstellen.

Wichtig

Bei der Montage der Durchfluss-Messsystem Komponenten sicherstellen, dass die O-Ringe
eingefettet werden.
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Anhang A

Verwendung desDisplays der
Auswerteelektronik

In diesem Anhang behandelte Themen:

*  Komponenten des Auswerteelektronik-Bedieninterfaces
. Verwenden der optischen Schalter

e Zugreifen auf und Verwenden des Display-Menlisystems
*  Displaycodes fiir Prozessvariablen

*  Codes und Abkiirzungen des Displaymentis

e Mendstrukturen fiir das Auswerteelektronik-Display

A.1 Komponenten des Auswerteelektronik-
Bedieninterfaces

Das Auswerteelektronik-Bedieninterface besteht aus einer Status-LED, dem LC-Display und
zwei optischen Schaltern.
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Abbildung A-1: Auswerteelektronik-Bedieninterface
A

09967156
G/CC 4

o

Status-LED

LC-Display

Prozessvariable

Optischer Schalter Scroll (Blattern)
Anzeige fiir optischen Schalter
Optischer Schalter Select (Auswéhlen)
MaReinheit fiir Prozessvariable
Aktueller Wert der Prozessvariable

TomMTmoN®>

A.2 Verwenden der optischen Schalter

Mit den optischen Schaltern auf dem Bedieninterface der Auswerteelektronik kann das
Display der Auswerteelektronik gesteuert werden. Die Auswerteelektronik verfiigt Giber
zwei optische Schalter: Scroll (Blattern) und Select (Auswahlen).

Die optischen Schalter werden durch Blockieren des Lichts vor ihren Offnungen mittels
Daumen oder Finger aktiviert.

Hinweis
Die optischen Schalter kénnen durch die Glasscheibe aktiviert werden. Den Gehdusedeckel der
Auswerteelektronik nicht entfernen.

Die Anzeige des optischen Schalters leuchtet auf, wenn die Auswerteelektronik erkennt,
dass ein optischer Schalter aktiviert wurde.

Tabelle A-1: Anzeige und Schaltzustiande des optischen Schalters

Anzeige des optischen Schal- = Schaltzustand des optischen Schalters
ters

Dauerhaft rot Ein optischer Schalter ist aktiviert.
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Tabelle A-1: Anzeige und Schaltzustidnde des optischen Schalters (Fortsetzung)

Anzeige des optischen Schal- = Schaltzustand des optischen Schalters
ters

Rot blinkend Beide optischen Schalter sind aktiviert.

Zugreifen auf und Verwenden des Display-
Menisystems

Das Display-Men(system wird verwendet, um verschiedene Konfigurations-,
Administrations- und Wartungsaufgaben durchzufthren.

Hinweis
Es ist nicht mdglich, auf alle Konfigurations-, Administrations und Wartungs-Funktionen (iber das

Display-Mentiisystem zuzugreifen. Eine komplette Verwaltung der Auswerteelektronik ist nur mit
einem separaten Kommunikationstool méglich.

Vorbereitungsverfahren

Der Zugriff auf das Display-Men(system ist nur moglich, wenn der Bedienerzugriff auf das
Menii Off-Line (Offline) oder das Men( Alarm aktiviert ist. Der Zugriff auf das komplette
Mendsystem ist nur moglich, wenn der Bedienerzugriff auf das Meni Off-Line (Offline) und
das Menii Alarm aktiviert ist.

Verfahren

1. Aufdem Auswerteelektronik-Display die optischen Schalter Scroll (Blattern) und Select
(Auswahlen) gleichzeitig betatigen, bis die Anzeige auf dem Display wechselt.

Das Mentii Off-Line (Offline) kann auf unterschiedliche Art und Weise in
Abhdngigkeit bestimmter Faktoren aufgerufen werden.

e Wenn ein Alarm aktiv und der Zugriff auf das Men(i Alarm aktiviert ist, wird SEE
ALARM (Siehe Alarm) angezeigt.

* Wenn kein Alarm aktiv und die Smart Systemverifizierung an der
Auswerteelektronik aktiviert ist, wird ENTER METER VERFY (Systemverifizierung
aufrufen) angezeigt.

* Wenn kein Alarm aktiv und die Smart Systemverifizierung an der
Auswerteelektronik nicht aktiviert ist, wird OFF_LINE MAINT (Offline-Wartung)
angezeigt.

2. Die optischen Schalter Scroll (Bléttern) und Select (Auswahlen) verwenden, um durch das
Display-Meniisystem zu navigieren.
* Scroll (Blattern) verwenden, um durch Optionslisten zu blattern.
*  Mit Select (Auswahlen) wird die aktuelle Option ausgewahlt.

3. Wenn nach einer Auswahl CODE? auf dem Display angezeigt wird, muss der Wert
eingegeben werden, der fiir Off-Line Password (Offline-Passwort) konfiguriert wurde.

a. Wenn der Cursor an der ersten Stelle blinkt, Scroll (Blattern) aktivieren, bis das
korrekte Zeichen angezeigt wird und danach Select (Auswahlen) aktivieren.
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b. Dieses Vorgehen fiir das zweite, dritte und vierte Zeichen wiederholen.

Hinweis

Wenn der korrekte Wert fiir Off-Line Password (Offline-Passwort) nicht bekannt ist,

30 Sekunden warten. Der Passwort-Bildschirm wird automatisch ausgeblendet und der
vorherige Bildschirm angezeigt.

4. Wenn Scroll (Blattern) auf dem Display blinkt, den optischen Schalter Scroll (Blattern)

aktivieren, danach Select (Auswéhlen) und dann noch einmal den optischen Schalter
Scroll (Blattern) aktivieren.

Hinweise auf dem Display fiihren durch diese Tastenfolge. Die Tastenfolge Scroll-
Select-Scroll schiitzt gegen unbeabsichtigte Aktivierung des Offline-Mendis. Sie stellt
keine SicherheitsmalRnahme dar.

5. Beenden eines Display-Meniis und Zuriickkehren zu einem Men( héherer Ebene:

* Scroll (Bléttern) aktivieren, bis die Option EXIT (BEENDEN)angezeigt wird. Danach
Select (Auswahlen) aktivieren.

* Ist die Option EXIT (BEENDEN) nicht verfligbar, Scroll (Blattern) und Select (Auswéhlen)
gleichzeitig betdtigen, bis der vorherige Bildschirm wieder angezeigt wird.

6.  Zum Beenden des Display-Meniisystems kann eine der folgenden Methoden
verwendet werden:

* Jedes Menii separat beenden und so zurlick bis zum obersten Mendi navigieren.

* Warten, bis das Display nach einer gewissen Zeit wieder Prozessvariablendaten
anzeigt.

Eingeben eines FlieRkommawertes tiber das Display

Bestimmte Konfigurationswerte (z. B. Messanfang und Messende) werden als
FlieRkommawerte eingegeben. Vom Display werden Dezimal- und Exponentialwerte fiir
FlieRkommawerte unterstiitzt.

Mit dem Display kdnnen maximal 8 Zeichen einschlieRlich Vorzeichen eingegeben
werden. Das Dezimalkomma wird nicht als Zeichen gezahlt. Die Exponentialschreibweise
wird verwendet, um Werte einzugeben, die aus mehr als 8 Zeichen bestehen.

Eingeben eines FlieBkommawertes in Dezimalschreibweise

Mit der Dezimalschreibweise kénnen Werte im Bereich von -9999999 bis 99999999
eingegeben werden. Durch Eingabe des Dezimalpunktes kénnen Werte mit einer
Genauigkeit von 0 bis 4 eingegeben werden (4 Zeichen rechts vom Dezimalkomma).

Die (iber das Display eingegebenen Dezimalwerte miissen den folgenden Anforderungen
entsprechen:

. Sie kénnen aus maximal 8 Ziffern bestehen oder 7 Ziffern einschlieBlich negativem
Vorzeichen (=), um eine negative Zahl darzustellen.

. Sie kdnnen ein Dezimalkomma enthalten. Das Dezimalkomma zéhlt dabei nicht als
Zahl. Das Dezimalkomma muss so positioniert sein, dass die Genauigkeit des Wertes
4 nicht tibersteigt.
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Wenn der Konfigurationsbildschirm das erste Mal aufgerufen wird, wird der aktuelle
Konfigurationswert in Dezimalschreibweise angezeigt und das aktive Zeichen blinkt. Wenn
der Wert positiv ist, wird das Vorzeichen nicht angezeigt. Wenn der Wert negativ ist, wird
ein Minuszeichen angezeigt.

Verfahren
«  Andern des Wertes:
1. Select (Auwahlen) aktivieren, bis die gewlinschte Ziffer aktiv ist (blinkt).

Mit Select (Auswahlen) wird der Cursor um eine Stelle nach links verschoben.
Befindet sich der Cursor ganz links, wird er mit Select (Auswahlen) nach ganz rechts
verschoben.

2. Mit Scroll (Bléttern) wird der Wert der aktiven Ziffer gedandert.
3. Diesen Vorgang wiederholen, bis alle Ziffern wie gewiinscht eingestellt sind.
. Andern des Vorzeichens eines Wertes:
- Wenn der aktuelle Wert negativ ist, Select (Auswahlen) aktivieren, bis das
Minuszeichen blinkt, und danach Scroll (Blattern) aktivieren, bis diese Stelle leer ist.

- Wenn der aktuelle Wert positiv ist und sich eine leere Stelle links neben dem
Wert befindet, Select (Auswahlen) aktivieren, bis der Cursor unter der leeren Stelle
blinkt, und dann Scroll (Blattern) aktivieren, bis das Minuszeichen angezeigt wird.

- Wenn der aktuelle Wert positiv ist und sich keine leere Stelle links neben dem
Wert befindet, Select (Auswahlen) aktivieren, bis der Cursor unter der ganz linken
Ziffer blinkt, und dann Scroll (Blattern) aktivieren, bis das Minuszeichen angezeigt
wird.

. Verschieben des Dezimalkommas:

1. Select (Auswahlen) aktivieren, bis das Dezimalkomma blinkt.
2. Scroll (Blattern) aktivieren.

Das Dezimalkomma wird von seiner aktuellen Position entfernt.

3. Select (Auswahlen) aktivieren und die Position des Dezimalkommas beobachten.

Wahrend sich der Cursor nach links bewegt, blinkt das Dezimalkomma zwischen
jedem Ziffernpaar bis zu einer maximalen Genauigkeit von 4 (vier Ziffern rechts
des Dezimalkommas).

Hinweis

Wenn die Position ungiiltig ist, wird das Dezimalkomma nicht angezeigt. Mit dem
Aktivieren von Select (Auswahlen) fortfahren, bis das Dezimalkomma rechts neben dem
angezeigten Wert angezeigt wird.

4. Wenn sich das Dezimalkomma in der gewiinschten Position befindet, Scroll
(Blattern) aktivieren.
Das Dezimalkomma wird an seiner aktuellen Position eingefiigt.

. Um den angezeigten Wert im Speicher der Auswerteelektronik zu speichern, Scroll
(Blattern) und Select (Auswahlen) gleichzeitig aktivieren und gedriickt halten, bis sich
die Anzeige andert.

Konfigurations- und Bedienungsanleitung 243



Verwendung desDisplays der Auswerteelektronik

244

- Wenn der angezeigte Wert derselbe wie derim Speicher der Auswerteelektronik
befindliche Wert ist, wird der vorherige Bildschirm angezeigt.

- Wenn der angezeigte Wert nicht derselbe wie derim Speicher der
Auswerteelektronik befindliche Wert ist, blinkt SAVE/YES? (SPEICHERN/JA?) auf
dem Display. Select (Auswahlen) aktivieren.

Um den angezeigten Wert nicht im Speicher der Auswerteelektronik zu speichern,
Scroll (Blattern) und Select (Auswahlen) gleichzeitig aktivieren und gedriickt halten, bis
sich die Anzeige dndert.

- Wenn der angezeigte Wert derselbe wie derim Speicher der Auswerteelektronik
befindliche Wert ist, wird der vorherige Bildschirm angezeigt.

- Wenn der angezeigte Wert nicht derselbe wie derim Speicher der
Auswerteelektronik befindliche Wert ist, blinkt SAVE/YES? (SPEICHERN/JA?) auf
dem Display. Scroll (Blattern) aktivieren.

Eingeben eines FlieBkommawertes in
Exponentialschreibweise

Die Exponentialschreibweise wird zur Eingabe von Werten verwendet, die entweder
groRer als 99999999 oder kleiner als ~9999999 sind.

Werte, die in Exponentialschreibweise (iber das Display eingegeben werden, miissen die
folgende Form haben: SX.XXXEYY. In dieser Zeichenfolge bedeutet:

S =Vorzeichen. Ein Minuszeichen (=) gibt einen Wert mit negativem Vorzeichen an.
Eine leere Stelle gibt eine positive Zahl an.

X. XXX = Die vierstellige Mantisse.
E = Die Exponentenanzeige.
YY = Der zweistellige Exponent.

Verfahren

1.

Umschalten von Dezimalschreibweise auf Exponentialschreibweise.

a. Select (Auswahlen) wie gewlinscht aktivieren, bis die ganz rechte Ziffer blinkt.
b. Scroll (Blattern) aktivieren, bis E angezeigt wird.

c. Select (Auswahlen) aktivieren.

Hinweis

Wenn der Wert in der Dezimalschreibweise geandert wurde und die Anderungen nicht
gespeichert wurden, gehen diese Anderungen beim Umschalten auf Exponentialschreibweise
verloren. Den Dezimalwert speichern, bevor auf Exponentialschreibweise umgeschaltet wird.

Den Exponenten eingeben.
Das erste Zeichen kann ein Minuszeichen oder eine Ziffer zwischen 0 und 3 sein. Das
zweite Zeichen kann eine beliebige Ziffer zwischen 0 und 9 sein.

a. Select (Auswahlen) aktivieren, um den Cursor auf das ganz rechte Zeichen auf dem
Display zu verschieben.

b. Scroll (Blattern) aktivieren, bis das gewlinschte Zeichen angezeigt wird.
c. Select (Auswéhlen) aktivieren, um den Cursor eine Stelle nach links zu verschieben.

d. Scroll (Blattern) aktivieren, bis das gewiinschte Zeichen angezeigt wird.
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Die Mantisse eingeben.

Die Mantisse muss ein vierstelliger Wert mit einer Genauigkeit von 3 sein (das
entspricht allen Werten zwischen 0,000 und 9,999).

d.

h.

Das Vorzeichen eingeben.

d.

Select (Auswahlen) aktivieren, um den Cursor auf die ganz rechte Stelle der
Mantisse zu verschieben.

. Scroll (Blattern) aktivieren, bis das gewtinschte Zeichen angezeigt wird.

Select (Auswahlen) aktivieren, um den Cursor um eine Ziffer nach links zu
verschieben.

Scroll (Blattern) aktivieren, bis das gewiinschte Zeichen angezeigt wird.

Select (Auswahlen) aktivieren, um den Cursor um eine Ziffer nach links zu
verschieben.

Scroll (Blattern) aktivieren, bis das gewiinschte Zeichen angezeigt wird.

. Select (Auswéhlen) aktivieren, um den Cursor um eine Ziffer nach links zu

verschieben.

Scroll (Blattern) aktivieren, bis das gewiinschte Zeichen angezeigt wird.

Select (Auswahlen) aktivieren, um den Cursor um eine Ziffer nach links zu
verschieben.

. Scroll (Blattern) aktivieren, bis das gew(inschte Zeichen angezeigt wird.

Bei positiven Zahlen muss eine Leerstelle ausgewdhlt werden.

Um den angezeigten Wert im Speicher der Auswerteelektronik zu speichern, Scroll

(Blattern) und Select (Auswahlen) gleichzeitig aktivieren und gedriickt halten, bis sich
die Anzeige andert.

d.

Wenn der angezeigte Wert derselbe wie der im Speicher der Auswerteelektronik
befindliche Wert ist, wird der vorherige Bildschirm angezeigt.

Wenn der angezeigte Wert nicht derselbe wie der im Speicher der
Auswerteelektronik befindliche Wert ist, blinkt SAVE/YES? (SPEICHERN/JA?) auf
dem Display. Select (Auswahlen) aktivieren.

(Optional) Zuriickschalten von Exponentialschreibweise auf Dezimalschreibweise.

Select (Auswahlen) aktivieren, bis E blinkt.

b. Select (Auswahlen) aktivieren, bis d angezeigt wird.

C.

Select (Auswahlen) aktivieren.

Displaycodes fiir Prozessvariablen

Tabelle A-2: Displaycodes fiir Prozessvariablen

Code Definition Kommentar oder Referenz
AVE_D Durchschnittsdichte

AVE_T Durchschnittstemperatur

BRD_T Platinentemperatur

CONC Konzentration
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Tabelle A-2: Displaycodes fiir Prozessvariablen (Fortsetzung)

Code Definition Kommentar oder Referenz

DRIVE% Antriebsverstarkung

EXT_P Externer Druck

EXT_T Externe Temperatur

Fvz Feldverifizierungsnullpunkt Nur fiir Anwendungen im eichge-
nauen Verkehr

GSVF Gas-Standardvolumendurchfluss

GSVI Gas-Standardvolumen-Gesamtzdhler

GSVT Gas-Standardvolumen-Summenzahler

LPO_A Amplitude linke Aufnehmerspule

LvolLl Volumen-Gesamtzdhler

LZERO Nullpunktdurchfluss

MASSI Masse-Gesamtzdhler

MTR_T Gehdusetemperatur (nur Sensoren der T-Serie)

NETM Netto-Massedurchfluss Anwendung nur zur Konzentration-
smessung

NETV Netto-Volumendurchfluss Anwendung nur zur Konzentration-
smessung

NETMI Nettomasse-Gesamtzdhler Anwendung nur zur Konzentration-
smessung

NETVI Nettovolumen-Gesamtzahler Anwendung nur zur Konzentration-
smessung

PWRIN Eingangsspannung Bezieht sich auf die Eingangsspannung
des Core-Prozessors

RDENS Dichte bei Referenztemperatur Anwendung nur zur Konzentration-
smessung

RPO_A Amplitude rechte Aufnehmerspule

SGU Einheiten fir spezifisches Gewicht

STDV Standard-Volumendurchfluss Anwendung nur zur Konzentration-
smessung

STDVI Standardvolumen-Gesamtzdhler Anwendung nur zur Konzentration-
smessung

TCDENS Temperaturkorrigierte Dichte Nur Mineralélanwendung

TCORI Temperaturkorrigierter Gesamtzéhler Nur Mineralélanwendung

TCORR Temperaturkorrigierter Summenzahler Nur Mineral6lanwendung

TCVOL Temperaturkorrigiertes Volumen Nur Mineralélanwendung

TUBEF Messrohrfrequenz

WTAVE Gewichteter Durchschnitt
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Codes und Abkiirzungen des Displaymeniis

Tabelle A-3: Codes und Abkiirzungen des Displaymeniis

Code oder Ab-

kiirzung Definition Kommentar oder Hinweis

ACK ALARM Alarm bestatigen

ACK ALL Alle Alarme bestdtigen

ACT Aktion

ADDR Adresse

AO 1 SRC Fixiert auf die Prozessvariable, die dem Primarausgang zu-

geordnet ist

AO1 Analogausgang 1 (primarer mA-Ausgang)

AO2 Analogausgang 2 (sekundérer mA-Ausgang)

AUTO SCRLL Automatischer Bildlauf

BKLT Hintergrundbeleuchtung

B LIGHT

CAL Kalibrieren

CHA Kanal A

CHB Kanal B

CHC Kanal C

CHANGE PASSW | Passwort oder Passcode dandern Passwort oder Passcode dndern, das/

CHANGE CODE der fir den Zugriff auf die Funktionen
des Bedieninterfaces erforderlich ist

CONFG Konfiguration

CORE Core Prozessor

CURZ Aktueller Nullpunktwert

CUSTODY XFER Eichgenauer Verkehr

DEV Bindrereignis Mithilfe des erweiterten Ereignismo-
dells konfigurierte Ereignisse

DENS Dichte

DGAIN, DRIVE % Antriebsverstarkung

DI

Bindreingang

DISBL Deaktivieren Auswahlen, um zu deaktivieren

DO1 Bindrausgang 1

DO2 Bindrausgang 2

DSPLY Digitalanzeiger

ETOR2 Ereignis 1 oder Ereignis 2 Mithilfe des Basis-Ereignismodells
konfigurierte Ereignisse

ENABL Aktivieren Auswahlen, um zu aktivieren

ENABLE ACK »Alle bestdtigen“ aktivieren Aktivieren oder Deaktivieren der ACK
ALL Funktion

ENABLE ALARM Alarmmend aktivieren Zugriff auf das Alarmmen( vom Dis-

play
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Tabelle A-3: Codes und Abkiirzungen des Displaymeniis (Fortsetzung)

Code oder Ab-

kiirzung Definition Kommentar oder Hinweis

ENABLE AUTO Auto Scroll aktivieren Auto Scroll-Funktion aktivieren oder
deaktivieren

ENABLE OFFLN Offline aktivieren Zugriff auf das Offline-Menti vom Dis-
play

ENABLE PASSW Passwort aktivieren Aktivieren oder Deaktivieren des Pass-
wortschutzes fiir Displayfunktionen

ENABLE RESET ,Zahler zurticksetzen“ aktivieren Aktivieren oder Deaktivieren der Funk-
tion ,,Zahler zurticksetzen“ vom Bedie-
ninterface

ENABLE START »Zahler starten” aktivieren Aktivieren oder Deaktivieren der Funk-
tion ,Zahler Start/Stopp“ vom Bedie-
ninterface

EVNT1 Ereignis 1 Nur mithilfe des Basis-Ereignismodells
konfigurierte Ereignisse

EVNT2 Ereignis 2 Nur mithilfe des Basis-Ereignismodells
konfigurierte Ereignisse

EXTRN Extern

FACZ Werkseitiger Nullpunktwert

FCF Durchflusskalibrierfaktor

FL SW Durchflussschalter

FLSWT

FLDIR Durchflussrichtung

FO Frequenzausgang

FO FREQ Frequenzfaktor

FO RATE Durchflussfaktor

FRFL Frequenz=Durchfluss

FREQ Frequenz

GSV Gas-Standardvolumen

HYSTRSIS Hysterese

INTERN Intern

10 Eingang/Ausgang

LANG Sprache

LOCK Schreibschutz

LOOP CUR Messkreisstrom

MTRF Gerdtefaktor

M_ASC Modbus ASCII

M_RTU Modbus RTU

MAO1 mA-Ausgang 1 (primdrer mA-Ausgang)

MAO2 mA-Ausgang 2 (sekunddrer mA-Ausgang)

MASS Massedurchfluss

MBUS Modbus

248 Micro Motion® Auswerteelektronik Modell 2700 mit eigensicheren Ausgédngen




Verwendung desDisplays der Auswerteelektronik

Tabelle A-3: Codes und Abkiirzungen des Displaymeniis (Fortsetzung)

Code oder Ab-

kiirzung Definition Kommentar oder Hinweis

MFLOW Massedurchfluss

MSMT Messung

OFFLN Offline

OFF-LINE MAINT | Offline-Wartung

P/UNT Impulse/Einheit

POLAR Polaritdt

PRESS Druck

QUAD Quadratur

r. Revision

SCALE Skaliermethode

SIM Simulation Verwendet fiir Messkreistest, kein
Simulationsmodus. Mittels Display
kein Zugriff auf den Simulationsmo-
dus.

SPECL Spezial

SRC Quelle Variablenzuordnung

TEMP, TEMPR Temperatur

UNT/P Einheiten/Impuls

VAR 1 Displayvariable 1

VER Version

VERFY Priifung

VFLOW Volumendurchfluss

VOL Volumen, Volumendurchfluss

WRPRO Schreibschutz

XMTR Auswerteelektronik
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A.6 Meniistrukturen fiir das Auswerteelektronik-
Display

Abbildung A-2: Offline-Menii - Oberste Ebene

Scroll and Select simultaneously
for 4 seconds

SEE ALARM ENTER METER VERFY(" OFF-LINE MAINT EXIT

(1) This option is displayed only if the transmitter is connected to an enhanced core processor and the meter verification software is installed on the transmitter.
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Abbildung A-3: Offline-Menii - Versionsinformationen

Scroll and Select simultaneously
for 4 seconds

Scroll

OFF-LINE MAINT

1_

Select

Scroll

‘ SWREV ‘

Select

i

g
(%)
=
(<)
3
3
o

*

Scroll

-

ETO info*

Scroll

ia

Concentration measurement or
petroleum measurement info*

Scroll

L3

CUSTODY XFER*

Scroll

o

‘ SENSOR VERFY* ‘

Scroll

‘ EXIT ‘

}

* Displayed only if the corresponding ETO or
application is installed on the transmitter.
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Abbildung A-4: Offline-Menii - Konfiguration: Einheiten und E[A

Scroll and Select
simultaneously
for 4 seconds

Scroll
OFF-LINE MAINT

Select

Scroll
CONFG

Select

uNTS

Select Select

<
o
-
(7}
1]
<

CHA CHB Scroll CHC
e ] oo | [ sorwme |
T N T
[ woroun | [ sozmm |
Ccowerow | [ en
Scroll i

SETPOINT FL SW

252 Micro Motion® Auswerteelektronik Modell 2700 mit eigensicheren Ausgédngen



Verwendung desDisplays der Auswerteelektronik

Abbildung A-5: Offline-Menii - Konfiguration: Gerdtefaktor, Display und digitale Kommunikation

Scroll and Select simultaneously
for 4 seconds

Scroll

OFF-LINE MAINT

MTR F DISPLAY
Select

TOTALS RESET

LocK

Select

ADDRESS HART

voL TOTALS STOP LOOP CURR HART

Scroll Scroll Scroll

DISPLAY OFFLN* EXIT

Scroll Scroll

EXIT DISPLAY ALARM

Scroll

DISPLAY ACK

Scroll

AUTO SCRLL**

Scroll

CODE OFFLN***

Scroll

CODE ALARM***

Scroll

DISPLAY RATE

Scroll

DISPLAY BKLT

Scroll

DISPLAY LANG

“If you disable access to the offine menu, the offine menu wil disappear as soon s you exit. To re-enable Scrol
access, you must use ProLink Il or the Communicator.

“If Auto Seroll s enabled, a Scroll Rate screen is displayed immediately after the Auto Scroll screen.

“**f either password s enabled, a Change Code screen will be displayed. VAR 1

Scroll

EXIT
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Abbildung A-6: Offline-Menii - Alarme

Scroll and Select simultaneously
for 4 seconds

'

SEE ALARM ‘

ACK ALL* ‘

Scroll

|
Y

EXIT ‘

Yes
|
Scroll

Y

Active/
unacknowledged
,—W—‘
Yes No
‘ Alarm code ‘ ‘ NO ALARM ‘

|
Scroll Select Scroll
[_scrol_] [ select |

ACK ‘

|—YesJ—No—|

[ Select ] [ Scroll ]

}

EXIT ‘

*This screen is displayed only if the ACK ALL function is enabled and there are unacknowledged alarms.
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Abbildung A-7: Offline-Menii — Systemverifizierung: oberste Ebene
| Scroll and Select simultaneously
| for 4 seconds

Scroll

ENTER METER VERFY [«

RUN VERFY RESULTS READ SCHEDULE VERFY

Scroll

Se;ect Sellect Sellect
' i 7

Abbildung A-8: Offline-Menii - Zeitplan fiir Systemverifizierung

SCHEDULE VERFY

A

Schedule set?

¥ No- Yes: 1

SCHED IS OFF TURN OFF SCHED/YES?

Scroll

Scroll

Schedule deleted

A

HOURS LEFT |<—

A

[ scroll_] [ select ]
A
> SET NEXT —{ Scroll_}—» SET RECUR | xx HOURS |
| xx HOURS | | xx HOURS |
v v
|  saverves? | |  saverves? | el EXIT
+—N0J—Yes—* rNoJ—Yes—* |_|_|
[ scroll_] [ select ] [ scroll_] [ select ] [ scroll_] (select ]
A < <
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Abbildung A-9: Offline-Menii - Systemverifizierungstest

—» RUN VERFY |« <

| OUTPUTS

+

v

| CONTINUE MEASR | —{"Scroil 1-p] FAULT LAST VALUE EXIT

¥
| ARE YOU SUREIYES? |

v
s X% SENSOR ABORT/YES?

———————————Pass— @ Abort

Select

Fail
Y h 4 A
| PASS VERFY | | CAUTION VERFY | | ABORTED VERFY |
| RESuLTS VIEW/YES? | | Abort Type |
[ Scroll_] [ Select ]
| 4 Y
To Ruhcount | RERUN/YES? |
(see Results Read)
+—Yes—|—No—|
| Correct condition | Scroll

— —To Enter Meter Verfy- —
_Select
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Abbildung A-10: Offline-Menii - Systemverifizierungsergebnisse

RESULTS READ

> RUNCOUNT x
I
v v
(__Scroll_]
Pass W Abort
Fail
, ¥ ]
| xx HOURS | | xx HOURS | | xx HOURS |
| PASS | | CAUTION | | Abort Type |

Select Select

Select

x
x
-
(4]
-]
2
S~
x
x
-
(7]
-
2
B

Select Select

xx R STF% |

I
I

| xx R STF% |

Select Select

RESULTS MORE?

( Select | [ Scroll ]
| L -To Run Verfy— »

To Runcount x-1
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Abbildung A-11: Offline-Menii - Summenzdhler und Gesamtzdhler

Process variable
display

Mass total display

Volume total display

Select
E1--SP®

Scroll Scroll Scroll

RESET®

E2--SP™"

(1) The Event Setpoint screens can be used to define or change the setpoint for Event 1 or Event 2 in the basic event model. These screens are displayed only if the event is defined on mass total or volume total.
Note that this functionality does not apply to discrete events (the enhanced event model).

(2) The transmitter must be configured to allow starting and stopping totalizers from the display.

(3) The transmitter must be configured to allow resetting totalizers from the display.
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Abbildung A-12: Offline-Menii — Nullpunkteinstellung

Scroll and Select simultaneously
for 4 seconds

Scroll

‘ OFF-LINE MAINT ‘

is to an

‘ *This option is displayed only if the
enhanced core processor.

‘ ZERO

CAL ZERO y

‘ ZERO/YES? ‘
4% Current zero display ‘

No—LYes

E

4 RESTORE ZERO* EXIT

J

L

‘ Factory zero display ‘

]
Scroll

‘ CAL FAIL ‘ ‘ CAL PASS ‘
‘ RESTORE ZERO }47

v ‘
Troubleshoot

l
Scroll
‘ RESTORE EXIT

L

l

‘ ‘ RESTORE ZERO/YES? ‘

YesLN 0

[ Scroll ] I Select ] [ Select ]
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Anhang B

VerwendungProlLink Il mit der
Auswerteelektronik

B.1

260

In diesem Anhang behandelte Themen:

e Grundlegende Informationen (iber das ProLink I
*  Verbinden mit ProLink Il
e Mendstruktur fir ProLink Il

Grundlegende Informationen iiber das
ProLink I

ProLink Il ist ein Softwaretool von Micro Motion. Es lduft auf Windows und erméglicht den
Zugriff auf alle Daten und Funktionen der Auswerteelektronik.

ProLink Il Anforderungen

Zur Installation von ProLink Il brauchen Sie:
. Das ProLink Il Installationsmedium

. Das ProLink Il Installationskit fir Ihre Anschlussart
ProLink Il sowie das passende Installationskit erhalten Sie von Micro Motion.
ProLink Il Dokumentation

Die meisten Anweisungen in dieser Betriebsanleitung setzen voraus, dass Sie bereits mit
ProLink Il vertraut sind oder sich mit Windows-Programmen auskennen. Wenn Sie mehr
Informationen brauchen, als Sie in dieser Betriebsanweisung finden, schlagen Sie im
Handbuch ProLink Il (ProLink® Il Software fiir Micro Motion® Auswerteelektroniken:
Installations- und Betriebsanleitung) nach.

Fiir die meisten ProLink Il Installationen wird die Betriebsanleitung zusammen mit dem
ProLink Il Programm installiert. Dariiber hinaus finden die Betriebsanleitung fiir ProLink Il
auf der Micro Motion Dokumentations-CD oder der Micro Motion Website
(www.micromotion.com).

ProLink Il Merkmale und Funktionen

ProLink Il bietet alle Funktionen zur Konfiguration und zum Betrieb der
Auswerteelektronik. ProLink Il bietet auRerdem eine Reihe zusatzlicher Merkmale und
Funktionen, einschlieRlich:

. Der Méglichkeit, die Auswerteelektronik-Konfigurationsdaten auf einer Datei auf
dem PC zu speichern und sie auf andere Auswerteelektroniken zu laden oder zu
kopieren

. Die Moglichkeit, spezifische Datentypen in einer Datei auf dem PC zu protokollieren

. Ein Inbetriebnahme-Wizard

. Ein Priifungs-Wizard
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Ein Gas-Wizard

Diese Funktionen werden in der ProLink Il Betriebsanleitung beschrieben. Sie werden nicht
im aktuellen Handbuch beschrieben.

ProLink Il Meldungen

Wenn Sie ProLink Il mit einer Micro Motion Auswerteelektronik verwenden, sehen Sie eine
Reihe von Meldungen und Hinweisen. Diese Betriebsanleitung beschreibt nicht alle dieser
Meldungen und Hinweise.

Wichtig
Der Benutzer ist fiir die Reaktion auf Meldungen und Hinweise und die Befolgung aller
Sicherheitshinweise verantwortlich.

B.2 Verbinden mit ProLink Il

Eine Verbindung von ProLink Il zur Auswerteelektronik ermdglicht das Lesen von
Prozessdaten, die Konfiguration der Auswerteelektronik und das Durchfiihren von
MaRnahmen fiir die Wartung und fiir die Stérungsanalyse/-beseitigung.

B.2.1 ProLink Il Verbindungsarten

Es stehen unterschiedliche Verbindungsarten fiir die Verbindung von ProLink Il zur
Auswerteelektronik zur Verfiigung. Die Verbindungsart auswdhlen, die fiir das
vorgesehene Netzwerk und die jeweiligen Aufgaben geeignet ist.

Die Auswerteelektronik unterstiitzt die folgenden ProLink Il Verbindungsarten:

Serviceport Verbindungen
HART/Bell 202 Verbindungen

Bei der Auswahl einer Verbindungsart die folgenden Faktoren beachten:

Serviceport Verbindungen verwenden Standard-Verbindungsparameter, die bereits
in ProLink Il definiert sind, und die deshalb nicht konfiguriert werden missen.

HART/Bell 202 Verbindungen verwenden Standard HART Verbindungsparameter,
die bereits in ProLink lldefiniert sind. Der einzige Parameter, der noch konfiguriert
werden muss, ist die Adresse der Auswerteelektronik.

Fiir einige Verbindungsarten miissen der Anschlussraum oder das Gehduse der
Spannungsversorgung gedffnet werden. Diese Anschliisse sollten nur vorlaufig und
mit entsprechenden Sicherheitsvorkehrungen erfolgen.

Modbus Verbindungen, einschlieBlich Serviceport Verbindungen, sind gew&hnlich
schneller als HART Verbindungen.

Bei Verwendung einer HART Verbindung kénnen beim ProLink Il nicht mehr als ein
Fenster gleichzeitig gedffnet werden. Dies dient dazu, den Netzwerkverkehr zu
verwalten und die Geschwindigkeit zu optimieren.

Es kdnnen nicht gleichzeitig mehrere Verbindungen an denselben
Anschlussklemmen hergestellt werden. Gleichzeitige Verbindungen kénnen dann
hergestellt werden, wenn die Verbindungen unterschiedliche Anschlussklemmen
verwenden.
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B.2.2

262

Herstellen einer Service Port-Verbindung

/A VORSICHT!

Wenn sich die Auswerteelektronik in einem Ex-Bereich befindet, keine Service Port
Verbindung verwenden. Service Port Verbindungen erfordern das Offnen des
Anschlussgehéauses. Das Offnen des Anschlussgehéuses bei eingeschalteter
Auswerteelektronik kann zu einer Explosion fithren. Um eine Verbindung mit einer im Ex-
Bereich installierten Auswerteelektronik herzustellen, eine Verbindungsmethode verwenden,
bei der das Entfernen des Gehdusedeckels nicht erforderlich ist.

Vorbereitungsverfahren

ProLink Il Installiert und lizenziert auf Ihrem PC

Eine der folgenden Versionen:

- RS-485 zu RS-232 Signalkonverter

- USB an RS-485 Signalkonverter

Ein verfligbarer serieller Port oder USB Port

Adapter wie erforderlich (z. B. 9-adrig bis 25-adrig)

Verfahren
1. Signalkonverter an den seriellen Port oder USB Port des PCs anschlieen.
2. Zugriff auf Service Port Anschlussklemmen:
a. Die Endkappe der Auswerteelektronik entfernen, um Zugriff auf das
Anschlussgehduse zu erhalten.
b. Die Schraube an der Warnklappe I6sen und das Gehduse der
Spannungsversorgung offnen.
3. Die Adern des Signalkonverters an den Service Port, Anschlussklemmen 7

(RS-485/A) und 8 (RS-485/B), anschlieRen.

Hinweis
Normalerweise, jedoch nichtimmer, ist die schwarze Ader der Anschluss fiir RS-485/A und die
rote Ader fiir RS-485/B.
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Abbildung B-1: Anschluss an Service Port

PC

Signalkonverter

Service Port Anschlussklemme 7 (RS-485/A)

Service Port Anschlussklemme 8 (RS-485/B)

Auswerteelektronik mit Anschlussgehduse und Gehduse der Spannungsversorgung geéffnet

moN®>

Anmerkung
Diese Abbildung zeigt einen seriellen Port Anschluss. USB Anschliisse werden ebenfalls unterstiitzt.

4. Starten Sie ProLink I1.
Connection > Connect to Device auswahlen.

6. Protocol (Protokoll) auf Service Port einstellen.

Hinweis

Service Port-Anschliisse verwenden Standard-Anschlussparameter und eine Standardadresse.
Diese miissen hier nicht konfiguriert werden.

7. Den Wert des COM Port auf den Wert des PC COM-Ports einstellen, der fiir diese
Verbindung verwendet wird.

8. Klicken Sie auf Connect.

Benotigen Sie Hilfe? Wenn eine Fehlermeldung erscheint:
e Die Adern vertauschen und erneut versuchen.
e Sicherstellen, dass der korrekte COM-Port angegeben wurde.

 Die physische Verbindung zwischen PC und Auswerteelektronik priifen.

B.2.3 Herstellen einer HART/Bell 202 Verbindung

Der Anschluss kann direkt an die primaren mA Anschlussklemmen an der
Auswerteelektronik, an jeden beliebigen Punkt in einem HART Messkreis oder an einen
beliebigen Punkt in einem HART Multidrop-Netzwerk erfolgen.
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A\ VORSICHT!

Wenn sich die Auswerteelektronik in einem Ex-Bereich befindet, keine direkte Verbindung mit
den Anschlussklemmen der Auswerteelektronik herstellen. Eine direkte Verbindung an die
Anschlussklemmen der Auswerteelektronik und das Offnen des Gehiusedeckels der
Auswerteelektronik bei eingeschaltetem Gerit kann zu einer Explosion fithren. Um eine
Verbindung mit einer im Ex-Bereich installierten Auswerteelektronik herzustellen, eine
Verbindungsmethode verwenden, bei der das Offnen des Anschlussgehéuses nicht erforderlich
ist.

A\ VORSICHT!

Bei einem direkten Anschluss an die mA Anschlussklemmen kann sich dies auf den mA Ausgang
der Auswerteelektronik auswirken. Wenn der mA Ausgang fiir die Durchflussiiberwachung
verwendet wird, miissen die Gerdte auf manuelle Steuerung eingestellt werden, bevor eine
direkte Verbindung mit den mA Anschlussklemmen méglich ist.

Vorbereitungsverfahren

. ProLink Il Installiert und lizenziert auf Ihrem PC
. Eine der folgenden Versionen:
- RS-232 an Bell 202 Signalkonverter
- USB an Bell 202 Signalkonverter
. Ein verfligbarer serieller Port oder USB Port
o Adapter wie erforderlich (z. B. 9-adrig bis 25-adrig)

Verfahren
1. Signalkonverter an den seriellen Port oder USB Port des PCs anschlie3en.
2. Direkter Anschluss an die Anschlussklemmen der Auswerteelektronik:

a. Die Endkappe der Auswerteelektronik entfernen, um Zugriff auf das
Anschlussgehduse zu erhalten.

b. Die Adern des Signalkonverters an die Anschlussklemmen 1 und 2 anschlieen.

Hinweis
HART Verbindungen sind nicht polaritdtsempfindlich. Es spielt dabei keine Rolle, welche
Ader dabei an welche Anschlussklemme angeschlossen wird.

c. Widerstdnde nach Bedarf hinzufligen.

Wichtig
HART/Bell 202 Verbindungen erfordern einen Spannungsabfall von 1 VDC. Um dies zu
erreichen, einen Widerstand von 250-600 Q zu der Verbindung hinzufiigen.
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Abbildung B-2: Anschluss an Anschlussklemmen der Auswerteelektronik

PC
Signalkonverter
Widerstand 250-600 £2

Auswerteelektronik mit Anschlussgehduse und Gehduse der Spannungsversorgung geéffnet
Externe Spannungsversorgung

mo N ®>

Anmerkung
Diese Abbildung zeigt einen seriellen Port Anschluss. USB Anschliisse werden ebenfalls unterstiitzt.

Der Signalkonverter muss tiber einen Widerstand von 250-600 Q angeschlossen
werden. Der mA Ausgang erfordert eine externe Spannungsquelle mit
mindestens250 Q und 17,5V (siehe folgende Abbildung). Um den Anforderungen
fiir Widerstdande gerecht zu werden, kann jede beliebige Kombination von
Widerstdnden R1, R2 und R3 verwendet werden.
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Abbildung B-3: Anforderungen an die Spannungsversorgung und
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3. Anschluss von einem Punkt im lokalen HART Messkreis:

a. Die Adern des Signalkonverters an einen beliebigen Punkt im Messkreis
anschlieRen.

b. Widerstande nach Bedarf hinzufiigen.

Wichtig
HART/Bell 202 Verbindungen erfordern einen Spannungsabfall von 1 VDC. Um dies zu
erreichen, einen Widerstand von 250-600 Q zu der Verbindung hinzufiigen.
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Abbildung B-4: Anschluss iiber lokalen Messkreis

R3

‘Rj ¥

R1

A. PC
Signalkonverter

C. Jede beliebige Kombination von Widerstédnden R1, R2 und R3, die erforderlich ist, um den Anforderungen fiir HART
Kommunikationswiderstdnde zu entsprechen.

D. Prozessleitsystem oder SPS
Auswerteelektronik mit Anschlussgehduse und Gehduse der Spannungsversorgung geéffnet
F.  Externe Spannungsversorgung

o

m

Anmerkung
Diese Abbildung zeigt einen seriellen Port Anschluss. USB Anschliisse werden ebenfalls unterstiitzt.

Der Signalkonverter muss (iber einen Widerstand von 250-600 Q angeschlossen
werden. Der mA Ausgang erfordert eine externe Spannungsquelle mit
mindestens250 Q und 17,5V (siehe folgende Abbildung). Um den Anforderungen
fiir Widerstdnde gerecht zu werden, kann jede beliebige Kombination von
Widerstanden R1, R2 und R3 verwendet werden.
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Abbildung B-5: Anforderungen an die Spannungsversorgung und
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4. Anschluss iber ein HART Multidrop-Netzwerk:

a. Die Adern des Signalkonverters an einen beliebigen Punkt im Netzwerk
anschlieRen.

b. Widerstande nach Bedarf hinzufiigen.

Wichtig
HART/Bell 202 Verbindungen erfordern einen Spannungsabfall von 1 VDC. Um dies zu
erreichen, einen Widerstand von 250-600 Q2 zu der Verbindung hinzufiigen.
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Abbildung B-6: Anschluss iiber Multidrop-Netzwerk

onNn®>

Signalkonverter

Widerstand 250-600 2

Gerdte im Netzwerk

Master Gerdt

10.

11.

Starten Sie ProLink II.
Connection > Connect to Device auswahlen.
Protocol auf HART Bell 202 setzen.

Hinweis
HART/Bell 202 Anschliisse verwenden Standard-Anschlussparameter. Diese miissen hier nicht
konfiguriert werden.

Wenn ein USB Signalkonverter verwendet wird, Converter Toggles RTS aktivieren.

Address/Tag auf die in der Auswerteelektronik konfigurierten HART Abfrageadresse
einstellen.

Hinweise

* Beiderersten Verbindungsherstellung mit der Auswerteelektronik die Standardadresse 0
verwenden.

e Wenn keine HART Multidrop Umgebung verwendet wird, wird gewohnlich der
Standardwert fiir die HART Abfrageadresse verwendet.

¢ Auf Poll klicken, sofern die Adresse der Auswerteelektronik nicht bekannt ist. Das
Programm durchsucht das Netzwerk und zeigt eine Liste mit erkannten
Auswerteelektroniken an.

Den Wert des COM Port auf den Wert des PC COM-Ports einstellen, der fiir diese
Verbindung verwendet wird.

Master entsprechend einstellen.

Option | Beschreibung

Sekundar | Diese Einstellung verwenden, wenn ein anderer HART Host, wie ein Prozessleit-
system, im Netzwerk vorhanden ist.
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Option ‘ Beschreibung

Primdr | Diese Einstellung verwenden, wenn kein anderer Host im Netzwerk vorhanden

ist. Handterminal ist kein Host.

12. Klicken Sie auf Connect.

Benoétigen Sie Hilfe? Wenn eine Fehlermeldung erscheint:

e Die HART Adresse der Auswerteelektronik tiberpriifen.
 Sicherstellen, dass der korrekte COM-Port angegeben wurde.

e Die physische Verbindung zwischen PC und Auswerteelektronik priifen.
 Sicherstellen, dass der mA Ausgang mit Spannung versorgt wird.

e Erhohen oder Verringern der Widerstande.

 Sicherstellen, dass es keinen Konflikt mit einem anderen HART Master gibt.

B.3 Meniistruktur fir ProLink I

Abbildung B-7: Hauptmenii

‘ kAdditional menu options»

File View Connection
Load from Xmtr to File Connect to Device
Save to Xmtr from File Disconnect
License

Preferences

» Use External Temperature

» Enable Inventory Totals Reset

» Enable External Pressure Compensation
» Copper RTD

Installed options
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Abbildung B-8: Hauptmenii (Fortsetzung)

ProLink

Tools

Plug-ins

Gas Unit Configurator
Meter Verification
Options

* ProLink Il Language
* Error Log On

Data Logging*

Enable/Disable
Custody Transfer

Configuration
Output Levels
Process Variables
Status

Alarm Log
Diagnostic Information
Calibration

Test

API Totalizer Control
CM Totalizer Control
Totalizer Control

Finger Print

API Process Variables
CM Process Variables
PPI Variables

ED Process Variables
Batcher Control

Run Filler

Core Processor Diagnostics

NOC - Well Performance Measurement

* For information about using Data Logger, refer to the ProLink Il manual.
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Abbildung B-9: Konfigurationsmenii

ProLink >
Configuration

—-Additional configuration options »

Flow

* Flow Direction

* Flow Damp

* Flow Cal

* Mass Flow Cutoff

* Mass Flow units

» Mass Factor

* Dens Factor

* Vol Factor

* Flow Switch Variable

* Flow Switch Setpoint

* Flow Switch Hysteresis
* Vol Flow Cutoff

* Vol Flow Units

* Vol Flow Type

* Std Gas Vol Flow Cutoff
+ Std Gas Vol Flow Units
+ Std Gas Density

» Gas Wizard

T Series
*FTG
*FFQ
DTG
*DFQ1

* DFQ2
K3
D3
D4
K4

Density

* Dens Units

* Dens Damping

* Slug High Limit
* Slug Low Limit

* Slug Duration

* Low Density Cutoff
* K1

* K2

*FD

* D1

+ D2

» Temp Coeff (DT)
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Abbildung B-10: Konfigurationsmenii (Fortsetzung)

ProLink >

Configuration

——-Additional configuration options —»

Analog output
Primary/secondary output
* PV/ISV is

* Lower range value

* Upper range value

* AO cutoff

* AO added damp

*LSL

+ USL

* Min Span

+ AO fault action

» AO fault level

* Last measured value timeout

Frequency/Discrete output
Frequency

* Tertiary variable

* Scaling method

* Freq factor

* Rate factor

* Pulses per unit

* Units per pulse

* Freq pulse width

* Last measured value timeout
* Freq fault action

* Freq output polarity
Discrete output

* DO assignment

* DO polarity

* DO fault action

Temperature

» Temp Units

» Temp Cal Factor

» Temp Damping
 External Temperature

Pressure

* Flow Factor

* Dens Factor

« Cal Pressure

* Pressure Units

» External Pressure
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Abbildung B-11: Konfigurationsmenii (Fortsetzung)

ProLink >
Configuration

—————————————— - —Additional configuration options-»

Device

* Tag

* Date

* Descriptor

* Message

» Sensor type

* Floating pt ordering
* Add comm resp delay
* Transmitter serial number
Digital comm settings
* Fault setting

* HART address

* Loop current mode
* HART device ID

* Modbus address

» Enable write protect
Update rate

» Update rate

* 100 Hz variable
Burst setup

» Enable burst

* Burst cmd

* Burstvar 1..4

Discrete input

* Assignment
* Polarity
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Abbildung B-12: Konfigurationsmenii (Fortsetzung)

ProLink >
Configuration
———————————— - —Additional configuration options- %
RS-485 Events Discrete Events
* Protocol Event 1/2 » Event Name
* Parity * Variable » Event Type
* Baud Rate * Type * Process Variable
« Stop Bits * Setpoint * Low Setpoint (A)
* High Setpoint (B)
Alarm Polled Variables
* Alarm Polled Variable 1/2
* Severity + Polling Control

 External Tag
* Variable Type
* Current Value

Abbildung B-13: Konfigurationsmenii (Fortsetzung)

ProLink >
Configuration

—————————————— - —Additional configuration options-—»

Special Units

» Base mass unit

* Base mass time

» Mass flow conv fact
* Mass flow text

* Mass total text

* Base vol unit

» Base vol time

« Vol flow conv fact

* Vol flow text

* Vol total text

+ Gas unit configurator

Display

* mA1

*Var2...Var15

Display Precision

» Var

* Number of Decimals

* Display Language

* Display Start/Stop Totalizers
* Display Totalizer Reset

* Display Auto Scroll

* Display Offline Menu

* Display Offline Password

* Display Alarm Menu

+ Display Ack All Alarms

+ Display Backlight On/Off

* Display Alarm Screen Password
* Display Status LED Blinking
* Display Variable 1 Selection
+ Offline Password

+ Auto Scroll Rate

» Update Period
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Abbildung B-14: Konfigurationsmenii (Fortsetzung)

ProLink >
Configuration

—————————————— - ——Additional configuration options-—+»

CM Setup Variable mapping
* Active Curve *PVis
* Derived Variable *SVis
* Reset All Curve Info *TVis
» Show Advanced User Options *QVis

* Lock/Unlock CM Curves
* Curve Configured

* Curve Name

» Water Ref Temp

» Water Ref Dens

* Trim Slope

* Trim Offset

* Alarm Limit

* Units

* Special Unit String

« Save this curve to a file
* Load this curve from a file
* Enable Density Low

* Enable Density High

* Ehable Temp. Low

* Enable Temp. High
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Abbildung B-15: Konfigurationsmenii (Fortsetzung)

ProLink >
Configuration

—————————————— »— — - Additional configuration options- —»

API Setup

* Generalized Crude or JP4

» Generalized Products

* User Defined TEC

» Generalized Lubricants

* Degrees API, Reference
Temperature is 60° F

* Kg/ms @ Reference Temp

Sensor

» Sensor s/n

» Sensor Model
» Sensor Matl

* Liner Matl

* Flange

System

» Weights and Measures
Approval

* Software Rev

» Totalizer Reset Options
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Abbildung B-16: Konfigurationsmenii (Fortsetzung)

ProLink >
Configuration

Sensor Simulation

* Enable/disable
Mass flow

» Wave form

* Fixed value

* Period

* Minimum

* Maximum
Density

* Wave form

* Fixed value

* Period

* Minimum

* Maximum
Temperature

» Wave form

* Fixed value

* Period

* Minimum

* Maximum

Channel

* Channel A

* Channel B
* Type Assignment
* Power Type

* Channel C
* Type Assignment
* Power Type
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Anhang C

VerwendungProLink Il mit der
Auswerteelektronik

In diesem Anhang behandelte Themen:

e Grundlegende Informationen (iber das ProLink Il
*  Verbinden mit ProLink Il
e Mendstruktur fiir ProLink Il

C.1 Grundlegende Informationen iiber das
ProLink III

ProLink Il ist eine Konfigurations- und Service-Software von Micro Motion. Sie lduft auf
Windows und ermdglicht den Zugriff auf alle Daten und Funktionen der
Auswerteelektronik.

ProLink Ill Anforderungen

Zur Installation von ProLink Il brauchen Sie:
. Das ProLink Ill Installationsmedium

. Das ProLink Il Installationskit fiir Ihre Anschlussart
ProLink lll sowie das passende Installationskit erhalten Sie von Micro Motion.
ProLink Il Dokumentation

Die meisten Anweisungen in dieser Betriebsanleitung setzen voraus, dass Sie bereits mit
ProLink lll vertraut sind oder sich mit Windows-Programmen auskennen Falls Sie weitere
Informationen benoétigen, die Sie nicht in dieser Betriebsanleitung finden, schlagen Sie im
ProLink Il Handbuch (ProLink® Il Konfigurations- und Service-Software fiir Micro Motion®
Auswerteelektroniken: Betriebsanleitungl) nach.

Fiir die meisten ProLink IIl Installationen wird die Betriebsanleitung zusammen mit dem
ProLink Il Programm installiert. Dariiber hinaus finden die Betriebsanleitung fiir ProLink I
auf der Micro Motion Dokumentations-CD oder der Micro Motion Website
(www.micromotion.com).

ProLink lll Merkmale und Funktionen

ProLink Il bietet alle Funktionen zur Konfiguration und zum Betrieb der
Auswerteelektronik. ProLink Ill bietet auRerdem eine Reihe zusatzlicher Merkmale und
Funktionen, einschlieRlich:

. Der Moglichkeit, die Auswerteelektronik-Konfigurationsdaten in einer Datei auf dem
PC zu speichern und sie auf andere Auswerteelektroniken zu laden oder zu kopieren

. Die Maglichkeit, spezifische Datentypen in einer Datei auf dem PC zu protokollieren

. Die Maglichkeit, Leistungstrends fiir verschiedene Datentypen auf dem PC
anzuzeigen
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. Die Mdglichkeit, die Verbindung zu mehr als einem Gerat herzustellen und deren
Informationen anzuzeigen

. Ein gefiihrter Verbindungsassistent

Diese Funktionen werden in der ProLink Il Betriebsanleitung beschrieben. Sie werden nicht
in der aktuellen Betriebsanleitung beschrieben.

ProLink Ill Meldungen

Wenn Sie ProLink Ill mit einer Micro Motion Auswerteelektronik verwenden, sehen Sie eine
Reihe von Meldungen und Hinweisen. Diese Betriebsanleitung beschreibt nicht alle dieser
Meldungen und Hinweise.

Wichtig
Der Benutzer ist fiir die Reaktion auf Meldungen und Hinweise und die Befolgung aller
Sicherheitshinweise verantwortlich.

C.2 Verbinden mit ProLink llI

Eine Verbindung von ProLink Ill zur Auswerteelektronik ermdglicht das Lesen von
Prozessdaten, die Konfiguration der Auswerteelektronik und das Durchfiihren von
MaRnahmen fiir die Wartung und fir die Stérungsanalyse/-beseitigung.

C.2.1 ProLink Ill Verbindungsarten

Es stehen unterschiedliche Verbindungsarten fiir die Verbindung von ProLink Il zur
Auswerteelektronik zur Verfligung. Die Verbindungsart auswahlen, die fiir das
vorgesehene Netzwerk und die jeweiligen Aufgaben geeignet ist.

Die Auswerteelektronik unterstiitzt die folgenden ProLink Il Verbindungsarten:

. Serviceport Verbindungen
o HART/Bell 202 Verbindungen

Bei der Auswahl einer Verbindungsart die folgenden Faktoren beachten:

. Serviceport Verbindungen verwenden Standard-Verbindungsparameter, die bereits
in ProLink Il definiert sind, und die deshalb nicht konfiguriert werden miissen.

o HART/Bell 202 Verbindungen verwenden Standard HART Verbindungsparameter,
die bereits in ProLink llidefiniert sind. Der einzige Parameter, der noch konfiguriert
werden muss, ist die Adresse der Auswerteelektronik.

. Fiir einige Verbindungsarten miissen der Anschlussraum oder das Gehduse der
Spannungsversorgung gedffnet werden. Diese Anschliisse sollten nur vorldufig und
mit entsprechenden Sicherheitsvorkehrungen erfolgen.

. Modbus Verbindungen, einschlieBlich Serviceport Verbindungen, sind gewéhnlich
schneller als HART Verbindungen.

o Bei Verwendung einer HART Verbindung kénnen beim ProLink Il nicht mehr als ein
Fenster gleichzeitig ge6ffnet werden. Dies dient dazu, den Netzwerkverkehr zu
verwalten und die Geschwindigkeit zu optimieren.
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C.2.2

Es kdnnen nicht gleichzeitig mehrere Verbindungen an denselben
Anschlussklemmen hergestellt werden. Gleichzeitige Verbindungen kénnen dann
hergestellt werden, wenn die Verbindungen unterschiedliche Anschlussklemmen
verwenden.

Herstellen einer Service Port Verbindung

A\ VORSICHT!

Wenn sich die Auswerteelektronik in einem Ex-Bereich befindet, keine Service Port
Verbindung verwenden. Service Port Verbindungen erfordern das Offnen des
Anschlussgehiuses. Das Offnen des Anschlussgehiuses bei eingeschalteter
Auswerteelektronik kann zu einer Explosion fithren. Um eine Verbindung mit einer im Ex-
Bereich installierten Auswerteelektronik herzustellen, eine Verbindungsmethode verwenden,
bei der das Entfernen des Gehdusedeckels nicht erforderlich ist.

Vorbereitungsverfahren

ProLink Il Installiert und lizenziert auf lhrem PC
Eine der folgenden Versionen:

- RS-485 zu RS-232 Signalkonverter

- USB an RS-485 Signalkonverter

Ein verfligbarer serieller Port oder USB Port
Adapter wie erforderlich (z. B. 9-adrig bis 25-adrig)

Verfahren
1. Signalkonverter an den seriellen Port oder USB Port des PCs anschlieRen.
2. Zugriff auf Service Port Anschlussklemmen:
a. Die Endkappe der Auswerteelektronik entfernen, um Zugriff auf das
Anschlussgehduse zu erhalten.
b. Die Schraube an der Warnklappe I6sen und das Gehause der
Spannungsversorgung 6ffnen.
3. Die Adern des Signalkonverters an den Service Port, Anschlussklemmen 7

(RS-485/A) und 8 (RS-485/B), anschlieRen.

Hinweis
Normalerweise, jedoch nicht immer, ist die schwarze Ader der Anschluss fiir RS-485/A und die
rote Ader fiir RS-485/B.
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Abbildung C-1: Anschluss an Service Port

PC

Signalkonverter

Service Port Anschlussklemme 7 (RS-485/A)

Service Port Anschlussklemme 8 (RS-485/B)

Auswerteelektronik mit Anschlussgehduse und Gehduse der Spannungsversorgung geéffnet

moN®>

Anmerkung
Diese Abbildung zeigt einen seriellen Port Anschluss. USB Anschliisse werden ebenfalls unterstiitzt.

4, Starten Sie ProLink IlI.
Connect to Physical Device auswahlen.

6. Protocol (Protokoll) auf Service Port einstellen.

Hinweis

Service Port-Anschliisse verwenden Standard-Anschlussparameter und eine Standardadresse.
Diese miissen hier nicht konfiguriert werden.

7. Den Wert des PC Port auf den Wert des PC COM-Ports einstellen, der fiir diese
Verbindung verwendet wird.

8. Klicken Sie auf Connect.

Benotigen Sie Hilfe? Wenn eine Fehlermeldung erscheint:
e Die Adern vertauschen und erneut versuchen.
e Sicherstellen, dass der korrekte COM-Port angegeben wurde.

 Die physische Verbindung zwischen PC und Auswerteelektronik priifen.

C.2.3 Herstellen einer HART/Bell 202 Verbindung

Der Anschluss kann direkt an die primaren mA Anschlussklemmen an der
Auswerteelektronik, an jeden beliebigen Punkt in einem HART Messkreis oder an einen
beliebigen Punkt in einem HART Multidrop-Netzwerk erfolgen.
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A\ VORSICHT!

Wenn sich die Auswerteelektronik in einem Ex-Bereich befindet, keine direkte Verbindung mit
den Anschlussklemmen der Auswerteelektronik herstellen. Eine direkte Verbindung an die
Anschlussklemmen der Auswerteelektronik und das Offnen des Gehiusedeckels der
Auswerteelektronik bei eingeschaltetem Gerit kann zu einer Explosion fithren. Um eine
Verbindung mit einer im Ex-Bereich installierten Auswerteelektronik herzustellen, eine
Verbindungsmethode verwenden, bei der das Offnen des Anschlussgehéuses nicht erforderlich
ist.

A\ VORSICHT!

Bei einem direkten Anschluss an die mA Anschlussklemmen kann sich dies auf den mA Ausgang
der Auswerteelektronik auswirken. Wenn der mA Ausgang fiir die Durchflussiiberwachung
verwendet wird, miissen die Gerdte auf manuelle Steuerung eingestellt werden, bevor eine
direkte Verbindung mit den mA Anschlussklemmen méglich ist.

Vorbereitungsverfahren

. ProLink Il Installiert und lizenziert auf lhrem PC
. Eine der folgenden Versionen:
- RS-232 an Bell 202 Signalkonverter
- USB an Bell 202 Signalkonverter
. Ein verfiigbarer serieller Port oder USB Port
o Adapter wie erforderlich (z. B. 9-adrig bis 25-adrig)

Verfahren
1. Signalkonverter an den seriellen Port oder USB Port des PCs anschlie3en.
2. Direkter Anschluss an die Anschlussklemmen der Auswerteelektronik:

a. Die Endkappe der Auswerteelektronik entfernen, um Zugriff auf das
Anschlussgehduse zu erhalten.

b. Die Adern des Signalkonverters an die Anschlussklemmen 1 und 2 anschlieen.

Hinweis
HART Verbindungen sind nicht polaritdtsempfindlich. Es spielt dabei keine Rolle, welche
Ader dabei an welche Anschlussklemme angeschlossen wird.

c. Widerstdnde nach Bedarf hinzufligen.

Wichtig
HART/Bell 202 Verbindungen erfordern einen Spannungsabfall von 1 VDC. Um dies zu
erreichen, einen Widerstand von 250-600 Q2 zu der Verbindung hinzufiigen.
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Abbildung C-2: Anschluss an Anschlussklemmen der Auswerteelektronik

PC
Signalkonverter
Widerstand 250-600 2

Auswerteelektronik mit Anschlussgehduse und Gehduse der Spannungsversorgung geéffnet
Externe Spannungsversorgung

mo N ®>

Anmerkung
Diese Abbildung zeigt einen seriellen Port Anschluss. USB Anschliisse werden ebenfalls unterstiitzt.

Der Signalkonverter muss tiber einen Widerstand von 250-600 Q angeschlossen
werden. Der mA Ausgang erfordert eine externe Spannungsquelle mit
mindestens250 Q und 17,5V (siehe folgende Abbildung). Um den Anforderungen
fiir Widerstdande gerecht zu werden, kann jede beliebige Kombination von
Widerstdnden R1, R2 und R3 verwendet werden.
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Abbildung C-3: Anforderungen an die Spannungsversorgung und
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3. Anschluss von einem Punkt im lokalen HART Messkreis:

a. Die Adern des Signalkonverters an einen beliebigen Punkt im Messkreis
anschlieRen.

b. Widerstande nach Bedarf hinzufiigen.

Wichtig
HART/Bell 202 Verbindungen erfordern einen Spannungsabfall von 1 VDC. Um dies zu
erreichen, einen Widerstand von 250-600 Q zu der Verbindung hinzufiigen.
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Abbildung C-4: Anschluss iiber lokalen Messkreis

R3

‘Rj ¥

R1

A. PC
Signalkonverter

C. Jede beliebige Kombination von Widerstédnden R1, R2 und R3, die erforderlich ist, um den Anforderungen fiir HART
Kommunikationswiderstdnde zu entsprechen.

D. Prozessleitsystem oder SPS
Auswerteelektronik mit Anschlussgehduse und Gehéduse der Spannungsversorgung geéffnet
F.  Externe Spannungsversorgung

o

m

Anmerkung
Diese Abbildung zeigt einen seriellen Port Anschluss. USB Anschliisse werden ebenfalls unterstiitzt.

Der Signalkonverter muss (iber einen Widerstand von 250-600 Q angeschlossen
werden. Der mA Ausgang erfordert eine externe Spannungsquelle mit
mindestens250 Q und 17,5V (siehe folgende Abbildung). Um den Anforderungen
fiir Widerstdnde gerecht zu werden, kann jede beliebige Kombination von
Widerstanden R1, R2 und R3 verwendet werden.
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Abbildung C-5: Anforderungen an die Spannungsversorgung und
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4. Anschluss iber ein HART Multidrop-Netzwerk:

a. Die Adern des Signalkonverters an einen beliebigen Punkt im Netzwerk
anschlieRen.

b. Widerstande nach Bedarf hinzufiigen.

Wichtig
HART/Bell 202 Verbindungen erfordern einen Spannungsabfall von 1 VDC. Um dies zu
erreichen, einen Widerstand von 250-600 Q2 zu der Verbindung hinzufiigen.
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Abbildung C-6: Anschluss iiber Multidrop-Netzwerk

c
A. Signalkonverter
B. Widerstand 250-600 £2
C. Gerdte im Netzwerk
D. Master Gerdt
Starten Sie ProLink Ill.

Connect to Physical Device auswahlen.
Protocol auf HART Bell 202 setzen.

Hinweis
HART/Bell 202 Anschliisse verwenden Standard-Anschlussparameter. Diese miissen hier nicht
konfiguriert werden.

Wenn ein USB Signalkonverter verwendet wird, Toggle RTSaktivieren.

Address/Tag auf die in der Auswerteelektronik konfigurierten HART Abfrageadresse
einstellen.

Hinweise

* Beiderersten Verbindungsherstellung mit der Auswerteelektronik die Standardadresse 0
verwenden.

e Wenn keine HART Multidrop Umgebung verwendet wird, wird gewohnlich der
Standardwert fiir die HART Abfrageadresse verwendet.

¢ Auf Poll klicken, sofern die Adresse der Auswerteelektronik nicht bekannt ist. Das
Programm durchsucht das Netzwerk und zeigt eine Liste mit erkannten
Auswerteelektroniken an.

10. Den Wert des PC Port auf den Wert des PC COM-Ports einstellen, der fiir diese
Verbindung verwendet wird.

11.  Master entsprechend einstellen.

Option | Beschreibung

Sekundar | Diese Einstellung verwenden, wenn ein anderer HART Host, wie ein Prozessleit-
system, im Netzwerk vorhanden ist.
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Option ‘ Beschreibung

Primdr | Diese Einstellung verwenden, wenn kein anderer Host im Netzwerk vorhanden

ist. Handterminal ist kein Host.

12. Klicken Sie auf Connect.

Benoétigen Sie Hilfe? Wenn eine Fehlermeldung erscheint:

e Die HART Adresse der Auswerteelektronik tiberpriifen.
 Sicherstellen, dass der korrekte COM-Port angegeben wurde.

e Die physische Verbindung zwischen PC und Auswerteelektronik priifen.
 Sicherstellen, dass der mA Ausgang mit Spannung versorgt wird.

e Erhohen oder Verringern der Widerstande.

 Sicherstellen, dass es keinen Konflikt mit einem anderen HART Master gibt.

C3 Meniistruktur fiir ProLink lll

Abbildung C-7: Gerdte-Tools: Hauptmenii

Alerts

Calibration Data
Wizards 2
Configuration b
Calibration 2

Configuration Transfer p

Diagnostics b
Trending 2
Diata Logging...

Print...

Totalizer Control b

Device Information

Disconmect
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Abbildung C-8: Gerdte-Tools: Konfiguration (mit eichamtl. Transfer)

Alerts
Calibration Data
Wizards 3
Configuration ¥ | Writ=-Protection
Configuration Transfer ¥ | Process Measurement ¥
Diagnostics ] 1jo b
Treafrr ’ Transmitter Display 3
Data Logging... Alert Severity
Fault Processing

Prink... Events b
Tatalizer Control p | Totalizer Control Methods

i i Communications 4
Device Information Weights & Measures
Disconnect Informational Parameters »

Abbildung C-9: Konfiguration: Prozessmessung (mit Konzentrationsmessung)

Alerts
Calibration Data
Wizards 3
Configuration k| Write-Protection
Configuration Transfer b | Process Measurement b | Sensor Polling Rate
Diagnostics L 1o DI} i
Tty Transmitter Display ¥ | Density
St LT Alert Severity Temperaturs
Fault Processing Pressure Compensation

Print... Everts b | Concentration Measurement
Totalizer Control p | Totalizer Control Methods

_ i Communications »
LEss e Informational Parameters »

Disconnect
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Abbildung C-10: Konfiguration: Prozessmessung (mit Konzentrationsmessung)

Blerts
Calibration Data
Wizards 3
Configuration ¥ | Write-Protection
Configuration Transfer ¥ | Frocess Measurement b | Senszor Polling Rate
Diagnostics ] 1jo L R
Trerafre ’ Transmitter Display ¥ | Density
Tt et Alert Severity Temperature
Fault Processing Pressure Compensation

Print... Events b | Petroleum Measurement
Totalizer Control p | Totalizer Control Methods

i i Communications 4
Liztizs it sits | Informational Parameters ¢

Disconnect

Abbildung C-11: Konfiguration: E[A

Alerts
Calibration Data
Wizards [
Configuration k[ Writ=-Protection
Calibration b | Procsss Measurement b
Configuration Transfer » | 1jo b | Outputs ]
Diagnostics N Transmitter Display P | Action Assignment
TTeraiT , Alert Seuerlt',.r.
e LT Fault Processing
Events k
Print... Totalizer Contral Methods
Totalizer Control b | Communications ’
Informational Parameters »
Device Information
Disconnect
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Abbildung C-12: Konfiguration: Auswerteelek Bedieninterface

Alerts

Calibration Data

Wizards b

Configuration P [ Writ=-Protection

Calibration ¥ [ Procsss Measurement b

Configuration Transfer » | 1jo b

T , T:ansmitter Display b | General

Tooriis > Alert Seuerlt',.r. Display Variables

fele Lol Fault Processing Display Security
Events k[ Ak all

Print... Taotalizer Contral Methods

Totalizer Control v | Communications 4
Informational Parameters »

Device Information

Disconmect

Abbildung C-13: Konfiguration: Ereignisse

Blerts
Calibration Data
Wizards 3
Configuration b | Write-Protection
Calibration ¥ | Process Measurement b
Configuration Transfer » | [jO b
R ’ Transmitter Display [
TTerarTe ’ Alert SE."I.-'EFI[",.I'.
S LT Fault Processing
_ Events P | Basic Events
Print... Tatalizer Control Methods Enhanced Events
Totalizer Control v | Communications ’
Informational Parameters »
Device Information
Disconnect
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Abbildung C-14: Konfiguration: Kommunikation

Alerts
Calibration Data
Wizards »
Configuration P [ Write-Protection
Configuration Transfer ¥ | Process Measurement 4
Diagnostics b 44 ) ) '
Trending R Trans;ﬁ;:tertflsplay 3
_ Alert Severi
Data Logging...
Fault Processing
Print... Events ]
Totalizer Control , Totalizer Control Methods
Communications ¥ | Fault Action
Device Information Informational Parameters » | Communications (HART)
Disoonnect Communications (Modbus)

Abbildung C-15: Konfiguration: Informationsparameter

Alerts
Calibration Data
‘Wizards 2
Configuration P [ Wiite-Protection
Calibration ¥ | Process Measursment 3
Configuration Transfer b | 1j0 ]
e > Transmitter Display 3
Trerofrs b Alert Seuerlt',.r.
T rme o Fault Processing
Ewvents ]
Print... Totalizer Control Methods
Totalizer Control b | Communications b
Informational Parametsrs » | Sensor
Device Information i
Transmitter
Disconnect
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Abbildung C-16: Gerdte-Tools: Kalibrierung

Alerts

Calibration Data

Wizards 3

Configuration 3

Calibration ¥ | Zero Verification and Calibration
Configuration Transfer » |  Density Calibration k
erreie y | Temperature Ch.lihraticun 2
Trending b me Cubput 1 Trim

Data Logging...

Print...

Totalizer Control 3

Device Infarmation

Disconnect

Abbildung C-17: Kalibrierung: Dichtekalibrierung

Blerts

Calibration Data

Wizards 3

Configuration b

Calibration ¥ | Zero Verification and Calibration

Configuration Transfer » | Density Calibration ¥ | Density Calibration - Point 1 {Air)
R y | Temperature Calibration b | Density Calibration - Point 2 {Water)
TerafTe , m Output 1 Trim Density Calibration - Flowing Density
Data Logaing...

Print...

Tatalizer Contral 2

Device Information

Disconmect
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Abbildung C-18: Kalibrierung: Temperaturkalibrierung

Alerts

Calibration Data

Wizards 3

Configuration 3

Calibration ¥ | Zero Verification and Calibration

Configuration Transfer » | Density Calibration k

e y | Temperature 'Célibmtiﬂn b | Temperature Calibration - Cffset
Trerafre N met Output 1 Trim Temperature Calibration - Slope
Data Logging...

Print...

Totalizer Control 3

Device Infarmation

Disconnect

Abbildung C-19: Gerite-Tools: Ubertragung der Konfiguration

Blerts

Calibration Data
Wizards 3
Configuration 3
Calibration 3

Configuration Transfer » | Save or Load Configuration Data
Impaort Data from ProLink I

Diagnostics F ]
et ’ Import Data from ProLink I_I
St LT Restore Factory Configuration
Print...

Taotalizer Control b

Device Information

Disconnect
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Abbildung C-20: Diagnose: Test

Alerts

Calibration Data
Wizards b
Configuration 2
Calibration [

Configuration Transfer p

Diagnostics b | Testing b | mA Output 1 Test
Trending ¥ | Core Processor Diagnostics Discrete Output Test
Data Logging...

Print...

Taotalizer Control »

Device Information

Disconmect

Abbildung C-21: Diagnose: Systemverifizierung

Alerts

Calibration Data

Wizards 3

Configuration 3

Configuration Transfer ¢

Diagnostics ¥ [ Testing 3

Trending ¥ | Core Processor Diagnostics

Data Logging... Meter Verification P [ Run Test...

Print... Schedule Meter Verification
Totalizer Control 3

Device Information

Disconnect
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Abbildung C-22: Gerdte-Tools: Trenderstellung

Blerts

Calibration Data
Wizards 3
Configuration 3
Calibration 3

Configuration Transfer

Diagnostics F

Trending b | Create Trend Chart... I
Data Logging...

Prink...

Totalizer Control 3

Device Information

Disconnect
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Anhang D

Verwendung derHandterminal mit der
Auswerteelektronik

D.1

298

In diesem Anhang behandelte Themen:

*  Grundlegende Informationen (iber das Handterminal
. Verbinden mit Handterminal
e Mendstruktur fiir das Handterminal

Grundlegende Informationen iiber das
Handterminal

Das Handterminal ist ein Handterminal zur Konfiguration sowie zum Daten- und
Funktionshandling, das mit verschiedenen Geraten, einschlieBlich Micro Motion
Auswerteelektroniken, verwendet werden kann. Es ermdglicht den Zugriff auf alle Daten
und Funktionen der Auswerteelektronik.

Handterminal Dokumentation

Die meisten Anweisungen in dieser Betriebsanleitung setzen voraus, dass Sie bereits mit
dem Handterminal Handterminal vertraut sind und daher die nachfolgenden Schritte
durchfiihren kénnen:

. Einschalten des Handterminal

. Navigieren durch die Men(s des Handterminal Handterminals

. Aufnahme der Kommunikation mit HART-kompatiblen Geraten

. Senden von Konfigurationsdaten an das Gerat

. Benutzen der alphanumerischen Tastatur zur Eingabe von Informationen

Wenn Sie nicht in der Lage sind die oben aufgefiihrten Punkte auszufiihren, nehmen Sie
die Betriebsanleitung des Handterminal zur Hand, bevor Sie mit dem Handterminal
arbeiten. Sie finden die Betriebsanleitung fiir Handterminal auf der Micro Motion
Dokumentations-CD oder der Micro Motion Website (www.micromotion.com).

Gerdtebeschreibungen (DDs)

Damit das Handterminal mit Ihrem Gerat arbeiten kann, missen die entsprechenden
Gerdtebeschreibungen (Device-Deskriptoren, DD) installiert sein. Die Modell 2700
Auswerteelektronik erfordert die folgenden HART-Gerdtebeschreibungen: 2000IMass flo,
Dev v6, DD v4.

Auf dem Handterminal Handterminal installierte Geratebeschreibungen anzeigen:

1. Im HART-Anwendungsmenii klicken Sie auf Utility > Available Device Descriptions.

2. Wdhlen Sie Micro Motion aus der Liste der Hersteller und gehen Sie anschlieRend zur
Liste der installierten Gerdtebeschreibungen.
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Wenn Micro Motion nicht aufgefiihrt ist oder Sie die erforderliche Gerdtebeschreibung nicht
sehen, verwenden Sie das Handterminal Easy Upgrade Programm, um die
Gerdteschreibung zu installieren, oder wenden Sie sich an Micro Motion.

Handterminal Menii und Meldungen

Viele der Men(is in dieser Betriebsanleitung beginnen mit dem Online-Menii. Stellen Sie
sicher, dass Sie durch das Online-Men(i navigieren kdnnen.

Wenn Sie Handterminal mit einer Micro Motion Auswerteelektronik verwenden, sehen Sie
eine Reihe von Meldungen und Hinweisen. Diese Betriebsanleitung beschreibt nicht alle
dieser Meldungen und Hinweise.

Wichtig
Der Benutzer ist fiir die Reaktion auf Meldungen und Hinweise und die Befolgung aller
Sicherheitshinweise verantwortlich.

D.2 Verbinden mit Handterminal

Eine Verbindung von Handterminal zur Auswerteelektronik ermdglicht das Lesen von
Prozessdaten, die Konfiguration der Auswerteelektronik und das Durchfiihren von
MaRnahmen fiir die Wartung und fiir die Stérungsanalyse/-beseitigung.

Handterminal kann an die primdren mA Anschlussklemmen an der Auswerteelektronik, an
jeden beliebigen Punkt in einem lokalen HART Messkreis oder an einen beliebigen Punkt in
einem HART Multidrop-Netzwerk angeschlossen werden.

/A VORSICHT!

Wenn die Auswerteelektronik in einer explosionsgefahrdeten Umgebung installiert ist,
Handterminal nicht an die mA Anschlussklemmen der Auswerteelektronik anschlieen. Diese
Verbindung erfordert das Offnen des Anschlussklemmenraums. Das Offnen des
Anschlussklemmenraums in einer explosionsgefdhrdeten Umgebung kann zu einer Explosion
fahren.

Vorbereitungsverfahren

Die folgende HART Gerdtebeschreibung (DD) muss auf dem Handterminal installiert sein:
2000IMass flo, Dev v6, DD v4.

Verfahren
1. Anschluss an die Anschlussklemmen der Auswerteelektronik:

a. Den Deckel des Anschlussklemmengehduses entfernen.
b. Die Adern von Handterminal an die Anschlussklemmen 1 und 2 an der
Auswerteelektronik anschlieBen und nach Bedarf Widerstdnde hinzufligen.

Handterminal muss (iber einen Widerstand von 250-600 Q2 angeschlossen
werden.

Hinweis
HART connections are not polarity-sensitive. It does not matter which lead you attach to
which terminal.
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Abbildung D-1: Handterminal Anschluss an die Anschlussklemmen der
Auswerteelektronik

Handterminal
Widerstand 250-600 2
Externe Spannungsversorgung

Auswerteelektronik mit Anschlussgehduse und Gehéduse der Spannungsversorgung
gedffnet

oONw >

2. Um eine Verbindung mit einem Punkt im lokalen HART Messkreis herzustellen, die
Adern von Handterminal an jeden beliebigen Punkt im Messkreis anschlieBen und
nach Bedarf Widerstdnde hinzufligen.

Handterminal muss (iber einen Widerstand von 250-600 Q angeschlossen werden.

Abbildung D-2: Handterminal Anschluss an lokalen HART Messkreis

Handterminal

Widerstand 250-600 2

Externe Spannungsversorgung

Auswerteelektronik mit Anschlussgehduse und Gehduse der Spannungsversorgung geéffnet

oON = >

3. Um eine Verbindung zu einem Punkt im HART Multidrop-Netzwerk herzustellen, die
Adern von Handterminal an jeden beliebigen Punkt im Netzwerk anschlieRen.
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Abbildung D-3: Handterminal Anschluss an ein Multidrop-Netzwerk

D
C

A. Handterminal

B. Widerstand 250-600 2

C. Gerdte im Netzwerk

D. Master Gerdt
4, Handterminal einschalten und warten, bis das Hauptmenii angezeigt wird.
5.  Beieiner Verbindung tiber ein Multidrop-Netzwerk:

a. Handterminal auf Abfrage einstellen.

Das Gerdt gibt alle giiltigen Adressen aus.
b. Die HART Adresse der Auswerteelektronik eingeben.
Die voreingestellte HART Adresse ist 0. In einem Multidrop-Netzwerk ist die

HART Adresse wahrscheinlich jedoch auf einen anderen eindeutigen Wert
eingestellt.

Nachbereitungsverfahren

HART Application > Online auswdhlen, um zum Menii Online zu navigieren. Die meisten
Konfigurations-, Wartungs- und FehlerbehebungsmaRnahmen werden {iber das Menii
Online ausgefiihrt.

Hinweis
Es werden moglicherweise Meldungen beziiglich DD oder aktiven Alarmen angezeigt. Durch
Betdtigen der entsprechenden Tasten die Meldung ignorieren und fortfahren.
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D.3 Meniistruktur fiir das Handterminal

Abbildung D-4: Online-Menii

On-Line Menu

Overview

1 Check Status

2 Primary Purpose Variables
3 Shortcuts

Configure
2 1 Manual Setup
2 Alert Setup

Service Tools

1 Alerts
Variables
Trends
Maintenance
Simulate

w

AL wON

302 Micro Motion® Auswerteelektronik Modell 2700 mit eigensicheren Ausgédngen



Verwendung derHandterminal mit der Auswerteelektronik

Abbildung D-5: Ubersichtsmenii

On-Line Menu >

1 Overview
Shortcuts
Device Information
Check Status Totalizer Control
1 Refresh Alerts —3— Zero Calibration
—1 2 Dev Status: Variables
Trends

3 Comm Status:

Meter Verification *

Device Information

1o wN -
T

1 Identification
Primary Purpose Variables 2 Revisions
L, Mass Flow Rate 3 Mat. of Construction
Volume Flow Rate 4 Licenses
Density 5 Weights and Measures **

Identification

Tag

Model

Xmtr Serial Num
Sensor Serial Num
Date

Descriptor
Message

Displayed only if meter
verification is enabled.

** Displayed only if the Weights
& Measures application is
enabled. Menu numbers are
adjusted as required.

NO A WN =

Revisions

Universal

Field Device

DD Revision
Transmitter Software
CP Software

ETO Number

|—2—

OB WN =

Mat. of Construction
1 Tube Wetted Mat.
3|2 Tube Lining

3 Sensor Flange

Weights and Measures
'—4—1 1 Cstdy Trnsfr Approval
2 W&M Software Version
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Abbildung D-6: Konfigurationsmenii: Hochste Ebene

On-Line Menu >
1 Configure

Manual Setup
Characterize
Measurements
Display
Inputs/Outputs
Info Parameters

abrLowownN -

Alert Setup

1 1/O Fault Actions
2 2 Alert Severity

3 Discrete Events
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Abbildung D-7: Konfigurationsmenii: Manuelle Einstellungen: Menii

On-Line Menu >
2 Configure >
1 Manual Setup

Characterize Inputs/Outputs
—1— 1 Sensor Type 1 Channels
2 Sensor Tag Parameters 2 mA Output 1
0 3 mA Output 2
o 4 Frequency Output
Measurements 5 Discrete Output
1 Flow 6 Communications
2 Density 7 Variable Mapping
3 Temperature
4 Update Rate Communications
—2— 5 LD Optimization 1 HART Address
6 Special Units
2 Tag
7 External Pressure/Temperature . -
. 3 Device Identification
8 Petroleum Measurement 5—
4 Dev ID (CP)
9 GSV
10 Conc Measure (CM) ** 5 Set Up Burst Mode
6 mA Output Mode
7 Set Up RS-485 Port
Display
1 Language Info Parameters
2 Display Variable Menu Features “—5— 1 Transmitter Info
—3— 3 Offline Variable Menu Features 2 Sensor Information
4 Backlight
g Blsplaylvl::‘alrlables Transmitter Info
ecimal Places 1 Tag
2 Xmtr Serial Num
—1— 3 Message
4 Descriptor

*  Displayed only if petroleum 5 Date
measurement is enabled on your 6 Write Protect
transmitter. Menu numbers are
adjusted as required.

** Displayed only if concentration .
measurement is enabled on your Sensor Information
transmitter. 1 Sensor Type

Lo | 2 Sensor Serial Num
3 Tube Wetted Mat.
4 Tube Lining
5 Sensor Flange
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Abbildung D-8: Konfigurationsmenii: Manuelle Einstellungen: Charakterisieren

On-Line Menu >
2 Configure >

1 Manual Setup >

1 Characterize

|
[
| |
l

Sensor Type 2
1 Curved Tube
2 Straight Tube
Curved Tube Sensor Type Straight Tube:
Sensor Tag Parameters Sensor Tag Parameters
1 FlowCal 1 Flow Parameters
2 D1 2 Density Parameters
3 D2
4 TC
5 K1 [ l
6 K2 1 2
7 FD ' |
Flow Parameters Density Parameters
1 Flow FCF D1
2 FTG D2
3 FFQ DT
DTG

©ONOORAWN =
N
N
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Abbildung D-9: Konfigurationsmenii: Manuelle Einstellungen: Messungen

On-Line Menu >
2 Configure >

1 Manual Setup >
2 Measurements

1

Flow

Flow Direction

Flow Damping

Mass Flow Unit
Mass Flow Cutoff
Volume Flow Unit *
Volume Flow Cutoff *
Mass Factor

Volume Factor

ONOOOBRWN -~

Additional
options

S S
2

Temperature

Temperature Unit
Temp Damping

4 1

2

Update Rate

Update Rate
100 Hz Variable

Density

Density Unit
Density Damping
Density Cutoff
Density Factor
Slug Duration
Slug Low Limit
Slug High Limit

~NoOo s WN =

L 6— 1
2

Special Units

Mass Special Units
Volume Special Units

Displayed only if Volume Flow Type = Liquid.

Menu numbers are adjusted as required.

** Displayed only if petroleum measurement is
enabled on your transmitter. Menu numbers
are adjusted as required.

Abbildung D-10: Konfigurationsmenii: Manuelle Einstellungen: Messungen

On-Line Menu >
2 Configure >

1 Manual Setup >
2 Measurements

1 Pressure
2 Temperature

External Pressure/Temperature

3 External Polling

Petroleum Measurement *
1 2540 CTL Table type

2 TEC

3 Ref Temperature

4 Petroleum Msmt Setup

Pressure

11—

U WN =

Pressure Unit

Pressure Compensation
Compensation Pressure
Flow Cal Pressure

Flow Press Factor

Dens Press Factor

GsV

Volume Flow Type
Gas Ref Density
GSV Cutoff

GSV Flow Unit
Gas Density Unit

abswnN =

L o_| 1

Temperature
Temperature Unit

2 External Temperature
3 Correction Temperature

10—

L3—|

AR WN =

External Polling
Poll Control

Ext Dev Tag 1
Polled Variable 1
Ext Dev Tag 2
Polled Variable 2

Conc Measure (CM) **

1 CM Configuration

2 Matrix Configuration

3 Enter Matrix

4 Trim CM Process
Variables

5 Reset Matrix Data

Displayed only if petroleum
measurement is enabled on your
transmitter. Menu numbers are
adjusted as required.

Displayed only if concentration
measurement is enabled on your
transmitter.
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Abbildung D-11: Konfigurationsmenii: Manuelle Einstellungen: Display

On-Line Menu >
2 Configure >
1 Manual Setup >

3 Display
Language Backlight
English 4 1 Control
11— German 2 Intensity (0-63)
French
Spanish
Display Variables
5| 1 Display Variables (1-5)
Display Variable Menu Features 2 g!sp:ay xar!ab:es (?;12))
1 Totalizer Reset 3 Display Variables (11-15)
2 Start/Stop Totals
—2—— 3 Auto Scroll
4 Scroll Time * Decimal Places
5 Refresh Rate 1 For Process Variables
6 Status LED Blinking —6— 2 For Totalizer Variables
3 For Diagnostic Variables
Offline Variable Menu Features
1 Offline Menu
2 Alert Menu
—3—1 3 Acknowledge Al * Displayed only if Auto Scroll is
4 Offline Passcode enabled. Menu numbers are
5 Alert Passcode adjusted as required.
6 Offline Passcode
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Abbildung D-12: Konfigurationsmenii: Manuelle Einstellungen: Eingdnge[Ausgdnge

On-Line Menu >
2 Configure >

1 Manual Setup >
4 Inputs/Outputs

——

Channels

1 Channel A
2 Channel B
3 Channel C

L Channel B
2— Frequency Output

Discrete Output

N

Frequency Output

1 FO Settings

2 FO Fault Parameters
3 FO Scaling

FO Settings

1 Third Variable

2 Max Pulse Width
3 FO Polarity

FO Fault Parameters
1 Third Variable

options

mA Output 1
1 Primary Variable

"] 2 mA Output Settings

3 mA Fault Settings

mA Output Settings
PV LRV

PV URV

PV Min Span

PV LSL

PV USL

PV MAO1 Cutoff
PV Added Damping

Lo

NOoO D WN =

MAO 1 Fault Settings
-3— 1 MAO1 Fault Action
2 MAO1 Fault Level

27 2 FO Fault Action

3 FO Fault Level

FO Scaling *

1 FO Scaling Method
—3— TV Frequency Factor

2
3 TV Rate Factor
4 Set FO Scaling

Options vary depending
on FO Scaling Method.

mA Output 2

1 Secondary Variable
2 mA Output Settings
3 mA Fault Settings

mA Output Settings
SV LRV

SV URV

SV Min Span

SV LSL

SV USL

SV MAQO2 Cutoff
SV Added Damping

Lo

NoO s WN =

MAO2 Fault Settings
L3— 1 MAO2 Fault Action
2 MAO2 Fault Level
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Abbildung D-13: Konfigurationsmenii: Manuelle Einstellungen: Eingdnge/Ausgdnge (Fortsetzung)

On-Line Menu >
2 Configure >
1 Manual Setup >
4 Inputs/Outputs

Discrete Output Variable Mapping

DO Assignment 1 Primary Variable
DO Polarity L_6—| 2 Secondary Variable
DO Fault Action 3 Third Variable
4

1
2
3
4 Flow Switch Source Fourth Variable
5
6

I

Flow Switch Setpoint
Hysteresis (0.1-10.0)

Communications
HART Address

Tag

Device Identification
Dev ID (CP)

Set Up Burst Mode
mA Output Mode

(¢,
DB WN -

Set Up Burst Mode
Burst Mode

Burst Option

Field Device Var 1
Field Device Var 2
Field Device Var 3
Field Device Var 4

OB WN =

Abbildung D-14: Konfigurationsmenii: Alarmeinrichtung

On-Line Menu >
2 Configure >
2 Alert Setup

Discrete Events

Discrete Event 1
Discrete Event 2
Discrete Event 3
Discrete Event 4
Discrete Event 5

Assign Discrete Action
Read Discrete Action
Review Discrete Actions

I/0 Fault Action
1 MAO1 Fault Action
2 MAO1 Fault Level —3—
3 MAO2 Fault Action

— 11 4 MAO2 Fault Level
5
6
7

FO Fault Action
FO Fault Level
Comm Fault Action

ONOO DA WN =

3 View Alert Severity

1,2,3,4,5 | Discrete Event x

1 Discrete Event Var

Alert Severity 2 Discrete Event Type
1 Fault Timeout 3 Setpoint A
27 2 SetAlert Severity 4 Setpoint B
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Verwendung derHandterminal mit der Auswerteelektronik

Abbildung D-15: Service Tools Menii: Hochste Ebene

On-Line Menu >
3 Service Tools

Alerts Maintenance
1 Refresh Alerts 1 Routine Maintenance
—1— Alert Name 2 Zero Calibration
Additional Information 4 3 Density Calibration
4 Temperature Calibration
5 Diagnostic Variables
6 Modbus Data
Variables
1 Variable Summary
2 Process Variables
3 Mapped Variables Simulate
—2— 4 Exter.nal Variables L5 1 Simulate Outputs
5 Totalizer Control 2 Simulate Sensor
6 Variables (PM) *
7 Variables (CM) **
8 Outputs . . )
*  Displayed only if petroleum measurement is
enabled on your transmitter. Menu numbers
are adjusted as required.
** Displayed only if concentration measurement
Trends is enabled on your transmitter. Menu numbers
L3 | 1 Process Variables are adjusted as required.
2 Diagnostic Variables

Abbildung D-16: Service Tools Menii: Variablen

On-Line Menu >
3 Service Tools >

2 Variables
___________ Addlt"lonal___________>
options
Variable Summary Totalizer Control
L4 Mass Flow Rate 1 All Totalizers
Volume Flow Rate 2 Mass
Density 3 Volume *
L5— 4 CM Volume at Reference Temperature ***
N 5 CM Net Mass ***
Process Variables 6 CM Net Volume ***
1 Mass Flow Rate . 7 Temp Corrected Volume (PM) **
2 Volun_ua Flow Rate 8 Custody Transfer ****
9 3 Density
4 Temperature
All Totalizers
1 Start Totalizers
Mapped Variables 1 2 Stop Totalizers
1 PV Mass Flow Rate "] 3 ResetAll Totals
3 2 8V Temp 4 Mass Total
3 TV Volume Flow Rate 5 Volume Total *
4 QV Volume Flow Rate
Mass
External Variables 1 Mass Flow Rate
4 1 External Temperature | o | 2 Mass Total
2 External Pressure 3 Mass Inventory
4 Reset Total
*  If Volume Flow Type = GSV, GSV variables
are displayed. Volume *
** Displayed only if petroleum measurement is 1 Volume Flow Rate
enabled on your transmitter. Menu numbers
are adjusted as required. 3— 2 Volume Total
*** Displayed only if concentration measurement 3 Volume Inventory
is enabled on your transmitter. Menu 4 Reset Total

numbers are adjusted as required.
**** Displayed only if the Weights & Measures
application is installed on your transmitter.
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Verwendung derHandterminal mit der Auswerteelektronik

Abbildung D-17: Service Tools Menii: Variablen

On-Line Menu >
3 Service Tools >

2 Variables
————————— >

Outputs

1 mA Output 1 (MAO1)
Variables (PM) * Lg| 2 mA Output 2 (MAO2)
1 Density at Reference Temperature 3 Frequency Output
2 Average Observed Density 4 DO State 1

=6— 3 Volume Flow at Reference 5 DO State 2
Temperature

4 Average Observed Temperature
5 CTL mA Output 1 (MAO1)

1 Present MAO1 Gauge
~171 2 PV MAO1

Variables (CM) ** 3 PV % Range

1 Standard Volume Flow Rate
2 Standard Net Volume Flow Rate
L7— 3 Net Mass Flow Rate mA Output 2 (MAO2)
4 Density at Reference o] ; g(fi;\mo'\;Aoz Gauge
5 Concentration o
6 Density (Fixed SG Units) 3 SV % Range

Frequency Output

-3— 1 Present Freq Gauge

*  Displayed only if petroleum measurement is 2 Present Freq Output
enabled on your transmitter. Menu numbers
are adjusted as required.

** Displayed only if concentration measurement
is enabled on your transmitter. Menu
numbers are adjusted as required.
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Verwendung derHandterminal mit der Auswerteelektronik

Abbildung D-18: Service Tools Menii: Wartung

On-Line Menu >
3 Service Tools >
4 Maintenance

Routine Maintenance Temperature Calibration
1 Trim mA Output 1 4— 1 Temperature
~1— 2 Trim mA Output 2 2 Temp Cal Factor
3 Meter Verification *
Diagnostic Variables
Meter Verification ** 1 Sensor Model
1 Run Meter Verification 2 Drive Gain
3— 2 View Test Results 3 LPO Amplitude
3 Schedule Meter —5— 4 RPO Amplitude
Verification 5 Tube Frequency
6 Live Zero
. 7 FId Verification Zero
Zero Calibration 8 Additional
1 Mass Flow Rate
2 Volume Flow Rate
| p_| 3 ZeroTime Additional
4 ZeroValue 1 Core Processor Input
5 Standard Deviation 8 Voltage
6 Perform Auto Zero 2 Board Temperature
7 Restore Factory Zero 3 Power On Time
Density Calibration Modbus Data
1 Mass Flow Rate “—6— 1 Read Modbus Data
2 Density 2 Write Modbus Data
3 Dens Pt1 (Air)
3 4 DensPr2 (Water)
5 Dens Pt3 T-Series
6 Dens Pt4 T-Series *  Displayed only if meter verification
7 _Flowing Dens (FD) - Si:;aal;lsgbnly if Smart Meter

Verification is enabled. For earlier
versions, the Meter Verification
Method is launched.

Abbildung D-19: Service Tools Menii: Simulation

On-Line Menu >
3 Service Tools >
5 Simulate

Simulate Outputs

1 mA Output 1 Loop Test
— 177 2 mA Output 2 Loop Test
3 Frequency Output Test

Simulate Sensor

Simulate Primary Purpose Variables
Mass Flow Rate

Density

Temperature

A ODN -~
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Voreingestellte Werte und Bereiche

Anhang E
Voreingestellte Werte und Bereiche

E.1 Voreingestellte Werte und Bereiche

Die Standardwerte und -bereiche reprasentieren die typische Auswerteelektronik-
Konfiguration. Je nach Bestellung der Auswerteelektronik sind bestimmte Werte vom
Hersteller konfiguriert und entsprechen nicht den Standardwerten und -bereichen.

Tabelle E-1: Voreingestellte Werte und Bereiche der Auswerteelektronik

Typ Parameter Standard Bereich Bemerkungen
Durchfluss FlieBrichtung Vorwadrts
Durchflussddmpfung 0,85 0,0-60,05s Vom Anwender eingegebener

Wert, korrigiert auf den néchst
niedrigeren vorkonfigurierten
Wertin der Liste. Im Modus Spe-
cial betragen die voreingestell-
ten Werte 1/5 des Normal-
wertes. Fiir Gasanwendungen
empfiehlt Micro Motion einen
Mindestwert von 2,56.

Durchflusskalibrierfaktor 1.00005.13 Bei Sensoren der T_Serie repra-
sentiert dieser Wert den ver-
knipften FCF- und FT-Faktor.

Massedurchfluss-Messeinheiten | g/s

Massedurchflussabschaltung 0,0q/s Empfohlene Einstellungist 5 %
des max. Durchflusses vom Sen-
Sor.

Volumendurchflussart FlGssigkeit

Volumendurchfluss-Messein- /s

heiten

Volumendurchflussabschaltung | 0/01/s 0,0 -xl/s x erhalten Sie durch die Multipli-

kation des Durchflusskalibrier-
faktors mit 0,2, bei Verwendung
der Einheit I/s.

Messgerate- Massefaktor 1
faktoren Dichtefaktor 1
Volumenfaktor 1
Dichte Dichteddampfung 1,65 0,0-60,0s Vom Anwender eingegebener

Wert, korrigiert auf den nachs-
ten vorkonfigurierten Wert in
der Liste.

(1) Im Modus Special betrdgt der Standardwert 0,64 s.
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Voreingestellte Werte und Bereiche

Tabelle E-1: Voreingestellte Werte und Bereiche der Auswerteelektronik (Fortsetzung)

en

Typ Parameter Standard Bereich Bemerkungen
Dichteeinheiten g/cm3
Dichteabschaltung 0,2 g/cm3 0,0-0,5
g/em?
D1 0 g/cm?3
D2 1g/cm3
K1 1000 ps 1000 - 50.000
us
K2 50.000 ps 1000 - 50.000
s
FD 0
Temp.-koeffizient 4,44
Schwallstro- Unterer Schwallstrom-Grenz- 0,0 g/cm3 0,0-10,0
mung wert g/cm?
Oberer Schwallstrom-Grenzwert | 5,0 g/cm?3 0,0-10,0
g/cm?3
Schwallstromdauer 0,0s 0,0-60,0s
Temperatur Temperaturdampfung 4,85 0,0-80s Vom Anwender eingegebener
Wert, korrigiert auf den nédchst
niedrigeren vorkonfigurierten
Wertin der Liste.
Temperatureinheiten Grad C
Temperaturkalibrierfaktor 1.00000T0.00
00
Druck Druckeinheiten PSI
Durchflussfaktor 0
Dichtefaktor 0
Kalibrierter Druck 0
SensorderT- | D3 0g/cm?3
Serie D4 0g/cm3
K3 Ous
K4 0 s
FTG 0
FFQ 0
DTG 0
DFQ1 0
DFQ2 0
Spezialeinheit- | Basis-Masseeinheit g

Basis-Massezeit

(%}

Massedurchfluss-Umrechnungs-
faktor

Basis-Volumeneinheit

Konfigurations- und Bedienungsanleitung

315



Voreingestellte Werte und Bereiche

Tabelle E-1: Voreingestellte Werte und Bereiche der Auswerteelektronik (Fortsetzung)

Typ Parameter Standard Bereich Bemerkungen
Basis-Volumenzeit s
Volumendurchfluss-Umrech- 1
nungsfaktor

Variablen- Primaérvariable Massedurch-

zuordnung fluss
Sekundarvariable Dichte
Tertidrvariable Massedurch-

fluss
Quartidrvariable Volumen-
durchfluss
mA-Ausgang 1 | Primarvariable Massedurch-
fluss
Messanfang -200,00000 g/s
Messende 200,00000 g/s

Analogausgangsabschaltung 0,00000 g/s
AO (Analogausgang) zusatzliche | 0,00000 s

Dampfung
UsG -2004g/s Schreibgeschiitzt.

USG wird auf Basis der Sensor-
groRe und Charakterisierung-
sparameter berechnet.

0SG 200g/s Schreibgeschiitzt.

OSG wird auf Basis der Sensor-
groRe und Charakterisierung-
sparameter berechnet.

Min. Spanne 0,3g/s Schreibgeschiitzt.
FehlermaBnahme Herunterskalie-
ren
Analogausgang-Storpegel - Her- | 3,2 mA 3,2-3,6mA
unterskalieren
Analogausgang-Storpegel - Her- 1 22 mA 21,0- 24,0 mA
aufskalieren
Zuletzt gemessener Wert vor 0,00s
Timeout
mA-Ausgang 2 | Sekunddrvariable Dichte
Messanfang 0,00 g/cm3
Messende 10,00 g/cm3

Analogausgangsabschaltung Not-A-Number

AO (Analogausgang) zusdtzliche | 0,00000 s
Dampfung

UsG 0,00 g/cm3 Schreibgeschiitzt.

USG wird auf Basis der Sensor-
groRe und Charakterisierung-
sparameter berechnet.
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Voreingestellte Werte und Bereiche

Tabelle E-1: Voreingestellte Werte und Bereiche der Auswerteelektronik (Fortsetzung)

Typ Parameter Standard Bereich Bemerkungen
0SG 10,00 g/cm3 Schreibgeschiitzt.
OSG wird auf Basis der Sensor-
groRe und Charakterisierung-
sparameter berechnet.
Min. Spanne 0,05 g/cm3 Schreibgeschiitzt.
FehlermaRnahme Herunterskalie-
ren
Analogausgang-Stérpegel - Her- | 3,2 mA 3,2-3,6mA
unterskalieren
Analogausgang-Storpegel - Her- | 22 mA 21,0-24,0mA
aufskalieren
Zuletzt gemessener Wert vor 0,00s
Timeout
Messanfang Massedurchflussrate -200,000 g/s
Volumendurchflussrate -0,2001L/s
Dichte 0,000 g/cm?
Temperatur -240,000 °C
Antriebsverstarkung 0,000 %
Standard-Gas-Volumendurch- -423,78 SCFM
fluss
Externe Temperatur -240,000 °C
Externer Druck 0,000 psi
Messende Massedurchflussrate 200,000 g/s
Volumendurchflussrate 0,200L/s
Dichte 10,000 g/cm3
Temperatur 450,000 °C
Antriebsverstarkung 100,000 %
Standard-Gas-Volumendurch- 423,78 SCFM
fluss
Externe Temperatur 450,000 °C
Externer Druck 100,000 psi
Frequenzaus- | Tertidrvariable Massedurch-
gang fluss
Frequenzfaktor 1.000,00 Hz 0,001 -10.000
Hz
Durchflussfaktor 1000 kg/min
Frequenz-Impulsbreite 277,0 ms 0oder0,5-
277,5ms
Skaliermethode Frequenz =
Durchfluss

Frequenz-FehlermaBnahme

Herunterskalie-
ren

Konfigurations- und Bedienungsanleitung
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Voreingestellte Werte und Bereiche

Tabelle E-1: Voreingestellte Werte und Bereiche der Auswerteelektronik (Fortsetzung)

Typ Parameter Standard Bereich Bemerkungen
Frequenz-Stérpegel — Herauf- 15.000 Hz 10,0 - 15.000
skalieren Hz
Frequenzausgangs-Polaritét Active high
Zuletzt gemessener Wert vor 0,0s 0,0-60,0s
Timeout

Bindrausgang | Quelle FlieBrichtung
Fehleranzeige Keine
Spannungsversorgung Intern
Polaritdt Active high

Polaritat Active low

Anzeige Hintergrundbeleuchtung ein/ Ein
aus
Hintergrundbeleuchtungs-In- 63 0-63
tensitat
Aktualisierungsrate 200 ms 100 -10.000

ms
Variable 1 Massedurch-
flussrate
Variable 2 Masse-Sum-
menzahler
Variable 3 Volumen-
durchflussrate
Variable 4 Volumen-Sum-
menzdhler
Variable 5 Dichte
Variable 6 Temperatur
Variable 7 Antriebsver-
starkung
Variable 8-15 Keine
Bedieninterface-Zahler starten/ = Deaktiviert
stoppen
Bedieninterface Zahler zuriick- = Deaktiviert
setzen
Display Auto Scroll Deaktiviert
Display Offline-Men(i Aktiviert
Display Offline-Passwort Deaktiviert
Display Alarm-Men(i Aktiviert
Display alle Alarme bestdtigen Aktiviert
Offline-Passwort 1234
Auto Scroll Rate 10s

Digitale Kom- | FehlermaRnahme Keine

munikation
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Voreingestellte Werte und Bereiche

Tabelle E-1: Voreingestellte Werte und Bereiche der Auswerteelektronik (Fortsetzung)

Typ

Parameter

Standard

Bereich

Bemerkungen

Fehler-Timeout

Os

0,0-60,0s
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Auswerteelektronik-Komponenten und Installationsverdrahtungs

AnhangF

Auswerteelektronik-Komponenten und
Installationsverdrahtungs

In diesem Anhang behandelte Themen:

. Installationsarten
e Anschlussklemmen fiir Spannungsversorgung und Erdung
e Ein-/Ausgangs-(E/A)-Verdrahtungsanschlussklemmen

F.1 Installationsarten

Die Auswerteelektroniken Modell 1700 und Modell 2700 kénnen auf fiinf verschiedene
Arten installiert werden, von denen jeweils nur eine auf Ihre spezifische Installation zutrifft.

. Integriert — Die Auswerteelektronik ist direkt an den Sensor montiert. Die
Auswerteelektronik muss nicht separat installiert werden, Sie miissen jedoch die
Spannungsversorgungs- und E/A-Verdrahtung anschlieRen.

Abbildung F-1: Integrierte Installation

Auswerteelektronik

. Flexibles Kabelschutzrohr fiir Hochtemperaturmodelle - Bei einigen
Hochtemperatur-Messsystemen ist bereits ein flexibles Kabelschutzrohr zwischen
Sensor und Auswerteelektronik installiert. Es miissen keine Kabel zwischen
Auswerteelektronik und Sensor angeschlossen werden, Sie miissen jedoch die
Elektronik separat montieren sowie die Spannungsversorgungs- und E/A-
Verdrahtung an die Auswerteelektronik anschlieRen.
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Auswerteelektronik-Komponenten und Installationsverdrahtungs

Abbildung F-2: Installation von Hochtemperaturmodellen mit flexiblem
Kabelschutzrohr

Fir die Installation von Hochtemperaturmodellen mit flexiblem Kabelschutzrohr
gelten die gleichen Installationsanweisungen wie fiir die externe Montage von 4-
adrigen Modellen. Dabei ist der Abstand zwischen dem Sensor und der
Auswerteelektronik jedoch durch die Lange des flexiblen Kabelschutzrohrs
beschrankt.

. Externe Montage, 4-adrig - Die Auswerteelektronik wird separat vom Sensor
installiert. Sie miissen die Auswerteelektronik vom Sensor separat montieren, ein 4-
adriges Kabel zwischen Auswerteelektronik und Sensor anschlieBen sowie die
Spannungsversorgungs- und E/A-Verdrahtung an die Auswerteelektronik
anschlieRen.
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Auswerteelektronik-Komponenten und Installationsverdrahtungs

Abbildung F-3: Installation mit externer Montage, 4-adrig — lackiertes
Aluminiumgehduse

Auswerteelektronik

Core Prozessor

4-adriges Kabel

Auswerteelektronik

Core Prozessor

4-adriges Kabel

. Externe Montage, 9-adrig - Die Auswerteelektronik und der Core Prozessor sind in
einem gemeinsamen Gehduse untergebracht, das vom Sensor separat montiert
wird. Sie miissen Auswerteelektronik/Core Prozessor vom Sensor separat
montieren, ein 9-adriges Kabel zwischen Auswerteelektronik/Core Prozessor und
Sensor anschlieRen sowie die Spannungsversorgungs- und E/A-Verdrahtung an die
Auswerteelektronik anschlieRen.
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Auswerteelektronik-Komponenten und Installationsverdrahtungs

Abbildung F-5: Installation mit externer Montage, 9-adrig

Auswerteelektronik

Anschlussdose

9-adriges Kabel

. Externer Core Prozessor mit externem Sensor - Bei einer Installation mit
externem Core Prozessor und externem Sensor sind alle drei Komponenten -
Auswerteelektronik, Core Prozessor und Sensor — getrennt und werden separat
installiert. Die Auswerteelektronik wird durch ein 4-adriges Kabel mit dem Core
Prozessor verbunden, und der Core Prozessor wird durch ein 9-adriges Kabel mit
dem Sensor verbunden.
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Auswerteelektronik-Komponenten und Installationsverdrahtungs

Abbildung F-6: Installation mit externem Core Prozessor und externem Sensor

F.2 Anschlussklemmen fiir Spannungsversorgung
und Erdung

Abbildung F-7: Anschlussklemmen Spannungsversorgung

A. Warnklappe
Gerdteerde
C Anschlussklemmen Spannungsversorgung

o
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F.3 Ein-/Ausgangs-(E[A)-
Verdrahtungsanschlussklemmen

Abbildung F-8: E|A-Verdrahtungsanschlussklemmen

A. mA/HART
Frequenz- oder Bindrausgang
C mA-Ausgang

®
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Historie NE 53

Anhang G
Historie NE 53

G.1 Historie NE 53

Betriebsanlei-

Datum Version Typ Anderung tung
08/2000 1.x Erweiterung Schreiben der Geratekennzeichnung mittels 3600204 A
Modbus hinzugefiigt
Einstellung Kommunikationshandling mit HART Tri-Loop
Produkt verbessert
Funktion Anzeige der Ausgangsoptions-Platinentyps wird
beim Einschalten im Display angezeigt
05/2001 2.x Erweiterung Alarm A106 hinzugefiigt, um anzuzeigen, dass | 3600204 B
der HART Burst-Modus aktiviert ist 3600647 A

Zugriff auf Auswerteelektronik in Fehlerstatusbit
via Modus hinzugefiigt

Steuerung des HART Burst-Modus jetzt via Mod-
bus moglich

Unterstiitzung fiir Auswerteelektronik
Modell 1700 hinzugefiigt

Unterstiitzung fiir eigensichere Auswerteelek-
tronikoption hinzugefiigt

Unterstiitzung zur Konfiguration von Prozessvar-
iableneinheiten fiir Massedurchfluss, Volumen-
durchfluss, Dichte und Temperatur mittels Be-
dieninterface hinzugefiigt.

Unterstiitzung fiir das Zuweisen von Prozessvar-
iablen zum mA- und Frequenzausgang mittels
Bedieninterface hinzugefiigt

Einstellung Interaktion der digitalen Stéreinstellung und
Stérung-Timeouts (zuletzt gemessener Wert
Timeout) bereinigt

Funktion Antriebsverstdrkung kann mA Ausgang zugewie-
sen werden

Druckkompensation via HART hinzugefiigt

Kanal B kann als Bindrausgang konfiguriert wer-

den

12/2001 3.x Erweiterung Unterstiitzung fir konfigurierbare E/A-Options- | 3600647 B
platine hinzugefiigt 3600785 A
Software-Versionsinformationen Giber Bedienin- | 20000325 A
terface oder Modbus verfiigbar 20000325B
Konfigurierbare Dichteabschaltung 20000150 A

200001508
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Historie NE 53

Betriebsanlei-

Datum Version Typ Anderung tung
Zusatzliche HART Variablen kdnnen QV zugewie- | 20000148 A
sen werden

Die Funktion Zahler starten/stoppen mit dem
Bedieninterface kann aktiviert oder deaktiviert
werden

Anwendung fiir die Mineral6lmessung verbes-
sert

Nullpunktwert als Displayvariable verfligbar

Optionen fir Einstellungen der Stérausgdnge er-
weitert

Temperaturalgorithmen fiir kryogene Anwen-
dungen neu

Einstellung Frequenzausgangsstabilitdt und Einheitenum-
rechnungen verbessert

Verarbeitung von Volumendurchfluss bei er-
kannter Schwallstromung verbessert

Verarbeitung von Dichtewerten und Kalibrierun-
gen wdhrend Stérbedingungen verbessert

Bedieninterface Konfiguration, Durchflussiiber-
wachung und optische Schalter gedndert

HART Kommunikation und Burst-Modus verbes-
sert

Funktion Anwendung fiir Mineraldlmessung hinzugefiigt

Option fiir eichgenauen Verkehr zur konfigurier-
baren E/A-Optionsplatine hinzugefiigt

HART Abfrage fiir externe(n) Druck/Temperatur
hinzugefiigt

06/2003 4.x Erweiterung Unterstiitzung fiir Auswerteelektronik 20000325 C
Modell 1500 hinzugefiigt 20000150 C
Auswerteelektronik Modell 1700 zeigt zusatzli- | 3600647 C
che Variablen an 20000148 B
Einstellung Verarbeitung bestimmter Alarmbedingungen 20001715A
verbessert

Verhalten bestimmter Modbus Kalibrierspeicher
geklart

Zusammenspiel zwischen bestimmten Dichte-
messeinheiten und Dichteabschaltwerten ge-
klart

Verarbeitung der mA Quelleneinstellung tiber
Bedieninterface verbessert

Druck- und Temperaturabfrage verbessert

HART Tri-Loop und andere Kommunikation ver-
bessert

Via Modbus skalierten Integerregister zuriickge-
gebener Wert wihrend Fehlerbedingung geklart
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Betriebsanlei-

Datum Version Typ Anderung tung
Funktion Bindrwerte jetzt iber Modbus verfliigbar
09/2006 5.x Erweiterung Bindrausgang als Durchflussschalter zuweisbar | 20001715 B

Storanzeige des Binarausgangs konfigurierbar

Unterstiitzung tber Bindreingang fiir mehrere
Aufgabenzuweisungen

Unterstiitzung fiir Abfrage des Bedieninterface
LED-Status via Modbus hinzugefiigt

HART und Modbus Befehle hinzugeftigt

Prozess-Komparator auf fiinf konfigurierbare
Ereignisse erweitert

Funktion zur Herstellung der Werkskonfigura-
tion

Funktion zur Nullpunktwiederherstellung

Alarmbhistorie erweitert

Schreibschutz fiir Konfigurationsdaten auswahl-
bar

Auswahl von Quellenzuordnungen fiir mA Aus-
gang erweitert

Speicherung von mA Bereichswerten erweitert

Anwendung fiir den eichgenauen Transfer fir
unabhangige Implantation der NTEP- und OIML-
Compliance erweitert

Einstellung Display Verbesserungen fiir FlieRkommadaten

Funktion Alarmstufe konfigurierbar

Gas Standardvolumen Funktionalitdt

Systemverifizierung als Option lieferbar

Mehrfach Display-Sprachenauswahl

09/2009 6.x Erweiterung Frequenzausgang als Bindrausgang bei Auswer- | 20001715 BA
teelektroniken der Serie 1000 konfigurierbar

Bindrausgang kann als Durchflussschalter bei
Auswerteelektroniken der Serie 1000 zugewie-
sen werden

Displayvariable 1 optional fixiert auf Prozessvari-
able, die dem primaren mA Ausgang zugewiesen
ist

Frequenzausgang Skaliermethode und zugehor-
ige Parameter (iber das Bedieninterface konfi-
gurierbar

Fir erweiterte Dichtemessung und Mineral6l-
messungen Prozessvariablen zeigt das Display
abwechselnd Variablennamen, Stromwert und -
einheit und Referenztemperatur an
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Historie NE 53

Datum

Version

Typ

Anderung

Betriebsanlei-
tung

Einstellung

Die folgenden Kombinationen sind nicht zulds-

sig:

* mA Ausgang Storaktion = Keine und Digital-
kommunikation Storaktion = NAN

* Frequenzausgang Stoéraktion = Keine und
Digitalkommunikation Storaktion = NAN

Displayvariablen, die auf eine Volumenprozess-
variable eingestellt sind, schalten automatisch
zwischen Fliissigkeit und GSV, entsprechend den
aktuellen Einstellungen des Volumendurchflus-
stypsum

Funktion

Hysterese fiir Durchflussschalter konfigurierbar

Feldverifizerungsnullpunkt zur Unterstiitzung
der Anwendung Weights & Measures hinzuge-
fugt

Priifsumme der Auswerteelektronik Firmware
und der Core Prozessor Firmware kénnen als Dis-
playvariablen zugewiesen und angezeigt werden
ProLink II

Konfigurations- und Bedienungsanleitung
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Index

A Anwendung Konzentrationsmessung
Abfrage Abgeleitete GroRen und berechnete
Druck Prozessvariablen 64
mit Handterminal 69 Konfiguration
mit ProLink Il 65 mit Handterminal 60
mit ProLink Ill 67 mit ProLink Il 54
Temperatur mit ProLink Ill 57

Anwendung Konzentrationsmessung Standardmatrizen 62

mit Handterminal 60 Ubersicht 54
mit ProLink Il 54 Anwendung Mineralélmessung

mit ProLink Ill 57 API-Referenztabellen 53
Konfiguration

Anwendung Mineral6lmessung
mit Handterminal 52

mit Handterminal 52

mit ProLink Il 49 mit ProLink Il 49
mit ProLink Ill 50 mit ProLink Il 50
Abgeleitete GroRe, siehe Anwendung Ubersicht 49
Anzeige

Konzentrationsmessung
Abgleichen, siehe mA-Ausgdnge, abgleichen
Abschaltungen

Zahlerwerte und eichamtliche Transfer
Anwendung 149

Dichte 46 AP|, siehe Anwendung Mineralélmessung
Massedurchfluss 24 Aufnehmer
Stérungsanalyse und -beseitigung 226 Daten sammeln 229
Volumendurchfluss 30 Stérungsanalyse und -beseitigung 228
address Auswerteelektronik
HART address 118 E/A-Anschlussklemmen 325
Erde 324

Aktualisierungsrate

Auswirkung auf Prozessmessung 82, 83 Installationsarten 320

Kommunikationsprotokolle 2

Display 75

inkompatible Funktionen 82, 83 Modellcode 2

Konfigurieren 81 Spannungsversorgungs-Anschlussklemmen 324
Alarm-Ment, siehe Display Auswerteelektronik-Bedieninterface
Alarme Siehe auch Display

Komponenten 239
Auto Scroll 75

Alarmcodes 193
Antwort der Auswerteelektronik 143
Anzeigen und Quittieren

unter Verwendung des Displays 139 B
unter Verwendung des Handterminals 142 basic events, siehe events
unter Verwendung von ProLink Il 141 Bedieninterface, siche Display
unter Verwendung von ProLink Il 141 Bedieninterface (LOI), siehe Display
Konfigurieren der Alarmbehandlung 84 Berechnungsgeschwindigkeit 83
Status Alarmstufe Bestdnde
Konfigurieren 85 Starten und Stoppen 144
Optionen 86 Zuriicksetzen 147
Stérungsanalyse und -beseitigung 193 Bindrausginge
Alarmmeldungen, siehe Alarme Messkreistest
Analogausgang Abschaltung 99 unter Verwendung des Displays 215
Antriebsverstdrkung unter Verwendung des Handterminals 219
Daten sammeln 228 unter Verwendung von ProLink Il 216
Storungsanalyse und -beseitigung 227, 228 unter Verwendung von ProLink Il 218
Antwortzeit 83 burst mode 119
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channel configuration 94
Charakterisierung
Dichteparameter 10
Durchflusskalibrierparameter 9
Parameter flir Sensor-Tags 8
Verfahren 7
communications, siehe digital communications
configuration
channel 94
digital communications 118
discrete outputs 110
events
basic 115
enhanced 116
frequency outputs 103
mA outputs 95
CTL 49
cutoffs
AO cutoff 99
interaction between AO Cutoff and process variable
cutoffs 100

D

Dampfung
Dichteddmpfung 45
Durchflussdampfung 23
Temperaturddmpfung 48
damping
Added Damping 101
interaction between Added Damping and process
variable damping 102
on mA outputs 101
Datum 91
DD, siehe HART-Geratebeschreibung (DD)
deadband, siehe hysteresis
Deskriptor 90
Dezimalschreibweise, siehe Display, Dezimalschreibweise
Dezimalwerte
Eingabe (iber Display 242
Genauigkeit der Displayvariablen 74
Diagnose
Messkreistest
unter Verwendung des Displays 215
unter Verwendung des Handterminals 219
unter Verwendung von ProLink Il 216
unter Verwendung von ProLink Il 218
Sensorsimulation 125
Smart Systemverifizierung 158
Dichte
Siehe auch Standarddichte
Dichtefaktor, siehe Druckkompensation
Dichtekalibrierung, siehe Kalibrierung, Dichte
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Dichtemessung
Abschaltung
Konfiguration 46
Wirkung auf Volumendurchflussmessung 47
Dampfung
Wechselwirkung mit zusatzlicher Dampfung 46
Wirkung auf Volumendurchflussmessung 46
Konfiguration 42
Messeinheiten
Konfiguration 42
Optionen 42
Schwallstrémung
Konfiguration 43
Stérungsanalyse und -beseitigung 226
Verhalten der Auswerteelektronik 44
Storungsanalyse und -beseitigung 208
Systemfaktor 177
digital communications
configuring HART/Bell 202 parameters 118
Digital Communications Fault Action
configuring 123
options 123
Digitale Kommunikation Storaktion 123
discrete outputs
configuring 110
Fault Action
configuring 113
options 114
faultindication 114
flow switch 112
polarity
configuring 113
options 113
source
configuring 110
options 111
Display
Aktivieren oder Deaktivieren von Bedienereingaben
Quittieren aller Alarme 79
Starten und Stoppen von Summenzdhlern 77
Zuriicksetzen von Summenzdhlern 78
Dezimalschreibweise 242
Display-Konfiguration
Aktualisierungsrate 75
Automatischer Bildlauf 75
Displaygenauigkeit 74
Displaysprache 72
Displayvariablen 73
Hintergrundbeleuchtung 76
LED-Blinken 77
Exponentialschreibweise 242
FlieBRkommawerte 242
Komponenten 239
Konfigurieren der Sicherheit
Alarm-Kennwort 80
Offline-Kennwort 80
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Zugriff auf Alarm-Men{ 80
Zugriff auf Offline-Menii 80
Mentiicodes 247
Menistrukturen 250
Optische Schalter 240
Prozessvariablencodes 245
Status LED-Zustdnde 192
Zugriff auf das Menisystem 241
Dokumentation 3
Druckkompensation
Druckmesseinheiten
Optionen 70
Konfiguration
mit Handterminal 69
mit ProLink Il 65
mit ProLink Ill 67
Ubersicht 65
Durchflussdampfung
Konfiguration 23
Wechselwirkung mit zusatzlicher Dampfung 24
Wirkung auf Volumendurchflussmessung 24
Durchflussfaktor 65, 107, siehe Druckkompensation
Durchflussrichtung
Konfiguration 37
Optionen 37
Storungsanalyse und -beseitigung 226
Wirkung auf Bindrausgdnge 40
Wirkung auf digitale Kommunikation 41
Wirkung auf Frequenzausgdnge 40
Wirkung auf mA-Ausgdnge 38
Wirkung auf Zahler und Bestdnde 41
Durchflussschalter (flow switch) 112

E

E/A-Anschlussklemmen 325
Eichamtliche Transfer Anwendung
Aufsichtsbehérden 129
Austausch des Core Prozessors 155
Auswirkung auf Betrieb und Wartung
NTEP 151
OIML 152
Auswirkung auf die Ausgange
NTEP 150
OIML 150
Auswirkung auf die Prozessvariablen
NTEP 150
OIML 150
Einstellung
mit ProLink Il 130
mit ProLink Ill 132
gesichert und ungesichert 129
Modi wechseln
mit dem Wechsel Hilfsprogramm 154
mit ProLink Il 153
mit ProLink Ill 154
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NTEP 149
OIML 149
Sicherheitstypen 129
Statusalarm A027:Sicherheitsverletzung 129, 155
Ubersicht 129,130
Ubersicht {iber den Betrieb 148
Verplombung 130, 132
Zdhler Riicksetzoptionen 130, 132
Eichpflichtiger Transfer, siehe Eichamtliche Transfer
Anwendung
Einheit, siehe Messeinheiten
enhanced events, siehe events
Erde 324
Erdung
Storungsanalyse und -beseitigung 214
Erhohte Dichte, siehe Anwendung
Konzentrationsmessung
events
configuring basic events 115
configuring enhanced events 116
Enhanced Event Action
configuring 116
options 117
event models 115
Exponentialschreibweise, siehe Display,
Exponentialschreibweise

F

Fault Action
digital communications 123
discrete outputs 113
frequency outputs 109
mA outputs 102
Fehler-Zeitiiberschreitung
Auswirkung auf Stéraktion 84
Konfigurieren 84
Feldverifizierung Nullpunkt (FVZ), siehe Eichamtliche
Transfer Anwendung
FlieBkommawerte, siehe Display, FlieBkommawerte
frequency outputs
configuring 103
Fault Action
configuring 109
options 109
maximum pulse width 108
polarity
configuring 105
options 106
process variable
configuring 104
options 104
scaling method
configuring 106
Frequency = Flow 107
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Frequenzausgdnge
Messkreistest
unter Verwendung des Displays 215
unter Verwendung des Handterminals 219
unter Verwendung von ProLink Il 216
unter Verwendung von ProLink Il 218
Storungsanalyse und -beseitigung 212,225
Frequenzfaktor 107

G

Geratebeschreibung (DD), siehe HART-
Geratebeschreibung (DD)

gesichert, siehe Eichamtliche Transfer Anwendung

GSV, siehe Standard-Gasvolumendurchflussmessung

H

Handterminal
Geratebeschreibung (DD) 298
Menistruktur 302
Startverbindung 7
Ubersicht 298,299
Verbindung mit der Auswerteelektronik 299
HART
address 118
Adresse 223
burst mode 119
Burst-Modus 224
Geratebeschreibung (DD) 298
HART/Bell 202
configuring 118
Handterminal-Verbindungen 299
Loop Current Mode 118
Messkreis 223
Messkreis Strommodus 223
variables
configuring 120
interaction with transmitter outputs 122
options 121
Hochfrequenzstérungen (HFS) 224
Hysterese 112

Informationsparameter 89
Installationsarten
Hochtemperaturmodell mit flexiblem
Kabelschutzrohr 320
extern, 4-adrig 320
extern, 9-adrig 320
externer Core-Prozessor mit externer
Auswerteelektronik 320
integriert 320

K

Kalibrierdruck, siehe Druckkompensation
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Kalibrierparameter, siehe Charakterisierung
Kalibrierung
Definition 157
Dichte D1 und D2
Ubersicht 179
unter Verwendung des Handterminals 183
unter Verwendung von ProLink Il 180
unter Verwendung von ProLink Il 181
Dichte D3 und D4
Ubersicht 184
unter Verwendung des Handterminals 187
unter Verwendung von ProLink Il 185
unter Verwendung von ProLink Il 186
mA-Ausgange, siehe mA-Ausgdnge, abgleichen
Temperatur
unter Verwendung von ProLink Il 189
unter Verwendung von ProLink Il 190
Kennwort
Alarm-Kennwort 80
Offline-Kennwort 80
Kommunikation
Protokolle 2
Kommunikationsmittel 2
Konfiguration
Ablaufdiagramm 16
Antwortzeiten 81
Anwendung Konzentrationsmessung, siehe
Anwendung Konzentrationsmessung
Anwendung Mineral6lmessung, siehe Anwendung
Mineral6lmessung
Dichtemessung 42
Display 72,77,80
Druckkompensation, siehe Druckkompensation
Eichamtlicher Transfer, siehe Eichamtliche Transfer
Anwendung
Informationsparameter 89
Massedurchflussmessung 20
Schreibschutz 18,128
Sichern 127
Standard-Gasvolumendurchflussmessung 31
Standardwerte 314
Temperaturmessung 47
Volumendurchflussmessung 26
Werkseinstellungen wiederherstellen
unter Verwendung von ProLink Il 19
unter Verwendung von ProLink Ill 19
Kundenservice
Kontakt ii
Kurve, siehe Anwendung Konzentrationsmessung
Kurzschlisse
Stérungsanalyse und -beseitigung 229

L

LD-Optimierung 180,181, 183
LED, siehe Status LED
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Letzter Messwert - Zeitliberschreitung, siehe Fehler-
Zeitiiberschreitung

Lower Range Value (LRV) 97

Luftkalibrierung, siehe Kalibrierung, Dichte

M

mA Messkreis Modus 118,223
mA outputs
Added Damping
configuring 101
interaction with flow damping 24
AO cutoff
configuring 99
configuring 95
Fault Action
configuring 102
Lower Range Value and Upper Range Value
configuring 97
default values 98
process variable
configuring 95
options 96
scaling 97
mA-Ausgdnge
Abgleichen
unter Verwendung des Handterminals 222
unter Verwendung von ProLink Il 221
unter Verwendung von ProLink Il 221
AO-Abschaltung
Wechselwirkung mit
Volumendurchflussabschaltung 30
Messkreistest
unter Verwendung des Displays 215
unter Verwendung des Handterminals 219
unter Verwendung von ProLink Il 216
unter Verwendung von ProLink Il 218
Storungsanalyse und -beseitigung 210, 224
Zusatzliche Dampfung
Wechselwirkung mit Dichteddmpfung 46
Massedurchflussmessung
Abschaltung
Konfiguration 24
Wechselwirkung mit AO-Abschaltung 25
Wirkung auf Volumendurchflussmessung 25
Durchflussdampfung 23
Konfiguration 20
Messeinheiten
Konfiguration 20
Optionen 21
Storungsanalyse und -beseitigung 205
Massendurchflussmessung
Systemfaktor 177
Matrix, siehe Anwendung Konzentrationsmessung
Maximum Pulse Width 108
Meldung 90

Menstruktur
Handterminal 302
ProLink Il 270
ProLink Il 289
Menistrukturen
Display 250
Messeinheiten
Dichte
Konfiguration 42,45
Optionen 42
Druck, siehe Druckkompensation
Massedurchfluss
Konfiguration 20
Optionen 21
Spezialeinheit 22
Standard-Gasvolumendurchfluss
Konfiguration 32
Optionen 33
Spezialeinheit 34
Temperatur
Konfiguration 47
Optionen 47
Volumendurchfluss
Konfiguration 27
Optionen 27
Spezialeinheit 28
Messkreistest
unter Verwendung des Displays 215
unter Verwendung des Handterminals 219
unter Verwendung von ProLink Il 216
unter Verwendung von ProLink Il 218
Metrologische Sicherheit, siehe Eichamtliche Transfer
Anwendung
Mitgefiihrtes Gas, siehe Dichtemessung,
Schwallstrémung
Modellcode 2

N

National Type Evaluation Program (NTEP), siehe
Eichamtliche Transfer Anwendung
Null
Null-Werkseinstellung wiederherstellen
unter Verwendung des Handterminals 175
unter Verwendung von ProLink Il 172
unter Verwendung von ProLink Il 174
Prozedur
unter Verwendung des Handterminals 175
unter Verwendung von ProLink Il 172
unter Verwendung von ProLink Il 174
Verifizierung
unter Verwendung von ProLink Il 11
unter Verwendung von ProLink Il 12
Vorherige Null wiederherstellen
unter Verwendung von ProLink Il 172
unter Verwendung von ProLink Il 174
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Offline-Men(i, siehe Display

Optische Schalter 240

Organization of Legal Metrology (OIML), siehe
Eichamtliche Transfer Anwendung

P

Physikalische Sicherheit, siehe Eichamtliche Transfer
Anwendung
Plombe, siehe Eichamtliche Transfer Anwendung
polarity
discrete outputs 113
frequency outputs 105
primary variable (PV) 120
ProLink I
Anforderungen 260
Menistruktur 270
Ubersicht 260, 261
Verbinden
HART/Bell 202 263
Service Port 262
Startverbindung 7
Verbindungsarten 261
ProLink IlI
Anforderungen 279,280
Menistruktur 289
Ubersicht 279,280
Verbinden
HART/Bell 202 282
Service Port 281
Startverbindung 7
verbinden mit der Auswerteelektronik 280
Verbindungsarten 280
Protokolle 2
Prozessmessung
Auswirkung auf Aktualisierungsrate 81-83

Auswirkung auf Berechnungsgeschwindigkeit 83

Prozessvariablen
Siehe auch Dichtemessung
Siehe auch Massedurchflussmessung

Siehe auch Standard-Gasvolumendurchflussmessung

Siehe auch Temperaturmessung
Siehe auch Volumendurchflussmessung
Auf dem Display verwendete Codes 245
Konfigurieren von Prozessvariablen 73
Werte anzeigen 137
Werte aufzeichnen 136

Priifen, siehe Systemvalidierung

pulse width 108

Q

quaternary variable (QV) 120
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R
Referenzdichte, siehe Standarddichte

S

scaling
frequency outputs 106
mA outputs 97
Schreibschutz 18,128
Schwallstrémung, siehe Dichtemessung,
Schwallstrémung
Scroll Rate 75
secondary variable (SV) 120
Sensor Material 91
Sensor Serial Number 91
Sensor-Auskleidungswerkstoff 92
Sensor-Flanschtyp 92
Sensor-Simulationsmodus
unter Verwendung von ProLink Il 125
unter Verwendung von ProLink Il 125
Sensorsimulation
Storungsanalyse und -beseitigung 212
Ubersicht 126
unter Verwendung des Handterminals 125
Sensorspulen
Storungsanalyse und -beseitigung 229, 230
Sensorverdrahtung
Storungsanalyse und -beseitigung 214
Sicherheit
Siehe auch Eichamtliche Transfer Anwendung
Zugriff auf Display-Meniis 80
Sicherheitsverletzung, siehe Eichamtliche Transfer
Anwendung
Sicherungen 127
Simulation
Sensorsimulation
unter Verwendung des Handterminals 125
unter Verwendung von ProLink Il 125
unter Verwendung von ProLink Il 125
Smart Systemverifizierung
Anforderungen 158
Ausfiihren eines Tests
unter Verwendung des Displays 159
unter Verwendung des Handterminals 163
unter Verwendung von ProLink Il 161
unter Verwendung von ProLink Il 162
automatische Ausfiihrung und Planung
unter Verwendung des Displays 168
unter Verwendung des Handterminals 170
unter Verwendung von ProLink Il 169
unter Verwendung von ProLink Il 170
Definition 157
Testergebnisse
anzeigen mit dem Display 164
anzeigen mit dem Handterminal 166
anzeigen mit ProLink Il 165
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anzeigen mit ProLink lll 166
Inhalt 163
Interpretation 166
Testvorbereitung 159
Software Sicherheit, siehe Eichamtliche Transfer
Anwendung
Spannungsversorgungs-Anschlussklemmen 324
Spezial-Messeinheiten
Massedurchfluss 22
Volumendurchfluss 28
Spezialmesseinheiten
Standard-Gasvolumendurchfluss 34
Sprache
fiir Display 72
Standard-Gasvolumendurchflussmessung
Abschaltung
Konfiguration 35
Wechselwirkung mit AO-Abschaltung 36
Konfiguration 31
Messeinheiten
Konfiguration 32
Optionen 33
Standarddichte 32
Volumendurchflusstyp 31
Wirkung der Durchflussdampfung auf 24
Wirkung der Massedurchflussabschaltung auf 25
Standarddichte 32
Standardwerte 314
Status LED 138,192
Statusalarme, siehe Alarme
Storaktion
beeinflusst von Fehler-Zeitiiberschreitung 84
Storungsanalyse und -beseitigung
Alarme 193
Antriebsverstarkung 226-228
Aufnehmerspannung 228
Bindrausgdange 224,226
Dichtemessung 226
Erdung 214
Frequenzausgdnge 212,224-226
HART-Kommunikation 223,224
Hochfrequenzstérungen (HFS) 224
Kurzschliisse 229,230
mA-Ausgdnge 210,224,226
Massendurchflussmessung 205, 226
Schwallstrémung (Zweiphasenstromung) 226
Status LED 192
Systemtest 212
Temperaturmessung 209
Verdrahtung 213,214
Volumenstrommessung 205, 226
Werkseinstellungen wiederherstellen
unter Verwendung von ProLink Il 19
unter Verwendung von ProLink Ill 19
Stromversorgung
Einschalten 5

Summenzahler
Starten und Stoppen
Aktion ausfiihren 144
Aktivieren der Displayfunktion 77
Zurlicksetzen
Aktion ausfiihren 145, 146
Aktivieren der Displayfunktion 78
Systemfaktoren, siehe Systemvalidierung
Systemvalidierung
alternative Methode fiir Volumenstrom 178
Definition 157
Standardmethode 177
Systemverifizierung, siehe Smart Systemverifizierung

T

Temperaturkalibrierung, siehe Kalibrierung, Temperatur
Temperaturmessung
Dampfung
Konfiguration 48
Wirkung auf Prozessmessung 48
Konfiguration 47
Messeinheiten
Konfiguration 47
Optionen 47
Stérungsanalyse und -beseitigung 209
tertiary variable (TV) 104,120
Testen
Messkreistest
unter Verwendung des Displays 215
unter Verwendung des Handterminals 219
unter Verwendung von ProLink Il 216
unter Verwendung von ProLink Il 218
Systemtest 125

U

ungesichert, siehe Eichamtliche Transfer Anwendung
Update Periode 75
Upper Range Value (URV) 97

\"

Verbindung
Handterminal 299
ProLink I
Arten 261
ProLink IlI
Arten 280
Startverbindung 7
Verdrahtung
E/A-Anschlussklemmen 325
Erde 324
Erdung
Stérungsanalyse und -beseitigung 214
Sensorverdrahtung
Storungsanalyse und -beseitigung 214
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Spannungsversorgungs-Anschlussklemmen 324
Verdrahtung der Stromversorgung
Stérungsanalyse und -beseitigung 213
Verdrahtung der Stromversorgung
Storungsanalyse und -beseitigung 213
Volumendurchflussmessung
Abschaltung
Konfiguration 30
Wechselwirkung mit AO-Abschaltung 30
Konfiguration 26
Messeinheiten
Konfiguration 27
Optionen 27
Volumendurchflusstyp 26
Wirkung der Dichteabschaltung auf 47
Wirkung der Dichtedampfung auf 46
Wirkung der Durchflussdampfung auf 24
Wirkung der Massedurchflussmessung auf 25
Volumendurchflusstyp
Anwendung Fliissigkeiten 26
Anwendung Gase 31
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Volumenkorrekturfaktor (VCF) 49
Volumenstrommessung
Storungsanalyse und -beseitigung 205
Systemfaktor 177,178

W

Warmeausdehnungskoeffizient (TEC) 49
Wasserkalibrierung, siehe Kalibrierung, Dichte

y4

Zahler
Anzeige der Werte und eichamtliche Transfer
Anwendung 149
zuriicksetzen
Optionen fir Eichamtliche Transfer
Anwendung 130, 132
Zusatzliche Dampfung 101
Zwei-Phasen-Durchfluss, siehe Dichtemessung,
Schwallstrémung
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